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KATA PENGANTAR 
 

 

Puji syukur kepada Tuhan yang maha esa, bahwa buku yang berjudul “Desain model 

Arsitektur dan Furnitur” dibagi jadi 2 (dua) bagian, yaitu buku jilid 1 (satu) dan buku jilid 2 (dua) 

yang telah dapat diselesaikan. Kedua buku itu memakai program aplikasi SketchUp yaitu 

aplikasi model 3D intuitif yang memungkinkan kita membuat dan mengedit model 2D dan 3D 

dengan menggunakan teknik cara “push and Pull” yang telah dipatenkan. Pemakaian push & 

Pull ini menyebabkan para desainer dapat mengubah permukaan datar menjadi bentuk 3D. 

Buku ini membahas desain model 3D seperti arsitektur, desain interior, arsitektur 

lanskap dengan memakai aplikasi SketchUp. Setelah SketchUp terinstal pada komputer kita, 

maka kita dapat memulai dengan menelusuri tempat penyimpanan (gudang) gambar 3D. 

Gudang Gambar 3D adalah berisi basis data model gambar 3D buatan para pengguna yang 

telah disediakan bagi siapa saja untuk diakses, mulai dari bangunan sederhana hingga seluruh 

gambar arsitektur bangunan kota dan furnitur pada abad pertengahan. 

Pada buku ini juga diajarkan fungsi dan tata letak dalam menggambar, perenderan 

permukaan dan didukung oleh Gudang gambar 3D yang tersedia secara ekstensi. Aplikasi 

SketchUp ini memiliki berbagai kemudahan yang mendukung desain arsitektur, desain interior, 

dan desain lanskap. Salah satu alasan dalam buku desain model arsitektur dan furnitur 

memakai aplikasi sketchup karena aplikasinya ringan, sehingga hampir semua komputer dapat 

mengoperasikan aplikasi sketchup dengan baik, demikian juga system antarmukanya juga 

menarik dan sedernana, bahkan bagi para pemula. Demikian juga tersedianya fungsi untuk 

mengimpor file ekstensi seperti 3ds, dwg, pdf, jpg dan lain lain. 

Semoga buku ini dapat memberi pengetahuan, pengalaman dan bermanfaat bagi para 

mahasiswa yang ingin belajar mengembangkan desain model arsitektur dan furnitur dengan 

cara yang mudah dan sederhana. 

 
 

Semarang, 20 Mei 2021 
 

Dr. Mars Caroline Wibowo, ST, M.Mm.Tech. 
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BAGIAN 1 

BAB 1 

DASAR SKETCHUP 

Untuk menggunakan Pemodelan Proses SketchUp secara efektif, Anda harus memiliki 
pemahaman dasar tentang konsep SketchUp. Ini termasuk mengetahui terminologi SketchUp 
dan memahami bagaimana SketchUp menampilkan model, bagaimana beberapa alat 
berfungsi, dan cara bekerja di SketchUp. 

Geometry 

SketchUp menampilkan model melalui geometri. Ini secara digital menghasilkan garis dan 
permukaan yang bila digabungkan membuat bentuk, bentuk, dan objek. Untuk buku ini, istilah 
geometri merujuk secara kolektif ke tepi dan muka, seperti yang dijelaskan di bagian berikut. 

Simple Geometry 

SketchUp membangun model menggunakan face dan edge. Edge (tepi) adalah garis tunggal 
yang dapat dihubungkan, dipindahkan, dan disesuaikan. Menghubungkan tiga atau lebih tepi 
dalam loop tertutup dapat membuat sebuah face. 

Face terdiri dari ujung-ujung yang saling terhubung dan menyerupai satu permukaan yang 
sangat tipis. Face bisa menyerupai banyak bentuk dan bentuk. 

 

Gambar 1.1 Face dan Edge/Line 

Menghapus tepi yang membentuk sebuah face akan menghapus face tersebut. Menyesuaikan 
tepi yang membentuk face akan mempengaruhi dan menyesuaikan face. Face dapat diberi 
volume untuk menjadikannya tiga dimensi. 

Geometri Kompleks 

Dengan menghubungkan geometri dalam urutan tertentu, Anda dapat membuat permukaan 
dan objek. Permukaan melengkung atau bulat terdiri dari serangkaian permukaan datar segi 
yang dihubungkan untuk menciptakan ilusi kelengkungan. Objek kubus 3D sederhana terdiri 
dari enam permukaan yang terhubung dan tepinya yang terkait . 
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Gambar 1.2 Permukaan yang terdiri dari face (kiri) dan kubus/benda (kanan) 

Kubus 3D memiliki volume; itu memiliki panjang, lebar, dan kedalaman yang bervariasi. 
Volume kubus ini berlubang, berlawanan dengan yang tampak padat. Menghapus sebuah 
permukaan akan menampilkan interior kubus. Semua objek 3D di SketchUp memiliki volume 
dan berlubang. Istilah volume digunakan secara teratur dalam buku ini untuk menggambarkan 
geometri yang memiliki panjang, lebar, dan kedalaman. 

Healing Face 

Istilah Healing face mengacu pada penggunaan Draw atau alat lain untuk menghasilkan 
geometri face dari tepi. Cara paling sederhana untuk healing face adalah dengan 
menggunakan line tool untuk membuat tepi yang akan menghasilkan face. 

 

Gambar 1.3 Objek tiga dimensi di SketchUp berlubang. 
 

 

Gambar 1.4 Line tool dan tepi digunakan untuk membuat face/healing face 
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Subdividing Face 

Subdiving (pengelompokan) Ini mengacu pada penggunaan geometri, biasanya tepi, untuk 
lebih membagi face menjadi beberapa face. Ada banyak contoh di mana Anda akan diminta 
untuk menggunakan drawing tool SketchUp untuk mempartisi atau membagi face menjadi 
beberapa face. 

 

 

Gambar 1.5 Tepi dapat membagi satu face menjadi dua atau lebih face. 

Sticky Geomeetry 

Tepi dan permukaan di SketchUp bersifat”sticky (melekat)" relatif terhadap geometri lain 
tempat keduanya terhubung. Memindahkan, memutar, atau mengedit tepi atau permukaan 
akan memengaruhi semua geometri yang terhubung. 

 

 

Gambar 1.6 Semua geometri terpasang (bersentuhan). 
 

Gambar 1.7 Menggerakkan permukaan depan kubus akan meregangkan/memindahkan 
semua geometri yang bersebelahan yang terhubung.. 
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Face Count 

Istilah hitungan face mengacu pada berapa banyak face yang menyusun model atau objek. 
Jumlah face yang tinggi menunjukkan bahwa model atau objek terdiri dari banyak face. Objek 
dengan jumlah face yang tinggi biasanya memiliki lebih banyak detail, yang membuatnya lebih 
diinginkan — misalnya, pohon 3D dibandingkan pohon 2D. 

 

Gambar 1.8 Objek hitung face rendah (kiri) versus objek hitung face tinggi (kanan) 

Model dengan jumlah face tinggi atau model yang dipenuhi dengan banyak objek dengan 
jumlah face yang tinggi dapat memengaruhi dan mungkin memperlambat kinerja komputer. 
Proses yang dijelaskan dalam buku ini secara langsung membahas masalah ini dengan strategi 
untuk menggunakan objek penghitungan face yang tinggi sambil menjaga kinerja komputer. 

Alat Dasar (Basic Tool) SketchUp 

Tool SketchUp beroperasi dengan menggunakan teknik Klik + lepaskan. Setelah alat diaktifkan, 
klik dan lepaskan tombol kiri mouse untuk menggambar tepi, memindahkan item, atau 
melakukan fungsi lainnya. Jangan klik dan tahan untuk menjalankan fungsi; ini dikenal sebagai 
Klik + seret. 

Untuk mempraktikkan teknik Klik + lepaskan, aktifkan alat, pilih titik pertama, dan lepaskan 
tombol mouse. Jangan klik dan seret. Bergantung pada alatnya, masukan lebih lanjut biasanya 
diperlukan, biasanya mengklik tombol kiri mouse untuk menyelesaikan suatu tindakan. 
Praktikkan teknik Klik + lepaskan saat Anda mengerjakan tutorial berikut 

 

Gambar 1.9 Alat SketchUp menggunakan teknik Klik + lepaskan. 
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Gambar 1.10 Aktifkan alat, klik geometri untuk memilih, dan lepaskan tombol mouse untuk 
melakukan tindakan. 

Alat Menggambar (Drawing tool) dan Modifikasi (modification tool) 

SketchUp menggunakan serangkaian drawing tool untuk membangun tepi dan permukaan. 
Sebagian besar alat ini dapat diakses dari bilah menu atas dengan memilih View -> Toolbars. 
Kemudian pilih Large Tool Set untuk mengaktifkan palet alat utama SketchUp. Arahkan kursor 
ke atas ikon alat dari Set Alat Besar untuk mengidentifikasi alat. Untuk mengilustrasikan cara 
kerja sebagian besar alat, bagian berikutnya memberikan gambaran umum mendetail tentang 
line tool dan Pilih. Alat tambahan dijelaskan dalam tutorial dan ringkasan singkat. 

Line tool 

Line tool digunakan untuk menggambar tepi yang dapat membagi atau healing face. Pilih line 
tool dari Set Alat Besar. Buat garis dengan memilih (klik kiri) titik pertama, lepaskan mouse, 
lalu pilih titik kedua. Anda harus memperhatikan bahwa line tool masih aktif atau”elastis", 
yang berarti SketchUp menunggu Anda untuk menggambar tepi tambahan. Gambarkan garis 
kedua, cobalah untuk membuatnya tetap”datar” pada permukaan gambar. Gambar garis 
ketiga yang menghubungkan ke ujung terbuka dari baris pertama. Jika digambar dengan benar, 
SketchUp akan menghasilkan face di antara semua garis. 

 

 

Gambar 1.11 Line tool dapat membuat/Healing satu face dengan tiga tepi yang digambar. 

Select Tool 

Pilih select tool (panah) dari Set Alat Besar. Alat ini akan sering digunakan. Alat Select 
melakukan sesuai dengan namanya; itu memilih tepi dan face. Ada beberapa cara untuk 
memilih geometri. 
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Mengklik Tunggal (Klik satu kali) Untuk memilih geometri, cukup klik pada tepi atau face 
dengan select tool. 

Menambah/Mengurangi Geometri Tahan tombol Shift ke bawah saat menggunakan select 
tool (disebut sebagai Shift + klik) akan memilih beberapa tepi, face, dan geometri. Jika 
geometri yang dipilih diklik lagi sambil menahan Shift + klik, geometri akan dikurangi atau 
dibatalkan pilihannya dari set pemilihan. 

Metode Aditif Ctrl + klik identik dengan Shift + klik kecuali itu tidak akan mengurangi atau 
membatalkan pilihan geometri yang sudah dipilih. 

Menggunakan Selection box Mengklik dan menyeret select tool (Klik + tahan dan seret) akan 
membuat selection box. Arah kotak pemilihan memberikan dua opsi: 

Seret dari kiri ke kanan membuat selection box yang hanya akan memilih geometri yang 
seluruhnya ada di dalam kotak 

Seret dari kanan ke kiri membuat selection box yang memilih apa pun yang disentuh kotak, 
termasuk geometri di dalamnya. 

Shift + klik dan Ctrl + klik berfungsi saat selection box digunakan. 
 

Gambar 1.12 Selection box digunakan untuk memilih geometri kubus/objek 3D. 
 

 

Gambar Objek yang dipilih 



7 
 

Additional Tool (Tool tambahan) 

Alat berikut adalah alat SketchUp dasar yang digunakan untuk menggambar, memodifikasi, 
atau menyesuaikan geometri muka dan tepi. Banyak dari alat ini digunakan secara ekstensif 
dengan berbagai tutorial. Anda harus terbiasa dengan fungsinya. Alat tambahan akan dibahas 
di seluruh buku ini. 

Arc Tool 

Ada beberapa alat busur di SketchUp. Alat yang difokuskan untuk buku ini adalah Busur Dua 
Titik. Bereksperimen dengan alat Arc sesuai kebutuhan. Busur Dua Titik membutuhkan tiga 
titik untuk dimasukkan. Titik pertama dan kedua menentukan panjangnya, dan titik ketiga 
memberikan radius atau tonjolan untuk busur. 

 

Gambar 1.13 Arc tool membutuhkan tiga titik untuk mendefinisikan sebuah busur. 

Rectangle (Persegi panjang) 

Rectangle Tool membuat face persegi panjang. Aktifkan alat Rectangle dan pilih titik persegi 
panjang pertama. Pahat akan tetap aktif dan membutuhkan masukan kedua yang akan 
membantu menentukan lebar dan panjang persegi panjang. 

 

Gambar 1.14 Rectangle Tool 

Move/Copy 

Geometri yang dipilih dapat direlokasi atau disalin. Geometri yang dipilih dapat dipindahkan 
hanya dengan mengklik sebuah titik dengan alat Pindah dan memindahkannya ke lokasi yang 
diinginkan. 
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Untuk membuat salinan, pilih geometri dan, dengan Pindahkan/Salin aktif, Ctrl + klik, lepaskan 
tombol mouse, dan gerakkan kursor menjauh dari aslinya. Geometri yang disalin akan 
bergerak saat diseret 

 

Gambar 1.15 Memilih sebuah objek dan kemudian menahan Ctrl dengan tool Move/Copy 
akan membuat salinan dari objek tersebut 

Eraser (Penghapus) dan Hidden Geometry (Hidden geometry) 

Seret eraser tool melewati tepi atau permukaan akan menghapusnya. Menahan tombol Shift 
saat menggunakan eraser tool pada geometri akan menyembunyikannya dari pandangan. 

Anda dapat melihat hidden geometry dengan mengaktifkan Tampilan ➢ Hidden geometry. 

Offset 

Offset tool membuat salinan geometri yang dipilih sejajar dengan pilihan awal. Menggunakan 
Offset pada face yang dipilih akan membuat salinan dari semua tepi yang membentuk face itu 
dan akan memperluas face (mengimbangi ke luar) atau membagi lagi face (offset ke dalam). 
Memilih dan mengimbangi tepi akan membuat salinan dari tepi yang dipilih. 

 

Gambar 1.16 Offset tool dapat mengimbangi permukaan dan tepi untuk membuat elemen 
paralel. 

Push/Pull Tool 

Push/pull tool memungkinkan pengguna untuk menambahkan volume ke face. Aktifkan alat 
dan arahkan kursor ke atas permukaan datar. Face akan disorot. Klik dan lepaskan di face. 
Dorong kursor ke atas. Ini akan menambah volume pada permukaan dengan menghasilkan 
geometri tambahan 
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Gambar 1.17 Push/pull tool membuat volume 3D dari face. 

Measurement window 

Measurement window, yang terletak di sudut kanan bawah layar, memungkinkan pengguna 
untuk menggambarkan dimensi secara akurat dan mencapai presisi saat pemodelan. 
Memasukkan nilai numerik tertentu memberikan panjang, lebar, tinggi, sudut rotasi, dan 
dimensi lain untuk geometri. SketchUp harus dimaksimalkan untuk melihat measurement 
window. 

 

Gambar 1.18 Measurement window memungkinkan pengguna memasukkan panjang, lebar, 
dan dimensi lain yang tepat untuk membuat geometri presisi. 

Untuk memasukkan nilai, Anda tidak perlu memilih measurement window. Saat alat aktif, 
cukup ketik nilai yang diinginkan ke dalam measurement window. Tekan tombol Enter untuk 
menerapkan nilai itu. 

Contoh: Pilih rectangle tool dan pilih titik pertama. Kemudian ketik 100 ′, 100 ′ (dimensi persegi 
panjang) dan tekan Enter. SketchUp akan membuat permukaan persegi panjang datar dengan 
panjang dan lebar 100 kaki. 

Style 

SketchUp memungkinkan Anda menyesuaikan bagaimana geometri dan lingkungan SketchUp 

muncul. Mereka dapat diatur melalui menu Styles (Window ➢ Default Tray ➢ Styles). Menu 
Styles memiliki banyak pilihan, dan dibutuhkan latihan untuk menyadari potensi penuh dari 
menu ini. Untuk saat ini, fokusnya ada pada edge dan lingkungan SketchUp. 
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Pengaturan Edge 

Pada menu Styles, pilih tab Edit. Lima ikon yang mengontrol banyak pengaturan SketchUp 
akan muncul. Pilih pengaturan Edge (pertama dari kiri). Secara default, Tepi Tampilan dan 
Profil keduanya dicentang. Membatalkan pilihan kedua opsi akan membuat semua tepi dalam 
model tidak terlihat. 

Garis Profil menambah ketebalan garis SketchUp yang membentuk tepi perimeter face. Garis 
profil juga menunjukkan saat tepi membagi face; garis akan kehilangan profil tebal dan 
menjadi tipis saat membelah face dengan benar. 

Kelemahan dari mencentang Profiles adalah membuat tepi perimeter tampak sangat tebal 
dibandingkan dengan tepi lainnya. Berlatih bekerja dengan Profil tidak dicentang. Anda 
kemudian dapat menentukan sendiri apakah Anda ingin menggunakannya atau tidak. 

 

 

Gambar 1.19 Profil tidak dicentang, menampilkan tepi yang tipis. 
 

Gambar 1.20 Profil dicentang”aktif", menampilkan tepi yang lebih tebal. 
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Background Setting (Pengaturan Background) 

Di menu Styles, opsi latar belakang berada di tengah di bawah tab Edit. Ada beberapa pilihan: 
Warna Latar Belakang, Langit, dan Tanah. 

Untuk saat ini, fokuslah pada latar belakang. Warna latar belakang default adalah krem. Anda 
mungkin ingin menyesuaikan warna latar belakang menjadi putih. Ini akan membuat tepi dan 
muka lebih mudah dilihat. Klik dua kali pada contoh warna latar belakang. Menu warna akan 
muncul. Sesuaikan nilainya untuk membuat latar belakang putih. 

Mencentang tab Sky atau Ground akan menambahkan simulasi langit atau tanah yang pudar 
ke lingkungan model. Untuk saat ini, biarkan kedua opsi tidak dicentang 

 

Gambar 1.21 Pengaturan Latar Belakang Langit dan Bumi diaktifkan dalam model SketchUp. 

Sistem Navigasi dan Inferensi 3D 

SketchUp adalah antarmuka dua dimensi yang memungkinkan pergerakan dalam lingkungan 
tiga dimensi. Tanpa sistem referensi, akan sulit untuk mengarahkan proyek Anda. Sistem 
inferensi SketchUp membantu Anda menemukan posisi Anda dalam ruang 3D dan 
memastikan presisi. Sistem inferensi terdiri dari sumbu gambar, kesimpulan titik, dan 
kesimpulan linier. 

Navigation (Navigasi) 

Anda perlu memahami cara bergerak di sekitar lingkungan SketchUp. Kontrol dasarnya adalah : 

Middle Mouse Button (MMB)/Tombol tengah mouse. 

Tombol mouse tengah memungkinkan Anda untuk memperbesar dan memperkecil. Menahan 
Tombol Mouse Tengah Menahan tombol tengah mouse dan menggerakkan mouse akan 
menyebabkan SketchUp mengorbit. 
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Menahan Tombol Shift + Mouse Tengah 

Menahan tombol Shift + mouse tengah (Shift + MMB) akan menyebabkan sebuah tangan kecil 
muncul sebagai penunjuk mouse, memungkinkan Anda untuk menggeser model. 

SketchUp membutuhkan geometri agar dapat bergerak dengan mudah dalam ruang 3D. Jika 
Anda mencoba memperbesar ruang”kosong", fungsi Zoom mungkin lambat atau tidak 
responsif. Jika Anda memperbesar dan memperkecil saat kursor sejajar dengan geometri apa 
pun, fungsi Zoom akan merespons. Hal yang sama berlaku untuk mengorbit; pastikan kursor 
sejajar di atas geometri dan kemudian orbit. Ini akan menyebabkan SketchUp mengorbit di 
sekitar geometri yang dirujuk kursor. 

Sistem Inferensi 

SketchUp menggunakan petunjuk visual khusus untuk membantu Anda menemukan posisi 
relatif Anda dalam lingkungan model. Ini disebut sistem inferensi dan terdiri dari berikut ini: 

Drawing on axis 

Sumbu gambar terdiri dari tiga garis: merah, hijau, dan biru. Garis-garis ini mewakili arah 
dalam ruang 3D. Hijau dan merah mewakili ruang horizontal. Sumbu biru mewakili dimensi 
vertikal. 

Titik Inferensi 

Titik inferensi membantu menghubungkan dan melampirkan geometri dalam ruang 3D. 
Sistem Point Inference muncul sebagai kotak kecil berwarna di tepi dan permukaan. Karena 
Anda dapat mengidentifikasi titik koneksi, sistem inferensi memungkinkan Anda 
menghubungkan garis dan permukaan dengan akurat dan presisi. Geometri dapat”diikat" ke 
titik koneksi tertentu 

 

Gambar 1.22 Drawing Axes 
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Gambar Point Interference system 

Contoh: Gambar garis 2D sederhana dengan line tool. Selanjutnya, arahkan line tool di kedua 
ujung garis yang digambar. Kotak hijau kecil muncul di ujungnya. Pindahkan line tool di atas 
garis yang digambar dan temukan beberapa titik berwarna lain yang terdaftar di Tabel A. 
Lakukan hal yang sama dengan satu sisi. 

 

 

Gambar 1.23 Interference Box Color 

Inferensi Linier 

Saat menggambar garis, atau memindahkan atau menyalin objek, SketchUp akan 
menunjukkan arah gerakan dengan menampilkan garis putus-putus berwarna hijau, merah, 
atau biru; setiap garis mewakili sumbu gambar. Ini adalah cara SketchUp untuk menunjukkan 
sumbu di mana geometri digambar, dipindahkan, atau disalin. 

 

Gambar 1.24 Line tool drawing on axis yang ditunjukkan dengan inferensi linier 
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Gambar 1.25 Geometri bergerak sepanjang sumbu hijau 
 

 

Gambar 1.26 Memindahkan objek”ke atas” sumbu biru 
 

Gambar 1.27 Gambar tepi tegak lurus 
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Drafting with Edge 

Menggunakan tepi yang sudah digambar adalah metode yang berguna untuk menyusun 
geometri. Saat mencoba membagi lagi satu face, Anda dapat memindahkan atau menyalin 
tepi untuk membagi lagi face sebagai berikut: 

1. Gambar persegi panjang 50’× 50'. 

2. Pilih tepi dengan alat Pindahkan/Salin. 
3. Salin dan pindahkan tepi 20’ke dalam pada permukaan. 
4. Pastikan tepi yang disalin tetap sejajar/tegak lurus dengan tepi lainnya. Setelah 

ditempatkan, tepi yang disalin akan membagi lebih lanjut face persegi panjang 
tersebut 

 

Gambar 1.28 Tepi kanan permukaan ini dipilih dan disalin 20 ′ di atasnya. Tepi yang disalin 
akan membagi satu sisi menjadi dua sisi. 

Demikian pula, face dapat dibagi lagi atau memiliki detail yang ditambahkan dengan 
menggunakan alat seperti Persegi Panjang dan Lingkaran. Menggunakan alat Rectangle di 
permukaan tidak akan membuat dua permukaan di atas satu sama lain. Sebaliknya, tepi dari 
alat Rectangle akan membagi face tempat mereka ditempatkan. 

Dalam banyak kasus, berguna untuk memindahkan geometri dengan menggunakan tepi lain 
sebagai referensi. Salah satu contohnya adalah menggunakan berbagai titik tepi, seperti titik 
akhir dan titik tengah, untuk membantu menempatkan geometri lainnya. Ini dilakukan dengan 
memilih geometri yang sedang dipindahkan atau disalin dan menggunakan geometri yang 
berdekatan untuk referensi. Ini memungkinkan penempatan yang sederhana dan akurat. 

Contoh lain adalah menggunakan panjang tepi untuk memindahkan atau menyalin geometri. 
Ini adalah metode umum saat mengerjakan bangunan. 

Contoh: Gambar persegi panjang 30’× 30'. Dengan menggunakan push/pull tool, tarik 
permukaan ke atas 25’. Selanjutnya, dengan Select tool, pilih empat sisi yang membentuk 
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permukaan atas kubus. Dengan tepi yang dipilih, salin satu set empat tepi langsung ke bawah 
sepanjang sumbu vertikal. 

Gunakan salah satu tepi vertikal yang menyusun volume untuk referensi — artinya, arahkan 
alat Pindahkan / Salin ke tepi dan pindahkan alat ke bawah. Pindahkan / Salin akan 
mereferensikan tepi. Tepi yang disalin dapat dipindahkan ke jarak tertentu dengan 
memasukkan jarak tersebut ke measurement window. Pindahkan/Salin tepi 5 kaki ke bawah 

 

Gambar 1.29 Sebuah persegi panjang yang ditambahkan ke face akan membagi lebih banyak 
face itu. 

 

Gambar 1.30 Gunakan tepian sebagai acuan untuk memindahkan atau menyalin geometri lain 
ke lokasi tertentu dan tepat. Tepi di Face 1 disalin ke Face 2. 
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Gambar 1.31 Gambarlah persegi panjang berukuran 30’× 30'. Push/pull permukaan setinggi 
25’ 

 

 

Gambar 1.32 Pilih tepi atas kubus dan salin ke bawah 5’, menggunakan tepi vertikal kubus 
untuk referensi. 
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Tepi yang disalin selanjutnya membagi keempat sisi volume. Face yang terbagi dapat 
dimanipulasi lebih lanjut; Push/pull dapat diterapkan untuk memindahkan permukaan ke 
dalam atau ke luar 

 

Gambar 1.33 Subdivisi yang dihasilkan pada face dapat Dorong/Ditarik ke segala arah. 

Model Organisasi 

Dua sistem yang sangat penting dan sinergis digunakan untuk mengatur geometri model. 
Sistem Komponen dan Grup dijelaskan secara rinci di bab berikutnya; itu membantu 
mengkonsolidasikan geometri menjadi bundel. Bundel ini kemudian dapat ditempatkan pada 
sistem kedua, yang disebut layer, memberikan pengguna kemampuan untuk mengaktifkan 
visibilitas (on/off) bundel. 

Layer 

Layer (Window -> default tray ->Layers) adalah alat organisasi paling penting di SketchUp. 
Menggunakan layer dengan benar sangat penting untuk pemodelan yang efisien; layer 
mempengaruhi proses pemodelan dan kinerja komputer. 

Secara khusus, layer mengontrol visibilitas geometri SketchUp. Mematikan sebuah layer akan 
membuat geometri pada layer tidak terlihat. Cara lainnya, mengaktifkan layer membuat 
geometri pada layer tersebut terlihat. 

Model SketchUp dapat berisi banyak geometri. Semakin banyak geometri yang terlihat, 
semakin besar kemungkinan kinerja komputer akan melambat, sehingga menghambat 
produksi pekerjaan. Selain itu, memiliki banyak objek yang terlihat dapat menghalangi 
kemampuan Anda untuk menavigasi dalam lingkungan 3D SketchUp karena geometri mulai 
menghalangi. 

Dengan menempatkan tepi dan permukaan pada layer dan menggunakan layer tersebut 
dengan benar, Anda dapat meminimalkan atau menghilangkan tantangan yang diciptakan 
oleh geometri yang melimpah. 

Layer 0 

Layer 0 adalah layer default di SketchUp. Setiap kali face, garis, atau tepi digambar di SketchUp, 
itu harus digambar pada Layer 0. (Pastikan kotak dialog Layer memiliki titik hitam kecil”on" di 
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sebelah kiri Layer 0.) Pemodelan pada Layer 0 akan mencegah face dan tepi yang digambar 
agar tidak berakhir di layer lain dan dari konflik dengan geometri saat lebih banyak detail 
ditambahkan. 

 

Gambar 1.34 tipikal daftar layer model situs 
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BAB 2 

KOMPONEN DAN GROUP 

SketchUp memiliki cara unik untuk mengatur tepi dan permukaan ke dalam kumpulan 
geometri yang mudah dikelola. Dua atau lebih tepi atau permukaan dapat dibuat menjadi 
sebuah komponen atau kelompok. Tepi dan permukaan gabungan ini menjadi satu item yang 
dapat dengan mudah direplikasi dan diedit. Membuat komponen dan grup memungkinkan 
fleksibilitas yang lebih besar saat Anda bekerja dengan geometri. 

Pentingnya Komponen dan Grup 

Komponen dan grup adalah andalan dalam membangun dan mengatur geometri. Situs 
lengkap dan rinci dan model bangunan diisi dengan mereka. Anda harus terbiasa dengan cara 
kerjanya. 

Keuntungan menggunakan komponen dan grup meliputi: 

 Mereka dapat diedit, disalin, dipindahkan, diputar, atau dihapus. 

 Mereka dapat dipindahkan dari geometri yang berdekatan. (Tepi dan permukaan yang 
tidak dikelompokkan atau nonkomponen menempel pada geometri lain. Komponen 
dan grup bersifat mandiri dan tidak lengket.) 

 Mereka dapat ditempatkan di layernya sendiri dengan mudah. (Layer dibahas nanti di 
bab ini.) 

Komponen dan grup hampir identik. Namun, mereka memiliki satu perbedaan penting: 
Mengedit atau mengubah komponen memengaruhi setiap contoh komponen itu. Meskipun 
beberapa salinan grup sama, mengedit satu grup tidak berpengaruh pada salinan lain dari grup 
itu. 

Menggunakan Component 

Ada jutaan komponen yang sudah dibuat yang tidak perlu Anda buat tetapi dapat digunakan 
untuk menambahkan tingkat detail yang signifikan ke model Anda. Penting untuk memahami 
cara menggunakannya dan di mana menemukannya. 

Tutorial: Dengan alat Rectangle, buat face berukuran 10’× 10'. Gunakan Tekan/Tarik untuk 
menambah volume dengan mengekstrusi tingginya 10 kaki. Dengan select tool, pilih semua 
geometri (tepi dan permukaan) yang menyusun kubus. Arahkan kursor ke atas pilihan dan klik 
kanan. Ini akan memunculkan menu konteks. Pilih Make Component. Masukkan nama di kotak 
dialog (Kotak, misalnya) dan pilih OK. Pastikan bahwa opsi Replace Selection with Component 
dicentang. Garis biru akan muncul di sekitar kubus. Sekarang menjadi komponen. 



21 
 

 
 

Gambar 2.1 Draft kubus 10´×10´×10´. Pilih seluruh objek dan klik kanan. Dari menu, pilih Make 
Component. Beri nama Kotak komponen baru. 

Menggunakan tool move/copy, buat lima salinan kubus dan letakkan di baris di sebelah aslinya. 
 

Gambar 2.2 Dengan tool Move/Copy, buat salinan komponen dan letakkan di sebelah aslinya. 
 

Gambar 2.3 Dengan alat Pindahkan/Salin, buat salinan kubus tambahan. 

Component Instances 

Pilih komponen yang disalin, klik kanan, dan pilih Edit Komponen dari menu konteks — atau 
cukup klik dua kali pada objek komponen. Saat Anda mengedit komponen atau grup, ini 
disebut bekerja di dalam instance komponen atau grup; hanya geometri yang terdiri dari 
komponen atau grup yang dapat diakses. 
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Catatan: Banyak tutorial dalam buku ini yang mengharuskan Anda bekerja dalam sebuah 
instance komponen atau grup. Kegagalan untuk bekerja dalam instance akan menyebabkan 
objek dan operasi tidak berfungsi dengan benar. 

 

Gambar 2.4 Edit komponen yang disalin dengan memasukkan instance komponen. Perhatikan 
garis luar di sekitar objek. Anda harus terbiasa bekerja dalam sebuah instance komponen 

Saat masih bekerja dalam contoh komponen yang disalin, gambar persegi panjang lain di salah 
satu face. Pilih dan jepret ke salah satu sudut face. Persegi panjang harus membagi bagian 
muka kubus. Push/pull bagian yang terbagi (lebih kecil) ke dalam 

Perhatikan bahwa semua komponen Cube diubah dengan cara yang sama seperti komponen 
yang diedit. Beginilah cara kerja komponen. Namun, jika kubus asli adalah sebuah grup, 
mengedit salinan grup tidak akan mempengaruhi iterasi lain dari grup itu. 

Mengklik di luar instance akan mengembalikan Anda ke ruang pemodelan umum. Berlatih 
bolak-balik antara model dan contoh komponen. 
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Gambar 2.5 di instance komponen, gambar persegi panjang pada permukaan kubus seperti 
yang ditunjukkan. 

 

Gambar 2.6 Dengan push/pull tool, dorong bagian face yang Anda buat dengan rectangle tool. 
 

Gambar 2.7 Mengedit satu komponen akan mengedit semua iterasi komponen itu di seluruh 
model. 

 

Gambar 2.8 Semua versi komponen Cube disesuaikan. 
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Menyesuaikan Komponen/Grup 

View Cara pengguna melihat sebuah komponen atau grup instance dapat disesuaikan di 
SketchUp. Dengan menyesuaikan pengaturan tampilan komponen dan grup, Anda akan 
mendapatkan pemahaman yang lebih baik tentang apa artinya bekerja dalam instance 
komponen atau grup. 

Untuk membantu mendemonstrasikan hal ini, di samping komponen Kubus yang dibuat 
sebelumnya, buat komponen lain: Menggunakan alat Lingkaran, gambar lingkaran 
berdiameter 10 kaki di tanah. Selanjutnya, menggunakan Push/Pull, tambahkan volume 10’ke 
lingkaran, buat silinder. 

Pilih seluruh silinder, klik kanan, dan pilih Make Component. Beri nama komponen Cylinder. 
Buat dua salinan komponen Cylinder dan letakkan di dekat kubus. 

Selanjutnya, pilih salah satu komponen Cube, klik kanan, dan pilih Edit Component — atau 
cukup klik dua kali pada komponen tersebut. Metode mana pun akan menempatkan konteks 
tampilan ke dalam instance komponen. 

Seperti yang dinyatakan sebelumnya, garis putus-putus muncul di sekitar komponen Kubus 
yang sedang diedit. Ini menunjukkan versi komponen yang sedang dikerjakan 

Semua komponen Cube lainnya disaring kembali, tetapi lebih jelas atau jelas daripada 
komponen Silinder. Saat instance komponen dimasukkan, komponen serupa tidak akan 
memiliki kontras sebanyak model lainnya, yang menunjukkan komponen mana yang sama 

 

Gambar 2.9 Membuat komponen Silinder yang berdekatan dengan kubus. Buat silinder 
dengan diameter 10”dan tinggi 10". 
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Gambar 2.10 Buat dua salinan dari komponen Cylinder dan letakkan di dekat komponen Cube 
 

Gambar 2.11 Tampilan model berubah dalam sebuah instance komponen. Komponen serupa 
sedikit pudar, sedangkan bagian model lainnya (dalam hal ini, silinder) menjadi hampir tidak 
terlihat. 

Komponen Silinder (atau model lainnya) memiliki lebih banyak kontras untuk membedakan 
antara contoh komponen tertentu dan geometri model lainnya. Jika ada model muka dan tepi 
lain yang tidak terkait, keduanya akan sama pudar. 

Anda dapat menyesuaikan pengaturan tampilan ini. Pergi ke menu Window dan pilih Model 
Info. Dari kotak menu Info Model, pilih Komponen. Pengaturan yang ditemukan di bawah tab 
ini memungkinkan Anda untuk menyesuaikan kontras dari komponen yang serupa (atau 
model lainnya) saat Anda bekerja dalam sebuah contoh komponen. 

Anda dapat menyesuaikan bilah geser di bawah Pudar Serupa untuk mengurangi atau 
meningkatkan seberapa jelas komponen yang serupa akan muncul saat Anda berada dalam 
contoh komponen tertentu. Penggeser Fade Rest of Model berfungsi serupa: 
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menyesuaikannya akan membuat model lainnya menjadi kurang atau lebih jelas saat Anda 
memasukkan instance komponen. 

Di samping setiap penggeser adalah kotak centang yang bertuliskan Sembunyikan. Jika kotak 
ini dicentang, semua komponen serupa atau model lainnya akan disembunyikan saat Anda 
memasukkan instance komponen. 

 

 

Gambar 2.12 Tab Model Info Components digunakan untuk mengatur tampilan model ketika 
komponennya diedit. 

 
 

Gambar 2.13 Pengaturan tampilan Komponen disesuaikan, dan bagian model lainnya dibuat 
lebih terlihat. 
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Gambar 2.14 Pengaturan tampilan Komponen disesuaikan. Komponen serupa menjadi lebih 
hidup, sementara model lainnya semakin memudar. 

Anda perlu tahu saat Anda bekerja dalam instance komponen atau grup, bukan di model 
lainnya. Memasukkan contoh komponen atau grup itu mudah. Sangat mudah sehingga Anda 
dapat melakukannya secara tidak sengaja dengan mengklik dua kali pada komponen atau grup. 
Perbedaan kontras dan kejelasan objek adalah petunjuk penting Anda. Pastikan Anda terbiasa 
dengan indikator penting dari instance komponen ini. 

Komponen di dalam Komponen 

Komponen dan grup dapat ditempatkan, ditempelkan, atau dibuat di dalam komponen lain. 

Contoh: Masukkan contoh grup dari salah satu kubus. Berikutnya, pilih dua dari permukaan 
yang berdekatan yang lebih kecil, klik kanan, dan pilih Make Component. Beri nama face Cube 
Faces dan pilih OK. Kedua permukaan sekarang menjadi komponen terpisah di dalam 
komponen Kubus 

 



28 
 

Gambar 2.15 Membuat komponen dengan memilih dua permukaan dalam instance 
komponen Cube. 

Karena mereka adalah komponen yang sama, setiap versi kubus akan memiliki komponen 
baru ini yang dibuat dalam instansinya. Keluar dari contoh kubus. 

 

Gambar 2.16 Komponen Cube Faces dibuat di semua instance komponen Cube. 

Pilih komponen Cylinder, lalu pilih Salin dari menu Edit (atau tekan Ctrl + C) Masukkan kembali 
salah satu instance Cube, pilih komponen Cube Faces, dan masukkan instance komponen itu. 

Untuk memastikan tampilan model dalam contoh komponen yang benar, cukup bandingkan 
geometri model yang dikontraskan seperti yang disebutkan sebelumnya. Sementara di 
instance Cube Faces, pergi ke Edit dan pilih Paste (atau Ctrl + V). Ini akan menempelkan versi 
komponen Cylinder di dalam instance Cube Faces. 
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Gambar 2.17 Pilih dan salin salah satu komponen Silinder. 
 

Gambar 2.18 Masukkan instance Kubus dan kemudian masukkan instance Face Kubus. Tempel 
silinder ke dalam komponen Face Kubus. Silinder akan ditempelkan ke semua contoh 
komponen Kubus dan Face Kubus. 

Contoh ini menggambarkan bagaimana sebuah komponen bisa berada di dalam sebuah 
komponen di dalam sebuah komponen. Langkah-langkah ini dapat diulangi tanpa henti dan 
penting untuk dipahami; banyak objek di SketchUp adalah komponen yang dibuat dari 
komponen lain. Ini membuat kemampuan untuk menavigasi di antara contoh komponen 
menjadi sangat penting. 

 

 
Gambar 2.19 Mengedit komponen Cylinder akan mengedit semua komponen yang serupa, 
terlepas dari lokasinya. 

Setelah Anda dapat menavigasi di antara mereka, Anda dapat dengan mudah mengedit 
komponen di dalam komponen. 



30 
 

1. Keluar dari instance komponen Cube Faces dan Cube dan kembali ke ruang kerja model 
umum. 

2. Pilih komponen Cylinder, klik kanan, dan pilih Edit Komponen (atau klik dua kali pada 
komponen). Perhatikan bahwa komponen Cylinder di dalam instance komponen Cube 
Faces memiliki tampilan jelas yang sama. 

3. Push/pull bagian atas Silinder 5 kaki lainnya. Semua versi komponen Cylinder akan 
disesuaikan. Keluar dari instance komponen dan kembali ke ruang pemodelan umum. 

Komponen dan Layer 

Pada bab sebelumnya, Anda diperkenalkan dengan layer SketchUp dan pentingnya mengatur 
geometri dalam model. Komponen dan grup dapat dengan mudah ditempatkan di atas layer. 
Menggunakan layer memberikan cara yang ampuh untuk memelihara organisasi model dan 
memelihara kinerja komputer; komponen intensif, seperti pohon, lebih mudah dikontrol di 
dalam model. 

Menggunakan komponen Cube sebelumnya, latihan berikut mendemonstrasikan teknik ini. 

1. Dari menu Window, pilih Layers. Buat layer baru bernama Cubes. 
2. Pilih semua versi komponen kubus dengan menggunakan panah seleksi dan tahan 

tombol Shift (Add Select). Setelah semua komponen Kubus dipilih, klik kanan sambil 
mengarahkan kursor ke salah satu kubus, dan dari menu konteks, pilih Info Entitas. 

3. Kotak menu Entity Info akan muncul. Window Layers menunjukkan layer di mana objek 
yang dipilih berada — saat ini Layer 0. Memilih panah tarik-turun di sebelah kanan 
layer akan memberikan daftar semua layer dalam model. Dengan memilih layer dari 
daftar, Anda dapat menempatkan semua geometri yang dipilih ke layer itu. Dengan 
komponen Cube masih dipilih, pilih layer Cubes. 

4. Di menu Layer, nonaktifkan layer Kubus untuk menghilangkan semua kubus. 
Mengaktifkan layer akan membuatnya muncul kembali. 

 

 
Gambar 2.20 Menu Entity Info memungkinkan Anda menempatkan geometri pada layer 
tertentu 

Teknik ini (menempatkan komponen pada layer) banyak digunakan dalam buku ini dan saat 
pemodelan. Berlatihlah mengatur komponen ke dalam layer, sehingga Anda menjadi mahir. 
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Pre‐Made Components 

Banyak objek di lingkungan binaan dapat ditambahkan ke model sebagai komponen. 
Meskipun Anda dapat membuat komponen kustom, cara tercepat dan ternyaman untuk 
mengisi model dengan objek adalah dengan menggunakan komponen yang telah dibuat 
sebelumnya. 

Komponen dapat mencakup bangku, mobil, orang, lampu pejalan kaki, tempat sampah, rambu, 
rambu lalu lintas, bangunan, berbagai perabotan, pohon, semak, bunga, window, pintu, 
kereta api, dan jembatan. Daftarnya tidak ada habisnya. Sebagian besar model 
menggabungkan berbagai macam komponen. Hampir semua objek yang ditemukan di dunia 
nyata tersedia dalam komposisi yang telah dibuat sebelumnya. Anda dapat menemukan 
komponen siap pakai ini di berbagai tempat, beberapa di antaranya tercantum di bagian 
berikut ini. 

Penting untuk memahami dasar-dasar bekerja dengan komponen dan grup. Dengan 
mengetahui bagaimana fungsinya dalam model, Anda akan siap untuk bekerja, membuat, dan 
menyesuaikannya saat Anda menjelajahi bagian lain dari buku ini. 

Component Library 

Mengompilasi dan mengatur component library yang terbuat dari komponen yang dibuat 
sebelumnya dan khusus adalah penting. Atur komponen Anda menurut jenis kategori 

(misalnya, pohon, bangku, gedung). Menu Komponen (Window ➢ Default Tray ➢ Component) 
dapat dihubungkan ke perpustakaan komponen pengguna untuk akses mudah. 

Di bagian ini, Anda akan mempelajari tentang berbagai lokasi online tempat Anda dapat 
mendownload berbagai jenis komponen. Pertimbangkan untuk menjaga perpustakaan yang 
terorganisir saat Anda mengerjakan proyek dan mengunduh serta meneliti jenis komponen 
baru. 
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Gambar 2.21 Component Library Tree dikompilasi dari berbagai website 
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Gambar 2.22 Atur komponen Anda menjadi component library yang koheren untuk 
memudahkan akses dan penggunaan. 

3D Warehouse 

3D Warehouse adalah sumber yang bagus untuk model 3D gratis. Gudang adalah satu-satunya 
lokasi terbaik untuk memperoleh dan mengunduh model. Ini adalah tempat penyimpanan 
model 3D terbesar di Web. Pengguna, perusahaan, dan institusi SketchUp mengunggah dan 
mengunduh lebih dari satu miliar model setahun. 
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Gambar 2.23 Browser 3D Warehouse di SketchUp memungkinkan Anda mengunduh model 
langsung ke model Anda. 

3D Warehouse diakses melalui browser di SketchUp. Untuk mengaksesnya, buka File ➢ 3D 

Warehouse ➢ Dapatkan Model. Perhatikan bahwa Anda juga dapat memilih Bagikan Model, 
sehingga Anda dapat mengunggah model Anda ke 3D Warehouse untuk dilihat dan digunakan 
orang lain. 

3D Warehouse memungkinkan pengguna mengunduh hampir semua jenis objek, mulai dari 
bangunan dan tumbuhan berkualitas tinggi, buatan vendor, dan model tertentu, hingga 
interior dan fasilitas. 

Selain mengunduh model tutorial, bereksperimenlah dengan mengunduh dari Gudang 
berbagai jenis objek yang sesuai untuk proyek Anda. 
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Gambar 2.24 Opsi untuk membuka dan mengunduh atau mengunggah model ada di File ➢ 

3D Warehouse, Dapatkan Model, atau Bagikan Model. 

DanielTal.com 

DanielTal.com menawarkan akses ke komponen berkualitas tinggi. Mendaftar secara gratis 
memberi Anda akses ke paket komponen. Ini mencakup lebih dari 2.500 komponen yang 
mencakup berbagai industri, termasuk arsitektur, desain interior, dan desain situs. 
Menggunakan situs web ini adalah cara terbaik untuk memulai component library Anda 
sendiri 
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Gambar 2.25 Di DanielTal.com, Anda dapat mendaftar secara gratis dan mendapatkan akses 
ke ribuan komponen siap pakai berkualitas tinggi. 

FormFonts 

FormFonts (www.formfonts.com) adalah situs langganan yang menawarkan banyak 
komponen berkualitas tinggi. Langganannya terjangkau, dan model yang tersedia sangat 
berguna. 

Langganan adalah cara yang berharga untuk mengunduh model persis yang Anda perlukan 
untuk suatu proyek tanpa harus mencari 3D Warehouse — dan FormFonts menawarkan 
ribuan jenis model yang tidak ditemukan di Gudang. 

Anda dapat mengunduh contoh model FormFont gratis dari 3D Warehouse. Cari FormFonts3D 
menggunakan Opsi Koleksi. 
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Gambar 2.26 FormFonts menawarkan ribuan komponen siap pakai berkualitas tinggi. 

DynaSCAPE Sketch3D 

DynaSCAPE SketchUp 3D (http://sketch3d.dynascape.com) menawarkan ribuan model 
fasilitas luar ruangan dan tanaman berkualitas tinggi yang unik khusus untuk SketchUp. 
Meskipun menggunakannya memerlukan langganan, model yang tersedia tidak tertandingi 
untuk model vegetasi yang mencakup rerumputan, tanaman hias, pohon gugur, evergreen, 
dan banyak lagi. 
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Gambar 2.27 Sketch3D oleh DynaSCAPE menawarkan perpustakaan tanaman yang unik untuk 
SketchUp. 

Dari 3D Warehouse, Anda dapat mengunduh contoh tanaman Sketch3D. Lakukan penelusuran 
model (bukan koleksi) di 3D Warehouse untuk DynaSCAPE 
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Gambar 2.28 Penelusuran untuk DynaSCAPE di 3D Warehouse menyediakan akses ke 
pengambilan sampel komponen Sketch3D 
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BAB 3 

PROBLEM SOLVING 

SketchUp adalah alat pemecahan masalah. Penghobi dan desainer menggunakannya untuk 
membantu menghasilkan objek yang paling mewakili ide. Biasanya ada lebih dari satu cara 
untuk menyelesaikan tugas di SketchUp. Dengan menguasai SketchUp, Anda membuka 
banyak kemungkinan untuk mencapai tujuan apa pun yang dapat Anda bayangkan. 

Pemodelan Proses SketchUp menawarkan template yang dapat Anda terapkan pada 
pemodelan. Untuk memecahkan masalah, Anda perlu membayangkan seperti apa model 
selesai Anda dan apa yang akan dicapai oleh model tersebut. Meskipun gagasan ini tampaknya 
abstrak, dengan latihan Anda akan memahami apa yang diperlukan untuk membuat model, 
seperti apa bentuknya, dan bagian mana yang membutuhkan waktu paling lama untuk 
diselesaikan. Spesifikasi bervariasi dari model ke model, tetapi proses untuk membuat model 
adalah sama. 

Saat Anda bekerja dengan SketchUp, Anda akan segera mengetahui bahwa itu tidak selalu 
beroperasi sebagaimana mestinya. Terkadang, alat dan operasi akan memberikan hasil yang 
tidak diharapkan, dan Anda perlu menyelesaikan masalah untuk menyelesaikan tugas. 

Menurut Global Development Research Center (www.gdrc.org), pemecahan masalah terdiri 
dari beberapa langkah umum: 

1. Mendefinisikan masalah 
2. Menganalisis masalah 
3. Menghasilkan solusi yang mungkin 
4. Menganalisis solusi 
5. Memilih solusi terbaik 
6. Merencanakan tindakan selanjutnya (langkah selanjutnya) 

Problem Solving dengan SketchUp memerlukan langkah-langkah dasar yang sama. Jika 
SketchUp gagal berfungsi seperti yang diinginkan, cari solusi lain; ada lebih dari satu cara untuk 
mencapai tujuan modeling Anda. 

Mantra sederhana”terus bergerak maju" sangat relevan untuk bekerja dengan SketchUp. Di 
sinilah belajar dan memahami apa yang dapat dicapai alat SketchUp menjadi berguna. 
Beberapa alat SketchUp dapat menyelesaikan tugas yang sama seperti alat lainnya, tetapi alat 
tersebut melakukannya dengan menggunakan langkah dan proses yang berbeda. Dengan 
penggunaan dan latihan, Anda akan memahami perbedaan ini. Bab ini membahas beberapa 
masalah SketchUp yang umum dan cara mengatasinya. 

Tutorial Problem Solving 

Latihan dan tutorial dalam buku ini dimaksudkan untuk menunjukkan kepada Anda bagaimana 
menggunakan SketchUp. Selalu, Anda akan mengalami masalah, kesalahan, dan kecelakaan 
ketika tutorial tidak memberikan hasil yang diinginkan. Kecelakaan ini bisa membuat frustasi; 
Namun, jangan berkecil hati. Evaluasi masalah untuk melihat apakah kesalahan tersebut 
disebabkan oleh kesalahpahaman atau kesalahan langkah instruksi. Dalam beberapa kasus, 
kesalahan tersebut mungkin merupakan masalah dengan SketchUp itu sendiri. Dalam kedua 
kasus tersebut, Anda akan belajar sambil melakukan, dan pemecahan masalah akan 
membantu Anda menguasai SketchUp. 

Saat Anda mengerjakan tutorial, perhatikan poin-poin berikut: 
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 Jika hasil latihan Anda berbeda dari hasil latihan di buku, pastikan Anda tidak 
melewatkan atau salah menafsirkan langkah apa pun. 

 Pastikan Anda bekerja dalam contoh komponen yang benar. Jika Anda bekerja di 
instance yang salah, mulai tutorial dari awal. 

 Jika alat atau geometri tidak bekerja dengan benar atau memberikan hasil yang salah, 
lanjutkan dan lihat apakah Anda dapat menyelesaikan tutorial ini. Terkadang SketchUp 
tidak berfungsi secara konsisten. Beberapa dari hasil yang tidak tepat ini akan ditinjau 
di bagian selanjutnya. 

 Jika masalah terus berlanjut atau tidak mungkin mendapatkan hasil seperti yang 
ditunjukkan dalam tutorial, mulai ulang latihan dari awal. Awal yang baru biasanya 
akan mengatasi masalah yang dihadapi. 

Seperti yang disarankan sebelumnya, cobalah mengerjakan tutorial lebih dari satu kali. Sifat 
rinci dan kompleksitas instruksi membuat tutorial layak untuk diulang. Pengulangan akan 
membantu Anda mempelajari nuansa yang terlibat dengan SketchUp. Hal ini terutama terjadi 
saat Anda mengalami masalah atau terjebak saat berolahraga. 

Tipikal Masalah SketchUp 

Pembahasan berikut sama sekali tidak komprehensif; namun, ini mencakup beberapa masalah 
yang paling umum dan solusi yang mungkin. 

Hasil Berbeda di Komputer Berbeda 

Tidak semua komputer berperilaku sama dengan SketchUp. Tidak seperti Photoshop, 
AutoCAD, dan program 2D lainnya, SketchUp memiliki beberapa persyaratan yang lebih tinggi. 

Singkatnya, jenis perangkat keras yang digunakan komputer Anda memengaruhi kinerja 
SketchUp. Hal ini terutama berlaku saat Anda bekerja dengan model yang sangat detail dan 
kaya. 

Komputer yang menggunakan kartu permainan video, seperti kartu NVIDIA dan ATI Radeon, 
akan bekerja lebih baik daripada kartu terintegrasi atau yang lebih kecil dari Intel. Selain itu, 
semakin baik prosesor dan semakin banyak RAM, semakin baik fungsi komputer. Laptop 
secara khusus ditantang di bagian depan ini. Namun, ada beberapa laptop khusus”game" 
dan”media" yang dapat menangani hampir semua model SketchUp. 

SketcUp Freeze (SketchUp Macet) 

SketchUp terkadang tampak macet saat Anda menjalankan operasi (misalnya, saat Anda 
mengaktifkan Bayangan atau mencoba menggeser model). Namun, SketchUp jarang macet. 
Itu tidak berarti bahwa itu tidak crash. Anda akan tahu kapan SketchUp macet karena window 
Bug Splat khusus akan muncul, memberi tahu Anda bahwa telah terjadi crash. 

Saat SketchUp tampak membeku, Anda perlu menggali lebih dalam dan muncul dengan 
kesabaran. SketchUp masih berfungsi. Tunggu saja SketchUp menyelesaikan tugasnya. 

Pengguna PC dapat memeriksa Task Manager untuk melihat apakah SketchUp dibekukan. 
Untuk membuka Task Manager, tekan Ctrl + Alt + Delete. Saat Anda bekerja dengan SketchUp, 
biarkan Pengelola Tugas tetap terbuka dan diminimalkan di Desktop. Saat diminimalkan, bilah 
kinerja kecil berwarna hijau akan muncul di kanan bawah Desktop. Saat SketchUp sedang 
diproses, bilah kinerja akan menjadi setengah atau seluruhnya penuh dengan bilah hijau. 
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Auto Save 

SketchUp memiliki fitur Simpan otomatis (Window ➢ Preferences ➢ General) yang diatur 
untuk menyimpan pekerjaan Anda setiap 5 menit. Jika dicentang, setelan menyimpan model 
dan SketchUp mungkin tampak terhenti. Jika ini bermasalah, Anda dapat mengubah Simpan 
Otomatis ke interval yang lebih lama — tetapi jangan menonaktifkannya. 

Subdivide 

Dalam beberapa kasus, SketchUp mungkin tidak membagi face. Ini biasanya terjadi saat Anda 
menggambar tepi (garis atau busur) pada permukaan untuk membuat banyak permukaan. 

Tidak ada solusi yang mudah untuk masalah ini. SketchUp telah memperbaiki banyak kejadian 
ini, tetapi tidak semuanya. Solusi termudah adalah menggunakan alat Rectangle daripada 
menggambar satu sisi untuk menyelesaikan tugas yang sama. 

1. Tempatkan persegi panjang di bagian muka yang perlu dibagi lagi. 
2. Pastikan persegi panjang tidak menempel ke tepi yang berdekatan. 
3. Gambar tepi dari titik ujung persegi panjang ke tepi yang berdekatan untuk membuat 

garis luar yang diinginkan. Hapus tepi ekstra, pertahankan garis yang membagi face 
menjadi permukaan yang diperlukan. 

Dalam kebanyakan kasus, tepi alat Rectangle akan membagi face. Secara umum, tepi persegi 
panjang digunakan untuk membantu menentukan garis besar permukaan yang sedang dibagi 
lagi dari permukaan aslinya, menggunakan tepi untuk membantu”memahat" lebih lanjut face 
ke bentuk yang diinginkan. 

Sumber 

Berikut beberapa sumber daya online yang berguna jika Anda mengalami kebuntuan: 

 Situs DanielTal.com (www.danieltal.com) menyertakan sumber daya dan model gratis. 
Selain itu, tutorial mengulas banyak cara untuk memecahkan masalah beberapa 
masalah yang disebutkan di atas. 

 Banyak pengguna tingkat lanjut tinggal di forum SketchUcation 
(www.sketchucation.com) .Situs web yang harus dikunjungi ini adalah sumber yang 
bagus untuk mendapatkan bantuan, mengunduh Ruby Scripts khusus, dan 
mempelajari tentang tren SketchUp saat ini. Saya sangat menyarankan mendaftar 
gratis. 

 Mike Brightman menulis Alur Kerja SketchUp untuk Arsitek (Wiley, 2013), yang 
merupakan sumber daya yang berguna untuk semua disiplin ilmu. Ini menunjukkan 
kepada Anda bagaimana menggunakan program LayOut yang menyertai SketchUp Pro. 
Dia juga menawarkan tutorial dan sumber daya tambahan. Lakukan pencarian Google 
di Mike Brightman. 

http://www.danieltal.com/
http://www.sketchucation.com/


43 
 

BAB 4 

SKETCHUP EXTENSION (EKSTENSI SKETCHUP) 

Ekstensi adalah tulang punggung SketchUp dan harus disertakan dalam pengenalan program 
apa pun kepada pengguna baru. Di bab ini, Anda akan menemukan penjelasan dan prosedur 
untuk menggunakannya. Saya ingin memuji Chris Dizon karena telah mengilhami pendekatan 
terhadap materi yang dibahas dalam bab ini. 

Menggunakan SketchUp 

SketchUp di luar kotak dimuat dengan serangkaian menu sederhana. (Gambar 5-1). Mirip 
dengan smartphone, ini tidak dimuat sebelumnya dengan sangat banyak aplikasi atau alat juga 
seperti smartphone, SketchUp dapat disesuaikan untuk tugas atau fungsi tertentu. 

Merakit Ekstensi yang tepat untuk tugas tersebut adalah kunci untuk membuka kunci 
kemampuan SketchUp dalam membuat model dengan cepat dan akurat 

Jika Anda menggunakan SketchUp untuk pertama kalinya dan mulai memahami pemodelan 
dasar, mulailah menggunakan ekstensi. Jika Anda pengguna perantara atau mahir, ekstensi 
harus menjadi bagian fundamental dari alur kerja Anda. 

 



44 
 

Gambar 4.1 SketchUp hadir dengan perangkat sederhana. Tampil adalah Large Tool Set, yang 
berisi sebagian besar alat pemodelan utama. 

Ekstensi sebelumnya disebut plugin, skrip, dan Skrip Ruby. Semua istilah telah secara resmi 
digabungkan ke dalam istilah ekstensi oleh tim SketchUp. Namun, istilah-istilah ini masih 
ditemukan di banyak situs web ekstensi eksternal. 

Di www.danieltal.com, anggota memiliki akses ke serangkaian video di Ekstensi. Ini termasuk 
petunjuk rinci tentang mencari, menginstal dan mendemonstrasikan ekstensi. Tutorial 
mencakup materi yang lebih spesifik dan ekstensi ulasan dalam berbagai alur kerja. 

 

Gambar 4.2 Seperti halnya smartphone, Anda dapat menyesuaikan kumpulan alat SketchUp 
Anda 

 

Gambar 4.3 Ekstensi alat medan 

 

 

http://www.danieltal.com/
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Extension Warehouse 

Smartphone memiliki toko aplikasi, dan SketchUp memiliki Extension warehouse. Extension 
warehouse memungkinkan Anda untuk mencari dan memasang Ekstensi. Setiap Ekstensi 
diperiksa, diuji, dan diperbarui untuk versi SketchUp mendatang. Banyak, jika tidak sebagian, 
yang gratis. 

 

Gambar 4.4 The SketchUp Extension Warehouse mirip dengan toko aplikasi smartphone. 

Banyak ekstensi di situs web Extension Warehouse dikembangkan oleh perusahaan dan 
individu independen. Pengembang ini disebut sebagai penulis, dan Anda dapat mencari 
ekstensi menurut penulis. Kebanyakan penulis memiliki situs web eksternal di mana Anda 
dapat mengunduh ekstensi tambahan yang tidak ditemukan di Extension warehouse. 

Menginstal Weld 

Tutorial berikut akan memandu Anda melalui proses mengakses Extension warehouse dan 
kemudian mencari, memasang, dan menggunakan ekstensi Weld. Weld ditulis oleh situs web 
Smustard (dibahas nanti dalam bab ini). 

1. Window Install Extension Warehouse. 
2. Ini akan meluncurkan browser Extension Warehouse 
3. Di bagian atas layar, masuk. Ini membutuhkan akun Google. 
4. Dalam kotak Pencarian Extension warehouse di bagian atas layar, ketik Weld. 
5. Hasil pencarian akan menampilkan Weld dan PathCopy sebagai dua ekstensi teratas 
6. Pilih Weld. Ini akan membawa Anda ke halaman instalasi Weld 
7. Setiap ekstensi memiliki halamannya sendiri. Pastikan untuk meninjau halaman 

ekstensi dengan hati-hati. Dalam banyak kasus, mereka berisi informasi penting 
tentang cara menggunakan dan menginstal ekstensi. 

8. Di kanan atas, pilih Download. SketchUp akan meminta izin untuk menginstal ekstensi 
di sistem Anda. Klik Ya melalui opsi. 

9. SketchUp akan menunjukkan ekstensi aktif. 10. Baris menu ekstensi baru akan muncul 
di bagian atas layar. 
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Gambar 4.5 Pada menu Window, pilih Extension Warehouse untuk membuka browser 
Extension Warehouse. 

 

Gambar 4.6 Hasil pencarian Extension Warehouse untuk Weld 
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Gambar 4.7 Halaman Weld pada Extension Warehouse 

Menggunakan Weld 

Petunjuk berikut menunjukkan cara menggunakan ekstensi Weld. 

1. Dengan alat Arc, gambar dua busur yang terhubung. 
2. Pilih kedua busur. 
3. Buka opsi menu Ekstensi di bagian atas layar. 
4. Pilih Weld 

Kedua busur sekarang digabungkan sebagai satu entitas yang dapat dipilih. 
 

Gambar 4.8 Gambarlah dua busur yang terhubung. 
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Gambar 4.8 Dengan busur dipilih, pilih Weld dari menu Extensions. 

Weld memiliki banyak kegunaan di mana beberapa tepi dan busur dilas bersama. Ada banyak 
keuntungan dari tepi yang dilas, termasuk membuatnya lebih mudah untuk mengimbangi 
garis. 

Extension Website 

Seperti disebutkan, banyak penulis telah membuat ekstensi untuk SketchUp. Dua situs web 
utama tempat Anda dapat menemukan ekstensi mereka akan dibahas nanti di bab ini. Secara 
kolektif, SketchUcation dan Smustard menyediakan akses ke ratusan ekstensi, yang sebagian 
besar tidak tersedia di Extension warehouse. 

Menginstal Extension 

Ada tiga cara untuk memasang ekstensi. 

 Dengan mengakses Extension warehouse seperti yang ditunjukkan sebelumnya 

 Dengan memilih Ekstensi Preferensi SketchUp 

 Dengan menginstal secara manual melalui folder file Windows atau Mac 

Saat Anda mengakses situs tertentu, pastikan Anda membaca petunjuk khusus mereka 
tentang cara memasang ekstensi mereka. Proses umumnya biasanya sama, tetapi langkah 
spesifiknya mungkin sedikit berbeda. 
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Gambar 4.9 Anda dapat menginstal beberapa ekstensi dengan memilih Ekstensi Preferensi. 

Plugin Store SketchUcation 

Plugin Store SketchUcation adalah ekstensi penting. Alat medan yang lebih kuat hanya dapat 
ditemukan di SketchUcation. Seperti Extension Warehouse, Plugin Store adalah browser yang 
memungkinkan Anda mencari dan menginstal ekstensi langsung ke SketchUp dari situs web 
SketchUcation. 

Untuk memasang ekstensi Toko Plugin SketchUcation, cukup ikuti langkah-langkah berikut: 

1. Lakukan pencarian Google untuk menemukan Toko Plugin SketchUcation. 

2. Pilih tautan Toko Plugin 
3. Mendaftar untuk mendapatkan akun gratis. 
4. Unduh dan simpan file Alat SketchUcation ke komputer Anda. 
5. Buka SketchUp dan pilih Preferensi Window. 
6. Pilih tab Extensions 
7. Pilih Instal Ekstensi. 
8. Arahkan ke lokasi pengunduhan. 
9. Pilih file SketchUcation Tools dan klik OK. 
10. Tutup dan mulai ulang SketchUp. 
11. Pergi ke Extensions dan pilih SketchUcation. 
12. Pilih Toko Plugin SketchUp dari daftar. 

Ini akan membuka browser tempat Anda dapat mencari dan menginstal ekstensi 
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Gambar 4.10 Browser Toko Plugin SketchUcation di SketchUp 

Smustard 

Smustard.com memiliki banyak skrip yang kuat. termasuk Profile Builder dan skrip 
Pembersihan AutoCAD. Smustard juga memiliki dua skrip gratis di Extension Warehouse: Weld, 
dibahas sebelumnya, dan PathCopy. 
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Gambar 4.11 situs ekstensi The Smustard 

Ekstensi yang Direkomendasikan 

Tabel 5-1 mencantumkan beberapa ekstensi yang berguna dan di mana menemukannya. 
Luangkan waktu untuk menjelajahi alat yang disebutkan di sini dan pelajari cara 
menerapkannya ke alur kerja Anda. Anda akan menemukan harta karun berupa ide dan waktu 
Anda akan dihabiskan dengan baik. 
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BAB 5 

GETTING STARTED DENGAN SKETCUP 

Dahulu kala, perangkat lunak untuk membangun model tiga dimensi (3D) dari benda-benda 
seperti bangunan, mobil, dan barang lainnya sulit digunakan bahkan sangat sulit. Orang-orang 
pergi ke sekolah selama bertahun-tahun untuk mempelajari perangkat lunak itu. Dan jika itu 
belum cukup buruk, perangkat lunak pemodelan 3D itu mahal - sangat mahal sehingga satu- 
satunya orang yang menggunakannya adalah para profesional dan pembajak perangkat lunak . 
Setelah memulai debutnya pada tahun 2000, SketchUp mengubah semua itu. 

Di SketchUp, Anda tidak menganggap model 3D sebagai konstruksi matematika yang rumit 
(cara berpikir komputer). Anda membangun model dengan elemen yang sudah dikenal: garis 
dan bentuk. Untuk menggunakan SketchUp, Anda bahkan tidak perlu tahu cara menggambar. 
Di SketchUp, Anda dapat membuat bidang apa saja, dan SketchUp menangani hal-hal seperti 
perspektif dan bayangan untuk Anda. 

Hal-hal yang Harus Segera Anda Ketahui 

Sebelum melanjutkan ke pembahasan, berikut beberapa informasi yang mungkin Anda 
perlukan: 

 Dapatkan SketchUp dengan mengunduhnya dari www.sketchup.com. 

 SketchUp dapat di gunakan dengan baik di Windows dan Mac OS X. Sebagian besar, 
SketchUp terlihat (dan berfungsi) dengan cara yang sama pada keduanya. 

 SketchUp memiliki versi gratis dan lengkap: SketchUp Make dan SketchUp Pro. 
SketchUp Make melakukan sebagian besar hal yang dilakukan versi lengkap tetapi 
dirancang untuk penggunaan non-komersial. Dengan SketchUp Pro, Anda 
mendapatkan fitur hebat yang dibutuhkan orang-orang seperti arsitek, ahli konstruksi, 
dan profesional desain lainnya untuk bertukar file dengan perangkat lunak lain. 
SketchUp Pro juga menyertakan seluruh aplikasi terpisah - dijuluki LayOut - untuk 
membuat presentasi dan gambar konstruksi dari model SketchUp Anda. 

 Jika Anda tahu Anda membutuhkan SketchUp Pro, maka lanjutkan dan unduh. Anda 
bisa mencobanya secara gratis sebelum harus membeli lisensinya. Setelah masa uji 
coba berakhir, SketchUp Pro berhenti bekerja sampai Anda melisensikannya. 

Membandingkan SketchUp dengan Program Pemodelan 3D Lainnya 

Jika Anda membaca buku ini, saya menganggap Anda setidaknya tertarik pada dua hal: 
membuat model 3D dan menggunakan SketchUp untuk melakukannya. Bagian berikut 
memberi tahu Anda sesuatu tentang bagaimana SketchUp dibandingkan dengan program 
pemodelan 3D lainnya - berapa lama waktu yang dibutuhkan untuk mengetahui cara 
menggunakannya dan jenis model yang dihasilkannya. 

SketchUp vs 3D Lainnya 

Di antara aplikasi pemodelan 3D yang banyak tersedia, SketchUp adalah yang paling mudah 
digunakan. Perangkat lunak ini berhasil karena satu alasan: Dalam beberapa jam peluncuran 
SketchUp untuk pertama kalinya, Anda bisa menjadi cukup ahli di SketchUp untuk 
membangun sesuatu bangunan. Anda tidak memiliki manual tebal untuk dibaca, dan tidak ada 
konsep geometris khusus untuk dipahami. Memodelkan di SketchUp adalah tentang 
memegang mouse Anda dan membuat sesuatu. 

http://www.sketchup.com/
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Jadi, berapa lama waktu yang Anda butuhkan untuk mengetahui cara kerja SketchUp? Itu 
tergantung pada Background dan pengalaman Anda. Secara umum, Anda bisa berharap 
membuat sesuatu dapat dikenali dalam waktu kurang dari empat jam. Bukan berarti Anda 
akan menjadi ahli - itu hanya berarti kurva belajar SketchUp sangat menguntungkan. Anda 
tidak perlu tahu banyak untuk memulai, tetapi Anda masih akan memahaminya bertahun- 
tahun dari sekarang. Faktanya, Saya menemukan beberapa hal hanya dengan menulis buku 
ini. 

Tetapi apakah SketchUp mudah? Banyak orang berkata begitu, padahal sebenarnya itu semua 
relatif, tergantung dnegan orang masing-masing. SketchUp, tanpa diragukan lagi, lebih mudah 
daripada program pemodelan lain yang pernah saya coba, tetapi pemodelan 3D itu sendiri 
bisa jadi rumit. Beberapa orang langsung mengerti, dan beberapa orang membutuhkan waktu 
lebih lama. Jika Anda ingin membuat model 3D dan memiliki waktu luang, tidak ada tempat 
yang lebih baik untuk memulai selain SketchUp (dan dari buku ini, tentu saja). 

Memahami perbedaan antara Paper dan Clay 

Perangkat lunak pemodelan tiga dimensi hadir dalam dua bentuk dasar: Solid dan Surface. 
Poin-poin berikut menggambarkan perbedaannya: 

 SketchUp adalah pemodel surface (permukaan). Segala sesuatu di SketchUp pada 
dasarnya terbuat dari permukaan tipis, dijuluki sebagai face. Seperti yang ditunjukkan 
pada Gambar 1-1, bahkan benda yang terlihat tebal (seperti dinding cinderblock) 
sebenarnya adalah cangkang berlubang. Membuat model di SketchUp sangat mirip 
dengan membuat sesuatu dari kertas - kertas yang sangat tipis. 

Pemodel surface seperti SketchUp sangat bagus untuk membuat model dengan cepat 
karena yang Anda perlukan untuk membuat model adalah seperti apa bentuknya. Itu 
tidak berarti bahwa pemodel permukaan kurang mampu; mereka hanya dimaksudkan 
untuk visualisasi 

 Menggunakan pemodel solid (padat) lebih seperti bekerja dengan tanah liat (clay). 
Saat Anda memotong model padat menjadi dua, Anda akan menciptakan permukaan 
baru tempat Anda memotong. Itu karena benda padat. Program seperti SolidWorks, 
form • Z, dan Autodesk Inventor adalah untuk membuat model yang solid. 

Orang yang membuat suku cadang - seperti insinyur mesin dan perancang industri - 
cenderung bekerja dengan model yang solid karena mereka dapat menggunakannya 
untuk melakukan perhitungan yang cukup tepat. Mampu menghitung volume suatu 
benda berarti Anda dapat mengetahui beratnya. Selain itu, mesin khusus dapat 
menghasilkan prototipe kehidupan nyata langsung dari file model padat. 

 

Gambar 5.1 Model SketchUp berlubang. 
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Apa Yang Harus Anda Ketahui (dan Tidak Seharusnya) Anda Ketahui dari SketchUp 

SketchUp, bagaimanapun, adalah spesialis yang melakukan satu hal dengan sangat baik: 
membangun model 3D. Berikut adalah daftar hal-hal (semua terkait pembuatan model) yang 
dapat Anda lakukan dengan SketchUp: 

 Memulai model dengan banyak cara: Dengan SketchUp, Anda dapat memulai model 
dengan cara apa pun yang sesuai untuk apa yang Anda buat: 

o Dari foto: Punya foto benda yang ingin Anda bangun 
o Dengan file komputer lain: Selain foto, Anda dapat mengimpor file AutoCAD 

dan file khusus lainnya, seperti 3DS, DEM, IFC, dan COLLADA. (Jika Anda 
memerlukan opsi khusus itu, Anda sudah tahu apa yang dilakukan jenis file 
tersebut.) 

o Dari cuplikan lokasi geografis: Di SketchUp, mudah untuk mengambil cuplikan 
lokasi geografis (pada dasarnya sebagian kecil planet) dari Google Earth. 

 Bekerja dengan Bebas atau Bekerja dengan Terikat: Model Anda bisa sangat samar 
atau sangat presisi. SketchUp seperti kertas dalam hal ini; jumlah detail yang Anda 
tambahkan sepenuhnya terserah Anda. 

 Bangun sesuatu yang nyata atau buat sesuatu baru: Apa yang Anda buat dengan 
SketchUp bukanlah masalahnya. Anda bekerja hanya dengan garis dan bentuk - atau 
di SketchUp, edge dan face. Bagaimana Anda mengaturnya adalah urusan Anda. 
SketchUp tidak lagi dimaksudkan untuk membuat bangunan, melainkan untuk 
membuat hal-hal lain. Ini hanyalah tool untuk menggambar dalam 3D. 

 Bagikan model Anda: Setelah membuat sesuatu yang ingin Anda pamerkan, Anda 
dapat mencetak model Anda, membuat file gambar, menganimasikan guide, 
mengekspor model ke format 3D lain, atau mengunggah model Anda ke 3D Warehouse 
(repositori raksasa model SketchUp online). 

SketcUp dirancang sejak awal untuk menjadi pemodel yang paling ramah, tercepat, dan paling 
berguna - dan hanya itu saja. Tersedia program-program fantastis yang melakukan hal-hal 
dalam daftar berikut, dan SketchUp dapat bertukar file dengan sebagian besar dari mereka: 

 Rendering fotorealistik: Sebagian besar pemodel 3D memiliki penyaji foto bawaan 
mereka sendiri, tetapi membuat tampilan model yang terlihat seperti foto adalah 
pekerjaan yang cukup terspesialisasi. SketchUp selalu berfokus pada rendering 
nonphotorealistic (NPR). NPR (seperti yang dikenal) pada dasarnya adalah teknologi 
yang membuat segala sesuatunya terlihat seperti gambar tangan - kebalikan dari 
fotorealisme. 

 Animasi: Beberapa paragraf yang lalu, saya menyebutkan bahwa SketchUp dapat 
mengekspor guide animasi, tetapi itu berbeda. Film yang dapat Anda buat dengan 
SketchUp melibatkan gerakan”kamera" di sekitar model Anda. Perangkat lunak 
animasi sejati memungkinkan Anda memindahkan berbagai hal di dalam model Anda. 
SketchUp tidak melakukannya, tetapi versi Pro memungkinkan Anda mengekspor ke 
program yang melakukannya. 

Mengikuti Tur Sepuluh Menit SketchUp 

Dalam tur ini, Anda mengetahui semua yang ada di interface SketchUp - seperti cara Anda 
melihat-lihat tempat baru sebelum memutuskan di mana Anda akan meletakkan sofa, tempat 
tidur, dan meja. Saat memulai pemodelan, Anda akan tahu di mana mencari tool dan perintah 
yang Anda butuhkan. 
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Gambar 5.2 Semua bagian SketchUp 

Seperti yang ditunjukkan pada Gambar 1-2, SketchUp memiliki tujuh bagian utama: 

 Modeling window: Lihat area besar di tengah layar komputer Anda? Itu window 
pemodelan Anda. Anda membuat model di sini, dan window pemodelan Anda selalu 
menampilkan tampilan 3D model Anda, meskipun Anda melihatnya dari atas atau 
samping. 

 Menu Bar : Jika Anda telah menggunakan komputer dalam 30 tahun terakhir, Menu 
bar bukanlah hal baru. Setiap menu berisi daftar panjang opsi, perintah, tool, 
pengaturan, dan barang lainnya yang berkaitan dengan hampir semua yang Anda 
lakukan di SketchUp. Saya memperkenalkan Anda pada perintah-perintah pada menu- 
menu ini di seluruh buku ini, dan Anda dapat mencari tahu apa yang dilakukan salah 
satu dari mereka menggunakan indeks buku ini. 

 Toolbar: Klik tombol toolbar untuk mengaktifkan tool atau perintah. SketchUp 
memiliki beberapa toolbar, tetapi hanya satu yang terlihat saat Anda meluncurkan 
SketchUp pertama kali: Getting Start Toolbar. Lihat bagian yang akan 
datang,”Customizing the Toolbar” untuk detail tentang menemukan opsi toolbar 
lainnya. 

 Kotak dan panel dialog: Anda akan menemukan kotak dialog tradisional yang 
memungkinkan Anda memilih opsi dan kemudian menghilang setelah selesai. Kotak 
dialog Buka dan kotak dialog Simpan adalah contoh yang baik. Di Windows, SketchUp 
2016 dan versi yang lebih baru memiliki baki panel yang membantu Anda bekerja 
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dengan komponen, warna, style, dan lainnya. Secara default, baki muncul di sisi kanan 
antarmuka. Anda mulai dengan default tray yang berisi panel yang paling sering 
digunakan pemula. Untuk menyesuaikan baki, pilih Windows => Manage Trays dan 
gunakan Tray dialog box untuk mengkonfigurasi ulang apa yang Anda lakukan (atau 
tidak) dapat dilihat di sini. Di Mac, tool untuk komponen, warna, style, dan sebagainya 
terlihat seperti kotak dialog, tetapi Anda dapat menumpuknya seperti baki dan 
membiarkan kotak dialog ini tetap terbuka selama Anda membutuhkannya. 

 Status bar: Anda dapat menganggap ini sebagai dasbor SketchUp Anda. Status bar 
dapat berisi informasi kontekstual yang Anda gunakan saat Anda membuat model. 
Sering kali, Anda akan memeriksa di sini untuk melihat opsi apa yang mungkin tersedia 
untuk apa saja yang Anda lakukan. Modifier Key (ketukan keyboard yang Anda 
gunakan bersama tools tertentu untuk menjalankan fungsi tambahan), petunjuk 
langkah demi langkah, dan informasi umum tentang apa yang Anda lakukan semuanya 
muncul di satu tempat: di sini. 

 Measurement Box: Anda menggunakan kotak ini sepanjang waktu saat Anda 
membuat model di SketchUp. Bergantung pada apa yang Anda lakukan, kotak ini 
menampilkan informasi tentang apa yang Anda modelkan atau memungkinkan Anda 
menentukan panjang, sudut, atau pengukuran lain yang tepat. 

 Menu konteks: Hal-hal yang dicontext-clicks di window pemodelan Anda biasanya 
menyebabkan menu konteks perintah dan opsi terbuka. Ini selalu relevan dengan apa 
pun yang Anda context-clicks (dan apa pun yang Anda lakukan saat itu), jadi konten 
setiap menu konteks berbeda. Di komputer Windows, Anda mengcontext-clicks 
dengan mengklik tombol kanan mouse. Di Mac, Anda menahan tombol ⌘ sambil 
mengeklik. 

 Mouse dengan roda gulir: Anda biasanya menemukan tombol kiri (yang Anda gunakan 
sepanjang waktu), tombol kanan (yang membuka menu konteks), dan roda gulir 
tengah yang Anda putar bolak-balik dan klik turun seperti tombol. Mouse dengan roda 
gulir akan meningkatkan pengalaman SketchUp Anda lebih dari apa pun yang dapat 
Anda beli. Mouse Ajaib Mac memungkinkan Anda untuk menggulir tidak dengan roda, 
tetapi dengan menggerakkan jari Anda ke depan atau ke belakang di sepanjang bagian 
atas mouse. Namun, tanpa roda gulir yang dapat Anda tahan untuk mengorbit, 
memodelkan Mac dengan Magic Mouse jauh lebih tidak efisien daripada 
menambahkan mouse roda gulir ke pengaturan Mac Anda. 

 Keyboard: Kedengarannya konyol, tetapi beberapa orang telah mencoba 
menggunakan SketchUp tanpa keyboard; itu tidak mungkin. Begitu banyak hal yang 
perlu Anda lakukan sepanjang waktu (seperti membuat salinan) melibatkan keyboard 
Anda, jadi sebaiknya Anda memiliki satu keyboard jika Anda berencana menggunakan 
SketchUp. Misalnya saja untuk copy-paste sebuah objek/komponen anda perlu klik kiri 
pada mouse bersamaan dengan menekan tombol ctrl pada keyboard. 

Customizing Toolbar 

Getting Started toolbar berisi sebagian kecil tool yang dapat Anda gunakan di SketchUp. 

Untuk mengakses lebih banyak tool, melakukan hal yang berbeda tergantung pada sistem 
operasi mana yang Anda gunakan: 

 Windows: Pilih View =>Toolbars. Di kotak dialog Toolbar, saya merekomendasikan 
memilih Large Tool Set check box untuk memulai. Kemudian, Anda dapat 
menambahkan toolbar saat Anda membutuhkannya (dan saat Anda mengetahui apa 
yang dilakukan tool tersebut). 
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 Mac: Pilih View => Tool Palettes => Large Tool Set. Untuk menambahkan lebih banyak 
tool, klik kanan pada Getting Started toolbar (yang tepat di atas window pemodelan 
Anda) dan pilih Kustomisasi Toolbar. Sekarang seret tool apa pun yang Anda inginkan 
ke toolbar dan klik tombol Selesai. 

Memeriksa beberapa tools khusus 

Sebagian besar program grafis memiliki banyak kotak pengontrol kecil, dan SketchUp tidak 
terkecuali. Inilah yang menurut Saya perlu mendapat perhatian khusus: 

 Preferences: Jika Model Info dialog box berisi pengaturan untuk file SketchUp yang 
Anda buka sekarang, Preferences dialog box memiliki kontrol untuk bagaimana 
SketchUp berperilaku - tidak peduli file apa yang Anda buka. Berikan perhatian khusus 
pada panel Pintasan (Shortcuts Panel), tempat Anda dapat mengatur pintasan 
keyboard untuk tool atau perintah apa pun dalam program. Untuk mengatur 
Preferences Anda, pilih Window => Preferences (Windows) atau SketchUp => 
Preferences (Mac). 

 Model Info: Kotak dialog ini, mengutip Bard, ibu dari semua kotak dialog. Ia memiliki 
kendali untuk segala sesuatu di bawah matahari; Anda pasti harus membukanya dan 
meluangkan waktu untuk melaluinya. Kemungkinannya, saat Anda tidak dapat 
menemukan setelan yang Anda cari, itu ada di Info Model. Untuk membuka kotak 
dialog ini, pilih Window => Model Info. 

 Entity Info: Ini sangat kecil, tetapi ia menunjukkan informasi tentang entitas - edge, 
face, grup, komponen, dan banyak hal lainnya - dalam model Anda. Di Windows, Anda 
akan menemukan Entity Info (Entity Info) di default tray dan dapat mengaktifkan atau 
menutupnya dengan mengklik panahnya. Di Mac, pilih Window => Entity Info. 

 Instructor: Instructor hanya melakukan satu hal: menunjukkan kepada Anda 
bagaimana menggunakan tool apa pun yang kebetulan diaktifkan. Selagi Anda 
mempelajari cara menggunakan SketchUp, biarkan Instructor tetap terbuka. Anda juga 
dapat membukanya kapan saja dengan mengklik panah yang mengarah ke kanan di 
default tray atau, di Mac, pilih Window => Instructor. 
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BAB 6 

GETTING RUNNING START 
 

Menyiapkan Workspace Anda 

Saya tahu - penyiapan itu membosankan. Siapa yang ingin membolak-balik menu dan kotak 
dialog opsi alih-alih masuk? Saya akan membuat bagian ini lebih singkat dan manis. Bagian ini 
hanya tentang memastikan Anda memulai di tempat yang tepat. 

Ikuti langkah-langkah berikut untuk bersiap: 

1. Luncurkan SketchUp. 

Kotak dialog Selamat Datang di SketchUp muncul, seperti yang ditunjukkan pada 
Gambar 2-1. Kotak dialog terlihat sedikit berbeda di SketchUp Make versus SketchUp 
Pro, tetapi langkah-langkah untuk menyiapkan ruang kerja Anda berfungsi sama di 
kedua versi. 

2. Buka area Template dengan mengklik panah di sebelah namanya, pilih salah satu 
template Desain Arsitektur, dan klik tombol Start Using SketchUp. 

File SketchUp baru terbuka. 

Jika kotak dialog Selamat Datang di SketchUp tidak muncul, bisa jadi Anda atau orang 
lain yang telah menggunakan SketchUp pada PC atau Laptop Anda menyettingnya 
seperti itu agar tidak muncul sehingga akan secara otomatis saat memulai. Pilih Help 
=> Welcome to SketchUp dari menubar, pilih template Desain Arsitektur, dan klik 
tombol Mulai Menggunakan SketchUp. Kemudian pilih File => New untuk membuka 
file baru dengan template yang Anda pilih. 

3. astikan Anda dapat melihat Toolbar Srart. 

Gambar dibawah ini menunjukkan Toolbar Srart. Jika tidak terlihat di window 
pemodelan Anda, pilih View => Toolbars => Getting Started untuk membuatnya 
muncul. Jika Anda menggunakan Mac, pilih View => Show Toolbar. 

4. Kosongkan window pemodelan Anda. 

Jika komputer Anda telah menjalankan SketchUp, Anda mungkin melihat kotak dialog 
di semua tempat. Jika itu masalahnya, kembalikan semuanya ke tempatnya dengan 
menyetel ulang ruang kerja Anda: 

a. Pilih Preferensi Window (Microsoft Windows) atau SketchUp => Preferensi 
(Mac OS X). 

b. Di kotak dialog Preferensi, pilih panel Ruang Kerja di sebelah kiri. 
c. Klik tombol Reset Workspace. 
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Gambar 6.1 

 

Gambar 6.2 tampilan langsung Getting Started Toolbar 

Membuat Quick Model (Model Cepat) 

Gambar menunjukkan tampilan layar komputer Anda saat ini. Anda akan melihat deretan tool 
di bagian atas window pemodelan Anda, orang kecil, dan tiga sumbu pemodelan berwarna - 
garis merah, hijau, dan biru. 
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Gambar 6.3 Seperti inilah tampilan layar Anda di Windows (Atas) dan di Mac (bawah). 

Ikuti langkah-langkah berikut untuk membangun rumah anjing: 

1. Hapus gambar orang kecil yang ada di layar Anda. 
 

Menggunakan Tool Select (gambar panah di ujung kiri toolbar Anda), klik orang kecil 
untuk memilihnya. (Orang tersebut akan berubah pada setiap versi SketchUp yang 
berbeda. Kemudian pilih Edit => Delete. Di SketchUp 2016, orang tersebut adalah 
Lisanne. Di SketchUp 2017, Anda melihat Chris.) 

2. Pilih Camera => Standard View => Iso. 
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Perintah ini mengalihkan Anda ke tampilan isometrik (3D) model Anda, yang 
memungkinkan Anda membuat sesuatu tanpa harus”berpindah-pindah". 

3. Gambarlah sebuah persegi panjang di tanah. 
 

Gunakan Tool Rectangle Tool untuk menggambar persegi panjang dengan melakukan 
hal berikut: 

a. Klik sekali untuk menempatkan satu sudut di sisi kiri layar Anda. 
b. Klik lagi untuk menempatkan sudut yang berlawanan di sisi kanan layar Anda. 

Ingatlah bahwa Anda berada dalam perspektif 3D, atau pandangan dunia, jadi persegi 
panjang Anda lebih terlihat seperti berlian - sudut 90 derajat tidak terlihat seperti 
sudut 90 derajat dalam perspektif. 

4. Pilih Push/Pull Tool dan tarik persegi panjang Anda ke dalam kotak dengan mengklik 
persegi panjang lalu klik lagi di suatu tempat di atas persegi panjang. 

 

Pada titik ini, model Anda akan terlihat seperti Gambar 6.5; jika tidak, gunakan 
Tekan/Tarik lagi untuk membuat kotak Anda terlihat dengan ketinggian yang tepat. 

Tips 

Jika Anda tidak sengaja atau kebabkalasan menarik/mendorong kotak Anda dan tiba- 
tiba menghilang, Anda mungkin mendorong/menarik bagian atas kotak Anda sampai 
ke tanah. Untuk mengembalikan kesemula atau sesuai yang diinginkan cukup pilih Edit 
=> Undo dan lanjutkan. 

5. Pilih Line tool dan gambar dua garis diagonal untuk atap Anda, seperti yang 
ditunjukkan pada Gambar 6.6. 

 

Berikut adalah penjelasan langkah demi langkah tentang cara menggambar garis: 

a. Klik sekali di titik tengah bagian atas bagian depan kotak Anda untuk memulai 
garis Anda. Anda tahu bahwa Anda berada di titik tengah saat melihat titik kecil 
berwarna biru muda dan kata Midpoint muncul. Di SketchUp, tip ini disebut 
inferences. Bergerak perlahan untuk memastikan Anda melihat inferensi 
Midpoint. 

b. Klik lagi di suatu tempat di sepanjang salah satu edge sisi face depan kotak 
Anda untuk mengakhiri garis Anda. Tunggu sampai Anda melihat inferensi On 
Edge berwarna merah sebelum Anda mengklik; jika tidak, baris baru Anda tidak 
akan berakhir di edge yang seharusnya. 
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c. Ulangi dua langkah sebelumnya untuk menggambar garis yang serupa tetapi 
berlawanan dari titik tengah ke edge di sisi lain face. Jangan khawatir tentang 
membuat garis diagonal Anda simetris; untuk tujuan latihan ini, tidaklah 
penting begitu. 

6. Push/pull segitiga untuk meninggalkan atap yang miring. 

Gunakan Push/Pull tool (yang sama yang Anda gunakan pada Langkah 4) untuk 
menyingkirkan bagian segitiga dari kotak Anda, meninggalkan Anda dengan atap 
miring. Lihat Gambar 6.7 untuk melihat ini beraksi dan kemudian ikuti langkah-langkah 
berikut: 

a. Pilih Edit => Select None untuk memastikan Anda tidak memiliki apa pun yang 
dipilih dalam model Anda. Jika opsi menu ini berwarna abu-abu, Anda dapat 
melakukannya. 

b. Pilih Push/Pull tool lalu klik permukaan segitiga kanan sekali untuk memulai 
operasi push/pull. 

c. Gerakkan kursor Anda ke kanan untuk mendorong segitiga sejauh mungkin 
(sehingga sejajar dengan ujung kotak Anda). 

d. Klik lagi (pada segitiga) untuk mengakhiri operasi push/pull dan untuk 
menghilangkan permukaan segitiga. 

e. Masih menggunakan Push/Pull tool, klik dua kali permukaan segitiga kiri untuk 
mengulangi operasi push/pull sebelumnya, sehingga permukaan itu juga 
menghilang. 

7. Gambar persegi panjang di face depan Anda. 

Beralih kembali ke Rectangle tool (yang Anda gunakan pada Langkah 3) dan gambar 
persegi panjang di bagian depan kotak runcing Anda. Pastikan bagian bawah persegi 
panjang Anda sejajar dengan bagian bawah kotak Anda dengan memperhatikan 
inferensi On Edge berwarna merah yang muncul sebelum Anda mengklik. Gambar 6.8 
menunjukkan seperti apa model Anda setelah selesai. 

Tips 

Menggunakan Rectangle tool adalah proses dua langkah: Anda mengklik sekali untuk 
menempatkan satu sudut dan sekali lagi untuk menempatkan sudut yang berlawanan. 
Hindari menggambar garis dan bentuk dengan menyeret kursor Anda. Di SketchUp, 
melakukan hal itu hanya akan membuat pemodelan lebih sulit. Berlatih mengklik sekali 
untuk memulai operasi, seperti menggambar persegi panjang, dan mengklik lagi untuk 
berhenti. 

8. Gambarlah busur (Arc)  di atas persegi panjang yang baru saja Anda gambar. 
 

Gunakan arc tool 2 point untuk menggambar busur di atas persegi panjang Anda, 
seperti yang diilustrasikan pada Gambar 6.3. Ikuti langkah-langkah ini untuk 
menggambar busur: 

a. Klik sudut kiri atas persegi panjang untuk menempatkan satu titik ujung busur 
Anda. Pastikan Anda melihat inferensi Endpoint hijau sebelum Anda mengklik. 

b. Klik sudut kanan atas persegi panjang untuk menempatkan titik ujung lainnya 
dari busur Anda. 
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c. Gerakkan kursor ke atas untuk membentuk garis yang Anda gambar menjadi 
busur, lalu klik jika Anda menyukai tampilan busur tersebut. 

9. Pilih Eraser tool dan kemudian klik garis horizontal antara persegi panjang dan busur 
untuk menghapus garis itu. 

 

10. Push/Pull pintu yang sudah Anda buat agak masuk ke dalam. 

Ingat, Gunakan Push/Pull tool (yang saat ini Anda sudah berpengalaman) untuk 
mendorong face”pintu keluar" yang Anda buat di Langkah 7 hingga 9. 

Ingat 

Gunakan Push/Pull tool dengan mengklik satu face sekali untuk memulai, gerakkan 
kursor Anda untuk mendorong/menariknya masuk atau keluar, lalu klik lagi untuk 
berhenti. 

11. Hapus garis horizontal di bagian bawah pintu dengan mengkliknya dengan eraser 
tool. 

Ini membuat garis (dan seluruh face di atasnya) menghilang. Gambar 6.10 
menunjukkan seperti apa rumah anjing Anda yang sudah jadi. 

 

Gambar 6.4: Gambar persegi panjang 3D di tanah. 
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Gambar 6.5: Gunakan Push/Pull tool untuk mengekstrusi persegi panjang ke dalam kotak. 
 

Gambar 6.6: Gambarlah dua garis diagonal yang akan menjadi puncak atap Anda 
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Gambar 6.7: Gunakan Push/Pull tool untuk membentuk atap berpuncak pada kotak Anda 
 

Gambar 6.8: Sebuah persegi panjang digambar di depan kotak runcing Anda. 
 
 

Gambar 6.3: Gambarlah busur di atas persegi panjang Anda. 
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Gambar 6.10: Buat bukaan pintu dengan menghapus edge bawahnya. 

Untuk pengenalan yang lebih rinci tentang menggambar garis dan bekerja dengan titik tengah, 
sudut, dan lainnya. 

Menambahkan Beberapa Cat 

Untuk mewarnai bidang yang sudah anda buat, Anda harus memahami cara memutarnya 
terlebih dahulu. Bergerak di sekitar model Anda adalah keterampilan paling penting untuk 
dikembangkan saat Anda pertama kali mempelajari SketchUp. Jalankan melalui langkah- 
langkah berikut untuk menerapkan warna (dan tekstur) ke face dalam model Anda, dan untuk 
mengetahui tentang bergerak saat Anda melakukannya: 

1. Di Windows, buka Material Panel dengan mengklik panah kanan di sebelah namanya 
di Default Tray. Di Mac, pilih Window => Material. 

Anda melihat versi Windows dan Mac dari material panel pada Gambar 6.11. 

2. Klik warna atau tekstur yang Anda suka. 
 

Saat Anda melakukannya, Anda secara otomatis mengambil tool Paint Bucket dan 
mengisinya dengan bahan pilihan Anda. 

3. Warnai beberapa face dalam model Anda dengan mengklik sembarang face dengan 
tool Paint Bucket. 

4. Ganti bahan. 

Pilih bahan lain dari material panel dengan mengkliknya. 

5. Warnai sisa face yang bisa Anda lihat. 

Ulangi Langkah 2 hingga 4 selama yang Anda suka. Menemukan material panel di 
SketchUp seperti mendapatkan sekotak krayon baru ketika Anda masih kecil (Anda 
tahu, kotak besar, dengan rautan bawaan). 

6. Pilih tool Orbit; itu ada di toolbar, tepat di sebelah kiri tangan yang menyeramkan 
(juga dikenal sebagai tool Geser). 
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7. Klik di suatu tempat di sisi kiri layar Anda dan seret kursor Anda ke kanan, seperti 
yang ditunjukkan pada Gambar 6.12. Lepaskan tombol mouse Anda setelah selesai. 

Model Anda akan berputar, atau mengorbit! 

Tips 

Jika Anda sedang mengorbit, dan Anda telah menyeret kursor sejauh mungkin, dan 
Anda belum mengorbit sebanyak yang Anda inginkan, jangan khawatir. Lepaskan saja 
tombol mouse, gerakkan kursor ke tempat semula saat Anda mulai mengorbit, dan 
mengorbit lagi dengan mengklik dan menyeret. Untuk melihat apa yang ingin Anda 
lihat, Anda biasanya memerlukan banyak hambatan terpisah (orbit terpisah, saya kira). 

8. Zoom In dan Zoom Out jika perlu dengan memilih tool Zoom dan menyeret kursor ke 
atas dan ke bawah di window pemodelan Anda. 

 

Seret naik untuk memperbesar, dan menyeret ke bawah untuk memperkecil. 

Tips 

Anda juga dapat memperbesar dan memperkecil dengan memutar roda gulir pada 
mouse Anda. Jika Anda memiliki Mac dengan Magic Mouse, gerakan gulir berfungsi 
seperti roda gulir. 

Jika perlu, gerakkan dalam dua dimensi dengan tool Pan dengan memilihnya lalu klik 
dan seret kursor Pan di dalam window pemodelan Anda. 

9. Gunakan Pan untuk menggeser model Anda di dalam window pemodelan tanpa 
memutarnya atau membuatnya terlihat lebih besar atau lebih kecil. Anda bisa 
menggeser ke segala arah. 

 

10. Gunakan tool Orbit, Zoom, Pan, dan Paint Bucket untuk menyelesaikan pengecatan 
rumah anjing Anda. 

Sekarang setelah Anda mengetahui cara menggerakkan model, cobalah mengecat 
bagian yang berbeda dengan warna spesifik ini, seperti yang ditunjukkan pada Gambar 
6.13: 

 Warnai dinding luar dengan warna merah-coklat. 

 Warnai atap dengan warna biru muda. 

 Cat interior kuning-oranye. 
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Gambar 6.11: Material panel di Windows (kiri) dan di Mac (kanan). 
 

Gambar 6.12: Pilih tool Orbit dan seret kursor Anda untuk memutar mode Anda 
 

Gambar 6.13: Orbit (putar) model Anda untuk mengecat semua permukaan. 
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Tips 

Saat Anda baru memulai, Anda dapat dengan mudah tersesat dengan tool navigasi (Orbit, 
Zoom, dan Geser). Jika Anda bingung, pilih Camera => Zoom Extents. SketchUp memangkas 
model Anda tepat di depan Anda, seperti yang ditunjukkan pada Gambar 6.14. 

Sekadar info, Zoom Extents juga merupakan tombol di toolbar; itu tepat di sebelah tool Zoom. 
 

Gambar 6.14: Gunakan Perluasan Zoom setiap kali Anda tidak dapat mengetahui ke mana 
tujuan model Anda. 

Memberikan Beberapa Style Model Anda 

Style SketchUp memungkinkan Anda mengubah tampilan model Anda - pada dasarnya cara 
menggambarnya - hanya dengan beberapa klik mouse. SketchUp juga dilengkapi dengan 
pustaka style yang telah dibuat sebelumnya yang dapat Anda gunakan tanpa mengetahui apa 
pun tentang cara kerjanya. 

Ikuti langkah-langkah berikut untuk mencoba beberapa style pada rumah anjing Anda: 

1. Buka panel Styles dengan mengklik panah penunjuk kanan di sebelah namanya di 
Default Tray (Windows). Atau pilih Window => Styles (Mac). 

Secara default, Anda melihat select tab, tempat Anda dapat menelusuri dan memilih 
style. Di bagian atas select tab, daftar turun bawah memungkinkan Anda membuka 
pustaka style yang berbeda. Style di setiap pustaka muncul di paruh bawah select tab. 

2. Dari daftar drop-down, pilih library Assorted Styles, seperti yang ditunjukkan pada 
Gambar 6.15. 

3. Klik salah satu style untuk melihat bagaimana style tersebut mengubah keseluruhan 
tampilan model Anda. 

Anda dapat mengklik melalui berbagai style untuk melihat apa pilihan Anda. Gambar 
6.16 menunjukkan rumah anjing dengan beberapa style yang diterapkan - dapatkah 
Anda mencari tahu yang mana? 

4. Kembali ke style asli Anda dengan mengklik ikon Dalam Model dan memilih style 
Desain Arsitektur. 

 

Di panel Style, mengeklik ikon Dalam Model menampilkan daftar semua style yang 
telah Anda terapkan ke model Anda. Style Desain Arsitektur harus menjadi yang 
pertama dalam daftar. 
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Gambar 6.16: Rumah anjing yang sama dengan empat style yang sangat berbeda 
diterapkan padanya. 
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Gambar 6.15: Library Assorted Styles adalah contoh style SketchUp yang sudah 
dicampur. 

Switching Sun (Menyalakan Sinar Matahari) 

Anda akan menggunakan apa yang saya anggap sebagai salah satu fitur terbaik SketchUp: 
Bayangan. Saat Anda mengaktifkan Shadows, Anda mengaktifkan matahari bawaan SketchUp. 
Bayangan yang Anda lihat di window pemodelan akurat untuk waktu dan lokasi apa pun yang 
Anda tetapkan. 

Siap menyoroti model Anda? Ikuti langkah ini: 

1. Gunakan Orbit, Zoom, dan Pan untuk mendapatkan tampilan udara tiga perempat 
dari rumah anjing Anda, seperti tampilan yang ditunjukkan pada Gambar 6.17. 

Klik tanda panah kanan di sebelah panel Shadows di default tray (Windows). Atau pilih 
Window => Shadows (Mac). 

2. Anda melihat panel Shadow setting. (Lihat Gambar 6.17.) 
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3. Klik tombol Show/Hide Shadows (di pojok kiri atas) untuk beralih ke matahari. 

Rumah anjing Anda membuat bayangan di tanah. 

4. Gerakkan penggeser Waktu bolak-balik. 

Mengubah waktu berarti Anda sedang menggerakkan matahari SketchUp di langit. 
Saat matahari bergerak, begitu juga bayangan Anda. Untuk melihat bayangan yang 
akurat, Anda juga harus melakukan geolokasi model Anda, yang merupakan cara yang 
bagus untuk mengatakan bahwa Anda memberinya garis lintang. 

 

 

Gambar 6.17: Gunakan Orbit, Zoom, dan Pan untuk menavigasi hingga model Anda terlihat 
seperti ini. 
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BAB 7 

PEMODELAN PROSES SKETCHUP 

SketchUp adalah program pemodelan tiga dimensi yang dapat Anda gunakan untuk 
membangun lingkungan yang kaya dan ekspresif. Karena SketchUp dikembangkan sebagai alat 
pemodelan 3D untuk semua orang, kekuatannya berasal dari alat yang mudah digunakan dan 
lingkungan kerja 3D yang intuitif. Menggunakan proses pemodelan yang efisien adalah rahasia 
untuk membuat model SketchUp yang efisien dan terperinci. Metode Pemodelan Proses 
SketchUp yang digunakan dalam buku ini meliputi 

 Membangun model dalam urutan yang logis 

 Menambahkan detail dengan menggunakan sumber daya yang tersedia 

 Mengatur model untuk menjaga kinerja komputer dan ruang kerja 3D yang bersih 

 Memahami edge dan face 

 Representasi tiga dimensi pada layar dua dimensi 

 Inferencing seperti seorang profesional 

 Pemanasan dengan SketchUp 

 Membariskan entitas dengan guide 

 Menambahkan warna dan tekstur pada pekerjaan Anda 

Baik Anda seorang pemula atau pengguna SketchUp mahir, Anda harus memahami metode 
Pemodelan Proses SketchUp untuk memanfaatkan buku ini sepenuhnya. Bab-bab berikut 
menggunakan proses sebagai dasar untuk mengembangkan teknik pemodelan yang lebih 
maju. Apakah Anda memodelkan dari imajinasi Anda, rencana yang digambar dengan tangan, 
Computer Aided Design (AutoCAD), atau Digital Elevation Model (DEM), prosesnya sendiri 
sama. 

Semua tentang Edge dan Face 

Di SketchUp, semuanya terdiri dari salah satu dari dua jenis elemen: edge atau permukaan. 
Itu adalah elemen penyusun dasar dari setiap model yang pernah Anda buat. 

Ingat, Secara kolektif, edge dan permukaan dalam model Anda adalah geometri. Program 
pemodelan lain memiliki jenis geometri lain, tetapi SketchUp cukup sederhana. Itu hal yang 
baik - Anda memiliki lebih sedikit untuk dilacak. 

Gambar di sebelah kiri pada Gambar 7.1 adalah kubus dasar yang digambar di SketchUp; itu 
terdiri dari 12 edge dan 6 sisi. Model di sebelah kanan jauh lebih kompleks, tetapi geometrinya 
sama; itu semua hanya edge dan face. 
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Gambar 7-1: Model SketchUp dibuat dari edge dan muka. 

Living di Edge 

Edge adalah garis. Anda dapat menggunakan banyak tool untuk menggambar, menghapus, 
memindahkan, menyembunyikan, dan bahkan meregangkannya. Berikut beberapa hal yang 
perlu Anda ketahui tentang edge SketchUp: 

 Edge selalu lurus. Tidak hanya semua yang ada di model SketchUp Anda terdiri dari 
edge, tetapi semua edgenya juga lurus sempurna. Bahkan busur dan lingkaran dibuat 
dari segmen garis lurus kecil, seperti yang ditunjukkan pada Gambar 7-2. 

 Edge tidak memiliki ketebalan. Yang ini agak sulit untuk dipahami. Anda tidak perlu 
khawatir tentang seberapa tebal edge dalam model Anda karena bukan itu cara kerja 
SketchUp. Bergantung pada cara Anda memilih untuk menampilkan model, edge Anda 
mungkin terlihat memiliki ketebalan yang berbeda, tetapi edge Anda sendiri tidak 
memiliki ketebalan bawaan. 

 Hanya karena Anda tidak dapat melihat Edge-nya, bukan berarti Edge nya tidak ada. 
Edge dapat disembunyikan sehingga Anda tidak dapat melihatnya; melakukannya 
adalah cara yang populer untuk membuat bentuk tertentu. Perhatikan Gambar 7-3. Di 
sebelah kiri adalah model yang terlihat membulat. Di sebelah kanan, edge tersembunyi 
terlihat sebagai garis putus-putus - lihat bagaimana permukaan yang tampak 
melengkung mulus dibuat dari edge lurus? 

 

Gambar 7.3 : Garis lengkung yang rata dibuat dari edge yang lurus. 

 

Gambar 7.3: Bahkan bentuk organik dan bentuk melengkung dibuat dari edge lurus. 
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Menghadapi fakta tentang face 

Face adalah permukaan. Jika Anda menganggap model SketchUp terbuat dari tusuk gigi dan 
kertas (yang memang sejenisnya), face pada dasarnya adalah kertas. Inilah yang perlu Anda 
ketahui tentang face: 

 Anda tidak boleh memiliki face tanpa edge. Untuk memiliki face, Anda harus memiliki 
setidaknya tiga edge coplanar (pada bidang yang sama) yang terhubung. Dengan kata 
lain, sebuah face ditentukan oleh edge yang mengelilinginya, dan semua edge tersebut 
harus berada pada bidang datar yang sama. Karena Anda membutuhkan setidaknya 
tiga garis lurus untuk membuat bentuk tertutup, permukaan harus memiliki setidaknya 
tiga sisi. Namun, tidak ada batasan jumlah sisi yang dapat dimiliki face SketchUp. 
Gambar 3-4 menunjukkan bagaimana face bisa menghilang saat Anda menghapus 
edge yang mendefinisikan satu atau lebih face. Saya mulai dengan model di sebelah 
kiri dan menghapus edge yang melengkapi bagian atas dan salah satu bagian samping. 
Hasilnya, ditunjukkan di kanan, kedua face itu menghilang. 

 Face selalu datar. Di SketchUp, bahkan permukaan yang terlihat melengkung dibuat 
dari beberapa permukaan datar. Dalam model yang ditunjukkan pada Gambar 7-5, 
yang tampak seperti permukaan berbentuk organik (di sebelah kiri) sebenarnya 
hanyalah banyak permukaan yang lebih kecil (di sebelah kanan). Untuk membuat 
sekumpulan permukaan datar tampak seperti permukaan yang besar dan melengkung, 
ujung-ujung di antaranya dihaluskan. 

 
Sama seperti edge, permukaan tidak memiliki ketebalan apa pun. Jika face sangat mirip 
dengan potongan kertas, berarti itu adalah potongan kertas yang sangat tipis - tidak 
memiliki ketebalan apa pun. Untuk membuat permukaan yang tebal (katakanlah, 
dinding setebal 6 inci), Anda perlu menggunakan dua permukaan secara 
berdampingan. 

 

Gambar 7.4: Anda membutuhkan setidaknya tiga sisi untuk membuat sebuah face. 
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Gambar 7.5: Semua permukaan datar, bahkan yang membentuk permukaan yang lebih besar 
dan melengkung. 

Memahami hubungan antara edge dan face 

Sekarang Anda tahu bahwa model dibuat dari edge dan permukaan, Anda akan memahami 
cara kerja SketchUp. Berikut beberapa informasi yang harus mengisi kekosongan: 

 Setiap kali SketchUp dapat membuat face. Tidak ada yang namanya”face tool" dalam 
perangkat lunak ini; SketchUp secara otomatis membuat face setiap kali Anda selesai 
menggambar bentuk tertutup dari tiga edge coplanar atau lebih. Gambar 7.6 
menunjukkan ini dalam tindakan: Segera setelah garis menghubungkan edge terakhir 
ke yang pertama, SketchUp membuat face. 

 Anda tidak dapat menghentikan SketchUp untuk membuat face, tetapi Anda dapat 
menghapusnya jika mau. Jika SketchUp membuat face yang tidak Anda inginkan, 
cukup klik kanan face tersebut dan pilih Hapus dari menu konteks. Face itu dihapus, 
tetapi edge yang mendefinisikannya tetap ada, seperti yang diilustrasikan pada 
Gambar 37. 

 Menelusuri kembali edge menciptakan kembali face yang hilang. Jika Anda sudah 
memiliki lingkaran edge coplanar yang tertutup tetapi tidak memiliki permukaan 
(karena Anda telah menghapusnya, mungkin), Anda dapat menggambar ulang salah 
satu edge untuk membuat permukaan baru. Cukup gunakan Line tool untuk 
menelusuri salah satu segmen edge, dan face muncul kembali, seperti yang 
ditunjukkan pada Gambar 7.8. 

 Menggambar edge sepanjang face akan membagi face menjadi dua. Saat Anda 
menggambar edge (seperti dengan Line tool) dari satu sisi face ke sisi lain, Anda 
memotong face itu menjadi dua. Hal yang sama terjadi ketika Anda menggambar 
lingkaran edge yang tertutup (seperti persegi panjang) pada sebuah face - Anda akan 
mendapatkan dua sisi, satu”di dalam” yang lain. Pada Gambar 7.9, kita membagi 
sebuah face menjadi dua dengan tool Line dan kemudian mengekstrusi satu face 
sedikit dengan tool Push/Pull. 

 Menggambar edge yang memotong edge lain akan memisahkan kedua edge yang 
bersentuhan. Dengan cara ini, Anda dapat membagi edge sederhana yang Anda 
gambar dengan Line tool, serta edge yang dibuat saat Anda menggambar bentuk 
seperti persegi panjang dan lingkaran. Seringkali, pemotongan otomatis ini diinginkan, 
tetapi jika tidak, Anda selalu dapat menggunakan grup dan komponen untuk 
memisahkan geometri Anda. 



78 
 

 
 

Gambar 7.6: SketchUp secara otomatis membuat face setiap kali Anda membuat loop tertutup 
dari edge coplanar. 

 

Gambar 7.7: Anda dapat menghapus face tanpa menghapus edge yang menentukannya. 
 

Gambar 7.8: Cukup lacak kembali edge mana pun pada loop tertutup untuk memberi tahu 
SketchUp agar membuat face baru. 
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Gambar 7-9: Memisahkan face dengan edge, lalu mengekstrusi salah satu permukaan baru. 

Menggambar dalam 3D pada Layar 2D 

Untuk pemrogram komputer, membiarkan Anda menggambar objek 3D di layar adalah 
masalah yang sulit. Anda tidak akan berpikir itu menjadi masalah besar; bagaimanapun juga, 
orang telah menggambar dalam perspektif untuk waktu yang sangat lama. Jika beberapa 
orang tua dapat mengetahuinya 500 tahun yang lalu, mengapa komputer Anda mengalami 
masalah? 

Masalahnya, persepsi manusia tentang kedalaman di atas kertas adalah tipuan mata. Dan 
tentu saja, komputer Anda tidak memiliki mata yang memungkinkannya menafsirkan 
kedalaman tanpa memikirkannya. Anda perlu memberikan instruksi eksplisit pada komputer 
Anda. Di SketchUp, ini berarti menggunakan sumbu gambar dan inferences, seperti yang saya 
jelaskan di bagian selanjutnya. 

Memberi instruksi dengan sumbu gambar 

Lihat tiga garis berwarna yang bersilangan di window pemodelan SketchUp? Ini adalah sumbu 
gambar, dan itu adalah kunci untuk memahami cara kerja SketchUp. Sederhananya, Anda 
menggunakan sumbu gambar SketchUp untuk mengetahui di mana Anda berada dan ke mana 
Anda ingin pergi dalam ruang 3D. Saat Anda bekerja dengan sumbu warna, Anda perlu 
mengingat tiga hal penting: 

 Sumbu gambar merah, hijau, dan biru menentukan ruang 3D dalam model Anda. Jika 
Anda berdiri di tempat di mana ketiga sumbu bertemu - asal sumbu - sumbu biru akan 
berjalan secara vertikal, melewati kepala dan kaki Anda. Sumbu merah dan hijau 
menentukan bidang tanah di SketchUp; Anda akan berdiri di atasnya. Semua sumbu 
berada pada sudut siku-siku satu sama lain, dan meluas hingga tak terbatas dari 
asalnya. 

 Saat Anda menggambar, memindahkan, atau menyalin sesuatu yang sejajar dengan 
salah satu sumbu berwarna, Anda bekerja ke arah warna itu. Perhatikan Gambar 7.10. 
Pada gambar pertama, saya menggambar garis yang sejajar dengan sumbu merah, 
atau menggambar”ke arah merah". Anda tahu sebuah garis sejajar dengan sumbu 
merah karena garis tersebut berubah menjadi merah untuk memberi tahu Anda. Pada 
gambar kedua, saya memindahkan kotak yang sejajar dengan sumbu biru, 
atau”bergerak ke arah biru". Garis putus-putus biru tampaknya memberi tahu Anda 
hal itu. 

 Sumbu gambar berwarna membantu Anda memberi tahu SketchUp apa yang Anda 
maksud. Misalnya, pada Gambar 7.11, menggerakkan silinder ke arah biru dan hijau 
melibatkan pergerakan kursor ke atas. Sumbu gambar membantu SketchUp 
mengetahui apakah Anda ingin memindahkan silinder di luar angkasa (di atas tanah) 
atau kembali ke angkasa. 
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Ingat, Saat Anda bekerja di SketchUp, Anda menggunakan sumbu gambar berwarna sepanjang 
waktu. Mereka tidak hanya berguna; itulah yang membuat SketchUp berfungsi. Mereka 
membuat pemodelan di SketchUp dengan cepat, akurat, dan relatif intuitif. Saat Anda 
membuat model, yang harus Anda lakukan adalah memastikan bahwa Anda bekerja dalam 
arah warna yang Anda inginkan: Sejajarkan geometri Anda dengan sumbu yang sesuai dan 
perhatikan petunjuk visual yang memberi tahu arah Anda bekerja. 

 

Gambar 7.10: Isyarat visual memberi tahu Anda saat Anda menggambar atau memindahkan 
geometri sejajar dengan sumbu gambar. 

 

Gambar 7.11: Sumbu membantu Anda membuat model 3D pada layar 2D. 
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Perhatikan inferences 

Jika Anda pernah menghabiskan waktu bermain-main dengan SketchUp, Anda telah 
memperhatikan semua lingkaran kecil berwarna, kotak, garis putus-putus, tip layar kuning, 
dan coretan lain yang muncul saat Anda menggerakkan kursor di sekitar window pemodelan 
Anda. Semua hal ini secara kolektif disebut sebagai mesin inferensi SketchUp, dan tujuan 
utamanya adalah membantu Anda saat Anda membuat model. Untungnya, memang demikian. 
Tanpa inferences (kata bagus yang disebutkan di atas), SketchUp tidak akan terlalu berguna. 

Point Inferencess 

Umumnya, inferences SketchUp membantu Anda lebih akurat. Titik inferences muncul saat 
Anda menggerakkan kursor ke bagian tertentu dari model Anda. Mereka tampak seperti 
lingkaran dan kotak kecil berwarna, dan jika Anda berhenti sejenak, label kuning akan muncul. 
Misalnya, inferensi Endpoint kecil berwarna hijau (yang muncul setiap kali kursor Anda 
mengarahkan kursor ke ujung edge) membantu Anda secara akurat menghubungkan edge 
yang Anda gambar ke ujung edge lain dalam model Anda. 

 

Gambar 7.12: Point inferencess muncul saat Anda mengarahkan kursor ke titik-titik utama dan 
membantu Anda menggambar secara akurat. 

Ingat, Dalam SketchUp, garis disebut edge, dan permukaan disebut permukaan. Segala 
sesuatu dalam model Anda terdiri dari edge dan muka. 

Linier Interfecences 

Seperti yang mungkin telah Anda ketahui, warna memainkan peran besar dalam antarmuka 
pengguna SketchUp, atau tampilannya. Mungkin contoh terbaik dari hal ini ada di inferensi 
linier perangkat lunak -”garis pembantu" yang muncul untuk membantu Anda bekerja lebih 
tepat. Gambar 7.13 mengilustrasikan inferences linier yang penting, dan berikut adalah 
deskripsi dari apa yang mereka lakukan: 

 On Axis: Jika edge yang Anda gambar sejajar dengan salah satu sumbu gambar 
berwarna, edge tersebut mengubah warna sumbu tersebut. Pada Gambar 7.13, Anda 
melihat inferensi On Red Axis. 

 From Point: Yang ini agak sulit untuk dijelaskan. Ketika garis berwarna dan putus-putus 
muncul saat Anda menggerakkan kursor, kursor Anda”sejajar" dengan titik di ujung 
lain dari garis putus-putus. Secara alami, warna inferensi Dari Titik mencerminkan 
sumbu tempat Anda berbaris”di". Terkadang inferences From Point muncul dengan 
sendirinya, dan terkadang Anda harus mendorongnya; lihat bagian”Menggunakan 
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inferences untuk membantu Anda membuat model,” selanjutnya di bab ini, untuk 
detailnya. 

 Perpendicular: Saat Anda menggambar edge yang tegak lurus ke edge lainnya, edge 
yang Anda gambar berubah menjadi magenta (ungu kemerahan). 

 Parallel: Jika edge yang Anda gambar sejajar dengan edge lain dalam model Anda, 
warnanya berubah menjadi magenta untuk memberi tahu Anda. Anda memberi tahu 
SketchUp sisi mana yang Anda minati untuk”sejajar" dengan mendorong inferences. 

 Tangent at Vertex: Yang ini hanya berlaku ketika Anda menggambar busur 
(menggunakan tool Busur) yang dimulai pada titik akhir busur lain. Jika busur yang 
Anda gambar bersinggungan dengan busur yang lain, busur yang Anda gambar 
berubah menjadi sian. 

Garis singgung, dalam hal ini, berarti transisi antara kedua busur itu mulus. 
 

Gambar 7.13: Inferences linier SketchUp membantu Anda menyelaraskan geometri baru 
dengan geometri yang ada. 

Menggunakan inferences untuk membantu Anda membuat model 

Sebagian besar penggunaan mesin inferensi SketchUp melibatkan penguncian dan dorongan 
inferensi - terkadang bahkan secara bersamaan. Pada awalnya, tindakan ini tampak seperti 
hal di mana Anda menepuk kepala dan menggosok perut pada saat yang bersamaan, tetapi 
dengan latihan, akan lebih mudah. 

 Mengunci inferensi: Jika Anda menahan tombol Shift saat Anda melihat salah satu dari 
empat jenis inferensi linier yang dijelaskan sebelumnya, inferensi tersebut terkunci - 
dan tetap terkunci sampai Anda melepaskan Shift. Saat Anda mengunci inferensi, Anda 
membatasi tool apa pun yang Anda gunakan untuk bekerja hanya ke arah inferensi 
yang Anda kunci. 

 Mendorong inference: Terkadang inferences yang Anda butuhkan tidak muncul 
dengan sendirinya. Jika ini terjadi, Anda harus mendorongnya. Untuk mendorong 
inferensi, arahkan kursor ke bagian model yang ingin Anda”simpulkan", lalu perlahan- 
lahan kembali ke apa pun yang Anda lakukan saat Anda memutuskan untuk 
menggunakan inferensi. 

Contoh berikut mengilustrasikan bagaimana Anda dapat mengunci dan mendorong inferensi 
untuk menggambar model 3D. Pada Gambar 7.14, katakanlah Anda ingin menggambar garis 
pada sumbu biru yang sejajar dengan pojok kanan belakang rumah dan setinggi edge bawah 
atap. Berikut adalah cara Anda menggunakan inferences untuk membantu Anda: 
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1. Dengan Line tool dipilih, dorong inferensi Dari Titik dengan mengarahkan kursor ke 
sudut kanan belakang rumah dan kemudian perlahan-lahan gerakkan kursor Anda 
dari sudut itu untuk mendorong inferensi Dari Titik. 

2. Klik untuk menyetel titik awal garis dan tahan tombol Shift untuk mengunci garis ke 
arah biru saat Anda menggambar garis. Inferensi garis biru menjadi lebih tebal untuk 
menunjukkan garis terkunci pada arah biru. 

3. Saat garis dekat dengan titik akhir yang Anda inginkan, arahkan kursor mouse ke titik 
akhir tersebut sambil terus menahan tombol Shift. Saat inferensi ke titik akhir 
muncul, klik untuk menyetel titik akhir baris baru Anda. 

 

Gambar 7.14: Kunci dan dorong inferences saat Anda menggambar geometri baru dalam 
hubungannya dengan geometri yang ada 

Memanaskan Otot SketchUp Anda 

Sekitar delapan keterampilan SketchUp berguna setiap kali Anda menggunakan SketchUp. 
Jenis pendidikan formal mungkin akan menyebutnya kompetensi inti. Apa pun yang Anda 
sebut aktivitas ini, saya perkenalkan semuanya di bagian berikut. Kapan pun Anda 
membutuhkan penyegaran cepat, kembali ke bagian ini. 

Mendapatkan tampilan terbaik dari apa yang Anda lakukan 

Menggunakan SketchUp tanpa mempelajari cara mengorbit, memperbesar, dan menggeser 
seperti mencoba membuat kapal di dalam botol. Dalam gelap. Dengan tangan terikat di 
belakang punggung. Menggunakan sumpit. Dapatkan fotonya? 

Ingat, setengah dari pemodelan di SketchUp menggunakan tool Orbit, Zoom, dan Geser, yang 
memungkinkan Anda mengubah tampilan sehingga Anda dapat melihat apa yang Anda 
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lakukan. Kebanyakan orang yang mencoba mencari tahu SketchUp sendiri membutuhkan 
waktu terlalu lama untuk memahami pentingnya tool navigasi ini dan menghabiskan waktu 
berjam-jam untuk menyipitkan mata, mendengus, dan mengalami waktu yang menyedihkan 
untuk mencoba”memahami" apa yang sedang mereka kerjakan. Bagian berikut membantu 
Anda menghindari sakit kepala (secara harfiah). 

Menuju ke orbit 
 

Pegang segelas air di tangan Anda. Sekarang putar dan putar pergelangan tangan Anda ke 
segala arah sehingga air menutupi Anda dan seluruh ruangan. Berhenti saat gelas benar-benar 
kosong. Saya rasa itu adalah cara yang cukup berkesan untuk mengetahui tentang tool Orbit, 
bukan? 

Sama seperti pergelangan tangan Anda yang membantu Anda memutar dan memutar kaca 
untuk melihatnya dari setiap sudut, pikirkan untuk menggunakan Orbit sebagai cara untuk 
terbang mengelilingi pekerjaan Anda. Gambar 7.15 menunjukkan Orbit dengan segala 
kemegahannya. 

 

Gambar 7.15: Tool Orbit memungkinkan Anda melihat model Anda dari sudut mana pun. 

Tips 

Meskipun Anda dapat menemukan tool Orbit pada menu Kamera dan tombol Orbit pada 
toolbar, berikut cara Anda harus selalu mengorbit: Tahan roda gulir mouse dan gerakkan 
mouse Anda. Lihat model Anda berputar? Lepaskan roda gulir setelah Anda selesai. 
Menggunakan mouse untuk mengorbit berarti Anda tidak perlu berpindah tool setiap kali 
Anda menginginkan tampilan yang lebih baik, yang menghemat banyak waktu. 
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Zoom In dan Zoom Out 

 
 

Pegang gelas kosong Anda sejauh lengan. Pejamkan mata Anda dan kemudian arahkan gelas 
ke arah Anda, berhenti tepat saat kaca tersebut menghantam hidung Anda. Sekarang 
lemparkan kaca ke seberang ruangan, perhatikan bagaimana kaca itu menyusut saat semakin 
jauh. Singkatnya, menjelaskan tool Zoom. 

Anda menggunakan Zoom untuk mendekati (dan lebih jauh dari) model Anda. Jika Anda 
mengerjakan sesuatu yang kecil, Anda memperbesarnya hingga memenuhi window 
pemodelan Anda. Untuk melihat semuanya sekaligus, perkecil. Gambar 7.16 adalah 
demonstrasi. 

 

Gambar 7.16: Gunakan tool Zoom untuk lebih mendekati aksi. 

Tips 

Saat Anda menggambar di SketchUp, Anda memperbesar dan memperkecil model Anda 
sepanjang waktu, dan kiat berikut membuat pembesaran cepat dan mudah: 

 Untuk memperbesar dan memperkecil, putar jari Anda pada roda gulir mouse Anda. 
Cara ini adalah cara termudah untuk melakukan zoom. Anda dapat menemukan tool 
Zoom pada menu Kamera dan tombol Zoom pada toolbar, tetapi memperbesar 
dengan roda gulir mouse berarti Anda tidak perlu berpindah tool. Saat Anda berhenti 
menggulir, Anda berhenti memperbesar dan kembali ke tool aktif Anda. 

 Saat Anda menggulir, SketchUp memperbesar kursor Anda. Posisikan kursor di atas 
bagian model mana pun yang ingin Anda lihat lebih dekat (atau dari jauh). 

 Gunakan Zoom Extents untuk melihat semuanya. 
 

Jika Anda ingin model Anda mengisi window pemodelan Anda (yang sangat berguna 
saat Anda”tersesat" dengan tool navigasi - percayalah, ini terjadi pada semua orang), 
cukup pilih Kamera ⇒ Zoom Extents. Anda juga dapat mengklik tombol Zoom Extents 
pada toolbar. 

Hanya berputar-putar 
 

Menggunakan tool Pan sangat mirip dengan mencuci window: Anda menggerakkan handuk 
kertas ke depan dan ke belakang, tetapi tisu tetap rata dan tidak pernah mendekat atau lebih 
jauh dari Anda. Tool Pan pada dasarnya untuk menggeser tampilan model Anda di sekitar 
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window pemodelan Anda. Untuk melihat sesuatu yang ada di sebelah kanan, Anda 
menggunakan Pan untuk menggeser model Anda ke kiri. Sesederhana itu. 

Tips 

Meskipun Anda menemukan tool Pan di menu Kamera dan tombol Pan di toolbar, berikut cara 
terbaik untuk menggeser: Tahan tombol scroll wheel mouse Anda dan tekan tombol Shift. Saat 
Anda melakukan keduanya pada saat yang sama - pada dasarnya, Orbit + Shift - kursor Anda 
untuk sementara berubah menjadi tool Pan, dan Anda dapat menggerakkan mouse untuk 
menggeser. 

Menggambar dan menghapus edge dengan mudah 

Inilah rahasia untuk membuat model apa pun yang Anda inginkan di SketchUp: Belajar 
menggunakan Line tool tanpa harus terlalu memikirkannya. Anda menggunakan Line tool 
untuk menggambar edge individu, dan karena model SketchUp benar-benar hanya kumpulan 
edge yang mewah (tentu saja diatur dengan hati-hati), apa pun yang dapat Anda buat di 
SketchUp, Anda dapat membuatnya dengan Line tool. 

Ingat, model SketchUp terdiri dari edge dan permukaan. Setiap kali Anda memiliki tiga atau 
lebih edge yang membentuk bentuk tertutup dan berada di bidang yang sama, SketchUp 
membuat face. Jika Anda menghapus edge yang membatasi, atau membatasi, face, face juga 
akan hilang. Lihat bagian”Semua tentang Edge dan Face," di awal bab ini, untuk informasi lebih 
lanjut tentang hubungan antara edge dan permukaan. 

Menggambar edge itu sederhana. Ikuti saja langkah-langkah ini: 

1. Pilih Line tool. 
 

 

Anda dapat memilih Line tool dari menu Gambar atau toolbar. Menekan tombol L juga 
mengaktifkan tool Line. 

2. Klik di mana Anda ingin baris Anda dimulai. 
3. Pindahkan kursor Anda ke titik akhir yang diinginkan untuk garis Anda dan klik lagi 

untuk mengakhiri. 

Saat Anda menggambar segmen garis dengan Line tool, perhatikan bagaimana 
SketchUp secara otomatis mencoba menggambar garis lain? Ini disebut pita karet - 
Line tool memungkinkan Anda terus menggambar segmen edge, secara otomatis 
memulai setiap segmen baru di akhir yang sebelumnya Anda gambar. 

4. Saat Anda ingin Line tool berhenti menggambar garis, tekan tombol Esc untuk 
memotong garis di tempat terakhir yang Anda klik. 

Tips 

SketchUp memungkinkan Anda menggambar garis dengan dua cara: Anda dapat 
menggunakan metode klik-seret-lepas atau klik-gerak-klik. Saya sangat menyarankan melatih 
diri Anda untuk mengklik-klik-klik. Anda akan memiliki lebih banyak kendali, dan tangan Anda 
tidak akan terlalu lelah. Saat Anda menggambar edge dengan mengeklik dan menyeret mouse 
(klik-seret-lepas), Anda kemungkinan besar akan”menjatuhkan” garis Anda secara tidak 
sengaja. Karena Line tool hanya menggambar garis lurus, pikirkan untuk tidak 
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MENONAKTIFKAN GARIS PENGIKAT KARET 

 

Bergantung pada apa yang Anda buat dan cara Anda bekerja, Anda mungkin ingin 
menonaktifkan perilaku pita karet tool Line. Untuk melakukannya, ikuti langkah-langkah 
berikut: 

1. Pilih Window => Preferences (SketchUp => Preferences di Mac). 
2. Pilih panel Gambar dari daftar di sebelah kiri di kotak dialog Preferensi. 
3. Kosongkan kotak centang Lanjutkan Gambar Garis. 

menggunakannya seperti pensil (meskipun terlihat seperti pensil) dan lebih seperti gulungan 
benang lengket. 

 

Eraser tool dirancang khusus untuk menghapus edge. Anda dapat menemukan tool ini pada 
menu Gambar dan toolbar, atau aktifkan dengan menekan tombol E. Untuk menghapus edge, 
pilih Eraser tool dan klik edge yang tidak Anda suka untuk menghapusnya. Anda juga dapat 
menarik edge dengan Penghapus, tapi itu sedikit lebih sulit. Untuk menghapus beberapa edge 
sekaligus, pilih mereka (pemilihan dijelaskan di bagian selanjutnya,”Memilih apa yang ingin 
Anda pilih"); lalu context-clicks pada pilihan dan pilih Hapus. 

 

 
 

Akurasi injeksi ke dalam model Anda 

Sering kali, Anda perlu memastikan bahwa model Anda akurat - bahwa yang Anda buat 
modelkan sesuai dengan ukuran yang Anda inginkan. Di SketchUp, kunci akurasi adalah 
Measurement box. Kotak teks kecil yang kuat ini berada di pojok kanan bawah window 
SketchUp Anda. 

Berikut beberapa hal yang dapat dilakukan Measurement box: 

 Buat garis dengan panjang tertentu. 

 Gambar persegi panjang dengan ukuran tertentu. 

 Push/pull face dengan jarak tertentu. 

 Ubah jumlah sisi dalam poligon. 

 Pindahkan sesuatu pada jarak tertentu. 

 Putar sesuatu dengan jumlah derajat tertentu. 

 Buat salinan dalam jumlah tertentu. 

 Bagilah garis menjadi beberapa segmen. 

 Ubah bidang pandang Anda (seberapa banyak yang bisa Anda lihat). 

Tips 

Berikut yang perlu Anda ketahui tentang Measurement box: 

 Anda tidak perlu mengklik Measurement box untuk memasukkan angka. Yang ini 
salah satunya: Pemula SketchUp sering berasumsi bahwa mereka perlu mengklik 
Measurement box (mungkin untuk memilihnya) sebelum mereka dapat mulai 
mengetik. Anda tidak perlu mengekliknya - cukup mulai mengetik, dan apa pun yang 
Anda ketik akan otomatis muncul di kotak. Setiap kali Anda menggambar, 
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Measurement box”mendengarkan" Anda mengetik sesuatu yang mengontrol 
ketepatan geometri Anda. 

 Measurement box peka konteks. Kotak menerima nilai berdasarkan apa yang Anda 
lakukan. Jika Anda menggambar edge dengan Line tool, kotak mendengarkan 
panjangnya; jika Anda memutar bentuk, kotak mendengarkan sudut. 

 Anda dapat menyetel satuan default untuk Measurement box dan mengganti default 
bila diperlukan. 

o Anda tidak perlu mengetikkan unit jika Anda ingin menggunakan unit default. 
Mungkin Anda ingin garis yang Anda gambar memiliki panjang 14 inci. Jika inci 
adalah satuan pengukuran default Anda, cukup ketik 14 ke dalam 
Measurement box dan tekan Enter - SketchUp menganggap yang Anda maksud 
adalah 14 inci. 

o Ketikkan unit jika Anda ingin mengganti unit default. Misalnya, jika default 
Anda adalah inci dan Anda ingin menggambar sesuatu sepanjang 14 kaki, ketik 
14’dan tekan Enter. Anda dapat mengganti unit pengukuran default dengan 
mengetikkan unit apa pun yang Anda inginkan. Jika Anda ingin memindahkan 
sesuatu dengan jarak 25 meter, ketik 25m dan tekan Enter. 

o Anda mengatur unit default di kotak dialog Model Info. Anda dapat membuka 
kotak dialog ini dari menu Window. Buka panel Units, dan pilih unit default baru 
Anda dari menu drop-down. 

 Terkadang, Measurement box melakukan lebih dari satu hal. Dalam keadaan tertentu, 
Anda dapat mengubah mode kotak (apa yang”didengarkan") dengan memasukkan 
jenis unit setelah angka. Misalnya, saat Anda menggambar lingkaran,”nilai" default di 
Measurement box adalah radius. Jika Anda mengetik 6 dan menekan Enter, radius 
lingkaran menjadi 6 inci. Tetapi jika Anda mengetik 6s, Anda memberi tahu SketchUp 
bahwa Anda menginginkan 6 sisi (dan bukan inci), sehingga lingkaran Anda menjadi 
segi enam. Jika Anda mengetik 6 dan menekan Enter, lalu mengetik 6s dan menekan 
Enter lagi, SketchUp menggambar segi enam (lingkaran 6 sisi) dengan radius 6 inci. 

 Measurement box memungkinkan Anda berubah pikiran. Selama Anda tidak 
melakukan apa pun setelah menekan Enter, Anda selalu dapat mengetikkan nilai baru 
dan menekan Enter lagi; tidak ada batasan berapa kali Anda dapat berubah pikiran. 

 Anda dapat menggunakan Measurement box selama operasi. Dalam kebanyakan 
kasus, Anda dapat menggunakan Measurement box dengan tepat saat Anda 
menggunakan sebuah tool. Begini cara kerjanya: 

o Klik sekali untuk memulai operasi Anda (seperti menggambar garis atau 
menggunakan Move Tool). 

o Gerakkan mouse Anda sehingga Anda mengarah ke arah warna yang benar. 
Pastikan untuk tidak mengklik lagi. Jika Anda menggunakan Line tool dan ingin 
menggambar sejajar dengan sumbu hijau, pastikan edge yang Anda gambar 
berwarna hijau (menampilkan inferensi edge hijau). 

o Tanpa mengklik Measurement box, ketik dimensi yang Anda inginkan. Dimensi 
muncul di kotak. 

o Tekan Enter untuk menyelesaikan operasi. 
 Anda juga dapat menggunakan Measurement box setelah operasi. Melakukannya 

akan merevisi apa yang baru saja Anda lakukan. Misalnya, Anda ingin memindahkan 
sebuah kotak, seperti yang ditunjukkan pada Gambar 7.17, 5 meter ke arah merah 
(sejajar dengan sumbu merah). Inilah yang Anda lakukan: 

o Dengan Move Tool, klik kotak sekali untuk mengambilnya. 
o Gerakkan mouse sampai Anda melihat inferensi linier merah. 
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MENGUBAH UKURAN SEGALA SESUATU DENGAN TAPE MEASUREMENT TOOL 
 
Pertimbangkan bahwa Anda telah mengerjakan SketchUp, tidak memberikan perhatian 
khusus pada seberapa besar sesuatu dalam model Anda, saat Anda tiba-tiba memutuskan 
bahwa Anda membutuhkan apa yang telah Anda buat untuk menjadi ukuran tertentu. 
SketchUp memiliki trik hebat untuk menangani situasi yang tepat ini: Anda dapat 
menggunakan tool Pita Pengukur untuk mengubah ukuran seluruh model Anda berdasarkan 
satu pengukuran. 

 
Berikut cara kerja tool ini: Pada gambar berikut, Aidan mulai membuat model tangga 
sederhana. Memastikan bahwa ukurannya tepat akan mempermudah pengerjaannya. 
Aidan tahu tinggi anak tangga, jarak vertikal antar anak tangga, harus 7 inci, jadi inilah yang 
dia lakukan: 

 
1. Pilih tool Pengukur Pita pada toolbar atau menu Tool. 

o Ketik 5m dan tekan Enter. Kotak itu diposisikan tepat 5 meter dari tempat Anda 
mengambilnya. Namun, setelah Anda melihat penempatan itu, Anda 
menyadari bahwa kotak itu perlu bergerak sedikit lebih jauh. 

o Ketik 15m lalu tekan Enter lagi. Kotak itu bergerak 10 meter lagi ke arah merah. 
o Anda dapat terus mengubah posisi kotak sampai Anda senang (atau bosan). 

 Measurement box memberi tahu Anda nilai atau nilai apa yang diharapkannya. 
Misalnya, pilih Line tool dan Measurement box memberi tahu Anda tool ini 
mendengarkan lama. Pilih Move Tool, dan Anda melihat kotak mengharapkan jarak. 
Fitur ini sangat bagus karena mengingat semua yang dapat dilakukan kotak pada saat 
tertentu cukup sulit - bahkan untuk pemodel SketchUp yang berpengalaman. 

 

Gambar 7.17: Anda dapat memindahkan kotak sejauh 5 meter dan kemudian berubah pikiran 
dan memindahkannya sejauh 15 meter 

 



90 
 

 
 

Memilih apa yang ingin Anda pilih 

Jika Anda ingin memindahkan, memutar, menyalin, menskalakan, atau memanipulasi 
geometri yang ada dalam model Anda, Anda harus memilihnya terlebih dahulu. Pilihan Anda 
memberi tahu SketchUp geometri apa yang ingin Anda ubah. 

 

Untuk memilih sesuatu, Anda menggunakan (drum roll, tolong) tool Pilih, yang terlihat persis 
sama dengan tool Pilih di setiap program grafik lain di planet ini - ini adalah panah. Itu hal yang 
baik karena memilih bukanlah hal yang harus Anda pelajari kembali setiap kali Anda 
mengambil program baru. Berikut semua yang perlu Anda ketahui tentang memilih berbagai 
hal di SketchUp: 

 Masalah Teknis : Secara teknis, setiap hal yang Anda lihat di window pemodelan 
Anda adalah entitas. SketchUp memiliki tiga jenis entitas: 

o Elemen adalah potongan dasar geometri seperti edge dan permukaan. 
o Objek terdiri dari elemen. Kapanpun Anda ingin membuat sesuatu yang 

terpisah dengan nama dan metadatanya sendiri, Anda membuat sebuah objek. 
Di SketchUp, mereka ada di mana-mana. 

o Anotasi adalah hal-hal seperti teks, guide, dimensi, dan bidang bagian. Ini 
semacam kategori penampung-semua - apa pun yang bukan elemen atau objek 
adalah anotasi. 

 
 
 
 
 
 
 
 
 
 
 
 

 
2. Untuk meletakkan Pita Pengukur dalam mode Pengukur, tekan tombol Ctrl (Opsi 

pada Mac) sehingga tanda plus (+) di sebelah kursor Pengukur Pita Perekat 
menghilang. 

3. Klik sekali untuk mulai mengukur jarak yang akan berubah (dalam hal ini, ketinggian 
riser) dan klik lagi untuk berhenti. 

4. Ketik dimensi yang diinginkan (7 untuk 7 inci). 
5. Di kotak dialog, konfirmasikan pengubahan ukuran dengan mengklik Ya. 

 

Setelah Aidan mengklik tombol Ya, seluruh modelnya diubah ukurannya secara 
proporsional ke dimensi yang dia masukkan. 
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 Cukup klik apa saja di model Anda untuk memilihnya (saat Anda menggunakan tool 
Pilih, tentu saja). 

 Untuk memilih lebih dari satu hal, tahan tombol Shift saat Anda mengklik semua hal 
yang ingin Anda pilih. 

 Tips : Tombol Shift bekerja dua arah saat menggunakan tool Select. Anda dapat 
menggunakannya untuk menambahkan ke set hal yang Anda pilih (yang saya sebutkan 
sebelumnya), tetapi Anda juga dapat menggunakannya untuk mengurangi sesuatu dari 
pilihan Anda. Dengan kata lain, jika Anda memiliki banyak hal yang dipilih dan Anda 
ingin batal memilih sesuatu, cukup tahan Shift saat Anda mengekliknya - itu tidak 
dipilih lagi. 

 Entitas yang dipilih di SketchUp terlihat berbeda bergantung pada apa itu: 
o Edge yang dipilih menjadi biru. 
o Face yang dipilih berubah dari abu-abu polos menjadi abu-abu biru (jika Anda 

menggunakan style default). 
o Grup dan komponen yang dipilih memiliki kotak biru di sekelilingnya. 
o Anotasi yang dipilih berubah menjadi biru. 

 Tips : Cara yang jauh lebih bagus untuk memilih berbagai hal dalam model Anda adalah 
dengan menggandakan dan mengklik tiga kali. Saat Anda mengklik dua kali sebuah face, 
Anda memilih face itu dan semua edge yang menentukannya. Mengklik dua kali edge 
memberi Anda edge itu ditambah semua permukaan yang terhubung dengannya. Saat 
Anda mengeklik tiga kali edge atau face, Anda memilih seluruh konglomerasi yang 
menjadi bagiannya. Lihat Gambar 7.18. 

 Anda dapat memilih beberapa hal sekaligus dengan menyeret kotak di sekitarnya. 
Anda memiliki dua jenis kotak pemilihan; yang Anda gunakan bergantung pada apa 
yang Anda coba pilih. Lihat Gambar 7.19: 

o Pemilihan Window: Jika Anda mengklik dan menyeret dari kiri ke kanan untuk 
membuat selection box, Anda membuat pilihan window. Dalam kasus ini, 
hanya hal-hal yang seluruhnya ada di dalam selection box Anda yang dipilih. 

o Pemilihan persilangan: Jika Anda mengklik dan menyeret dari kanan ke kiri 
untuk membuat kotak pemilihan, Anda membuat pemilihan persilangan. 
Dengan salah satunya, apa pun yang disentuh selection box Anda (termasuk 
yang ada di dalamnya) dipilih. 

 

Gambar 7.18: Coba edge dan permukaan dengan satu klik, dua kali, dan tiga kali klik pada 
model Anda untuk membuat jenis pilihan yang berbeda. 
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Gambar 7.19: Menyeret dari kiri ke kanan akan memilih semua yang ada di dalam selection 
box Anda. Menyeret dari kanan ke kiri akan memilih semua yang disentuh selection box Anda. 

Ingat, Hanya karena Anda tidak dapat melihat sesuatu, bukan berarti itu tidak dipilih. Setiap 
kali Anda membuat pilihan, adalah ide yang sangat baik untuk mengorbit untuk memastikan 
Anda hanya memiliki apa yang ingin Anda dapatkan. Memilih terlalu banyak secara tidak 
sengaja merupakan kesalahan yang mudah dilakukan. 

Memindahkan dan Menyalin seperti Pro 
 

Untuk memindahkan, meregangkan, atau menyalin geometri di SketchUp, gunakan Move 
Toolkan. Benar, Move Tool tidak hanya untuk bergerak, dan bagian ini menjelaskan semua 
rahasia Move Tool yang akan membantu Anda dengan cepat beralih ke pemodelan 3D yang 
lebih kompleks. 

Memindahkan Sesuatu 

Move Tool adalah salah satu yang terlihat seperti empat panah merah. Menggunakan tool ini 
melibatkan mengklik entitas yang ingin Anda pindahkan, memindahkannya ke tempat yang 
Anda inginkan, dan mengklik lagi untuk menjatuhkannya. Manuvernya tidak rumit, tetapi 
memahaminya membutuhkan sedikit waktu. 
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Berikut tips agar berhasil menggunakan Move tool: 

 Klik, Move, dan klik. Jangan seret mouse Anda. Banyak pengguna SketchUp baru yang 
akan berpindah dengan mengeklik dan menyeret. Itu berhasil, tetapi dalam jangka 
panjang, memindahkan sesuatu lebih sulit seperti itu. Alih-alih, berlatihlah mengeklik 
sekali untuk mengambil sesuatu, gerakkan mouse Anda tanpa menekan tombol apa 
pun, dan mengeklik lagi untuk meletakkan apa pun yang Anda gerakkan. 

 Klik point yang memungkinkan Anda memosisikan apa pun yang Anda coba pindahkan. 
Misalnya, Gambar 7.20 menunjukkan dua kotak. Untuk menumpuk satu di atas kotak 
lainnya dengan tepat, Anda tidak bisa begitu saja mengeklik di mana saja di kotak 
pertama dan memindahkannya ke kotak lainnya. Anda harus mengklik sudut bawah 
kotak yang akan segera menjadi atas dan memindahkan kursor ke sudut atas kotak 
bawah. 

 Tekan tombol Esc untuk membatalkan operasi pemindahan. Saat Anda mulai 
memindahkan sesuatu (dengan sengaja atau tidak sengaja), Anda tergoda untuk 
menggunakan Pindah untuk mengembalikannya seperti semula. Tak pelak, Pindah 
malah mengacaukan model Anda. Sebaliknya, tekan Esc, yang merupakan cara 
tercepat dan termudah untuk keluar dari operasi Pindah dan menjaga model Anda 
tetap utuh. 

 Perhatikan inferences yang berguna. Untuk memindahkan sesuatu ke salah satu arah 
berwarna, tunggu sampai Anda melihat titik-titik inferensi linier On Axis muncul; lalu 
tahan Shift untuk mengunci diri Anda ke arah itu. Untuk informasi lebih lanjut tentang 
menggunakan mesin inferensi SketchUp, lihat bagian sebelumnya”Mengawasi 
inferensi". 

 Bergerak tepat dengan Measurement box. Anda dapat memindahkan benda dengan 
jarak yang tepat dengan Measurement box; lihat”Memasukkan akurasi ke dalam 
model Anda", di awal bab ini. 
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MENCERITAKAN SKETCHUP SIAPA BOS DENGAN AUTO-FOLD 
 

Ini akan terjadi pada Anda cepat atau lambat: Saat Anda mencoba memindahkan simpul, 
sisi, atau face, Anda tidak dapat pergi ke arah yang Anda inginkan. SketchUp tidak ingin 
Anda membuat lipatan (saat face dan edge ekstra dibuat menggantikan satu face) dengan 

Gambar 7.20: Untuk memindahkan barang dengan tepat, pilih titik yang tepat untuk 
mengambil barang dan meletakkannya. 

Membentuk form dengan Move Tool 

Move Tool SketchUp tidak hanya untuk memindahkan seluruh objek. Anda juga dapat 
menggunakan tool ini untuk mengubah bentuk model Anda. Untuk melakukan ini, pindahkan 
sebuah simpul (di mana titik-titik ujung edge bertemu), sebuah edge, sebuah permukaan, atau 
kombinasi dari semua ini. Dengan hanya memindahkan entitas tertentu (semua hal yang baru 
saja saya sebutkan), Anda dapat mengubah bentuk geometri Anda secara drastis, seperti yang 
ditunjukkan pada Gambar 7.21. 

 

Gambar 7.21: Anda dapat menggunakan Move Toolkan pada simpul, edge, dan permukaan 
untuk membuat model bentuk yang berbeda. 

Tips 

Menggunakan Move Tool untuk membuat formulir (bukan hanya memindahkannya) adalah 
cara yang sangat ampuh untuk bekerja tetapi tidak terlalu intuitif. Lagi pula, tidak ada di dunia 
fisik yang berperilaku seperti Move Tool. Anda tidak bisa begitu saja meraih edge lantai kayu 
keras dan menaikkannya untuk mengubahnya menjadi tanjakan di kehidupan nyata. Di 
SketchUp, Anda bisa - dan seharusnya. 
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To Preselect atau Not To Preselect 

Move tool bekerja dengan dua cara berbeda; pada akhirnya Anda perlu menggunakan 
keduanya, bergantung pada apa yang Anda coba pindahkan: 

 Memindahkan pilihan: Saat Anda memilih satu atau beberapa entitas, Move toolkan 
hanya memindahkan pilihan. Perilaku ini berguna saat Anda perlu memindahkan lebih 
dari satu hal sekaligus; Gambar 7.22 menunjukkan cara memindahkan item yang dipilih 
dengan Move tool. 

 Bergerak tanpa pilihan: Jika Anda tidak membuat pilihan, Anda dapat mengklik apa 
saja di window gambar untuk memindahkannya. Hanya hal yang Anda klik yang 
bergerak. 

Move toolkan, jadi SketchUp membatasi gerakan Anda ke arah yang tidak akan menambah 
lipatan. Untuk memaksa pemindahan, tekan dan tahan tombol Alt (Command di Mac) saat 
Anda bergerak. Saat Anda melakukan ini, Anda memberi tahu SketchUp bahwa tidak apa- 
apa untuk melanjutkan - membuat lipatan jika perlu. Ini disebut Lipat Otomatis, dan gambar 
berikut memperlihatkan cara kerjanya. 
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Gambar 7.22: Menggunakan Move tool ketika Anda memiliki pilihan memindahkan hanya hal- 
hal dalam pilihan itu. 

Membuat salinan dengan Move tool 

Banyak orang menghabiskan waktu untuk berburu di SketchUp, mencoba mencari cara 
membuat salinan. Ini sangat sederhana: Anda cukup menekan tombol pengubah - tombol 
pada keyboard Anda yang memberi tahu SketchUp untuk melakukan sesuatu yang berbeda - 
saat Anda menggunakan Move toolkan. Alih-alih memindahkan sesuatu, Anda memindahkan 
salinannya. Berikut beberapa hal yang perlu diperhatikan: 

 Tekan tombol Ctrl (Windows) atau tombol Option (Mac) untuk membuat salinan. 
Anda dapat menekan tombol pengubah sebelum atau setelah Anda mengklik entitas 
yang ingin Anda pindahkan. Saat Move tool dalam mode Salin, tanda + kecil muncul di 
sebelah kursor Pindah, dan salinan Anda bergerak saat Anda menggerakkan mouse. 
Gambar 7.23 menunjukkan ini dalam tindakan. 

Jika Anda memutuskan tidak ingin membuat salinan, cukup tekan tombol Ctrl (Opsi di 
Mac) lagi untuk beralih kembali ke Pindah; tanda + menghilang. 

 Copy itu seperti Move, kecuali Anda sedang memindahkan (Move) salinan. Ini berarti 
bahwa semua aturan yang sama untuk menggunakan Move tool juga berlaku untuk 
membuat salinan. 

 Untuk membuat lebih dari satu salinan sekaligus, gunakan Measurements box. 
Misalnya, Anda ingin membuat lima salinan kolom dengan jarak yang sama, seperti 
yang ditunjukkan pada Gambar 7.24. Pertama, pindahkan salinan ke tempat yang Anda 
inginkan untuk kolom terakhir; lalu ketik 5/dan tekan Enter. Ini membuat lima salinan 
kolom dan memberi spasi secara merata antara kolom pertama dan terakhir dalam 
baris. Rapi, ya? 

 Tips : Untuk mengatur jarak yang tepat antara salinan Anda, pindahkan salinan untuk 
mengatur jarak antara setiap salinan. Kemudian ketik 5x, dan tekan Enter. 
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Gambar 7.23: Tekan Ctrl (Option pada Mac) untuk memberi tahu SketchUp agar membuat 
salinan saat Anda memindahkan sesuatu. 

 

Gambar 7.24: Gunakan Measurements box untuk membuat banyak salinan. 

Berputar ke arah yang benar(Rotate) 
 

Rotate tool berputar geometri berdasarkan sudut yang Anda tentukan. Tidak ada kejutan di 
sana. Namun, Rotate tool juga memiliki trik tersembunyi yang tidak ditemukan oleh sebagian 
besar pemodel baru hingga beberapa jam setelah mereka dapat menggunakannya. Namun, 
hal pertama yang pertama: 

 Lebih baik untuk memilih terlebih dahulu. Seperti halnya Move tool, memutar 
sesuatu yang telah Anda pilih biasanya lebih mudah. 
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 Rotate Toll juga dapat membuat salinan. Tekan tombol Ctrl (Option pada Mac) untuk 
beralih antara memutar dokumen asli atau menyalin. Anda juga dapat membuat 
beberapa salinan yang diatur dalam lingkaran atau sepanjang busur. Lihat bagian 
sebelumnya”Membuat salinan dengan Move tool", untuk membaca tentang 
menggunakanxdan/untuk membuat kelipatan. 

 Anda bisa menepatkannya. Measurements box memungkinkan Anda mengetik sudut 
yang tepat saat Anda berputar. Lihat”Memasukkan akurasi ke dalam model Anda" (di 
awal bab ini) untuk mengetahui lebih lanjut. 

Menggunakan Rotate: Metode dasar 

Ikuti langkah-langkah berikut untuk memutar berbagai hal dalam model Anda: 

1. Pilih semua yang ingin Anda putar. 
2. Aktifkan Rotate tool. 

Pintasan keyboard default untuk Rotate adalah Q. Rotate tool juga muncul di toolbar 
dan menu Tools. 

3. Klik sekali untuk membuat sumbu rotasi. 

Sumbu rotasi Anda adalah garis teoritis di sekitar entitas yang Anda pilih akan berputar; 
bayangkan poros sebuah roda. Meskipun akan menyenangkan jika SketchUp 
menggambar sumbu rotasi dalam model Anda, Anda hanya perlu membayangkannya. 

Tips 

Saat Anda memindahkan kursor busur derajat besar tool Rotate di sekitar layar Anda, 
kursor terkadang berubah orientasi dan warna. Saat Anda mengarahkan kursor ke face, 
kursor menyetel ulang dirinya sendiri untuk membuat sumbu rotasi yang tegak lurus 
dengan face tersebut. Jika kursor berwarna merah, hijau, atau biru, sumbu rotasinya 
sejajar dengan sumbu berwarna tersebut. 

Tips 

Anda dapat (dan harus) menggunakan penguncian inferensi saat Anda menggunakan 
Rotate tool. Arahkan kursor ke face mana pun dalam model Anda yang tegak lurus 
dengan sumbu rotasi yang Anda inginkan, tahan tombol Shift untuk mengunci orientasi 
tersebut, dan klik di tempat yang Anda inginkan. Lihat”Menggunakan inferences untuk 
membantu Anda membuat model” (di awal bab ini) untuk membaca semua 
tentangnya. 

4. Klik lagi untuk mulai memutar. 

Mengklik bagian dari hal yang Anda putar sangat membantu, terutama jika Anda 
memutar secara visual, bukan numerik (dengan mengetikkan sudut). 

5. Gerakkan mouse Anda; lalu klik lagi untuk menyelesaikan putaran. 

Jika Anda suka, sekarang saat yang tepat untuk mengetikkan sudut rotasi dan tekan 
Enter. Seperti semua hal lain di SketchUp, Anda bisa menjadi setepat yang Anda 
inginkan atau butuhkan. 
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Menggunakan Rotate: Metode yang tidak terlalu mendasar 

Metode dasar penggunaan Rotate baik-baik saja jika Anda perlu memutar sesuatu pada 
bidang tanah, tetapi metode ini tidak berguna jika sumbu rotasi Anda tidak vertikal. 
Menemukan face yang akan digunakan untuk mengarahkan kursor Anda bisa jadi rumit atau 
tidak mungkin, dan di situlah banyak pemodel SketchUp terpaku. 

Dengan metode rotasi yang tidak terlalu mendasar ini, Anda dapat menetapkan sumbu rotasi 
yang tepat (garis tak terlihat yang Anda putar) tanpa harus menggunakan permukaan yang 
sudah ada sebelumnya untuk orientasi. Ini membuat hal berputar sekitar satu juta kali lebih 
mudah. 

Dalam kasus ini, menggunakan Rotate berubah dari operasi lima langkah menjadi tujuh 
langkah. untuk penjelasan visual: 

1. Pilih semua yang ingin Anda putar. 
2. Aktifkan Rotate tool (Ala => Putar). 
3. Klik sekali untuk menetapkan sumbu rotasi Anda, tetapi jangan lepaskan - 

pertahankan jari Anda pada tombol mouse. 
4. Seret kursor Anda di sekitar (masih menahan tombol mouse) sampai sumbu rotasi 

Anda berada di tempat yang Anda inginkan. 

Saat Anda menyeret, perhatikan Rotate busur derajat Anda mengubah orientasi; garis 
dari tempat Anda mengklik ke kursor adalah sumbu rotasi. 

5. Lepaskan tombol mouse Anda untuk mengatur sumbu rotasi Anda. 
6. Klik (tetapi jangan seret) titik di mana Anda ingin”mengambil" apa pun yang Anda 

putar. 
7. Klik lagi untuk melepaskan hal yang Anda putar ke tempat yang Anda inginkan. 

 

Gambar 7.25: Tentukan sumbu rotasi kustom dengan menyeret-klik mouse Anda 

Membuat dan menggunakan guide 

Terkadang Anda perlu menggambar garis sementara saat Anda membuat model. Garis 
sementara, atau guide, berguna untuk menyejajarkan benda, membuat ukuran yang tepat, 
dan secara umum menambahkan presisi dan akurasi pada apa yang Anda buat. 

Pada SketchUp versi sebelumnya, guide disebut geometri konstruksi karena pada dasarnya 
seperti itulah mereka: jenis entitas khusus yang Anda buat kapan dan di mana Anda 
membutuhkannya. Mereka bukan bagian dari model Anda karena bukan bagian edge atau 
muka. Artinya, Anda dapat memilih untuk menyembunyikan atau menghapusnya - seperti 
anotasi lain, anotasi tersebut tidak memengaruhi geometri Anda yang lain. 
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Gambar 7.26 menunjukkan contoh guide dalam tindakan. Guide diposisikan 12 inci dari 
dinding dan 36 inci terpisah untuk menggambar sisi pintu. Guide lain (6 kaki, 8 inci dari lantai) 
menunjukkan bagian atas. Dengan guide ini di tempat, Anda dapat dengan mudah 
menggambar persegi panjang, dibatasi oleh guide Anda, yang Anda tahu ukurannya tepat dan 
di lokasi yang benar. 

 

Gambar 7.26: Gunakan guide untuk mengukur sesuatu sebelum Anda menggambar. 

Membuat guide dengan Tape Measure Tool 
 

Anda dapat membuat tiga jenis guide, dan Anda menggunakan tool Tape Measure untuk 
membuat semuanya, seperti yang ditunjukkan pada Gambar 7.27. 

 Parallel guide lines: Untuk membuat guide yang sejajar dengan edge, pilih Tape 
measure tool, dan klik di mana saja (kecuali titik akhir atau titik tengah) di sepanjang 
tepi. Kemudian gerakkan mouse Anda, dan guide garis putus-putus paralel muncul. Klik 
lagi untuk menempatkan guide di mana pun Anda inginkan. 

 Linear guide lines: Untuk membuat guide di sepanjang edge dalam model Anda, klik di 
mana saja di sepanjang edge kecuali di salah satu titik akhir. Kemudian klik lagi di 
tempat lain di sepanjang tepi. 

 Guide points: Anda mungkin ingin menempatkan sebuah titik di suatu tempat di luar 
angkasa; Anda dapat melakukannya dengan poin guide. Dengan tool Pengukur Pita, 
klik titik akhir tepi, lalu klik lagi di tempat lain. Tandaxkecil muncul di akhir garis putus- 
putus - itu adalah titik guide baru Anda. 
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Gambar 7.27: Gunakan Tape Measure tool untuk membuat garis guide dan titik. 

Ingat, Ini poin penting tentang tool Pengukur Pita: tool ini memiliki dua mode, dan membuat 
guide hanya di salah satunya. Menekan tombol Ctrl (Option pada Mac) untuk beralih antar 
mode. Saat Anda melihat + di sebelah kursor, Pita Pengukur Anda dapat membuat guide; bila 
tidak ada +, tidak bisa. 

Menggunakan guide untuk membuat hidup Anda lebih mudah 

Tips 

Saat Anda mengerjakan perangkat lunak ini, Anda akan selalu menggunakan guide; mereka 
adalah bagian tak terpisahkan dari cara kerja pemodelan di SketchUp. Inilah yang perlu Anda 
ketahui tentang menggunakannya: 

 Posisi guide secara tepat menggunakan Measurement box. Lihat bagian”Injecting 
accuracy into your model," di awal bab ini, untuk mengetahui caranya. 

 Hapus Guide satu per satu. Cukup klik atau seret di atasnya dengan 

 Erase tool untuk menghapus guide satu per satu. Anda juga dapat mengcontext-clicks 
dan memilih Hapus dari menu konteks. Hapus semua guide Anda sekaligus. Memilih 
Edit => Hapus Guide melakukan hal itu. 

 Sembunyikan guide satu per satu atau sekaligus. Konteks-klik satu guide dan pilih 
Sembunyikan untuk menyembunyikannya, atau batal pilih Lihat ⇒ Guide untuk 
menyembunyikan semuanya. Sebaiknya sembunyikan guide Anda daripada 
menghapusnya, terutama saat Anda masih menjadi model. 

 Pilih, Move, Copy, dan Rotate guide seperti entitas lain dalam model Anda. Guide 
bukanlah sesuatu yang rumit, tetapi Anda dapat memperlakukannya seperti itu di 
banyak waktu. 

Lukis face Anda dengan warna dan tekstur 

Saat menambahkan warna dan tekstur - secara kolektif disebut di SketchUp sebagai bahan - 
ke model Anda, lihatlah Material Panel dan pie toolnt Bucket. Bagian ini menawarkan 
pengenalan yang lebih mendalam tentang opsi Anda. 

Material Panel 

Material Panel terlihat berbeda di versi Windows dan Mac SketchUp, tetapi pada dasarnya 
mereka melakukan hal yang sama. Secara default, Material Panel muncul di Default Tray 
(hanya untuk Windows). Jika panel pernah tersembunyi dan Anda perlu membukanya kembali, 
pilih Window => Default Tray => Materials (Windows) atau Window => Materials (Mac). Di 
SketchUp, Anda dapat memilih dari dua jenis bahan untuk diterapkan ke face dalam model 
Anda: 
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 Warna: Ini sederhana - warna selalu warna solid. Anda tidak boleh memiliki gradien (di 
mana satu warna memudar menjadi warna lain), tetapi Anda dapat membuat warna 
apa pun yang Anda inginkan. 

 Tekstur: Tekstur SketchUp adalah gambar kecil yang dilapisi untuk menutupi face. Jika 
Anda mengecat face dengan, katakanlah, tekstur batu bata, yang sebenarnya Anda 
lakukan adalah memberi tahu SketchUp untuk menutupi permukaan dengan berapa 
pun jumlah ubin”foto bata" yang diperlukan untuk melakukan pekerjaan itu. Gambar 
pratinjau yang Anda lihat di Material Panel sebenarnya adalah gambar ubin gambar 
tekstur tunggal. 

SketchUp hadir dengan banyak tekstur, dan Anda selalu dapat online dan memilih dari 
ribuan lainnya yang tersedia untuk dijual. Dan jika itu masih belum cukup, Anda dapat 
membuatnya sendiri (meskipun prosesnya jauh di luar cakupan buku tebal sederhana 
ini). Untuk detail tentang teknik lanjutan seperti membuat tekstur kustom, lihat Pusat 
Bantuan SketchUp (http://help.sketchup.com). 

 

Fakta-fakta berikut tentang materi SketchUp juga berguna untuk diketahui saat Anda 
mengerjakannya: 

 Bahan bisa tembus cahaya. Menggeser penggeser Opasitas membuat materi yang 
Anda pilih lebih atau kurang tembus pandang, yang membuat melihat melalui window 
dalam model Anda jauh lebih mudah. Di Windows, Anda menemukan penggeser 
Opacity di tab Edit. 

 Tekstur dapat memiliki area transparan. Jika Anda melihat materi di perpustakaan 
Anggar, Anda akan melihat bahwa banyak di antaranya terlihat aneh; mereka memiliki 
area hitam yang tampaknya tidak benar. Area hitam ini adalah area transparansi: Saat 
Anda mengecat face dengan salah satu tekstur ini, Anda dapat melihat melalui area 
yang terlihat hitam. 

Paint Bucket Tool 
 

Mengaktifkan Paint Bucket Tool secara otomatis membuka Material Panel jadi itu berguna. 
Berikut semua yang perlu Anda ketahui tentang tool Bucket Cat: 

 Anda mengisinya dengan mengklik di Material Panel. Cukup klik bahan untuk memuat 
ember Anda dan kemudian klik face yang ingin Anda cat. 

 Menahan tombol Alt (⌘ di Mac) akan beralih ke tool Sampel. Dengan tool Sampel, 
Anda dapat mengeklik sembarang face dalam model Anda untuk memuat Paint Bucket 
Anda dengan bahan permukaan tersebut. Lepaskan tombol Alt untuk kembali ke pie 
toolnt Bucket. 

 Menahan tombol Shift akan melukis semua permukaan yang mirip. Tidak suka bata 
gelap pada model rumah Anda? Pilih material baru di Material Panel, tahan tombol 
Shift, dan klik sembarang face dengan batu bata diterapkan. Pada Gambar 7.28, Paint 
Bucket Tool siap untuk mengubah bata gelap menjadi opsi yang lebih terang, yang 
Anda lihat sebagai bahan aktif di kiri atas Material Panel. Setelah selesai, semua 
permukaan dalam model Anda yang cocok dengan yang Anda klik akan dicat dengan 
bahan baru. Jika ada yang tidak seperti yang Anda inginkan, cukup pilih Edit => Undo 
untuk mundur satu langkah. 

http://help.sketchup.com/
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Gambar 7.28: Tekan Shift dan klik dengan Paint Bucket untuk mengganti satu bahan dengan 
bahan lainnya. 

Lingkungan Buatan 

Sebagai pemodel, Anda akan menggunakan SketchUp untuk menggambarkan lingkungan 
binaan. Ungkapan lingkungan binaan mengacu pada lingkungan yang menyediakan 
pengaturan bagi aktivitas manusia, mulai dari ruang publik yang luas hingga taman kecil yang 
intim. 

Pemodelan Proses SketchUp membagi lingkungan binaan menjadi dua kategori: 

 Permukaan yang menentukan area 

 Benda yang duduk di permukaan 

Istilah-istilah ini secara langsung berhubungan dengan deskripsi yang diberikan untuk 
geometri (tepi dan muka) yang diuraikan di Bagian 1. 
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BAGIAN 2 

PERMODELAN DI SKETCHUP 

BAB 8 

MEMBANGUN BANGUNAN 

 
Meskipun SketchUp memungkinkan Anda membuat (hampir) apa pun yang dapat Anda 
pikirkan, bentuk tertentu lebih mudah dibuat daripada yang lain. Untungnya, bentuk 
semacam ini adalah yang paling ingin dibuat oleh sebagian besar orang dengan SketchUp. Itu 
bukan kebetulan; SketchUp dirancang dengan mempertimbangkan arsitektur, sehingga 
seluruh paradigma - model yang dibuat dari muka dan tepi, dan jenis tool yang ditawarkan 
SketchUp - sempurna untuk membuat hal-hal seperti bangunan. 

Tapi bagaimana dengan bangunan melengkung dan swoopy? Anda juga dapat menggunakan 
SketchUp untuk membuatnya, tetapi itu sedikit lebih sulit, jadi menurut kami itu bukan tempat 
yang baik untuk memulai. Karena kebanyakan orang tinggal di tempat-tempat kotak dengan 
ruangan bersudut kanan dan langit-langit datar, arsitektur semacam itu relatif mudah 
dipahami. 

Dalam bab ini, Anda akan menemukan beberapa dasar pemodelan SketchUp dalam hal 
pembuatan bangunan bujursangkar yang sederhana. Dengan menulis tentang bagaimana 
membangun hal-hal tertentu, daripada hanya menjelaskan apa yang dilakukan masing-masing 
tool, kami berharap dapat mempermudah Anda untuk memulai. Meskipun Anda tidak 
berencana menggunakan SketchUp untuk memodelkan hal-hal yang kami gambarkan, Anda 
tetap dapat menerapkan konsep ini pada kreasi Anda. 

Surface/Permukaan 

Permukaan menentukan bidang fisik dan tepi yang menyusun dunia binaan — jalan, trotoar, 
sungai, jalan setapak, medan, halaman rumput, trotoar, taman, ruang terbuka, jalan masuk, 
area parkir, danau, dll. Permukaan terdiri dari material seperti aspal dan beton, rumput dan 
bunga, tanah dan kerikil, serta air dan pasir. 

Proses Pemodelan SketchUp menggabungkan permukaan yang membentuk dasar model 
sebagai Flatwork Base. Langkah pertama dari proses pemodelan adalah membangun Flatwork 
Base. 

 

Gambar 8.1 Beberapa permukaan khas yang membentuk Flatwork Base 
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Objek 

Permukaan diisi dengan objek yang mensimulasikan lingkungan binaan. Objek adalah item 
yang ditempatkan di Flatwork Base — bangunan dan bangunan, pagar, monumen, pohon, 
mobil, lampu jalan, perabotan luar ruangan, lampu lalu lintas, semak, perkebunan, landai, dll. 

Langkah kedua dalam Proses Pemodelan SketchUp adalah menempatkan objek. Setelah 
semua benda ditempatkan di permukaan, model selesai. 

 
 

Gambar 8.2 Bangunan, pohon, dan lampu merupakan objek yang khas. 
 

 

Gambar 8.3 Permukaan dan objek membentuk lingkungan binaan. 

Menggambar Lantai dan Dinding 

Sebagian besar lantai dan dinding merupakan permukaan datar, jadi mudah untuk membuat 
model dengan edge lurus dan permukaan datar di SketchUp. Faktanya, kemungkinan besar 
hal pertama yang Anda modelkan di SketchUp sangat mirip dengan lantai dan dinding 
bangunan. 

Cara Anda mendekati pemodelan lantai dan dinding bergantung sepenuhnya pada jenis model 
yang Anda buat: 

 Eksterior: Model eksterior sebuah bangunan pada dasarnya hanyalah sebuah 
cangkang kosong; Anda tidak memiliki dinding interior, ruangan, atau furnitur yang 
perlu dikhawatirkan. Jenis model ini adalah proposisi yang sedikit lebih sederhana 
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untuk orang-orang yang baru mengenal SketchUp. 

 Interior: Model interior sebuah bangunan jauh lebih rumit daripada model interior saja; 
berurusan dengan ketebalan dinding interior, ketinggian lantai, langit-langit, dan 
perabotan melibatkan lebih banyak kecakapan pemodelan. 

Ingatlah, Inilah masalahnya: Karena semua yang ada di SketchUp terbuat dari permukaan yang 
sangat datar (tidak memiliki ketebalan), satu-satunya cara untuk membuat model dinding 

yang, katakanlah, tebal 8 inci adalah dengan menggunakan dua permukaan berdampingan 
dan terpisah 8 inci. Untuk model di mana Anda perlu menunjukkan ketebalan dinding - yaitu, 
model interior - Anda harus menggunakan pendekatan dua muka ini. Model eksterior lebih 
mudah dibuat karena Anda dapat menggunakan satu muka untuk merepresentasikan dinding, 
seperti yang ditunjukkan pada Gambar 8.4. 

 

Gambar 8.4: Gunakan permukaan tunggal untuk model eksterior dan muka ganda untuk 
model interior. 

Tips 

Membuat model yang menampilkan interior dan eksterior sebuah bangunan pada saat yang 
sama, sejujurnya, terlalu sulit. Jika Anda membutuhkan tampilan interior dan eksterior, 
buatlah dua model terpisah: satu interior dan satu eksterior. Dengan dua model terpisah, Anda 
dapat membuat model kombinasi dalam waktu seperempat dari waktu yang Anda gunakan 
untuk membuat dua model pertama - kami menjaminnya. 

Memulai dalam 2D 

Anda dapat membuat model interior bangunan dengan banyak cara. Di bagian ini, Aidan 
membagikan metode yang dia kembangkan selama bertahun-tahun dalam membuat model 
SketchUp. Pada dasarnya, Anda menggambar denah lantai dua dimensi yang mencakup 
semua dinding interior dan eksterior Anda, lalu menariknya ke ketinggian yang tepat 
(diekstrusi). Hanya setelah model Anda diekstrusi, Anda baru mengkhawatirkan pintu, window, 
dan tangga. 

Beralih ke tampilan 2D 

Sebelum Anda menggambar denah 2D, Anda perlu mengarahkan sudut pandang Anda. 
Menggambar dalam 2D paling mudah saat Anda melihat pekerjaan Anda langsung dari atas, 
melihat ke bawah pada bidang tanah. Anda juga ingin memastikan bahwa Anda tidak melihat 
sesuatu dalam perspektif, yang mengubah pandangan Anda tentang apa yang Anda miliki. 

Ikuti langkah-langkah sederhana ini untuk menyiapkan area pemodelan SketchUp Anda untuk 
gambar 2D: 



107 
 

1. Buat file SketchUp baru dengan memilih File => New. 

Bergantung pada template yang telah Anda setel untuk dibuka saat Anda membuat file 
SketchUp baru, Anda mungkin sudah berada dalam tampilan 2D. Jika semua yang Anda 
lihat adalah sumbu merah dan hijau dengan Background putih, Anda dapat melewati 
Langkah 2. Ingatlah bahwa Anda selalu dapat mengganti template dengan memilih 
Help => Welcome to SketchUp dan klik bagian Template dari kotak dialog yang muncul. 

2. Pilih Camera => Standard => Top. 

Ini mengubah sudut pandang Anda sehingga Anda melihat langsung ke tanah. 

3. Pilih Camera => Parallel Projection. 

Beralih dari Perspektif ke Proyeksi Paralel memudahkan untuk menggambar rencana 
dalam 2D. Pada titik ini, window pemodelan Anda terlihat seperti yang ditunjukkan 
pada Gambar 8.5. 

 

Gambar 8.5: Window pemodelan Anda akan terlihat seperti ini sebelum Anda mulai 
menggambar dalam 2D 

Tips 

Jangan ragu untuk menghapus komponen person (Chris pada 2017, Lisanne pada 2016, atau 
dalam versi SketchUp Anda, komponen person apa pun yang muncul di setiap file baru). Pada 
tampilan Atas, komponen orang adalah garis diagonal kecil itu. Untuk menghapus komponen, 
cukup context-clicksnya dan pilih Hapus. 

Membersihkan tool draf SketchUp 

Anda tidak memerlukan banyak tool untuk membuat draf rencana 2D di SketchUp. Gambar 4- 
3 menunjukkan toolbar dasar; semua yang Anda butuhkan ada di sana: 

 Line tool: Anda menggunakan Line tool (yang terlihat seperti pensil) untuk 
menggambar tepi, yang merupakan salah satu dari dua blok bangunan dasar model 
SketchUp. Pada dasarnya, Anda mengklik untuk mulai menggambar edge dan mengklik 
lagi untuk menyelesaikannya. 

 Eraser tool: Gunakan Penghapus untuk menghapus tepi, seperti yang ditunjukkan 
pada Gambar 8.6. Meskipun Anda tidak dapat menggunakan Penghapus untuk 
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menghapus face, menghapus edge yang mendefinisikan face secara otomatis juga 
akan menghapus face itu. Menggunakan Eraser tool di tepi. Anda dapat menggunakan 
Penghapus dengan dua cara: 

 Mengklik: Klik edge untuk menghapusnya satu per satu. 

 Menyeret: Klik dan seret edge untuk menghapusnya; ini lebih cepat jika Anda ingin 
menghapus banyak tepi. 

 Circle tool: Pada Toolbar Srart, circle tool bersembunyi di menu dropdown tool 
Rectangle. Menggambar lingkaran di SketchUp cukup mudah: Klik sekali untuk 
menentukan pusat dan sekali lagi untuk menentukan titik pada lingkaran (yang juga 
menentukan radius). Untuk memasukkan radius yang tepat, cukup gambar lingkaran, 
ketik radius, dan tekan Enter, seperti yang ditunjukkan pada Gambar 8.7. Untuk 
informasi lebih lanjut tentang mengetik sambil menggambar. 

 Arc tool: Pada versi 2017, SketchUp memiliki empat tool untuk membuat busur (dulu 
hanya memiliki satu). Lihat Gambar 8.8. Ini dia, secara berurutan: 

 Arc: 
 

Klik sekali untuk menentukan titik tengah, klik lagi untuk menentukan titik akhir 
pertama, dan klik untuk ketiga kalinya untuk menyelesaikan busur. Hasilnya adalah 
busur yang terbuat dari ruas-ruas pelurus. 

 2 Point Arc: 
 

Untuk menggunakan tool ini, Anda membuat garis dan menarik tonjolan yang 
membuat busur. Klik sekali untuk menentukan satu ujung, sekali lagi untuk 
menentukan ujung lainnya, dan ketiga kalinya untuk menentukan tonjolan. Jika Anda 
mau, ketikkan radius setelah Anda menggambar busur dengan memasukkan radius, 
unit, dan huruf r. Jika Anda menginginkan busur dengan radius 4 kaki, gambarlah 
sebesar apa pun besarnya, ketik 4'r, dan tekan Enter. 

 3 Point Arc: 
 

Alat ini membuat busur di sekitar titik pivot. Klik untuk mengatur titik awal, klik lagi 
untuk mengatur titik pivot, dan klik untuk ketiga kalinya untuk mengatur titik akhir 
busur. 

 Pie: 
 

Pie tool persis sama dengan tool Arc, tetapi dengan sentuhan yang berguna. Ini 
menghasilkan face berbentuk pai dan ketiga edge perimeternya. 
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 Offset tool: Offset tool membantu Anda menggambar edge dengan jarak konstan 
terpisah dari edge yang sudah ada dalam model Anda. Gambar biasanya lebih baik 
daripada kata-kata, jadi lihat Gambar 8.9. Menggunakan Offset pada bentuk akan 

membuat bentuk lain yang persis 6 inci lebih besar di sekelilingnya (gambar tengah), 
atau lebih kecil 6 inci di sekelilingnya (gambar kanan). edge offset adalah cara yang 
berguna untuk membuat hal-hal seperti ambang pintu dan trim window. 

o Anda dapat menggunakan Offset dengan dua cara; untuk kedua cara Anda 
mengklik sekali untuk memulai pengimbangan dan sekali lagi untuk berhenti: 

o Klik face untuk mengimbangi semua tepinya. Jika tidak ada yang dipilih, 
mengklik face dengan Offset tool memungkinkan Anda mengimbangi semua 
edge face itu dengan jumlah yang konstan, seperti yang ditunjukkan pada 
Gambar 8.9. 

o Preselect satu atau lebih coplanar (pada bidang yang sama) dan kemudian 
gunakan Offset. Jika Anda telah memilih tepi, Anda dapat menggunakan Offset 
hanya pada edge tersebut; ini berguna untuk menggambar hal-hal seperti 
kusen pintu dan balkon, seperti yang ditunjukkan pada Gambar 8.10. 

 Alat Pengukur Pita Pengukur melakukan banyak hal. Untuk mengukur jarak, klik dua 
titik mana pun dalam model Anda. Pembacaan jarak ada di Measurements box, di 
sudut kanan bawah window pemodelan Anda. 

 

Gambar 8.6 Semua tool yang Anda perlukan untuk membuat draf dalam 2D di SketchUp ada 
di toolbar dasar. 

 
 

Gambar 8.6: Gunakan Eraser tool untuk menghapus tepi. Menghapus edge yang 
mendefinisikan face juga menghapus face itu 
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Gambar 8.7: Menggambar lingkaran dengan mudah dengan circle tool. 
 

Gambar 8.8: Menggunakan tool Arc adalah operasi tiga langkah 
 

Gambar 8.9: Offset memungkinkan Anda membuat edge berdasarkan edge lainnya 
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Gambar 8.10: Menggunakan Offset pada satu set edge yang telah dipilih sebelumnya berguna 
untuk menggambar hal-hal seperti kusen pintu. 

Muncul dengan rencana sederhana 

Jika yang Anda coba lakukan hanyalah membuat model tampilan eksterior sebuah bangunan, 
ukur saja sekeliling bangunan sebenarnya, gambar garis luar bangunan tersebut di SketchUp, 
tarik ke atas dengan tool Push/pull, dan hapus permukaan atasnya jika Anda suka, seperti yang 
ditunjukkan pada Gambar 8.11. Kemudian Anda dapat menambahkan atap yang Anda 
inginkan, seperti yang dijelaskan dalam”Menaikkan Atap” di bagian selanjutnya pada bab ini. 
Dengan metode ini, dinding Anda hanya setebal satu sisi (artinya setipis kertas), tapi tidak apa- 
apa. Anda hanya tertarik di luar. 

 

Gambar 8.11: Untuk membuat model eksterior, ukur saja bagian luar bangunan Anda untuk 
menggambar garis luar di SketchUp. 

Mengukur bangunan yang ada sehingga Anda dapat memodelkan tampilan interior lebih 
mudah diucapkan daripada dilakukan. Bahkan arsitek dan pembangun berpengalaman pun 
sering bingung saat mencoba membuat model interior as-builts, yaitu gambar bangunan yang 
sudah ada. Lemari, ruang ventilasi, dinding interior, dan segala macam penghalang lainnya 
pasti akan menghalangi pengukuran yang baik. Biasanya, Anda memberikan pengukuran yang 
terbaik dan kemudian menyesuaikannya sedikit untuk memperbaikinya. Bagian berikut 
memandu Anda melalui proses tersebut. 

Menggambar garis interior 

Saat Anda membuat model interior bangunan, tujuan utama Anda adalah menciptakan ruang 
interior yang akurat. Untuk mencapai akurasi itu, kerjakan dari dalam ke luar. Jika pita 
pengukur Anda cukup panjang, ukur dulu dimensi utamanya. Artinya, ukur total lebar interior 
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dan panjang bagian dalam bangunan. Anda mungkin tidak bisa, tapi lakukan yang terbaik. 
Setelah itu, lanjutkan saja dengan menggunakan aritmatika dan logika dasar untuk 
mengetahui ukuran ruang. 

Tips 

Sebelum Anda mulai menggambar garis interior di SketchUp, buatlah gambar kertas. Gambar 
tersebut membantu Anda mengetahui apa yang Anda butuhkan untuk menggambar sehingga 
Anda dapat memfokuskan semua konsentrasi Anda untuk menggambar di komputer. Gambar 
8.40 menunjukkan sketsa kertas yang digunakan Aidan saat memodelkan rumahnya. 

 
 

Gambar 8.12: Sketsa kertas Aidan. 

Dari gambar kertas ini, berikut adalah cara Anda menggambar garis interior dasar rumah ini: 

1. Beralih ke tampilan overhead 2D. 

Bagian”Beralih ke tampilan 2D," di awal bab ini menjelaskan caranya. 

2. Dengan menggunakan Line tool, buatlah garis yang merepresentasikan panjang tepat 
dari sebuah dinding di dalam rumah. 

Misalnya, Aidan mulai menggambar dinding timur rumahnya dengan membuat garis 
sepanjang 17 kaki. (Lihat gambar kiri atas pada Gambar 8.13.) 
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Untuk menggambar garis yang tepat, klik sekali untuk memulai garis, klik lagi untuk 
mengakhiri garis, ketik 17’, dan tekan Enter. Ingat Anda tidak perlu mengklik di mana 
pun sebelum mengetik nilai yang tepat; Measurements box mendengarkan penekanan 
tombol Anda segera setelah Anda menggambar sesuatu. Setelah Anda menekan Enter, 
ukuran garis secara otomatis berubah menjadi tepat sepanjang 17 kaki. Jika mau, Anda 
dapat menggunakan Pita Pengukur untuk memeriksa ulang ukurannya. 

3. Hubungkan edge berikutnya ke edge pertama Anda. 

Seperti yang ditunjukkan pada gambar kiri bawah pada Gambar 8.13, Aidan bekerja 
searah jarum jam, menggambar edge 11 kaki, panjang 10 inci, dimulai dari ujung edge 
pertama dan menuju ke kanan dengan arah merah. 

4. Teruslah berjalan di sekitar rumah, sampai Anda kembali ke tempat Anda memulai. 
Jika Anda membuat kesalahan, gunakan Penghapus untuk menghilangkan tepi. Cara 
lainnya, batalkan dengan menekan Ctrl + Z (⌘ + Z di Mac) atau memilih Edit ⇒ Undo 
untuk mundur satu atau dua langkah. 

5. Jika semua pengukuran Anda tidak bertambah, sesuaikan hal-hal agar sesuai - 
beberapa inci ekstra di sana-sini tidak akan pernah membunuh siapa pun. 

Setelah Anda menyelesaikan garis luar (membentuk lingkaran tertutup dari edge yang 
semuanya berada pada bidang yang sama), sebuah face secara otomatis muncul. 
Sekarang Anda memiliki total 11 sisi dan 1 sisi. 

 

GAMBAR 8.13: Mulailah dengan menggambar edge sepanjang 17 kaki; kemudian gambarlah 
edge tegak lurus sepanjang 11 kaki, 10 inci. 
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Gambar 8.14: Garis keliling interior rumah Aidan yang telah selesai. 

Ingatlah, Jika Anda tersesat, dan tidak ada jumlah zoom dan geser yang membuat Anda 
kembali ke tampilan denah lantai Anda, pilih Kamera ⇒ Zoom Extents atau klik tool Zoom 
Extents. Bayangkan Zoom Extents sebagai tuas darurat yang dapat Anda tarik untuk mengisi 
window pemodelan dengan geometri Anda. 

Mengimbangi dan mengelompokkan dinding eksterior 

Dengan Offset tool, Anda dapat mengimbangi ketebalan dinding eksterior, yang memudahkan 
untuk memvisualisasikan ruang Anda. Berikut cara melakukannya: 

1. Menggunakan Offset tool, offset bentuk tertutup Anda dengan 8 inci ke luar. 
 

Offset 8 inci adalah ketebalan standar yang cukup untuk dinding eksterior, terutama 
untuk rumah di leher hutan Aidan. Lihat”Membersihkan tool draf SketchUp" di awal 
bab ini untuk detail tentang menggunakan Offset tool. Setelah Anda membuat offset, 
ketik 8”dan tekan Enter. 

2. Gunakan Line tool untuk menutup ceruk apa pun, membuat kantong dinding yang 
lebih tebal dari yang lain. 

3. Dengan Eraser tool, hapus edge ekstra. Lihat Gambar 8.13, kiri tengah. 

Dengan menghapus edge ekstra, Anda hanya memiliki dua permukaan: satu yang 
mewakili lantai dan satu lagi untuk dinding. 

4. Dengan Line tool, gambar edge yang menentukan ketebalan dinding eksterior Anda. 

Untuk contoh ini, Aidan memisahkan tonjolan (yang sebenarnya mewakili perapian 
dan lemari mekanis) dari bagian dinding yang mencapai atap, dua lantai. 

Setelah selesai, Anda akan mendapatkan beberapa permukaan: satu untuk lantai, satu 
untuk dinding luar (yang ketebalannya kurang lebih harus seragam), dan beberapa 
untuk tonjolan. 
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5. Pilih permukaan yang menentukan dinding eksterior. 

Cara termudah untuk melakukannya adalah dengan mengklik face dengan tool Pilih. 

6. Buatlah face yang baru saja Anda pilih menjadi sebuah grup. Untuk mengubah face 
yang Anda pilih di Langkah 5 menjadi sebuah grup, pilih Edit => Buat Grup. Anda 
melihat garis keliling biru di sekitar face Anda; itu grup yang baru saja Anda buat. 
Selamat - Anda sekarang resmi menjadi pengguna SketchUp 

Tips 

Pada tahap membuat denah lantai interior, Aidan mengabaikan hal-hal seperti pintu, window, 
dan tangga. Di mana dinding berisi pintu, dia menggambar dinding yang kokoh. Setelah Anda 
mengekstraksi denah lantai menjadi gambar 3D, menambahkan pintu, window, dan tangga 
jauh lebih mudah. 

Bekerja dari gambar 2D Anda, inilah cara Anda membuat dinding interior: 

1. Dengan tool Pita Pengukur, buat panduan untuk menandai lokasi tepat dinding 
interior. 

 

Misalnya, pemandu untuk dinding di kanan bawah sketsa adalah pemandu sejajar 5 
kaki, 3½ inci dari bagian dalam jalan masuk. 

Untuk membuat panduan paralel, klik edge tempat Anda ingin menggambar panduan, 
gerakkan kursor Anda (untuk memberi tahu SketchUp ke mana harus pergi), ketik jarak 
Anda dan tekan Enter. 

2. Dengan Line tool, gambar edge untuk merepresentasikan dinding interior. 

Dengan panduan, mudah untuk menggambar edge Anda dengan benar. 

Ingat, Jangan lupa untuk memperbesar! Jika Anda memiliki banyak tepian dan 
panduan dan Anda tidak dapat melihat apa yang Anda lakukan, perbesar saja. Banyak 
orang lupa mengubah sudut pandang mereka saat bekerja, dan 
pembesaran/pengecilan membuat semua perbedaan. 

3. Dengan Eraser tool, klik panduan Anda untuk menghapusnya. 
4. Gunakan Penghapus untuk menghapus segmen edge ekstra. 

Tujuannya adalah untuk memiliki sesedikit mungkin permukaan 2D untuk diekstraksi menjadi 
dinding 3D, beberapa saat kemudian. 

Tips 

Karena permukaan dinding luar - dan edge yang menentukannya - adalah bagian dari grup 
terpisah, secara tidak sengaja mencungkilnya dengan Penghapus akan menghapus semuanya. 
Jika ini terjadi, cukup pilih Edit ⇒ undo untuk mundur satu langkah, perbesar sedikit, dan coba 
lagi. 
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Gambar 8.15: Buatlah panduan untuk membantu Anda menemukan dinding interior pertama 
Anda, dan kemudian menggambar lebih banyak lagi. 

 
 

Gambar 8.16: Gunakan Line tool untuk membuat edge tempat pemandu berkumpul. 
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Gambar 8.16: Dengan menggunakan Penghapus, hapus panduan Anda dan segmen edge kecil 
yang tersisa dari gambar dinding interior. 

Beralih dari 2D ke 3D 

Dengan rencana 2D di tangan, Anda siap untuk mengekstruksinya menjadi model 3D. Proses 
ini sangat menyenangkan dan melibatkan tool yang membuat SketchUp terkenal: Push/pull. 
Pada bagian berikut, Anda mengambil denah lantai sederhana (yang Anda gambar di awal bab 
ini) dan mengubahnya menjadi dinding 3D. 

Mendapatkan tampilan yang bagus 

Sebelum Anda memunculkan rencana Anda ke dimensi ketiga, ubah sudut pandang Anda 
untuk mendapatkan gambaran yang lebih baik tentang apa yang Anda lakukan. Lihat Gambar 
8.17 dan ikuti langkah-langkah berikut: 

1. Pilih Camera => Perspective. 

Ini mengaktifkan mesin perspektif SketchUp, artinya sekarang Anda dapat melihat sesuatu 
dengan lebih realistis - cara orang benar-benar melihat sesuatu dalam 3D. 

2. Pilih Camera => Standard => Iso. 
 

Ini mengalihkan Anda dari tampilan atas ke tampilan isometrik (tiga perempat). Anda juga 
dapat melakukan ini dengan tool Orbit. SketchUp biasanya memberi Anda lebih dari satu cara 
untuk melakukan sesuatu. 

3. Pilih Camera => Zoom Extents. 
 

Zoom Extents memiliki tombolnya sendiri pada Toolbar Srart, tetapi kami tetap menggunakan 
tema menu Kamera, hanya untuk konsistensi. 

4. Pilih Camera => Field of View, ketik 45, dan tekan Enter. 

Anda telah mengubah bidang pandang dari 35 menjadi 45 derajat. Secara default, bidang 
pandang SketchUp disetel ke 35 derajat 
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Gambar 8.17: Sebelum Anda mulai bekerja dalam 3D, alihkan ke tampilan 3D. 

Mendorong/menarik jalan menuju kebahagiaan 

Push/pull tooladalah makhluk sederhana: tool ini mengekstrusi flat face menjadi bentuk 3D. 
Untuk menggunakan Push/pull, klik satu face sekali untuk mulai mendorong/menariknya, 
gerakkan kursor Anda sampai Anda menyukai apa yang Anda lihat, lalu klik lagi untuk berhenti 
mendorong/menarik. Itu dia. Tidak ada perangkat lunak yang begitu mudah digunakan dan 
dipahami dengan memuaskan. Untuk detail lebih lanjut tentang Push/Pull, lihat sidebar 
terdekat,”Lebih menyenangkan dengan Push/Pull." 

Tips 

Push/pull hanya berfungsi pada permukaan datar. Untuk mengedit face lengkung, Anda harus 
menggunakan sesuatu yang lain- mungkin fitur Intersect Faces. 

Langkah-langkah berikut menjelaskan cara menggunakan Push/Pull untuk mengekstrusi 
denah interior menjadi model 3D, seperti yang ditunjukkan pada Gambar 8.18: 

1. Pilih push/pull tooldari toolbar. 
 

Alat tersebut tampak seperti kotak kecil dengan panah merah di bagian atas. 

2. Klik permukaan dinding interior untuk mulai mengekstrusi itu. 

Jika Anda mengeklik face”lantai", Anda justru akan mengeluarkannya. Jika Anda tidak 
sengaja memilih face yang salah, tekan Esc untuk membatalkan operasi dan coba lagi. 

3. Pindahkan kursor Anda untuk menarik dinding; klik untuk menghentikan ekstrusi. 

Seberapa banyak Anda mengekstraksi face tidak menjadi masalah, karena Anda 
menambahkan presisi pada langkah berikutnya. 

4. Ketik tinggi langit-langit (seperti 8’) dan tekan Enter. 

Saat Anda melakukan ini, jarak push/pull direvisi untuk mencerminkan ketinggian 
plafon Anda. Di rumah ini, tingginya 8 kaki. 

5. Ulangi Langkah 2 hingga 4 untuk semua dinding interior. 
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Mengorbit membantu Anda melihat apa yang Anda lakukan saat mengerjakan model. 

6. Push/pull dinding luar agar sesuai dengan ketinggian dinding interior ini. 

Karena permukaan dinding luar adalah bagian dari grup, Anda perlu”membuka" grup 
sebelum Anda dapat melakukan apa pun. Untuk membuka grup, klik dua kali 
permukaan dinding luar, atau context-clicks dan pilih Edit Grup. Setelah Anda dapat 
bekerja di dalam grup, Anda dapat mengikuti Langkah 2 hingga 4 di langkah 
sebelumnya untuk membuat 3D grup dinding eksterior. Klik di mana saja di luar model 
untuk keluar dari grup setelah Anda selesai. 

 
 

Gambar 8.18: Push/pull ekstrusi face ke dinding rumah sebuah. 

Menambahkan lantai ke bangunan Anda 

Menambahkan lantai kedua (dan ketiga, dan keempat) ke model Anda tidak sesulit 
kelihatannya. Kuncinya adalah menganggap setiap tingkat sebagai”baki" terpisah yang terdiri 
dari dinding interior, permukaan lantai, dan langit-langit tingkat di bawahnya. Anda 
memodelkan setiap lantai sebagai grup individual, membuatnya lebih mudah untuk 
disembunyikan, diedit, dan dipindahkan. 
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Gambar 8.19: Level lantai seperti baki yang ditumpuk di dalam kotak yang terdiri dari dinding 
luar Anda. 

Untuk alasan yang sama, Anda juga membuat dinding eksterior menjadi kelompok terpisah. 
Mereka bertindak seperti sebuah”kotak" tempat tingkat lantai Anda bertumpuk, seperti yang 
ditunjukkan pada Gambar 8.19. 

Membuat kelompok untuk memisahkan beberapa hal 

Jika Anda telah mengikutinya sejak awal bab ini, edge dan permukaan yang membentuk 
dinding luar Anda sudah tertutup dalam satu kelompok dengan sendirinya. Jika tidak, 
pertimbangkan untuk melakukannya dengan serius sekarang. Jika Anda meluangkan waktu 
untuk mengelompokkan dinding eksterior Anda sebelum menambahkan lantai ke bangunan 
Anda, Anda bisa menghemat berjam-jam sakit kepala nanti. Percayalah pada kami. 

Peringatan! 

Orang-orang yang bermaksud baik yang telah bekerja dengan program pemodelan CAD atau 
3D lain sering kali menggunakan kesempatan ini untuk membawa layer ke dalam diskusi. Ya, 
SketchUp memiliki fitur Layer. Dan ya,”baki" lantai sangat mirip dengan layer, setidaknya 
secara konseptual. Namun Anda tidak boleh menggunakan Layer saat memodelkan beberapa 
tingkat pada bangunan yang sama. Layer di SketchUp tidak berfungsi seperti yang Anda kira. 

Jika dinding eksterior Anda sudah menjadi satu kelompok, langkah selanjutnya adalah 
mengubah sisa geometri lantai pertama Anda menjadi kelompok lain. Inilah cara Anda 
melakukannya: 

 

 

1. Pilih lantai dan dinding interior tingkat pertama. 
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Tips 

Anda dapat melakukannya secara efisien dengan tool Pilih: Cukup klik tiga kali pada face di 
dinding interior mana pun untuk memilih semua yang melekat padanya. 

2. Buat grup dengan memilih Edit => Buat Grup dari Menu bar. 

Menggambar lantai berikutnya 

Memodelkan setiap lantai baru langsung di atas lantai di bawahnya menjamin bahwa semua 
yang ada di gedung Anda sejajar. Beberapa orang menganjurkan untuk bekerja”menyimpang" 
dan menyatukan semuanya nanti, tetapi Aidan menemukan bahwa resep untuk masalah. 
Inilah cara Anda menambahkan lantai dua ke model rumah. Lihat Gambar 8.20 untuk melihat 
langkah-langkahnya sebagai gambar: 

1. Dengan Line tool, telusuri bagian dalam dinding luar untuk membuat permukaan 
baru. 

Ingatlah bahwa penelusuran hanya berfungsi jika semua yang Anda sentuh sudah menjadi 
bagian dari grup lain. Jika tidak, edge baru Anda akan melekat pada yang sudah ada, dan model 
Anda menjadi sangat, sangat berantakan. 

2. Push/pull face baru Anda ke dalam lempengan tebal. 

Seberapa tebal? Itu tergantung pada bangunan Anda, tetapi jarak langit-langit ke lantai yang 
wajar antara tingkat untuk rumah adalah sekitar 1 kaki. Anda dapat menghitungnya dengan 
meteran dan kalkulator. 

  

Tips 

Bagian bawah pelat baru adalah langit-langit lantai pertama. Memodelkan bangunan dengan 
cara ini meningkatkan visibilitas karena memungkinkan Anda menyembunyikan grup lantai 
untuk melihat grup di bawahnya. 

3. Gambarlah dinding interior lantai baru. 

Ini seperti menggambar lantai pertama. Beralih ke tampilan Atas (Kamera => Tampilan Standar 
=> Atas) dan kemudian gunakan tool Pengukur Pita, Penghapus, dan Garis untuk membuat 
draf denah lantai Anda. Mulailah dari awal bab ini untuk penyegar. 

Tip 

Jika lantai yang Anda gambar lebih besar dari lantai di bawahnya, konturnya akan tumpang 
tindih dengan dinding luar. Tidak apa-apa - cukup perhatikan di mana ujung dan face Anda 
akan berakhir saat Anda menggambar. Orbit sesekali untuk memeriksa apakah semuanya 
copacetic. 

Jika lantai baru Anda lebih kecil dari lantai di bawahnya, tunjukkan batas dalam dinding 
eksterior baru dengan satu sisi. Bagian selanjutnya menjelaskan apa yang harus dilakukan jika 
denah lantai pertama dan kedua Anda tidak sama persis. 

4. Push/pull dinding interior Anda ke ketinggian yang benar. 

Itu 8 kaki, dalam contoh ini. 

5. Kelompokkan dinding interior Anda, lantai Anda, dan langit-langit tingkat di 
bawahnya. 
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Jika Anda tidak yakin tentang cara melakukannya, lihat langkah-langkah dalam”Membuat grup 
untuk memisahkan semuanya", di beberapa halaman sebelumnya. 

6. Jika lantai atas Anda tidak lebih besar atau lebih kecil dari lantai bawah Anda, tarik 
dinding eksterior agar sesuai dengan interior Anda. 

Di sini Anda memperluas kotak yang menahan baki lantai Anda ke atas. Lihat langkah terakhir 
dalam”Mendorong/menarik jalan Anda menuju kebahagiaan" di awal bab ini untuk detailnya. 

 

 
 

 
 

Gambar 8.20: Gambarlah tepat di atas lantai bawah; lalu push/pull dinding interior hingga 
ketinggian plafon. 

Tips 

Kemungkinan lantai terbaru Anda tidak sejajar persis dengan lantai di bawahnya. Bacalah 
bagian selanjutnya untuk mencari tahu apa yang harus dilakukan. Jika bangunan Anda adalah 
salah satu dari sedikit bangunan dengan denah lantai yang selaras sempurna, Anda dapat 
melewati bagian berikutnya sepenuhnya. Selamat! Anda iblis yang beruntung. 

Membuat dinding eksterior tambahan 

Kebanyakan bangunan bukanlah ekstrusi sederhana; mereka menabrak dan keluar saat 
mereka bangkit. Dek lantai dua berada di atas garasi lantai pertama; kantilever kamar tidur di 
atas taman; atap perantara melindungi penambahan ruangan baru. Bangunan - terutama 
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rumah bertingkat - adalah rakitan yang rumit. Mencari tahu di mana dinding, lantai, dan langit- 
langit bersatu membutuhkan waktu, coba-coba, dan pertimbangan spasial yang tepat. 
Sebaiknya jangan mencoba langkah-langkah di bagian ini saat Anda lelah atau terganggu. 

Di rumah model Aidan untuk bab ini, lantai dua overhang dan, um, underhang (hore untuk 
neologisme) lantai pertama. Dimanapun ini terjadi, Anda perlu menambahkan bagian baru 
dari dinding eksterior, seperti yang ditunjukkan pada Gambar 8.21. 

 

 

Gambar 8.21: Garis besar lantai dua tidak sama persis dengan yang pertama. 

Untuk memulai lantai dua, gambar permukaan untuk menentukan dinding eksterior baru. 
Ikuti langkah-langkah berikut, yang sesuai dengan Gambar 8.22: 

1. Dengan tool Line, telusuri bagian dalam dinding eksterior baru Anda. 
2. Sembunyikan grup yang menyertakan dinding interior lantai dua Anda dengan 

mengcontext-clicksnya dan memilih Sembunyikan. 

Anda membuat grup ini dengan mengikuti langkah-langkah di bagian 
sebelumnya,”Menggambar lantai berikutnya." 

3. Pilih face yang Anda buat saat menelusuri keliling bagian dalam pada Langkah 1. 

Tidak melihat face? Mungkin Anda lupa menggambar edge di suatu tempat. 

4. Dengan Offset tool, offset edge permukaan yang Anda pilih dengan ketebalan dinding 
eksterior Anda. 

Dalam hal ini, ketebalannya 8 inci. 

5. Hapus face di tengah, hanya menyisakan face yang mewakili ketebalan dinding 
eksterior baru Anda. 

6. Perlihatkan grup yang Anda sembunyikan di Langkah 2 dengan memilih Edit => 
Unhide => Terakhir dari Menu bar. 
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Gambar 8.22: Gunakan Offset untuk menggambar permukaan yang mewakili dinding eksterior 
baru 

 

Setelah Anda menentukan permukaan dinding luar, Anda menyesuaikan bagaimana lantai dua 
bertumpu di atas lantai pertama dengan mengikuti langkah-langkah berikut: 

1. Buat grup dari dinding eksterior baru Anda dengan memilihnya dan kemudian pilih 



125 
 

Edit => Buat Grup. 
2. Hapus semua geometri lantai yang bukan miliknya. 

Misalnya, pada Gambar 8.23 (atas), bagian dari lantai dua memanjang melewati 
dinding luar di sisi kiri gambar. Klik dua kali grup dengan tool Pilih untuk mengeditnya, 
lalu gunakan Penghapus untuk menghilangkan hanya geometri yang bukan milik lantai 
baru Anda, berhati-hatilah untuk meninggalkan langit-langit yang menutupi lantai 
pertama. 

3. Dengan tool Pilih, klik dua kali permukaan dinding luar untuk membuka grup yang 
Anda buat pada Langkah 1. 

4. Push/pull ke bawah setiap permukaan dinding agar bertemu dengan bagian atas 
dinding eksterior lantai bawah. Lihat bagian bawah Gambar 8.23. 

 

 
 
 
 

 
 

Gambar 8.23: Hapus permukaan lantai ekstra; lalu push/pull dinding ke bawah. 

Baru sekarang Anda siap untuk melindungi lantai dua Anda dengan dinding eksterior yang 
baru. Melakukannya adalah proses beberapa langkah lainnya: 

1. Buat semua dinding eksterior Anda menjadi bagian dari kelompok yang sama: 
a. Pilih grup yang berisi dinding eksterior baru Anda, lalu pilih Edit ⇒ Potong. 
b. Dengan tool Pilih, klik dua kali grup yang berisi dinding luar bagian bawah Anda. 

Anda berada”di dalam" grup itu. 
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c. Pilih Edit => Tempel di Tempat. d. Pilih Edit => Group => Explode untuk 
memisahkan edge dan face dalam grup yang dipilih, menempelkannya ke grup 
yang lebih rendah. Wah. 

d. Dengan Line tool, tambahkan edge yang diperlukan. Dengan Eraser tool, hapus 
yang tidak relevan. 

2. Pada Gambar 8.24, Anda dapat melihat di mana model memiliki edge ekstra yang perlu 
dihapus. 

Ingat! 

Dengan keahlian SketchUp Anda, perhatikan warna saat Anda menggambar, gunakan tombol 
Shift untuk mengunci inferences, dan ingat untuk memperbesar apa yang Anda lakukan. 

3. Dengan tool Push/pull, tarik dinding luar Anda hingga setinggi dinding interior lantai 
dua Anda (juga ditunjukkan pada Gambar 8.24). 

4. Orbit di sekitar model Anda untuk memastikan semuanya baik-baik saja. Anda dapat 
melihat hasilnya di kanan bawah Gambar 8.24. 

 
 

 

Gambar 8.24: Lakukan apa yang perlu Anda lakukan untuk membuat dinding eksterior Anda 
terlihat benar. 

Naik, naik, dan menjauh 

Tips 

Sekarang setelah mengetahui teknik favorit Aidan untuk membuat model bangunan 
bertingkat, Anda dapat membangun setinggi yang Anda suka. Saat Anda melanjutkan, 
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informasi kecil berikut mungkin berguna: 

 Sembunyikan hal-hal untuk mendapatkan tampilan yang lebih jelas untuk tugas Anda 
saat ini. Saat Anda mengcontext-clicks entitas mana pun dan memilih Sembunyikan, 
sering kali lebih mudah untuk melihat apa yang Anda lakukan. Hal ini terutama 
berlaku untuk grup, itulah sebabnya, pada langkah-langkah di bagian sebelumnya, 
Anda bersusah payah membuat grup tersebut. Untuk melihat hal-hal yang 
tersembunyi, pilih Lihat ⇒ Hidden geometry. Untuk memperlihatkan sesuatu yang 
tersembunyi, context-clicks dan pilih Perlihatkan. 

 Lebih baik lagi, gunakan Outliner Jika Anda siap, lewati dan baca hal-hal tentang 
Outliner. Sangat relevan untuk tetap teratur dan melihat di mana Anda membuat 
gedung bertingkat. 

 Ada emas di Info Model. Pilih Window ⇒ Model Info dan kemudian klik opsi 
Components di sebelah kiri. Di samping penggeser Fade Rest of Model, Anda dapat 
memilih kotak centang Sembunyikan. Dengan kotak centang ini dipilih, semua hal di 

luar grup yang sedang Anda edit menjadi tersembunyi. Pemodel cerdas (seperti Anda) 
memanfaatkan permata ini secara bebas saat memotong pintu dan window di dinding 
interior, yang merupakan topik bagian selanjutnya. 

Memasukkan pintu dan window 

Untuk menambahkan pintu dan window, metode terbaik bergantung pada jenis bangunan 
yang Anda modelkan, apakah Anda menggunakan dinding satu muka atau dua muka, dan 
seberapa banyak detail yang Anda rencanakan untuk disertakan dalam model Anda. Anda 
dapat membuat bukaan di dinding Anda dengan beberapa cara: 

 Potong bukaan dengan komponen SketchUp. 3D warehouse berisi sejumlah pintu dan 
window yang dapat Anda unduh dan gunakan dalam model Anda. Beberapa dari 
mereka memotong bukaannya sendiri saat Anda memasukkannya ke face. Berikut 
tangkapannya: Komponen bukaan potong SketchUp hanya berfungsi pada dinding satu 
sisi, yang berarti komponen tersebut hanya sangat berguna untuk model bangunan 
eksterior. Jika Anda membangun model interior, Anda harus memotong bukaan Anda 
sendiri. 

 Potong bukaan sendiri. Untuk dinding dua sisi, ini adalah satu-satunya pilihan Anda; 
untungnya, ini mudah dilakukan. Pada dasarnya, gambar garis luar bukaan lalu 
gunakan Push/Pull untuk membuat bukaan. Prosesnya sama untuk pintu dan window. 

Menggunakan komponen yang sangat berguna dari SketchUp 

Selama Anda membuat model eksterior, Anda dapat menggunakan komponen pintu dan 
window dari 3D warehouse SketchUp. Tanpa banyak detail, inilah yang perlu Anda ketahui 
tentang mereka: 

 Komponen dapat diakses dari panel Komponen. Panel Komponen muncul di Default 
tray, tetapi jika Anda tidak melihatnya, periksa apakah Komponen dipilih pada 
submenu yang muncul saat Anda memilih Window ⇒ Default tray. Pada panel 
Components, klik menu drop-down di sebelah ikon In Model dan pilih Architecture, 
yang berisi koleksi Doors, Windows, dan DC Doors and Windows. Komponen yang 
dapat memotong bukaannya sendiri umumnya mengandung perekatan atau 
pemotongan dalam deskripsinya. Ingatlah bahwa Anda harus online untuk mengakses 
3D warehouse. 

 Anda dapat menemukan ratusan lainnya secara online. Jika Anda tersambung ke 
Internet, Anda dapat mengetik kueri penelusuran apa pun (seperti pintu putar) ke 
dalam kotak telusur kecil di bagian atas panel Komponen. Ini menjelajahi 3D 
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warehouse untuk istilah pencarian Anda dan menunjukkan hasil di bawah ini. 
Beberapa saran: 3D warehouse menyimpan begitu banyak barang sehingga membuat 
kueri Anda spesifik membantu Anda menyortir hasil. 

 Komponen dapat diedit. Jika Anda tidak menyukai sesuatu tentang komponen yang 
Anda temukan online, Anda dapat mengubahnya. 

 Beberapa komponen bersifat dinamis. Komponen Dinamis memiliki kemampuan 
khusus yang membuatnya lebih mudah untuk diubah ukurannya dan jika tidak 
dikonfigurasi ulang. 

 Saat komponen memotong bukaannya sendiri, bukaan tersebut tidak permanen. Saat 
Anda memindahkan atau menghapus komponen pintu atau window lubang yang 
Anda tempatkan dalam model, bukaannya mengikuti komponen tersebut. 

Ikuti langkah-langkah berikut untuk menambahkan komponen pintu atau window ke model 
Anda: 

1. Dengan tool Pengukur Pita, buat panduan untuk membantu Anda mengatur pintu 
atau window Anda. 

Panduan adalah cara terbaik untuk memastikan semuanya ada di tempat yang benar. 
Pada Gambar 8.25, dua pemandu horizontal (2,5 kaki dari dasar dinding luar) 
menandai tempat untuk meletakkan bagian bawah window. Satu petunjuk vertikal 
menandai tempat meletakkan edge kanan pintu. Setelah Rebecca menempatkan pintu, 
dia membuat panduan sejauh 4 kaki dari setiap sisi pintu, untuk membantu 
menempatkan window secara simetris. 

2. Di panel Komponen, pilih komponen yang ingin Anda tempatkan di model Anda. 
3. Di area gambar, klik untuk menempatkan komponen di tempat yang Anda inginkan. 

Pada Gambar 8.25, Anda melihat satu pintu dan empat contoh komponen window. 

4. Jika Anda tidak menyukai letak komponen Anda, gunakan Move tool untuk 
mengubah posisi komponen Anda. 

 

Gambar 8.25: Menempatkan komponen window dan pintu pada model Anda sangatlah 
mudah. 
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Membuat bukaan Anda sendiri 

Sering kali, Anda tidak bisa lepas dari penggunaan komponen pintu dan window bawaan 
SketchUp. Karena komponen ini tidak dapat menembus dinding bermuka dua, mereka 
dibatasi untuk penggunaan luar saja. Tidak apa-apa; membuat lubang sendiri di dinding itu 
cepat dan mudah, dan Anda akan mendapatkan apa yang Anda inginkan. 

Untuk memotong bukaan yang tepat pada dinding dua sisi, inilah yang perlu Anda lakukan; 
Gambar 8.26 menunjukkan langkah-langkah dasar: 

1. Tandai di mana Anda ingin membuka dengan pemandu. 

2. Gambar garis besar bukaan yang ingin Anda buat, pastikan untuk membuat face baru 
dalam prosesnya. 

Gunakan Line tool, dan perhatikan inferensi berwarna, yang memberi tahu Anda di 
mana Anda berada. 

3. Dengan tool Push/pull, tarik kembali permukaan baru Anda ke dalam ketebalan 
dinding sampai menyentuh permukaan di belakangnya. 

 Jika semuanya berjalan dengan baik, face Anda menghilang, membawa serta 
area face yang sesuai di belakangnya. Sekarang Anda memiliki bukaan di 
dinding Anda. Jika face Anda tidak menghilang, dan tidak ada celah yang 
tercipta, mungkin karena salah satu alasan berikut: 

 Facemu tidak sejajar satu sama lain. Teknik ini hanya berfungsi jika kedua 
permukaan sejajar. Perlu diingat bahwa hanya karena dua face terlihat sejajar, 
bukan berarti keduanya. 

 Anda mencapai tepi. Jika Anda mendorong/menarik face Anda ke face dengan 
edge yang melewatinya, SketchUp akan bingung dan tidak memotong bukaan. 
Gunakan Undo, singkirkan edge yang mengganggu (jika Anda bisa), dan coba 
lagi. 

 

 

Gambar 8.26: Dengan pemandu dan tool Push/pull, buat bukaan melalui permukaan paralel. 

Tips 

Jangan lupa untuk mengorbit! Jika Anda tidak dapat mendorong/menarik apa yang Anda 
maksud dengan mendorong/menarik, lakukan orbit hingga Anda dapat melihat apa yang 
Anda lakukan 

Metode Profil yang Disalin 

Metode pemodelan tangga ini bergantung, seperti yang terakhir, pada penggunaan Push/Pull 
untuk membuat bentuk 3D dari permukaan 2D, tetapi metode ini lebih elegan. Singkatnya, 
gambar profil - tampilan samping, semacam - satu langkah lalu salin langkah sebanyak yang 
Anda butuhkan, buat satu face, dan gambarkan semuanya menjadi bentuk. Pertama kali Anda 
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melakukan ini sangat memuaskan - salah satu operasi SketchUp yang”dijamin akan membuat 
Anda tersenyum” yang ingin Anda ulangi untuk teman-teman (dengan asumsi Anda memiliki 
teman kutu buku seperti kami). 

Ikuti langkah-langkah berikut untuk membuat tangga menggunakan metode Copied Profile, 
seperti yang ditunjukkan pada Gambar 8.29: 

1. Mulailah dengan face vertikal yang besar; pastikan bahwa itu cukup besar untuk 
tangga yang ingin Anda bangun. 

Anda pada akhirnya akan mendorong/menarik seluruh shebang keluar dari sisi face ini, 
asal Anda tahu. 

2. Di sudut bawah face, gambar profil satu langkah. 

Line tool adalah pilihan yang bagus, meskipun Anda mungkin ingin menggunakan satu 
atau dua busur, tergantung pada tingkat detail yang Anda butuhkan. 

3. Pilih semua edge yang membentuk profil langkah Anda. 

Tip 

Anda dapat menahan tombol Shift sambil mengklik dengan tool Pilih untuk memilih 
beberapa entitas. 

4. Buat salinan profil langkah Anda dan letakkan di atas yang pertama. 

Jika Anda tidak terbiasa dengan cara membuat salinan menggunakan Move tool 

5. Ketik jumlah langkah yang ingin Anda buat, ketik x, lalu tekan Enter. 

Misalnya, jika Anda menginginkan sepuluh langkah, ketikkan 10x. Teknik ini 
mengulangi operasi penyalinan yang baru saja Anda lakukan dengan berapa kali Anda 
menyuruhnya; tandaxsetelah nomor memberitahu SketchUp untuk membuat salinan. 

6. Jika perlu, gambar edge untuk memastikan bahwa semua profil langkah Anda adalah 
bagian dari satu face. 

7. Push/pull permukaan tangga untuk mencerminkan lebar tangga yang Anda inginkan. 

Bagian ini sepertinya ajaib bagi kebanyakan orang; kami tidak berpikir itu akan menjadi 
tua. 
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Gambar 8.29: Metode Profil yang Disalin. 

Gambar 4-30 membangkitkan nafsu makan Anda. Follow Me adalah kacang keren, semuanya. 
 

Gambar 4-30: Menggunakan Follow Me dengan metode Copied Profile menghasilkan 
beberapa geometri yang mengesankan. 

Menaikkan Atap 

Jika beruntung, atap yang ingin Anda bangun cukup sederhana. Sayangnya, pembangun 
rumah terkadang menjadi sedikit gila, membuat atap dengan lusinan kemiringan berbeda 
(lereng), atap, dan doodad lain yang membuat pemodelan mereka menjadi mimpi buruk. Oleh 
karena itu, bagian ini membuat semuanya cukup sederhana: Bagian berikut menunjukkan 
kepada Anda bagaimana mengidentifikasi dan membuat model bentuk atap dasar. Setelah itu, 
Anda menemukan tool hebat - Intersect Face - yang dapat Anda gunakan untuk merakit atap 
rumit dari bagian yang tidak terlalu rumit. 

Tip 

Hal yang rumit tentang atap adalah sulit dilihat. Jika Anda ingin membuat model dari sesuatu 
yang sudah ada, akan membantu jika Anda melihatnya dengan baik - tetapi itu tidak selalu 
memungkinkan dengan atap. Google Maps menawarkan cara yang rapi untuk melihat atap 
yang ada yang sedang Anda coba bangun. 

Peringatan 

Selalu, selalu buat grup dari seluruh bangunan Anda sebelum Anda mengerjakan atap Anda. 
Jika tidak, geometri Anda mulai saling menempel, Anda akhirnya menghapus dinding secara 
tidak sengaja, dan akhirnya, Anda kehilangan akal sehat. Selain itu, kemampuan untuk 
memisahkan atap Anda dari sisa bangunan kapan pun Anda mau sangat berguna. Anda juga 
dapat mengelompokkan atap Anda, jika itu masuk akal untuk apa yang Anda lakukan. 
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Sebelum Anda mendalami, berikut adalah panduan singkat untuk tipe atap umum dan 
terminologi yang mungkin berguna untuk penjelasan selanjutnya di bab ini. Gambar 4-31 
mengilustrasikan masing-masing istilah berikut: 

 Flat roof (atap datar): Atap datar hanya itu, kecuali sebenarnya tidak - jika atap benar- 
benar datar, itu akan mengumpulkan air dan bocor. Itulah sebabnya bahkan atap yang 
terlihat datar memiliki kemiringan yang sangat sedikit. 

 Pitched roof (Atap bernada tinggi): Atap apa pun yang tidak datar secara teknis adalah 
atap bernada tinggi. 

 Shed roof (Atap gudang): Atap gudang adalah atap yang miring dari satu sisi ke sisi 
lain. 

 Gabled roof (Gable roof): Gable roof memiliki dua bidang yang miring menjauh dari 
punggungan pusat. 

 Hip roof (Hip roof): Hip roof adalah salah satu tempat sisi dan ujung semua lereng ke 
arah yang berbeda. 

 Pitch: Sudut permukaan atap. 
 Gable: Gable adalah bagian dinding yang runcing yang berada di bawah puncak atap 

bernada. 

 Eave: Eave adalah bagian atap yang menjorok bangunan. 
 Fascia: Fascia adalah garis edge di sekitar edge atap yang kadang-kadang dipasang 

talang. 

 Soffit: Soffit adalah bagian bawah atap yang menjorok. 

 Rake: Rake adalah bagian dari Gable roof yang menggantung di atas Gable roof. 
 Lembah: Lembah terbentuk saat dua lereng atap bersatu; disinilah air mengalir saat 

hujan. 

 Dormer: Dormer adalah hal-hal kecil yang muncul di atas permukaan atap. Mereka 
sering memiliki window dan membuat ruang loteng lebih bisa digunakan. 

 Parapet: Atap datar yang tidak memiliki atap memiliki tembok pembatas - ekstensi dari 
dinding bangunan yang naik beberapa meter melewati atap itu sendiri. 

 

Gambar 4-31a. : Beberapa jenis atap, dan berbagai macam bagiannya 
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Gambar 4-31a. : Beberapa jenis atap, dan berbagai macam bagiannya 

Membangun atap datar dengan tembok pembatas 

Kabar baik! SketchUp secara praktis dibuat untuk memodelkan jenis atap ini. Dengan 
menggunakan kombinasi Offset tool dan Push/Pull, Anda dapat membuat tembok pembatas 
dalam waktu kurang dari satu menit. Ikuti langkah-langkah ini, seperti yang ditunjukkan pada 
Gambar 8-32: 

1. Dengan Offset tool, klik bagian atas bangunan Anda. 
2. Klik lagi di suatu tempat di dalam face yang sama untuk membuat face lain. 
3. Ketik ketebalan tembok pembatas Anda lalu tekan Enter. 

Ini menggambar ulang edge offset Anda menjadi jarak yang tepat dari edge face asli 
Anda. Seberapa tebal tembok pembatas Anda? Itu semua tergantung pada bangunan 
Anda, tetapi kebanyakan tembok pembatas memiliki ketebalan antara 6 dan 12 inci. 

4. Push/pull permukaan luar Anda (yang mengelilingi atap Anda) ke dalam tembok 
pembatas. 

5. Ketik tinggi tembok pembatas Anda lalu tekan Enter. 
 

Gambar 8-32: Membuat model tembok pembatas pada bangunan beratap datar itu mudah. 
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Membuat atap bangunan dengan atap miring 

Cara favorit Aidan untuk membuat atap, atau overhang atap, adalah dengan menggunakan 
Offset tool. Ikuti langkah-langkah ini untuk mendapatkan gambaran umum dan lihat Gambar 
4-33: 

1. Buatlah kelompok dari seluruh bangunan Anda sebelum Anda mulai membuat model 
atap. Memisahkan atap Anda membuat model Anda lebih mudah dikerjakan. 

2. Dengan Line tool, buat garis luar dari bagian-bagian atap Anda yang akan memiliki 
atap dengan ketinggian yang sama. Tujuannya adalah satu face yang bisa Anda offset. 
Banyak bangunan memiliki atap yang kompleks dengan atap dari semua ketinggian 
yang berbeda; Demi langkah ini, buat saja permukaan yang, jika diimbangi, akan 
membuat overhang atap di tempat yang tepat. 

3. Dengan Offset tool, buat face yang menjorok. Untuk instruksi tentang cara 
menggunakan Offset, lihat bagian”Membersihkan tool draf SketchUp", di awal bab ini. 

4. Hapus edge face asli Anda. Berikut cara cepat untuk melakukannya dengan tool Pilih: 
a. Klik dua kali di dalam face pertama Anda. Ini memilih face dan edge yang 

menentukannya. 
b. Tekan Hapus untuk menghapus semua yang dipilih. 

5. Push/pull permukaan atap yang menjorok untuk membuat fasia tebal. Atap yang 
berbeda memiliki fasia dengan ketebalan berbeda; jika Anda tidak tahu milik Anda, 
tebak saja yang terbaik. 

 

 

Gambar 4-33: Atap adalah bagian atap yang menggantung pada dinding bangunan. 

Membangun Gable roof 

Anda dapat membangun Gable roof dengan berbagai cara (setiap pakar SketchUp memiliki 
favoritnya), tetapi satu metode bekerja dengan sangat baik. 

Ikuti langkah-langkah berikut untuk membangun Gable roof, yang ditunjukkan pada Gambar 
8-34: 

1. Buat atap overhang, dengan mengikuti langkah-langkah di bagian sebelumnya. 
Kebanyakan Gable roof memiliki atap, jadi Anda mungkin perlu membuatnya untuk 
bangunan Anda. 

2. Dengan arc tool Derajat, buat panduan bersudut di sudut atap Anda. Bilah sisi di 
dekatnya,”Atap bernada tinggi bisa membuat Anda gila," mengarahkan Anda untuk 
membantu Busur derajat. 

Masalah Teknis 

Arsitek dan pembangun sering mengungkapkan sudut sebagai rasio naik-turun. Misalnya, 
kemiringan atap 4:12 (diucapkan 4 in 12) naik 4 kaki untuk setiap 12 kaki yang dilewatinya. 
Lereng 1:12 sangat dangkal, dan lereng 12:12 sangat curam. Saat Anda menggunakan arc tool 
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Derajat, Measurements box SketchUp memahami sudut yang dinyatakan sebagai rasio serta 
yang dinyatakan dalam derajat. Pengetikan 6:12 menghasilkan kemiringan 6 dalam 12. 

3. Dengan Line tool, gambarlah edge vertikal dari titik tengah atap Anda ke pemandu 
bersudut yang Anda buat pada Langkah 2. Titik pertemuan edge dan pemandu Anda 
adalah ketinggian bubungan atap. 

4. Gambarkan dua sisi dari atas garis vertikal Anda ke sudut atap Anda. Ini menciptakan 
dua face segitiga. 

5. Hapus edge vertikal yang Anda gambar pada Langkah 3 dan panduan yang Anda 
gambar pada Langkah 2. 

6. Push/pull ke belakang Gable roof segitiga Anda. Jika Gable roof Anda memanjang 
sampai ke ujung lain bangunan Anda, push/pull ke belakang sejauh itu. Jika atap Anda 
menabrak bagian lain dari atap, seperti yang ditunjukkan pada Gambar 4-35, tarik 
kembali hingga benar-benar”terkubur". Bagian”Menempelkan atap Anda bersama- 
sama dengan Sisi-Sisi yang Berpotongan”, selanjutnya di bab ini, memiliki lebih banyak 
informasi tentang cara membuat atap yang kompleks. 

7. Selesaikan bagian atap, fasia, soffit, dan rake sesuka Anda. 

Gable roof memiliki lebih banyak detail daripada yang bisa kita tutupi, tetapi Gambar 4-36 
menunjukkan beberapa yang umum. 

 

Gambar 8-34: Gable roof relatif mudah dibuat di SketchUp. 
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Gambar 8-35: Jika Gable roof Anda adalah bagian dari struktur atap yang lebih besar, mungkin 
saja atap itu akan menabrak kemiringan atap lain. 

 

Gambar 8-36: Beberapa detail Gable roof yang umum 

Membuat hip roof 

Percaya atau tidak, membangun hip roof lebih mudah daripada membangun Gable roof. Hip 
roof tidak memiliki garu, sehingga lebih mudah dibuat modelnya. Ikuti langkah-langkah 
berikut untuk mencari tahu sendiri: 

1. Ikuti Langkah 1 hingga 5 di bagian sebelumnya”Membangun Gable roof". 
2. Ukur jarak dari titik tengah Gable roof ke sudut atap. Karena hip roof memiliki 

kemiringan yang sama di semua sisi, Anda dapat menggunakan trik sederhana untuk 
mencari tahu di mana menempatkan pinggul di atap Anda. Ini jauh lebih mudah 
daripada menggunakan Busur derajat. 

3. Dengan Pita Pengukur, buat panduan jarak yang baru saja Anda ukur dari ujung Gable 
roof, seperti yang ditunjukkan pada Gambar 8-37. 

4. Gambarlah edge dari titik di punggung bukit yang baru saja Anda temukan ke sudut 
atap Anda, seperti yang ditunjukkan pada Gambar 8-37. Ini melakukan dua hal: Ini 
membagi sisi atap Anda menjadi dua sisi masing-masing dan membuat face baru (yang 
belum dapat Anda lihat) di bawah ujung Gable roof Anda. 

5. Hapus tiga sisi yang membentuk ujung Gable roof Anda, yang memperlihatkan 
nada”berpinggul" di bawahnya. Rapi, ya? Sekarang, ketiga permukaan atap Anda 
memiliki tinggi yang sama - sebagaimana mestinya. 

6. Jika sesuai, ulangi proses di ujung lain atap Anda. 
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Gambar 8-37: Untuk membuat hip roof, mulailah dengan Gable roof 

Rekatkan atap Anda dengan Intersect Faces 

Secara umum, semakin baru dan mahal sebuah rumah, semakin banyak kemiringan atap yang 
dimilikinya. Siapa yang tahu mengapa ini terjadi? Mungkin orang mengira rumah beratap 
kompleks lebih mirip istana Prancis. Apakah atap gila itu bagus tidak relevan dengan buku ini, 
tapi itu merepotkan, um, talang untuk dimodelkan. 

Untungnya, SketchUp memiliki fitur yang relatif sedikit diketahui yang sering membantu 
dalam hal membuat atap dengan banyak kemiringan: Intersect Faces. Inilah yang perlu Anda 
ketahui tentang tool kecil yang hebat ini: 

 Intersect Faces membuat geometri baru dari geometri yang sudah ada. Ini 
mengambil face yang Anda pilih dan menciptakan tepian di mana pun mereka 
berpotongan. Gambar 8-38 menunjukkan apa yang kami maksud: Mungkin Anda ingin 
membuat model kubus dengan potongan berbentuk silinder yang diambil darinya. 
Anda akan membuat model kubus dan membuat model silinder. Setelah 
memosisikannya dengan hati-hati, Anda kemudian dapat menggunakan Intersect face 
untuk membuat edge tempat kedua bentuk saling bertemu. Setelah itu, Penghapus 
dapat menghilangkan edge yang tidak Anda inginkan - sisa silinder, dalam hal ini. 

 Intersect face dan Eraser tool berjalan beriringan. Setiap kali Anda menggunakan 
Intersect Faces, Anda perlu menindaklanjuti dengan menghapus geometri yang tidak 
diinginkan. Untuk menemukan semuanya, orbit, zoom, dan geser di sekitar model 
Anda, zapping garis dan face yang tersesat dengan Penghapus saat Anda pergi 
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 Seringkali, pilih Intersect Faces with Model. tool ini memiliki tiga mode, tetapi 
sebagian besar waktu, Anda menggunakan mode dasar. Inilah yang dilakukan ketiga 
mode: 

o Intersect Faces with Model: Menciptakan edge di mana pun face yang Anda 
pilih berpotongan dengan face lain dalam model Anda - baik face lain dipilih 
atau tidak. 

o Intersect face dengan Pilihan: Hanya membuat edge di mana face yang dipilih 
bersinggungan dengan face yang dipilih lainnya. Ini berguna jika Anda mencoba 
lebih akurat. 

o Intersect Faces with Context: Memilih opsi ini akan membuat edge di mana 
face dalam grup atau komponen yang sama berpotongan; itulah mengapa ini 
hanya tersedia ketika Anda mengedit grup atau komponen. 

 Intersect face tidak memiliki tombol. Untuk menggunakannya, Anda harus 
melakukannya 

o Context-click dan pilih Intersect Faces. 
o Pilih Edit => Intersect Faces. 

 

Gambar 8-38: Menggunakan Intersect Faces untuk memotong silinder parsial dari sebuah 
kubus. 

Saat membuat atap, Anda dapat menggunakan Intersect Faces untuk menggabungkan banyak 
Gable roof, pinggul, atap, gudang, dan sebagainya menjadi satu atap. Melakukan hal itu 
bukanlah cakewalk, dan ini membutuhkan perencanaan yang matang, tetapi akan berhasil 
dengan baik ketika tidak ada orang lain yang mau. 

Gambar 8-39 menunjukkan atap yang rumit dengan beberapa elemen. Gable roof telah 
didorong/ditarik ke hip roof utama pada semua ketinggian yang berbeda, tetapi tepinya tidak 
ada di tempat semua permukaan yang berbeda bertemu. Dalam langkah-langkah berikutnya, 
gunakan Intersect face untuk membuat edge yang Anda inginkan dan kemudian gunakan 
Penghapus untuk membersihkan kekacauan: 

1. Pilih seluruh atap. 

Tips 

Jika Anda mengelompokkan bangunan dan atap Anda seperti yang kami 
rekomendasikan di awal bab ini, berikut adalah trik menghemat waktu: Sembunyikan 
grup yang berisi sisa bangunan Anda dan kemudian gambar selection box besar di 
sekitar seluruh atap dengan tool Pilih. 
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2. Pilih Edit => Intersect Faces => With Selected. 

Ini memberitahu SketchUp untuk membuat edge di mana pun Intersect face - yaitu, di 
mana pun face melewati satu sama lain tanpa tepi. 

3. Dengan Penghapus, dengan hati-hati hapus geometri ekstra di bagian dalam atap 
Anda, seperti yang ditunjukkan pada Gambar 8-39. 

Meskipun menghapus ini bisa menjadi pekerjaan yang berat, itu jauh lebih mudah 
daripada menggunakan Line tool dan mesin inferensi SketchUp untuk mencari tahu ke 
mana detail atap yang rumit harus ditempatkan. 

 

Gambar 8-39: Berikut adalah atap kompleks yang bisa disatukan oleh Intersect Faces. 

Metode 2D = 3D 

Saat Anda menggunakan pemodelan SketchUp untuk membuat permukaan dan objek, 
metode pemecahan masalah 2D = 3D penting untuk dipahami. Jika Anda dapat 
membayangkan dan menggambar sesuatu dua dimensi di SketchUp, Anda dapat 
menerjemahkan gambar 2D menjadi 3D 

Di seluruh buku ini, Anda akan melihat konsep tepi 2D yang membagi face yang kemudian 
diberi volume menggunakan berbagai alat. Buku ini berfokus pada penyusunan dasar 
perwakilan 2D dan mengartikulasikan dasar tersebut menjadi model 3D 
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Gambar Gambar 2D face cahaya dimodelkan menjadi 3D. 
 

Gambar Denah lokasi 2D siap dibuat 3D 
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Gambar Denah lokasi 2D dimodelkan menjadi denah lokasi 3D 

Drafting Dasar Flatwork 

Istilah Flatwork Base digunakan di seluruh buku ini. Ini mengacu pada area pemodelan dasar 
yang terdiri dari permukaan. 

Mari kita mulai dengan membuat model lingkungan binaan dari awal. Latihan berikut akan: 

 Perkenalkan komposisi khas dari Flatwork Base. Di dalamnya, Anda akan mengukir 
permukaan 3D persegi panjang untuk membuat permukaan individual yang 
menentukan lingkungan binaan — jalan, trotoar, halaman pohon, jalur berkelok, tapak 
bangunan, tangga, dan dinding. 

 Biasakan diri Anda dengan proses penyusunan Flatwork Base, termasuk mengatur dan 
menggunakan drawing tool dan layer. Nanti di bab ini, Anda akan mempelajari cara 
menambahkan objek ke Flatwork Base. 

Menggambar Dasar/Base 

Menggunakan drawing tool untuk membuat draf Flatwork Base sederhana, ikuti langkah- 
langkah berikut: 

1. Gambar dasarnya 
a. Buka Layers (Window Layers) dan pastikan Layer 0 terkini (seharusnya). Pilih 

alat Rectangle. 
b. Gambarlah permukaan persegi panjang 100’× 100' dengan memilih titik 

gambar persegi panjang pertama, ketik 100’, 100', dan tekan tombol Enter. 
Face persegi panjang yang dihasilkan akan digunakan untuk menyusun 
Flatwork Base. Drawing tool akan digunakan untuk membagi face menjadi 
beberapa face yang lebih kecil. 

2. Tentukan jalannya 
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a. Menggunakan line tool, temukan titik tengah (kotak cyan) dari tepi kanan 
persegi panjang. Pasang ke titik tengah dan gambar ke arah tengah persegi 
panjang, tegak lurus dengan tepi gambar 

b. Masukkan nilai 30’(di measurement window). Ini akan menggambar garis 
30’tegak lurus ke tepi kanan. 

3. Terus tentukan jalannya. 
a. Lanjutkan menggambar garis tegak lurus dari titik akhir garis 30’ke tepi atas 

persegi panjang. Ini akan membuat face terbagi pertama di permukaan. 
b. Menggunakan alat Select (panah hitam), pilih area permukaan yang lebih kecil. 

Permukaan adalah bagian facenya sendiri yang terbagi. Batalkan pilihan face 
dengan menekan Ctrl + T. Perintah ini memungkinkan Anda untuk 
membatalkan pilihan geometri yang dipilih. 

4. Terus tentukan jalannya. 
a. Dari titik akhir baris pertama, gambar garis lain ke tepi bawah persegi panjang. 

5. Terus tentukan jalannya. 
a. Gunakan eraser tool dan hapus garis yang digambar pertama (dari langkah 2). 

Ini menggabungkan permukaan yang lebih kecil menjadi satu permukaan. 
Permukaan yang terbagi mewakili jalan 

6. Tentukan trotoar dan rumput pohon 
a. Dengan select tool, pilih garis yang digambar di bagian sebelumnya. 
b. Dengan garis yang dipilih, pilih alat Pindah/Salin (Lihat menu Modifikasi Bilah 

Alat Pindah/Salin). 
c. Dengan Pindahkan/Salin aktif, pilih titik ujung bawah baris. Tahan Ctrl dan Klik 

+ seret mouse ke kiri, menggunakan tepi bawah untuk referensi. Ketik 8’(di 
measurement window) dan tekan Enter. 

Salinan garis dibuat 8’dari tepi. Area sempit di antara dua garis harus menjadi bagian 
muka yang dapat dipilih sendiri. 

7. Terus mendefinisikan trotoar dan rumput pohon: 
a. Pilih garis yang baru disalin dan Pindahkan/Salin garis 5’ke kiri, dengan 

mengulangi langkah 

Dua area permukaan sempit mewakili rumput pohon dan jalan beton. 

8. Tambahkan jejak melengkung. 
a. Pilih alat Arc. Kira-kira seperempat jalan ke atas dari sudut kiri bawah persegi 

panjang awal, mulailah menggambar busur, menjentikkan ke tepi kiri dan 
bergerak ke kanan, tegak lurus ke tepi kiri. 

b. Jepitkan titik busur kedua ke garis yang disalin yang dihasilkan pada langkah 
c.  Pilih titik ketiga untuk menentukan radius busur (tonjolan). Pastikan untuk 

menjepret ke titik inferensi Di Face. Berikan lengkungan halus pada busur, 
seperti yang ditunjukkan pada Gambar 6-8 

9. Gandakan busur untuk menentukan jeja. 
a. Menggunakan offset tool (View Toolbars Modification menu Offset), buat 

duplikat dari busur yang digambar. Pilih busur dan offset garis busur 
6’menuju”selatan" di permukaan. 

Perhatikan bahwa titik akhir busur offset tidak menyentuh atau terhubung ke salah 
satu tepi yang berdekatan. Ini akan mencegah area yang ditentukan untuk jalan 
setapak (antara dua busur) terbagi lagi. 
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10. Tentukan jejak melengkung. 

a. erbesar kedua ujung busur offset dan gunakan line tool untuk menggambar 
tepi dari titik akhir busur ke garis yang berdekatan. 

b. Periksa untuk melihat bahwa tepi yang ditambahkan sekarang membagi area 
antara busur menjadi permukaan yang terpisah. Permukaan ini akan menjadi 
jalan setapak. 

11. Bangun tapak bangunan 
a. Mulai dari sudut kiri atas, gambar persegi panjang 50’× 25' yaitu 13'-6 ″ dari 

tepi paling kiri dan 13'-6 ″ dari tepi atas. 
b. Alat Rectangle telah membagi area yang luas. Permukaan yang lebih kecil ini 

mewakili tapak bangunan. 
12. Tambahkan jalan masuk bangunan 

a. Mulai 25’ke bawah dari sudut kanan atas tapak bangunan yang digambar pada 
langkah 11, gambar garis tegak lurus ke kanan. Hubungkan garis ke tepi”jalan 
kaki" dari langkah 7. 

13. Lanjutkan menambahkan jalur masuk bangunan. 
a. Dengan Move/Copy, buat jalan kaki selebar 6’dengan menyalin dan 

memindahkan garis yang digambar pada langkah 12. 
14. Salin dan tempel tepian untuk menentukan tangga yang berdekatan dengan tapak 

bangunan 
a. Dengan Pindahkan/Salin, buat serangkaian langkah menggunakan garis tapak 

bangunan. Ketika dua garis masuk digambar bersebelahan dengan bangunan, 
mendefinisikan jalan masuk, tepi yang menyusun tapak bangunan dibagi lagi. 
Garis untuk bangunan yang terletak di antara dua jalur masuk sekarang 
menjadi garis yang dapat dipilih sendiri. 

b. Pilih garis ini di antara dua tepi dari langkah sebelumnya dan Pindahkan/Salin 
untuk membuat tiga langkah, masing-masing terpisah 1’. Ini adalah langkah- 
langkah menuju gedung. 

15. Buat draf dinding masuk 
a. Dengan alat Rectangle, pilih titik akhir di persimpangan jalan masuk dan trotoar, 

yang digambar pada langkah 9. Masukkan nilai 5 ′, 1 ′. Pastikan panjang persegi 
panjang yang digambar sejajar dengan trotoar. 

b. Ulangi langkah ini untuk sisi jalan yang lain. Permukaan ini akan digunakan 
untuk membuat dinding. 
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Gambar: Membuat Gambar Dasar Flatwork dan menentukan jalan 
 

Gambar: Membuat sketsa jalan setapak dan jalan setapak 
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Gambar: Menggambar tapak bangunan dan jalur masuk bangunan 
 

 

Gambar: Mendefinisikan pintu masuk dengan tangga dan dinding 

Meninjau Gambar 

Latihan sebelumnya menggambar, menyalin, dan memindahkan pekerjaan garis pada satu 
permukaan. Dengan membagi satu permukaan menjadi beberapa area yang lebih kecil, Anda 
menggambar jejak kaki yang menandakan permukaan tertentu. Sekarang setelah Anda selesai 
menyusun permukaan Flatwork Base, Anda perlu mengaitkan warna dengan permukaan ini 
untuk menyampaikan lebih banyak makna. 
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Gambar Permukaan Dasar Flatwork yang dirancang 

Menerapkan Material dan Warna 

Fase selanjutnya adalah mengaplikasikan warna pada permukaan untuk memberi arti pada 
permukaan. Pilih Paint Bucket dari Large Tool Set untuk membuka menu Material. Menu 
Material menyediakan beragam warna dan tekstur yang dapat diterapkan ke face. 

Untuk latihan ini, pilih warna yang paling mewakili setiap permukaan: 

 Abu-abu tua untuk jalan raya 

 Abu-abu muda untuk trotoar dan anak tangga 

 Coklat tua untuk dinding 

 Putih untuk luas bangunan 

 Beige atau coklat untuk jejaknya 

 Hijau muda untuk halaman pohon dan permukaan rumput di sekitar gedung 
 

Gambar: Menambahkan warna pada Flatwork Base 
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Setelah Anda memilih warna dari menu Material, cukup klik pada permukaan dengan aplikator 
(Paint Bucket). Ini akan menerapkan warna ke permukaan. 

Terapkan warna Anda ke permukaan 2D jika Anda bisa. Setelah permukaan 2D Dorong/Ditarik 
untuk menambah volume, warna akan secara otomatis diterapkan ke volume secara 
keseluruhan. Menerapkan warna sekarang menghemat waktu Anda karena Anda tidak perlu 
menerapkan kembali warna ke permukaan yang baru dibuat yang dibuat oleh push/pull tool 

 

Gambar: Warna apa pun pada face akan secara otomatis diterapkan ke volume saat 
Dorong/Ditarik. 

Model Pengorganisasian 

Buat Flatwork Base yang telah diwarnai dan selesai menjadi sebuah grup. Menggunakan alat 
Select, gambar kotak seleksi di sekitar semua permukaan dan tepi yang menyusun Flatwork 
Base. Klik kanan di dasar dan pilih Make Group 

 

Gambar: Ubah Flatwork Base menjadi sebuah grup. 
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Dasar Flatwork yang dikelompokkan memberikan kesempatan pertama untuk menerapkan 
organisasi layer. Pada menu Layers (Window Default Tray Layers), buat layer baru dengan 
memilih tombol Add Layer (+) di atas bilah menu. Layer baru bernama Layer 1 akan dibuat. 

Layer dapat ditampilkan dalam urutan abjad/numerik. Klik dua kali pada nama layer baru. 
Ubah nama layer 01-Flatwork. Menerapkan 01 ke layer Flatwork Base memastikan bahwa 
Flatwork Base akan selalu menjadi layer atas yang ditampilkan, yang membuatnya lebih 
mudah untuk ditemukan karena lebih banyak layer ditambahkan. 

Langkah selanjutnya adalah memindahkan grup Flatwork Base ke layer 01-Flatwork. Untuk 
melakukan ini, pilih grup Flatwork Base, klik kanan untuk membuka menu konteks, dan di 
paling atas, pilih Entity Info. 

Menu Entity Info menyediakan informasi, termasuk lokasi layer objek, tentang objek yang 
dipilih. Ini juga memungkinkan objek yang dipilih untuk dipindahkan ke layer yang berbeda. 
Saat ini, grup Flatwork Base berada di Layer 0. 

Pindahkan grup ke layer 01-Flatwork yang baru dibuat. Di Entity Info, pilih Layers menu pull- 
down. Periksa untuk memastikan grup Flatwork Base masih dipilih. Kemudian pilih 01- 
Flatwork Layer. Grup Flatwork sekarang berada di layer 01-Flatwork 

Mematikan layer ini akan membuat grup tidak terlihat; mengaktifkannya kembali akan 
membuatnya terlihat. 

 

Gambar: Buat layer baru untuk grup Flatwork Base. Pindahkan grup Flatwork Base ke layer 
baru. 

Menambahkan Volume 

Push/pull tool yang mudah digunakan (View Toolbars Modification menu Push/Pull) 
menambahkan volume 3D ke permukaan 2D. Pilih tool Push/Pull dan masukkan instance 
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Flatwork Base Group. Selanjutnya, arahkan kursor ke permukaan. Klik dan dorong mouse ke 
depan. Push/Pull akan mengubah permukaan 2D datar menjadi volume 3D. 

Seperti banyak alat SketchUp, Push/Pull memungkinkan pengguna memasukkan nilai dan 
dimensi tertentu. Pilih permukaan 2D. Kemudian masukkan dimensi nilai (di measurement 
window) dan tekan Enter. Push/Pull akan membuat ketinggian volume berdasarkan nilai yang 
dimasukkan. 

Anda dapat menggunakan metode yang sama untuk menentukan jalan, tangga, dinding, dan 
bangunan. Push/pull permukaan adalah langkah terakhir dalam menghasilkan Flatwork Base. 

Menurunkan Jalan 

Jalan raya adalah salah satu area permukaan pertama yang harus Anda tentukan dengan 
volume. Bahkan menambahkan sejumlah kecil volume membantu memberikan skala dan 
definisi ke semua area permukaan yang berdekatan. 

1. Masuk ke instance grup Flatwork Base. 
2. Pilih push/pull tool. Arahkan kursor ke area yang ditetapkan sebagai jalan. Push/pull 

ke bawah: Klik dan seret kursor ke bawah. Segera ketikkan nilai 6 ″. 
a. SketchUp akan melakukan salah satu dari dua hal 
b. SketchUp akan menurunkan permukaan atas 6″, dan permukaan jalan akan 

memiliki dinding 6″ yang mengelilinginya. 

Bergantung pada situasinya, Anda harus membersihkan permukaan jalan dengan melakukan 
salah satu langkah berikut: 

 Jika SketchUp membuat volume 6”, hapus permukaan atas dan" dinding”yang 
berdekatan. 

 Jika SketchUp menurunkan permukaan atas, cukup hapus dinding yang berdekatan 
 

Gambar: Push/pull permukaan jalan ke bawah 6˝. 
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Gambar: Hapus permukaan dan garis berlebih di sekitar jalan yang diturunkan. 

Dalam kedua kasus tersebut, jangan hapus geometri yang mendefinisikan tepi jalan 6″ yang 
berdekatan dengan rumput pohon dan jalan setapak. 

Membangun Gedung 

Push/pull area permukaan yang ditetapkan sebagai bangunan. Push/pull tapak bangunan ke 
volume setinggi 13’ 

 

Gambar: Tekan/Tarik untuk membuat volume bangunan. Hapus garis ekstra di face. Buat garis 
di sepanjang bagian atas volume 

Pada permukaan volume bangunan, dua garis vertikal dibuat di mana tepi jalan masuk 
bertemu dengan bangunan. Garis-garis ini akan menghalangi saat Anda membuat atap di 
bagian selanjutnya. Hapus garis-garis ini menggunakan eraser tool. Jangan hapus face 

Membuat Atap 

Buat garis di sepanjang permukaan atas volume bangunan. Gambarkan garis dari titik tengah 
ke titik tengah 

dpoint ke titik tengah. Pilih garis yang digambar dan gunakan alat Pindah/Salin untuk 
mengangkat garis ke atas sepanjang sumbu vertikal (biru). Gunakan tepi bangunan vertikal 
sebagai referensi. Segera masukkan nilai 5 ′ 
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Hal ini akan menyebabkan permukaan atas terlipat mengikuti garis, menirukan atap. 
 
 

Gambar: Gunakan Move/Copy untuk memindahkan garis yang digambar pada permukaan 
atas sepanjang sumbu vertikal untuk melipat permukaan atas untuk membuat atap. 

Push/pull Anak Tangga Dimulai dengan anak tangga terjauh dari bangunan, Push/pull ke atas 
dan masukkan nilai 6 ″. Ini akan membuat anak tangga dengan anak tangga 6″ 

Arahkan kursor ke langkah berikutnya dengan Push/Pull dan klik dua kali. Push/Pull secara 
otomatis akan mengulangi perintah terakhir yang dimasukkan. Kedua anak tangga itu 
sekarang memiliki ketinggian yang sama. Klik dua kali lagi. Ini akan Push/pull face 6 ″ lagi di 
atas langkah pertama 

Ulangi langkah ini untuk permukaan tangga lainnya sampai semuanya 6″ di atas anak tangga 
yang berdekatan, naik ke arah bangunan. 
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Gambar: Push/pull permukaan pertama untuk membuat langkah setinggi 6’ 
 

Gambar: Ulangi Push/Pull pada langkah lainnya. 
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Gambar: Push/pull permukaan dinding setinggi 2’. 

Push/Pull Dinding 

Gunakan push/pull tool untuk menaikkan kedua permukaan yang ditetapkan sebagai dinding 
ke ketinggian 2 kaki. Jalan masuk ke gedung harus diapit oleh dua jilid yang mewakili dinding 

Menambahkan Objek ke Flatwork Base 

Sekarang Flatwork Base sudah lengkap dengan geometri permukaan, warna, dan volume, 
langkah selanjutnya adalah menggabungkan dan mengatur objek ke alas. Seperti disebutkan, 
cara paling efisien untuk mengisi Flatwork Base adalah dengan menggunakan komponen yang 
sudah dibuat sebelumnya. 

Latihan ini akan fokus pada pengisian Flatwork Base dengan komponen (objek) yang sudah 
jadi seperti pohon, lampu pejalan kaki, bangku, mobil, orang, dan semak belukar. Anda dapat 
bereksperimen dan menggabungkan objek lain sesuka Anda. 

Seperti yang telah dibahas sebelumnya, Anda dapat mengunduh komponen yang sudah 
dibuat sebelumnya di sejumlah sumber. Setidaknya, pastikan untuk mengunduh komponen 
gratis dari 3D Warehouse. 
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Gambar: Volume selesai 

Mengorganisir Komponen 

Komponen perlu diimpor, diatur, dan ditempatkan pada layer karena dua alasan: 

 Beberapa komponen, seperti pohon 3D dan semak, terdiri dari banyak tepi dan 
permukaan. Menyalinnya secara massal dapat menghambat kinerja komputer secara 
signifikan. 

 Kemampuan untuk mematikan komponen akan memungkinkan Anda menavigasi 
ruang kerja SketchUp dengan lebih baik. Semakin sedikit geometri yang terlihat, 
semakin lancar SketchUp beroperasi. 

Contoh daftar layer akhir untuk model yang disusun dan terperinci mungkin terlihat 
 

Gambar: Daftar layer akhir model setelah penambahan layer komponen 

Membuat Layer Komponen 

Sebelum mengimpor komponen ke SketchUp, buat layer khusus untuk jenis komponen 
tersebut. Misalnya, jika komponennya adalah pohon 2D, gunakan menu Layer (Layer Default 
tray Window) untuk membuat layer bernama Pohon 2D. Buat layer ini aktif. 

Langkah selanjutnya adalah mengimpor komponen. Ada dua pilihan: 

 Di bawah Impor File, atur ekstensi file ke .skp, dan navigasikan ke lokasi komponen. 
Pilih komponen yang diinginkan 

 Gunakan menu Komponen (Komponen Default tray Window) untuk menavigasi ke 
folder komponen yang diinginkan dan memilih komponen. 

Komponen yang dipilih akan muncul di model dan di layer baru. Ketika sebuah komponen 
disalin, itu akan tetap berada di layer yang sama. 
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Komponen Tool 

Ada banyak alat yang mempengaruhi penempatan, salinan, rotasi, dan skala komponen. 
Daftar berikut adalah ikhtisar singkat dari beberapa alat: 

Move/Copy Seperti banyak alat SketchUp, Pindahkan/Salin memiliki banyak fungsi. 
Ctrl + Alt + klik dan seret untuk membuat salinan dari komponen/geometri yang dipilih. 
Memasukkan nilai (jarak) di measurement window akan menempatkan komponen 
yang disalin pada jarak yang ditentukan jauh dari aslinya. 

Move/Cpy Array - Pindah/Salin Linear memiliki kemampuan untuk membuat banyak 
salinan dalam satu baris. 

Contoh: Untuk menyalin komponen 10’ke segala arah, masukkan 5X di measurement 
window. Empat salinan akan dihasilkan di sepanjang sumbu gerakan yang sama, 
masing-masing berjarak 10’ 

 

Gambar: A Pindahkan/Salin array linier 

Anda dapat mengubah jarak dan nilai dalam contoh ini sesuai kebutuhan. Move/Copy akan 
selalu membuat sejumlah salinan (nilai yang dimasukkan minus 1) berjarak sama satu sama 
lain. Pindahkan/Salin array - Divisi Salin dan tempatkan komponen 40’dari aslinya. Masukkan 
5/(simbol bagi). Empat salinan akan dibuat, dengan jarak yang sama antara kedua komponen. 
Seperti Array - Linear, jarak dan nilai dapat diubah sesuai kebutuhan. 



156 
 

 
 

Gambar: Pindah/Salin Array - Divisi 

Pindahkan/Salin – rotate Perintah Pindahkan/Salin berfungsi ganda sebagai alat Rotate-on- 
Axis. Pilih Pindahkan/Salin dan arahkan kursor ke atas komponen yang dipilih. Tandaxkecil 
berwarna merah akan muncul di sekitar sisi komponen tempat alat berada. Memilih salah 
satuxakan menyebabkan busur derajat berputar kecil muncul, memungkinkan objek diputar 
pada sumbu. 

 

Gambar: Garis bidik Pindah/Salin dan rotasi 

Pelajari cara cepat menemukan garis bidik di berbagai sisi dan bermain dengan fungsi 
Pindahkan/Salin Putar. 

Rotate Tool. Alat Putar (Lihat menu Modifikasi Bilah Alat) memungkinkan Anda memilih dua 
titik rotasi untuk komponen yang dipilih: sumbu tengah dan sudut rotasi. Alat Rotate dapat 
menyusun objek menggunakan perintah yang sama seperti Move/Copy Linear dan Division 
Array 
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Gambar: Alat Putar 

Scale Tool. Alat Skala (View Toolbars Modification menu) memungkinkan komponen 
diperbesar, diperkecil, atau diubah ukuran dan bentuknya. 

Contoh: Pilih komponen dan aktifkan alat Skala. Serangkaian pegangan kotak hijau akan 
muncul di sekitar komponen. Pegang pegangan dan pindahkan masuk dan keluar untuk 
menyesuaikan ukuran dan dimensi komponen 

Komponen dapat diskalakan untuk mempertahankan proporsi dengan hanya menggunakan 
salah satu dari empat pegangan sudut. Anda dapat menskalakannya ke nilai tertentu dengan 
memasukkan nilai setelah pegangan hijau dipilih. Anda juga dapat menggunakan Skala untuk 
membuat gambar cermin yang tepat dari sebuah komponen dengan memilih salah satu 
pegangan dan memasukkan nilai –1. 

Anda harus berlatih komponen penskalaan menggunakan berbagai pegangan dan melihat 
pengaruhnya terhadap ukuran, bentuk, dan proporsi komponen. Selain itu, alat Skala dapat 
digunakan pada permukaan datar. 
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Gambar: Alat Skala 

PathCopy Ini adalah ekstensi khusus yang tersedia secara gratis di Extension warehouse (cari 
PathCopy di Extension warehouse Window). Ini memungkinkan komponen dan grup untuk 
disalin sepanjang busur dan garis nonlinier lainnya. 

Dari menu Extensions, pilih PathCopy. Akan ada dua pilihan: Copy to Path Nodes dan Copy to 
Spacing. Untuk saat ini, pilih Copy to Spacing. Masukkan nilai di measurement window dan 
tekan Enter. Selanjutnya, pilih busur dan kemudian komponennya. Komponen akan disalin di 
sepanjang busur pada interval yang ditentukan 

 
 
 

Gambar: Ekstensi PathCopy dapat menyusun komponen di sepanjang busur. 

Menambahkan Komponen ke dasar Flatwork 

Menggunakan komponen yang diunduh dari 3D Warehouse, tambahkan beberapa detail ke 
Flatwork Base. Pastikan untuk mengimpor setiap jenis objek ke layer yang ditentukan dan 
diberi nama. 

Mulailah dengan menambahkan pohon. Pergi ke Komponen Window. Pilih komponen pohon. 
Tempatkan pohon di area pekarangan pohon yang berdekatan dengan jalan di salah satu 
ujung pekarangan pohon. 

Selanjutnya, gunakan alat Pindahkan/Salin untuk menyusun pohon. Pilih pohon, pilih alat 
Pindahkan/Salin, dan Pindahkan/Salin pohon di sepanjang sumbu hijau dengan Ctrl + klik. 
Masukkan nilai 20’dan tekan Return. Pohon itu akan disalin 20’sepanjang sumbu hijau. 
Masukkan nilai 4X dan tekan Enter. Tiga salinan pohon akan dibuat sepanjang sumbu hijau, 
masing-masing berjarak 20 kaki 
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Gambar: Masukkan komponen Tree ke dalam model. Pindahkan/Salin pohon di halaman 
pohon dengan array linier. 

Jika Anda mengunduh PathCopy, gunakan itu untuk menempatkan empat pohon di sepanjang 
jalan setapak 

 

Gambar: Tambahkan dan susun lampu pejalan kaki di antara pepohonan. 

Selanjutnya, tambahkan lampu pejalan kaki di antara pepohonan. Tempatkan cahaya di antara 
dua pohon (perkiraan). Letakkan tiga lampu lagi ke dalam model di antara pepohonan 
menggunakan perintah Move/Copy. 

Lanjutkan mengimpor lebih banyak detail (seperti bangku, mobil, dan orang) ke tempat 
kejadian. Lakukan eksperimen dengan menggunakan berbagai alat untuk menyesuaikan 
ukuran, rotasi, dan lokasi. Pastikan untuk menempatkan semua jenis komponen pada layer 
yang sesuai. 
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Gambar: Orang, mobil, dan semak ditambahkan. 

 

Gambar: Bangku, garis lalu lintas, tempat sampah, dan kotak surat ditambahkan. 

Menambahkan Komponen Windows dan Pintu 

Fase terakhir dari pengisian model adalah menambahkan detail pada bangunan. 

Pertama, kosongkan ruang pemodelan: matikan semua layer kecuali Layer 0 dan Layer 01 
Flatwork Base 
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Gambar: Matikan layer komponen untuk membersihkan lingkungan kerja. 

Jika beberapa komponen tidak menjadi tidak terlihat, pilih komponen tersebut, klik kanan, 
dan aktifkan Entity Info. Tempatkan komponen pada layer yang benar. Buat layer yang sesuai 
sesuai kebutuhan. Grup Flatwork Base harus menjadi satu-satunya geometri yang terlihat. 

Komponen SketchUp memiliki kemampuan untuk”memotong lubang" pada permukaan. 
Kemampuan ini sangat berguna saat Anda membuat window dengan bahan atau warna 
transparan yang memungkinkan objek atau ruang di sisi lain terlihat. 

Masukkan contoh grup dan perbesar bangunan. Tambahkan detail pada permukaan bangunan 
menggunakan komponen Window dan Pintu. (Anda dapat mengunduh komponen Window 
dan Pintu dari 3D Warehouse.) Pilih komponen Window untuk bangunan tersebut. Tempatkan 
window ke salah satu permukaan vertikal bangunan. Komponen tersebut akan menempel ke 
permukaan dan membuat lubang sehingga terlihat ruang interior bangunan. Jika window 
komponen dihapus, permukaan bangunan akan pulih. 

Dengan menggunakan berbagai komponen Window dan Pintu yang tersedia, tambahkan ke 
permukaan bangunan. Tambahkan komponen pintu yang sejajar dengan anak tangga dan 
pintu masuk. 
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Gambar: Gunakan Move/Copy untuk menempatkan komponen Window pada permukaan 
bangunan. 

 

Gambar: Saat dipasang pada permukaan, komponen Bangunan dapat diskalakan dan 
disesuaikan seperti komponen biasa. 

Menyesuaikan Komponen Bangunan 

Komponen yang ditempatkan pada bangunan dapat diskalakan, disalin, dipindahkan, 
disusun, diputar, dan diedit sama seperti komponen lainnya. 

Pilih komponen Pintu dan sesuaikan ukurannya menggunakan alat Skala. Sesuaikan pintu 
agar sesuai dengan panjang anak tangga. 
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Gambar: Bangunan selesai dengan detail komponen 

Meninjau Model Lengkap 

Nyalakan semua layer dan tinjau modelnya Jika Anda mengikuti buku, Anda membuat model 
dasar dan sederhana, diisi dengan detail yang menentukan karakter ruang luar. Model 
dibuat tanpa bahan referensi apa pun. 

 

Gambar: Tampilan model yang sudah selesai sejajar mata 

Flatwork Base dibuat oleh: 

1. Menyusun dan membagi permukaan pada permukaan 2D 
2. Menambahkan warna pada permukaan yang ditentukan 
3. Memberikan volume dengan Push/Pull 

Objek dimasukkan dengan cara: 

4. Menggunakan komponen untuk merepresentasikan objek 
5. Menyusun objek komponen pada 

Flatwork Base Model ini disusun oleh: 

6. Membuat grup Flatwork Base 
7. Menempatkan grup Flatwork Base pada layernya sendiri 
8. Mengimpor objek komponen langsung ke layer mereka sendiri 

Ini adalah langkah-langkah yang menentukan metode Pemodelan Proses SketchUp. Urutan 
yang sama digunakan untuk membantu membangun model dari berbagai sumber: gambar 
tangan, file Computer Aided Design (AutoCAD), dan saat bekerja dengan Model Elevasi Digital. 
Memahami prinsip-prinsip dasar ini penting untuk mengerjakan sisa buku ini. 

Contoh Tingkat Lanjut 

Gambar contoh ini mengilustrasikan model yang dibuat dengan mengikuti proses yang 
digariskan. Model dibuat dalam waktu kurang dari 30 menit dan menggabungkan detail yang 
kaya, perspektif, dan banyak jenis fitur yang ditemukan di lingkungan binaan. Dengan 
menggunakan proses yang dijelaskan dalam bab ini, coba buat ulang desain. Jangan 
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berkeringat menjadi akurat, tetapi cobalah untuk membuat ulang kerangka dasar, bentuk, dan 
volume sebaik mungkin. 

 

Gambar: Dasar Flatwork disusun dari awal 
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Gambar: Warna ditambahkan ke Draf Flatwork Base. 

Anda dapat mengunduh tiga model yang mewakili tiga tahap dari contoh yang disertakan : 

 Contoh Lanjutan - dasar Flatwork 

 Contoh Tingkat Lanjut – Warna 

 Contoh Lanjutan - Rencana Situs Selesai 

Anda dapat memeriksa kemajuan Anda terhadap model-model ini. Model Rencana Situs yang 
Diselesaikan mencakup komponen objek situs. 
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Gambar: Volume ditambahkan ke permukaan — pekebun, tangga, jalan, jalan setapak, 
bangunan, dan dinding. 

 
 

Gambar: Detail komponen ditambahkan ke Flatwork Base. Komponen diunduh dari Paket 
Bonus 3D Warehouse Google untuk SketchUp 7 dan dari www.formfonts.com. 

 

Memodelkan Desain Anda Sendiri 

Sebelum melanjutkan dengan buku ini, cobalah untuk membuat model asli dari imajinasi Anda 
sendiri menggunakan metode Pemodelan Proses SketchUp. Gunakan materi referensi apa pun 
yang tersedia, seperti denah situs atau gambar Google Earth. Mulailah dari yang kecil dan 
bangun ke area model yang lebih besar, lalu terapkan lebih banyak detail pada lanskap dan 
bangunan. 

Jelajahi berbagai alat yang diuraikan dalam bab ini. Temukan bagaimana Ruby Scripts dapat 
digunakan dengan SketchUp untuk membantu dalam pemodelan. 

Selalu perhatikan layer dan gunakan. Mulailah mengumpulkan component library Anda 
sendiri. 

http://www.formfonts.com/
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BAB 9  

MEMBUAT BANGUNAN 

(CUSTOM SET PERABOTAN) 

SketchUp sangat bagus dalam memungkinkan Anda membuat model struktur yang dibangun, 
Anda dapat menggunakan SketchUp untuk membangun apa saja yang dapat Anda bayangkan. 
Yang Anda butuhkan hanyalah waktu, kecerdikan, dan kemampuan untuk mundur dan 
memecah hal-hal menjadi bagian-bagian dasarnya. SketchUp menyediakan tool yang fantastis 
untuk membuat formulir yang tidak berbentuk kotak, tetapi tool tersebut tidak sejelas 
Push/Pull dan Rectangle, sehingga kebanyakan orang tidak pernah menemukannya. Bab ini 
dikhususkan untuk membantu Anda menemukan sisi”bulat" SketchUp. 

Alasan lain untuk melewati kotak dasar? Banyak orang melihat pencetakan 3D (suara musik 
futuristik dan drive warp yang menarik) sebagai pelopor inovasi manusia berikutnya, dan 
pemodelan 3D - seperti yang Anda lakukan dengan SketchUp - adalah setengah dari 
persamaan itu. Jika Anda akan mencetak helm sepeda dan penyedot debu Anda sendiri dalam 
dekade berikutnya, Anda sebaiknya mahir membuat model bentuk organik. 

Dalam bab ini, Anda akan menemukan tool, teknik, dan tip lain untuk membuat formulir yang 
jelas-jelas tidak mirip bangunan. Harapan kami adalah Anda akan menggunakannya untuk 
mendorong batasan dari apa yang menurut Anda dapat dilakukan SketchUp. 

Ekstrusi dengan Tujuan: Follow Me 

Follow Me mungkin adalah contoh terbaik dari tool SketchUp yang kuat dengan nama yang 
kurang bagus. Ketika perancang perangkat lunak mencoba mencari tahu apa yang harus 
mereka sebut bayi baru mereka, masalah yang mereka hadapi adalah ini: tool ini melakukan 
apa yang program pemodelan 3D lainnya mendedikasikan dua atau tiga tool lain untuk 
dilakukan. Para desainer memilih nama yang tidak konvensional karena Follow Me adalah tool 
yang sepenuhnya tidak konvensional. 

Seperti yang ditunjukkan pada Gambar 9-1, Anda dapat menggunakan Follow Me untuk 
membuat segala macam bentuk: 

 Bottle, spindle, dan spheres: Ini semua adalah contoh bentuk bubut. Anda dapat 
membuatnya dengan memutar profil 2D (bentuk) di sekitar sumbu tengah untuk 
membuat model 3D. 

 Pipes, gutters, and moldings: Jika Anda melihat lebih dekat, ketiga hal ini pada 
dasarnya dibuat dengan mengekstrusi permukaan 2D di sepanjang path 3D; hasilnya 
adalah bentuk 3D yang kompleks. 

 Chamfers, fillet, dan dados: Tanpa menjelaskan apa semua ini (untuk itulah mesin 
telusur Internet), ketahuilah ini: Anda juga dapat menggunakan Follow Me untuk 
memotong profil. 
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Gambar 9-1: Follow Me memungkinkan Anda membuat semua jenis bentuk yang berbeda. 

Penggunaan Follow Me 

Tool Follow Me 

Alat Follow Me adalah alat serbaguna yang memungkinkan Anda membuat bentuk geometris 
kompleks dengan relatif mudah. Ini digunakan secara luas dalam tutorial bab. 

Contoh 1: 

1. Buat kubus 10’× 10’×10’. Di sudut kanan bawah kubus, buat tepi sepanjang 50’dengan 
line tool. Gambarkan tepi sehingga sejajar dengan sumbu inferensi hijau atau merah 

 

 

Gambar: Draf kubus 10´×10´×10´. 

2. Di ujung tepi, tarik dua busur. Cobalah untuk membuat busur bersinggungan dengan 
tepi dan satu sama lain. Tempatkan busur sehingga membentuk jalur yang lebih mulus 
dan berkelanjutan. 

3. Pastikan tepi dan kedua busur”rata" dan sama sekali tidak vertikal. 
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Gambar: Mulai dari kubus, buat konsep tepi sepanjang 50 ′ dan dua busur seperti yang 
ditunjukkan. 

4. Pilih tepi dan dua busur. Dengan ketiganya dipilih, aktifkan Follow Me (View Toolbars 
Modification Follow Me) lalu pilih face pada kubus yang tegak lurus dengan tepi dan 
busur. 

Face kubus akan Push/pull di sepanjang tepi yang dipilih. 
 

Gambar: Pilih tepi dan dua busur. Aktifkan Follow Me dan pilih face yang ditunjukkan di kubus. 
 
 

Gambar: Follow Me akan Push/pull permukaan kubus mengikuti jalur tepi yang dipilih. 

Contoh 2: 

Contoh ini menyertakan langkah-langkah yang umum untuk sebagian besar tutorial dalam bab 
ini. 

1. Dengan menggunakan alat Circle, buat draf permukaan lingkaran berdiameter 20 kaki 
di atas tanah. Pilih face dan tepi lingkaran, klik kanan, dan ubah geometri menjadi 
sebuah komponen (sebut saja Sphere) 
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Gambar: Buatlah sebuah lingkaran berdiameter 20’. Ubah face lingkaran menjadi sebuah 
komponen. 

2. Gunakan alat Pindahkan/Salin untuk memutar lingkaran ke posisi vertikal. Saat Anda 
mengarahkan kursor ke atas komponen dengan alat Pindahkan/Salin, perhatikan 
tanda silang merah kecil yang muncul. 3. Arahkan/Jepret alat Pindahkan/Salin ke salah 
satu garis bidik. Di tengah komponen, lingkaran rotasi akan muncul. Memilih crosshair 
akan memungkinkan Move/Copy memutar komponen. Anda dapat melakukan ini 
untuk sisi horizontal dan vertikal komponen. 

3. Dalam hal ini, sisi vertikal komponen adalah setipis kertas karena tidak memiliki 
volume. Arahkan alat Pindahkan/Salin di atas sisi tepi tipis dari komponen dan tekan 
ke tanda bidik yang muncul. Ini memungkinkan Anda untuk memutar komponen 
secara vertikal. Ini adalah keterampilan yang berguna untuk berlatih, dan Anda harus 
mampu melakukannya agar berhasil menyelesaikan tutorial. 

4. Dalam hal ini, sisi vertikal komponen adalah setipis kertas karena tidak memiliki 
volume. Arahkan alat Pindahkan/Salin di atas sisi tepi tipis dari komponen dan tekan 
ke tanda bidik yang muncul. Ini memungkinkan Anda untuk memutar komponen 
secara vertikal. Ini adalah keterampilan yang berguna untuk berlatih, dan Anda harus 
mampu melakukannya agar berhasil menyelesaikan tutorial. 
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Gambar: Gunakan tool Move/Copy untuk memutar komponen agar berdiri secara vertikal. 
Gunakan tanda bidik merah kecil di sisi komponen untuk menyelesaikan rotasi. (Ukuran 
crosshair dilebih-lebihkan dalam diagram ini.) 

5. Putar komponen lingkaran sehingga berdiri tegak lurus 
 

 

Gambar: Memutar komponen agar berdiri secara vertikal. 

6. Masukkan contoh komponen lingkaran. Di tepi paling bawah lingkaran, buat draf 
lingkaran berdiameter 20 kaki lainnya. Pastikan lingkarannya horizontal. Belajar 
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menyelaraskan dengan alat Lingkaran bisa jadi rumit, tetapi memiliki kesabaran untuk 
mengarahkan lingkaran baru ke bidang horizontal. 

 

Gambar: Masukkan instance komponen Circle dan buat draf lingkaran horizontal lainnya di 
dasar lingkaran vertikal. 

7. Dengan lingkaran bawah di tempat, saat masih dalam contoh komponen, pilih tepi 
lingkaran horizontal, aktifkan alat Follow Me, dan pilih face lingkaran vertikal. 

 

Gambar: Pilih tepi permukaan horizontal, aktifkan Follow Me, dan pilih permukaan 
permukaan vertikal. 

8. Face lingkaran vertikal akan”mengikuti" tepi yang dipilih dari lingkaran horizontal dan 
membuat bola. 
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Gambar: Alat Follow Me akan menyebabkan permukaan lingkaran vertikal mengikuti tepi tepi 
lingkaran horizontal, menghasilkan sebuah bola. 

Meskipun sangat serbaguna, Follow Me bisa menjadi alat yang merepotkan. Ini dapat 
mengalami kesulitan mengekstrusi bentuk yang lebih kompleks dan dapat bekerja secara tidak 
konsisten. Pembuat Profil adalah ekstensi alternatif yang hebat yang akan dibahas di akhir bab 
ini. 

Pada intinya, Follow Me memungkinkan Anda membuat formulir yang merupakan ekstrusi. Ini 
sedikit seperti Push/pull, kecuali bahwa ini tidak hanya bekerja dalam satu arah. Anda 
memberi tahu Follow Me untuk mengikuti suatu jalan, dan itu mengekstrusi face di sepanjang 
jalan itu. Jadi, Anda memerlukan tiga hal untuk menggunakan Follow Me: 

 Path: Di SketchUp, Anda dapat menggunakan edge, atau rangkaian edge apa pun, 
sebagai path. Yang harus Anda lakukan adalah memastikan bahwa gambar tersebut 
sudah diambil sebelum Anda menggunakan Follow Me. 

 Face: Sama seperti dengan Push/Pull, Follow Me membutuhkan face untuk diekstraksi. 
Anda dapat menggunakan face apa pun dalam model Anda, tetapi face harus dibuat 
sebelum Anda mulai menggunakan Follow Me. 

 Undo: Membayangkan seperti apa tampilan 2D sebagai bentuk 3D tidaklah mudah. 
Melakukan operasi Follow Me dengan benar biasanya membutuhkan beberapa kali 
percobaan. Itulah gunanya Undo. 

Ikuti langkah-langkah berikut untuk menggunakan Follow Me; Gambar 6-2 menunjukkan 
contoh dasar cara kerjanya: 

1. Gambarlah face untuk digunakan sebagai profil ekstrusi. Dalam contoh ini, Anda 
membuat pipa, jadi profil ekstrusi adalah face melingkar. 

2. Gambarlah edge (atau tepi) untuk digunakan sebagai path ekstrusi. Meskipun edge 
(atau tepinya) menyentuh face dalam kasus ini, fitur Follow Me tidak harus berfungsi. 

3. Pilih path ekstrusi lengkap yang ingin Anda gunakan. 



174 
 

 
 

4. Aktifkan tool Follow Me dengan memilih Tools => Follow Me. Untuk melihat Follow 
Me di toolbar Anda, pilih Large Tool Set. Pada Windows, pilih View => Toolbars, pilih 
kotak centang Large Tool Set di kotak dialog yang muncul, dan klik Close. Di Mac, pilih 
View => Tool Palettes => Large Tool Set. 

5. Klik face yang ingin Anda ekstrusi. Face Anda (profil ekstrusi) diekstrusi di sepanjang 
path yang Anda pilih pada Langkah 3, membuat bentuk 3D (dalam hal ini, bagian pipa). 

 

 

Gambar Menggunakan Follow Me untuk membuat bentuk ekstrusi sederhana. 

Tip 

Jika Anda ingin menggunakan Follow Me di seluruh perimeter face, Anda tidak perlu 
menghabiskan waktu memilih semua edge individu. Cukup pilih face dan kemudian gunakan 
Follow Me; tool ini secara otomatis bekerja di sekitar face yang dipilih. 

Masalah Teknis 

Anda juga dapat menggunakan Follow Me dengan cara lain: Daripada memilih path 
sebelumnya (seperti pada Langkah 3 dari daftar sebelumnya), Anda dapat mengklik 
sembarang face dengan Follow Me dan mencoba menyeretnya di sepanjang edge dalam 
model Anda. Meskipun metode menyeret ini berfungsi pada hal-hal sederhana, pemilihan 
awal path bekerja jauh lebih baik - ini benar-benar satu-satunya opsi untuk menggunakan 
Follow Me dengan cara yang dapat diprediksi. 

Membuat bentuk bubut seperti bola dan botol dan cerobong asap pembangkit listrik tenaga 
nuklir. 

Sejumlah hal yang mengejutkan dapat dimodelkan dengan menggunakan Follow Me untuk 
melakukan operasi mesin bubut. Mesin bubut adalah tool yang digunakan tukang kayu (dan 
ahli mesin) untuk memutar balok bahan mentah saat mereka mengukirnya - begitulah cara 
pemukul bisbol dibuat (bagaimanapun juga yang bagus). 

Membuat bentuk yang diekstrusi seperti talang dan pegangan tangan 

Sering kali, Anda ingin menggunakan Follow Me untuk membuat geometri (tepi dan 
permukaan) yang dilampirkan ke bagian lain dari model Anda. Contoh dari hal ini mungkin 
memodelkan talang yang mengelilingi atap rumah Anda. Dalam hal ini, Anda sudah memiliki 
jalan setapak yang ingin Anda gunakan untuk mengeluarkan profil (tepi atap). 

Saat Anda menggunakan Follow Me untuk mengekstrusi face di sepanjang path yang terdiri 
dari tepian yang sudah ada sebagai bagian dari model Anda, selalu lakukan dua hal: 
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MENGAPA KOMPUTER ANDA SANGAT LAMBAT 

 
Saat Anda menggunakan Follow Me dengan profil ekstrusi berupa lingkaran atau busur, 
Anda membuat bagian geometri 3D yang sangat besar. Dalam hal ini, besar, berarti 
geometri memiliki banyak sisi, dan sisi inilah yang memperlambat komputer Anda. Tanpa 
menjelaskan secara mendetail tentang cara kerja SketchUp (toh kami tidak benar-benar 
mengetahuinya), ingatlah ini: Semakin banyak face yang Anda miliki dalam model Anda, 
semakin buruk kinerja komputer Anda. Pada titik tertentu, Anda akan berhenti mengorbit, 
Scene Anda akan gagap, dan Anda akan tergoda untuk melakukan sesuatu yang mengerikan 
karena frustrasi. 

Peringatan 

Sebelum menggunakan Follow Me, buat model Anda yang lain menjadi grup terpisah. 
Percayalah pada kata-kata kami - Follow Me terkadang dapat mengacaukan model Anda, jadi 
jaga agar geometri Follow Me tetap terpisah, untuk berjaga-jaga. 

Ingat 

Buat salinan path ekstrusi Anda di luar grup Anda. Ada konsekuensi untuk bekerja dengan 
Follow Me di atas grup: edge (atau tepian) yang ingin Anda gunakan sebagai path ekstrusi 
tidak tersedia karena Anda tidak dapat menggunakan Follow Me dengan path yang ada di grup 
atau komponen terpisah . 

Yang harus dilakukan adalah : Anda perlu membuat salinan path di luar grup dan kemudian 
menggunakan salinan tersebut untuk melakukan operasi Follow Me. Berikut cara terbaik 
untuk membuat salinan path: 

a. Dengan tool Pilih, klik dua kali grup Anda untuk mengeditnya. 

b. Pilih path yang ingin Anda gunakan untuk Follow Me dan kemudian pilih Edit => Salin. 
c. Exhit (berhenti mengedit) grup Anda dengan mengklik di tempat lain di window 

pemodelan Anda. 
d. Pilih Edit ⇒ Tempel di Tempat. Anda memiliki salinan path yang ingin Anda gunakan, 

dan path itu berada di luar grup Anda. 

Masalah Teknis 

Skrip Weld Ruby adalah ekstensi SketchUp yang sangat berguna untuk membuat path ekstrusi 
untuk Follow Me. 

Saat Anda menggunakan edge yang ada (atau rangkaian tepi) sebagai path ekstrusi, bagian 
yang sulit adalah mendapatkan profil Anda di tempat yang tepat. Anda dapat melanjutkan 
dengan dua cara; mana yang Anda pilih bergantung pada apa yang Anda butuhkan untuk 
dimodelkan: 

 Gambarkan profil di tempatnya. Lakukan ini hanya jika path ekstrusi sejajar dengan 
salah satu sumbu gambar berwarna. 

 Gambarkan profil di tanah dan kemudian pindahkan ke posisinya. Jika path ekstrusi 
Anda tidak dimulai secara paralel dengan sumbu gambar berwarna, Anda mungkin 
harus menggambar profil Anda di tempat lain dan memindahkannya ke tempatnya 
nanti. 
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Menggambar profil Anda di tempatnya 

Pertimbangkan bahwa Anda memiliki model rumah. Anda ingin menggunakan Follow Me 
untuk menambahkan selokan yang melewati sekeliling atap. Anda memutuskan untuk 
menggambar profil pada tempatnya (tepat di atas atap itu sendiri) karena edge atap digambar 
sejajar dengan sumbu gambar berwarna. Ini berarti Anda akan lebih mudah menggunakan 
Line Tool untuk menggambar di udara. 

Trik untuk menggambar profil ekstrusi yang tidak berada di atas tanah adalah mulai dengan 
menggambar permukaan persegi panjang. Anda kemudian menggambar profil di face dan 
menghapus sisa persegi panjang lainnya. Gambar 6-6 menunjukkan bagaimana Anda 
menggambar profil selokan langsung di sudut atap; langkah-langkah berikut menjelaskan hal 
yang sama dengan kata-kata: 

Pipa pertama pada gambar berikut telah diekstrusi menggunakan Follow Me; itu dibuat 
dengan lingkaran 24 sisi sebagai profil ekstrusi, dan memiliki 338 face. Hidden geometry 
diaktifkan (di menu Tampilan) sehingga Anda dapat melihat berapa banyak face yang Anda 
miliki. 

 

Pipa kedua menggunakan lingkaran 10 sisi sebagai profil ekstrusi. Hasilnya, hanya ada 116 
face. Sungguh suatu peningkatan! 

 
Pipa ketiga juga menggunakan lingkaran 10 sisi sebagai profil ekstrusi, tetapi busur di path 
ekstrusi hanya terdiri dari 4 segmen, bukan 12 biasa. Pipa ini memiliki total 52 permukaan. 
Bahkan lebih baik. 

 
Gambar kedua pada gambar menunjukkan ketiga pipa dengan Hidden geometry dimatikan. 
Apakah perbedaan detail sebanding dengan peningkatan eksponensial dalam jumlah face? 
Sering kali, jawabannya tidak. 

 
Untuk mengubah jumlah sisi dalam lingkaran atau busur, tepat sebelum atau setelah Anda 
membuatnya, ikuti langkah-langkah berikut: 

 
1. Ketik jumlah sisi yang ingin Anda miliki. 
2. Ketik s untuk memberi tahu SketchUp yang Anda maksud”sisi". 
3. Tekan enter. 
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1. (Zoom In) Perbesar apa yang Anda lakukan. 

Banyak orang mencoba bekerja tanpa mengisi window pemodelan mereka dengan 
subjek yang ada. Tidak melakukannya seperti mencoba mengerjakan teka-teki silang 
sambil melihat ke arah yang salah melalui teropong. Mendekatlah - model SketchUp 
tidak menggigit! 

 

2. Dengan menggunakan Line Tool, gambar persegi panjang yang facenya tegak lurus 
dengan edge yang ingin Anda gunakan untuk Follow Me. 

Perhatikan baik-baik mesin inferensi SketchUp dan perhatikan warnanya untuk 
memastikan Anda menggambar dengan arah yang benar. 

3. Gunakan Line Tool (dan drawing tool SketchUp lainnya) untuk menggambar profil 
Anda langsung pada persegi panjang yang baru saja Anda gambar. 

Tips 

Yang penting di sini adalah memastikan bahwa profil ekstrusi Anda adalah satu face; jika tidak, 
Follow Me tidak akan berfungsi seperti yang Anda inginkan. 

4. Hapus sisa persegi panjang Anda, hanya menyisakan profilnya. 
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Gambar Menggambar profil ekstrusi dengan memulai dengan persegi panjang. 

Menggambar profil Anda di tempat lain 

Hal yang buruk tentang pegangan tangan adalah bahwa pegangan tangan hampir selalu pada 
sudut yang lucu, tidak sejajar dengan sumbu berwarna. Saat menggambar profil ekstrusi Anda 
pada tempatnya tidaklah nyaman, gambarlah di tanah dan pindahkan ke posisinya setelahnya. 

Inilah triknya: Gambarlah ekor - edge pendek - tegak lurus dengan profil ekstrusi Anda. Ekor 
ini membantu Anda menyejajarkan profil Anda dengan edge yang ingin Anda gunakan sebagai 
path ekstrusi untuk Follow Me. Langkah berikut menjelaskan cara Anda menggambar dan 
memosisikan profil untuk pegangan: 

1. Gambarkan profil ekstrusi Anda rata di atas tanah. 
2. Gambarlah edge pendek yang tegak lurus dengan face yang baru saja Anda gambar. 
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Ekor ini harus berasal dari titik di mana Anda ingin profil Anda dilampirkan ke path 
ekstrusi. 

3. Buatlah profil Anda dan ekornya menjadi satu kelompok. 

Ini membuatnya lebih mudah untuk bergerak dan berputar sekaligus 
 

4. Menggunakan Move tool, tempatkan profil Anda di ujung path ekstrusi. 

Untuk memastikan bahwa Anda memposisikan profil Anda secara akurat, ambil 
dengan mengklik titik di mana ekor bertemu dengan face dan kemudian jatuhkan 
dengan mengklik ujung path ekstrusi. 

5. Dengan Rotate tool, putar profil Anda ke posisinya. 

Di sinilah Anda perlu menggunakan sedikit keterampilan. 

6. Konteks-klik grup yang Anda buat pada Langkah 3 dan pilih Explode; hapus ekormu. 
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Gambar Gambar ekor pendek pada profil ekstrusi Anda untuk membantu Anda 
memposisikannya dengan Move toolkan dan Putar 

Mengurangkan dari model dengan Follow Me 

Bagaimana jika Anda ingin membuat model sabun batangan? Atau bantal sofa? Atau apa pun 
yang tidak memiliki edge tajam? Cara terbaik untuk melengkapi tepian di SketchUp adalah 
dengan menggunakan Follow Me. Selain menggunakan Follow Me untuk menambahkan 
model Anda, Anda juga dapat mengurangi model Anda. 

Begini cara kerjanya: Jika Anda menggambar profil ekstrusi di ujung permukaan bentuk 
gondrong, Anda dapat menggunakan Follow Me untuk menghapus setrip materi di sepanjang 
path apa pun yang Anda tentukan. Gambar 6-8 mendemonstrasikan konsep di atas kotak. 

 

 

Gambar Membuat edge bulat dengan Follow Me. 

Tips 
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Jika path ekstrusi yang ingin Anda gunakan untuk operasi Follow Me terdiri dari seluruh 
perimeter face Anda dapat menghemat waktu dengan hanya memilih face daripada semua 
edge yang menentukannya. . 

Tetapi bagaimana jika Anda ingin membuat sudut yang membulat di kedua arah, karena 
banyak sudutnya? Yang itu sedikit lebih sulit untuk dilakukan. Teknik dasarnya melibatkan 
penggunaan Follow Me di sudut yang telah Anda bulatkan dengan tool Push/pull. Setelah 
Anda membelokkan sudut dengan busur dengan radius yang benar, Anda dapat menggunakan 
salinan (atau contoh komponen, jika Anda pintar) dari sudut itu beberapa kali, di mana pun 
Anda membutuhkannya. Meskipun kami tidak akan menyebut solusi ini elegan, itu berhasil. 

kamu membutuhkan mereka. Meskipun kami tidak akan menyebut solusi ini elegan, itu 
berhasil. Sedangkan langkah-langkah berikut menjelaskannya dengan kata-kata, sebagai 
berikut: 

1. Gambar sebuah kotak. 

Kotak harus cukup besar untuk putaran yang ingin Anda terapkan. 
 

2. Dengan arc tool 2 Titik, gambar busur di sudut kotak. 

Saat Anda menggambar busur di sudut, perhatikan inferences yang membantu Anda 
menggambar dengan benar: 

 Setelah mengeklik untuk menempatkan satu titik akhir busur Anda, saat Anda 
memotong melintasi sudut, titik di mana garis Anda berubah menjadi magenta 
adalah tempat titik akhir Anda memiliki jarak yang sama (jarak yang sama) dari 
sudut yang Anda potong. 

 Setelah mengeklik untuk menempatkan titik akhir kedua, Anda akan melihat 
titik di mana busur yang Anda gambar berubah menjadi magenta - ini berarti 
busur Anda bersinggungan dengan (bersambung dengan) kedua edge yang 
terhubung dengannya. Anda ingin kasusnya seperti ini, jadi Anda harus 
mengklik saat Anda melihat magenta. 

Ingat 

Kurangi jumlah sisi pada busur Anda sebelum Anda mulai membulatkan. Lihat bilah 
sisi”Mengapa komputer Anda sangat lambat,” di awal bab ini, untuk mencari tahu 
alasannya. 

3. Push/pull permukaan baru ke bawah untuk membulatkan sudut. 
4. Gambar busur identik lainnya di salah satu sudut yang berbatasan langsung dengan 

sudut yang baru saja Anda bulatkan. 

Di sinilah Anda mengacu pada Gambar 9-9. Gambar lebih baik daripada kata-kata saat 
menjelaskan hal-hal seperti sudut yang berdekatan. 

5. Pilih edge yang ditunjukkan pada Gambar 9-9. 

6. Pilih tool => Follow Me. 
7. Klik face sudut busur untuk mengeluarkannya di sepanjang path yang Anda pilih 

pada Langkah 5. 
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8. Sembunyikan atau ratakan edge yang membutuhkannya. 

 

 

 

Gambar 9-9: Membuat sudut yang membulat di kedua arah. 

Setelah Anda memiliki sudut yang membulat penuh, Anda dapat menggunakan banyak dari 
mereka untuk membuat apapun yang Anda inginkan; ini hanya membutuhkan sedikit 
perencanaan. Gambar 6910 menunjukkan sabun batang sederhana yang dibuat dari delapan 
sudut membulat, disalin, dan dibalik sesuai dengan itu. Teks (jika Anda bertanya-tanya) dibuat 
dengan tool Teks 3D SketchUp, yang dapat Anda temukan di menu tool. 
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Gambar 9-10: Merakit sekumpulan sudut membulat untuk membuat objek relatif mudah. 
 

MENGHALUSKAN EDGE 
 

Jika Anda bertanya-tanya bagaimana cara menghilangkan semua garis jelek yang muncul 
saat Anda menggunakan Follow Me, jawabannya cukup sederhana: Anda dapat 
menghaluskan tepi, seperti Anda dapat menyembunyikannya. Perbedaan antara 
menyembunyikan dan menghaluskan diilustrasikan oleh gambar silinder pada gambar 
berikut: 

 

 Saat Anda menyembunyikan edge di antara dua face, SketchUp memperlakukan 
face tersebut seolah-olah edge Anda masih ada - hanya saja tidak menunjukkan edge 
tersebut. Bahan yang telah Anda terapkan ke setiap face tetap terpisah, dan setiap 
face diterangi secara terpisah oleh matahari SketchUp. Fakta terakhir adalah alasan 
mengapa hanya menyembunyikan edge di antara permukaan yang seharusnya 
mewakili kurva yang mulus tidak membuat semuanya terlihat mulus - Anda tetap 
mendapatkan tampilan segi, seperti yang Anda lihat di silinder kedua. 

 

 Saat Anda menghaluskan tepian di antara dua face, Anda memberi tahu SketchUp 
untuk memperlakukannya sebagai satu face - dengan satu bahan dan bayangan yang 
tampak mulus. Perbedaannya cukup besar, seperti yang Anda lihat pada silinder 
ketiga pada gambar. 

 

Anda dapat menghaluskan edge dengan dua cara: 
 

 Gunakan Penghapus. Untuk menghaluskan edge dengan Eraser Tool, tahan tombol 
Ctrl (Option pada Mac) saat Anda mengklik atau menyeret edge yang ingin Anda 
hilangkan. 

 Gunakan panel Soften Edges. Terletak di menu Window, panel ini memungkinkan 
Anda menghaluskan sekumpulan edge yang dipilih sekaligus, sesuai dengan sudut 
face yang berdekatan. Untuk memulai: Pilih bagian edge yang ingin dihaluskan, lalu 
gerakkan penggeser ke kanan sampai Anda menyukai tampilan model Anda. 



184 
 

 
 
 

Pemodelan dengan Scale Tool 

Pahlawan sejati jarang terlihat jelas. tool Skala adalah satu-satunya anggota yang paling 
disalahpahami dari perangkat terbatas SketchUp. Pemodel baru berasumsi bahwa Scale 
adalah untuk mengubah ukuran berbagai hal dalam model Anda. Itu benar secara teknis, 
tetapi kebanyakan orang hanya menggunakannya untuk mengubah ukuran keseluruhan objek; 
kekuatan Skala yang sebenarnya terjadi ketika Anda menggunakannya pada bagian-bagian 
objek untuk mengubah bentuknya. Gambar 6-11 mengilustrasikan bagaimana Skala dapat 
mengubah bentuk dasar menjadi bentuk yang lebih kompleks. 

 

Untuk tidak mulus tepinya, ikuti langkah-langkah berikut: 
 

1. Pilih View => Hidden Geometry sehingga opsi menu Hidden geometry dipilih. Ini 
membuat edge yang tersembunyi terlihat. 

2. Pilih edge yang ingin Anda hilangkan. 
3. Di panel Soften Edges, gerakkan slider ke kiri. 
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Gambar 9-11: Menggunakan tool Skala pada bagian-bagian objek mengubah bentuknya. 

Memahami Scale 

Prinsip dasar dari teknik ini cukup sederhana: Anda memilih geometri (tepi dan permukaan) 
dalam model Anda yang ingin Anda ubah ukurannya, aktifkan tool Skala, dan pergi ke kota. 

Berikut adalah daftar langkah-langkahnya, agar sangat jelas. Gambar 6-12 menceritakan kisah 
dalam gambar: 

1. Pilih bagian model Anda yang ingin Anda skalakan. 
2. Aktifkan tool Scale dengan memilih Tools => Scale. 

Anda juga dapat mengaktifkan Scale dengan mengklik tombolnya di toolbar atau 
dengan menekan tombol S di keyboard Anda. Setelah Anda mengaktifkan Skala, 
geometri yang Anda pilih pada Langkah 1 harus diapit dalam kotak kubus hijau kecil, 
atau pegangan. 

3. Klik sebuah pegangan dan kemudian gerakkan mouse Anda untuk mulai 
menskalakan geometri yang Anda pilih. 

Teruskan membaca untuk lowdown pada grip yang berbeda. 

4. Saat Anda selesai melakukan penskalaan, klik lagi untuk berhenti. 
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Gambar 9-12: tool Skala mudah digunakan. 

Sementara kita membahas tentang Skala, berikut beberapa hal lagi yang harus Anda ketahui: 

 Gunakan pegangan yang berbeda untuk mengukur dengan cara yang berbeda. 
Pegangan mana (kotak hijau kecil yang muncul saat Anda mengaktifkan tool Skala) 
yang Anda gunakan menentukan bagaimana skala geometri Anda: 

o Corner grips scale proportionally - tidak ada yang terdistorsi saat Anda 
menggunakannya. 

o Edge dan Side mendistorsi geometri Anda saat Anda menskalakan - gunakan 
keduanya untuk menekan skala Anda. 

 Tahan tombol Shift untuk mengatur skala secara proporsional. Ini terjadi secara 
otomatis jika Anda menggunakan salah satu pegangan sudut, tetapi tidak jika Anda 
menggunakan yang lain. Jika Anda tidak ingin mengubah skala Anda, tahan Shift. 

 Tahan tombol Ctrl (Option di Mac) untuk mengatur skala di sekitar pusat pilihan 
Anda. Anda mungkin mendapati diri Anda melakukan ini lebih sering daripada tidak. 

 Ketik faktor penskalaan untuk menskalakan secara akurat. Untuk menskalakan hingga 
50 persen, ketik 0,5. Mengetik 3,57 menskalakan geometri Anda sebesar 357 persen, 
dan mengetik 1.0 tidak akan menskalakannya sama sekali. 

 Ketikkan ukuran tertentu. Jika Anda mengetahui dimensi akhir yang ingin Anda capai 
dengan tool Skala, Anda dapat mengetiknya, diikuti dengan satuannya. Untuk 
menskalakan kotak berukuran 4 kaki hingga lebarnya 10 kaki, ketik 10’. 

 Genggaman mana yang muncul bergantung pada skala yang Anda lakukan. Lihat 
perbedaan pada Gambar 9-13. 

o Sering kali, Anda melihat kotak penskalaan yang dikelilingi oleh 26 pegangan 
hijau. 

o Jika Anda menskalakan geometri koplanar datar (muka dan edge yang 
semuanya terletak pada bidang yang sama) dan bidang tersebut sejajar 
sempurna dengan salah satu bidang utama dalam model Anda, Anda akan 
melihat persegi panjang yang terdiri dari 8 pegangan, bukan kotak dengan 26. 

o Jika yang Anda skalakan adalah Komponen Dinamis, Anda dapat melihat di 
mana saja dari 0 hingga 26 pegangan, tergantung pada cara pembuat 
menyiapkan komponen. 

 Anda tidak dapat membuat salinan saat Anda menskalakan. Move toolkan dan Putar 
memungkinkan Anda membuat salinan dengan menahan tombol di keyboard saat 
Anda menggunakannya, tetapi Skala tidak berfungsi dengan cara ini. Jika Anda perlu 
membuat salinan berskala, coba ini sebagai gantinya: 

o Pilih geometri yang ingin Anda skalakan dan salin, lalu buat menjadi grup. 
o Pilih Edit => Salin dari Menu bar dan kemudian pilih Edit => Tempel di Tempat 

dari Menu bar. 
o Skala grup yang disalin seperti yang Anda lakukan pada hal lain. 
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Gambar 9-13: grid bergantung pada apa yang Anda coba ukur. 

Scaling Profil untuk membuat Organic Form 

Di sinilah hal itu menjadi sangat menarik. Kami perlu berterima kasih kepada über- 
SketchUpper Justin Chin (yang menggunakan pegangan monsterzero online) karena telah 
mendemonstrasikan kekuatan profil penskalaan untuk membuat formulir organik. 
Metodenya bagus karena mudah dipahami dan cukup kuat untuk diterapkan di semua tempat. 

Jadi apakah metode ini? Anda menggunakan tool Skala yang dikombinasikan dengan 
serangkaian profil 2D untuk membuat bentuk 3D yang melengkung, tidak rata, dan jelas tidak 
berbentuk kotak. Banyak sekali benda di alam semesta yang cocok dengan kategori ini: kami, 
Anda, siput, kapal tempur alien antargalaksi, pisang - hampir semua yang tidak dibuat oleh 
mesin dapat dimodelkan menggunakan metode profil berskala pemodelan 3D . 

Menggabungkan Skala dan Push/pull 

Cara termudah untuk menggunakan metode ini terkait dengan Push/Pull. Berikut adalah 
contoh yang sangat sederhana tentang cara kerjanya. Lihat Gambar 9-14 untuk tampilan 
bergambar: 

1. Buat bentuk 2D. 

Tips 

Bentuk ini mungkin sesuatu yang sederhana (seperti lingkaran) atau sesuatu yang lebih 
kompleks; itu semua tergantung pada apa yang Anda coba modelkan. Bentuknya mungkin 
juga setengah bentuk jika yang Anda coba buat menunjukkan simetri bilateral. 

 

2. Push/pull bentuk 2D Anda menjadi bentuk 3D. 
3. Ubah skala face baru yang Anda buat sehingga sedikit lebih besar (atau sedikit lebih 

kecil) dari bentuk 2D asli dari Langkah 1. 
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Gambar 9-14: Menggunakan Skala dan Push/pull bersama adalah cara sederhana untuk 
membuat bentuk organik. 

Lihat bagian sebelumnya dalam bab ini untuk lebih spesifik tentang menggunakan tool Skala. 
Berikan perhatian khusus pada poin-poin tentang penggunaan tombol pengubah, atau tombol 
keyboard, untuk menskalakan secara proporsional atau tentang pusat dari apa yang Anda 
kerjakan. 

1. Push/pull face yang Anda skalakan di langkah sebelumnya. 

Cobalah untuk membuat ekstrusi ini hampir sama dengan yang Anda buat di Langkah 2. 

Tip 

Anda biasanya dapat mengklik dua kali sebuah permukaan dengan push/pull tooluntuk 
mengulangi operasi Push/pull terakhir yang Anda lakukan. 

2. Ulangi Langkah 3 dan 4 hingga Anda selesai. 

Anda dapat menambahkan penggunaan Rotate tool dengan terampil ke dalam campuran jika 
Anda suka; melakukannya memungkinkan Anda untuk melengkungkan dan menekuk formulir 
saat Anda membentuknya. 

Ingatlah hal-hal kecil berikut saat Anda menjelajahi teknik ini: 

 Perhatikan jumlah poligon Anda. Poligon adalah face, pada dasarnya - semakin 
banyak yang Anda miliki, model Anda menjadi”lebih berat", dan semakin buruk 
performanya di komputer Anda. Cobalah untuk meminimalkan jumlah face yang Anda 
kerjakan dengan mengurangi jumlah edge dalam bentuk 2D asli Anda. Lihat bilah 
sisi”Mengapa komputer Anda sangat lambat,” di awal bab ini, untuk keseluruhan 
berita. 

 Jangan takut untuk kembali dan menyesuaikan. Keindahan metode ini adalah 
fleksibilitasnya. Saat Anda bekerja, Anda dapat memilih salah satu profil 2D (bentuk) 
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dalam model Anda dan menggunakan tool Skala untuk menyesuaikannya. Cukup pilih 
lingkaran edge di sepanjang perimeter profil yang ingin Anda skalakan dan ambil dari 
sana. Gambar 6-15 mengilustrasikan contoh bagaimana Anda dapat menyesuaikan 
bentuk dengan penskalaan. 

 

Gambar 9-15: Anda dapat kembali dan menskalakan profil apa pun kapan saja saat Anda 
bekerja. 

Menggabungkan Skala dan Follow Me 

Cara lain untuk membuat formulir yang diekstrusi adalah dengan menggunakan Follow Me. 
(Lihat bagian pertama bab ini jika Anda membutuhkan penyegar.) Teknik ini cocok untuk 
membuat benda yang panjang, melengkung, dan meruncing seperti tentakel dan tanduk; ini 
sedikit memakan waktu, tetapi berfungsi dengan baik. 

Memodelkan tanduk banteng yang disederhanakan adalah ilustrasi yang baik dan langsung 
tentang cara kerja variasi Follow Me dari metode ini. Berikut cara melakukannya; lihat Gambar 
9-16 untuk melihat cerita dalam gambar: 

1. Menggambar lingkaran. 

Ini adalah profil ekstrusi untuk Follow Me. Pertimbangkan dengan baik untuk mengurangi 
jumlah sisi dalam lingkaran Anda dari standar 24 menjadi lebih seperti 10 atau 12. Lihat bilah 
sisi”Mengapa komputer Anda sangat lambat” (di awal bab ini) untuk mencari tahu bagaimana 
dan mengapa Anda harus melakukan ini. 

2. Gambarlah busur 10 sisi yang mulai tegak lurus dengan pusat lingkaran yang Anda 
gambar pada Langkah 1. 

Ketik 10s dan tekan Enter tepat setelah Anda mengklik untuk menyelesaikan menggambar 
busur Anda. Ini memberi tahu SketchUp untuk memastikan busur Anda memiliki 10 sisi (bukan 
default 12). Mengapa 10 sisi? Itu membuat matematika lebih mudah beberapa langkah dari 
sekarang. 

Tip 

Cara termudah untuk membuat busur setengah akurat dalam ruang 3D adalah mulai dengan 
menggambar persegi panjang. Jika Anda yakin persegi panjang ini terletak dengan benar, 
gunakan salah satu arc tool untuk menggambar di atas persegi panjang lalu hapus semuanya 
kecuali busurnya. 

3. Pilih busur yang baru saja Anda gambar. 

Ini adalah path ekstrusi untuk Follow Me. 

4. Aktifkan tool Follow Me dengan memilih Tools => Follow Me dari menu bar. 
5. Klik lingkaran yang Anda gambar pada Langkah 1 untuk mengeluarkannya di 

sepanjang path yang Anda gambar pada Langkah 2. 
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6. Pilih View => Hidden Geometry dari menu bar. 

Menampilkan hidden geometry dalam model Anda memungkinkan Anda memilih edge yang 
secara otomatis dihaluskan (dibuat tersembunyi) saat Anda menggunakan Follow Me di 
Langkah 4. 

7. Skala face di akhir ekstrusi baru Anda dengan faktor 0,1. 

Lihat”Memahami Skala,” di awal bab ini, untuk instruksi tentang bagaimana melakukan ini. 
Gunakan salah satu dari empat penjepit sudut pada kotak penskalaan, dan jangan lupa untuk 
menahan tombol Ctrl (Option pada Mac) saat Anda melakukan penskalaan - ini memaksa 
SketchUp untuk menskalakan bagian tengah face yang Anda ubah ukurannya . 

8. Pilih edge yang menentukan profil di samping terakhir dalam formulir ekstrusi Anda. 

Tips 

Bergantung pada sudut busur Anda, membuat pilihan ini bisa jadi rumit. Berikut beberapa tip 
yang mungkin bisa membantu: 

 Pilih View => Face Style => X-ray or View => Edge Style => Back Edge dari Menu bar 
untuk mempermudah melihat apa yang telah Anda pilih. 

 Tahan tombol Ctrl (Option di Mac) saat Anda mengorbit untuk menonaktifkan”biru 
adalah bias gravitasi naik/turun" SketchUp. Saat mengorbit dengan cara ini, 
cobalah menggambar banyak lingkaran kecil yang rapat dengan mouse Anda agar 
pandangan Anda miring ke arah yang Anda inginkan. Ini sama sekali bukan hal yang 
sederhana, tetapi memahami cara menonaktifkan sementara tool Orbit 
kecenderungan untuk menjaga sumbu biru lurus ke atas dan ke bawah adalah cara 
yang sangat bagus untuk bekerja. Melakukannya akan jauh lebih mudah untuk 
mendapatkan sudut yang tepat untuk membuat pemilihan window. Hal ini pada 
gilirannya membuat pemilihan edge yang menentukan profil jauh lebih mudah, 
dan itulah yang menjadi inti dari menjadi master Zen dari tool Orbit. 

9. Skala edge yang Anda pilih pada langkah sebelumnya dengan faktor 0,2. 

Mulai melihat apa yang terjadi? 

10. Ulangi Langkah 8 dan 9 untuk setiap profil yang tersisa di formulir Anda, tingkatkan 
faktor penskalaan sebesar 0,1 setiap kali. 

Tentu saja, Anda benar-benar dapat memilih untuk memahat bentuk Anda sesuka Anda, 
tetapi metode ini (menghitung sampai persepuluh) menghasilkan lancip yang halus. 

Proyek Santa-Claus-and-reindeer mengilustrasikan jenis model mewah dan tidak berbentuk 
kotak yang dapat Anda buat setelah Anda menguasai tool Skala. Ini bukan materi tingkat 
pemula, tetapi sepadan dengan waktu Anda jika Anda sudah siap. 
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Gambar 9-16: Gunakan Skala dengan Follow Me untuk membuat bentuk panjang dan 
meruncing seperti tanduk banteng ini. 

Membangun Fondasi Solid Tools 

Apa yang disebut operasi pemodelan solid (orang-orang mewah menyebutnya sebagai operasi 
Boolean) memberi Anda kemampuan untuk membuat bentuk yang Anda butuhkan dengan 
menambahkan atau mengurangi bentuk lain ke atau dari satu sama lain. Di beberapa halaman 
berikutnya, Anda akan menemukan cara menggunakan keenam Solid Tools SketchUp Pro, 
memberikan contoh mendetail untuk ketiganya yang paling berguna. 

Ingat! 

Lima dari enam Solid Tools hanya ada di SketchUp versi Pro. Lihat Tabel 9-1 (selanjutnya di 
bab ini) untuk mengetahui apa yang tersedia untuk Anda. 

 

Tabel 9.1 Solid Tool 

Tool Apa yang dilakukan dan bagaimana 
cara menggunakannya 

Dimulai 
dengan 

Diakhiri 
dengan 

Union Apa: Menggabungkan dua atau lebih 
padatan menjadi satu padatan. 
Menghapus geometri yang tumpang 
tindih. Mempertahankan kantong 
internal. 

 

 
*Bagaimana: Pilih padatan yang ingin 
Anda gunakan dan kemudian aktifkan 
alat tersebut. 

Dua + Solid Satu Solid 
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Outer Shell 

 

Apa: Menggabungkan dua atau lebih 
padatan menjadi satu padatan. 
Menghapus geometri yang tumpang 
tindih, termasuk kantong internal. 

 

 
*Bagaimana: sebagai alat Union. 

 

Dua + Solid 

 

Satu Solid 

 

Intersect 

 

Apa: Membuat satu benda padat di mana 
dua atau lebih benda padat saling 
tumpang tindih. Menghapus yang 
lainnya. Caranya: Sama seperti alat 
Union. 

 

Dua + Solid 

 

Satu Solid 

 

Substract 

 

Apa: Menggunakan satu padatan untuk 
memotong bagian dari padatan lainnya. 
Menghapus padatan pertama setelah 
selesai. 

 

 
Caranya: Aktifkan tool, klik”cutting” solid, 
lalu klik solid yang akan dipotong. 

 

Dua Solid 

 

Satu Solid 

 

Trim 

 

Apa: Menggunakan satu padatan untuk 
memotong bagian dari padatan lainnya. 
Menjaga yang tersisa dari kedua benda 
padat. 

 

 
Caranya: Sama seperti alat Kurangi. 

 

Dua Solid 

 

Dua Solid 
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split 

 

Apa: Memotong dua padatan yang 
tumpang tindih dan menciptakan 
padatan baru dari tumpang tindih. Tidak 
menghapus apa pun. 

 

 
Caranya: Sama seperti alat Union. 

 

Dua Solid 

 

Tiga Solid 

 

*Kantong internal seperti benda padat di dalam benda padat - itu adalah volume yang 
benar-benar tertutup yang kebetulan terletak di dalam volume utama benda padat. 
Bayangkan model bola tenis SketchUp. Karena bola tenis memiliki ketebalan, Anda 
memerlukan dua permukaan untuk membuat model satu: satu untuk bagian dalam, dan 
satu untuk bagian luar. Jika Anda memilih keduanya dan membuat grup, Anda akan 
memiliki solid dengan kantong internal di dalamnya. 

 
 

Memahami Solid 

Sebelum Anda dapat menggunakan tool Padat, Anda membutuhkan zat padat. Berikut enam 
hal yang perlu Anda ketahui tentang makanan padat; Anda dapat menganggapnya sebagai 
Aturan Padat: 

 Solid tidak lebih dari sebuah benda yang benar-benar tertutup. Tidak ada lubang atau 
celah lain; jika Anda mengisinya dengan air, tidak ada yang akan bocor. Karena alasan 
ini, benda padat terkadang disebut kedap air. Berikut cara lain untuk memikirkannya: 
Setiap edge yang kokoh harus dibatasi oleh dua sisi. 

 Tepi atau permukaan ekstra tidak diperbolehkan. Anda tidak akan berpikir bahwa 
satu atau dua edge atau permukaan akan membuat banyak perbedaan, tetapi 
kenyataannya - padatan tidak boleh berisi geometri tambahan, titik. Gambar 6-25 
menunjukkan beberapa contoh hal-hal yang dapat mendiskualifikasi bentuk tertutup 
seluruhnya dari menjadi padatan. 

Beberapa ekstensi SketchUp mempermudah untuk mengetahui mengapa grup atau 
komponen tertentu tidak solid. Sebagai permulaan, lihat Solid Inspector2 oleh 
ThomThom. 

 Hanya kelompok dan komponen yang dapat berupa Solid. Yang ini masalah besar. 
Agar SketchUp menyadari sesuatu yang solid, Anda harus membuatnya menjadi grup 
atau komponen terlebih dahulu. Hal lain: Grup dan komponen yang solid tidak boleh 
memiliki grup dan/atau komponen lain yang bersarang di dalamnya. 

 Membuat solid tidak membutuhkan tool khusus. Anda tidak harus memilih dari 
daftar objek khusus untuk membuat benda padat; Anda membuatnya dengan tool 
SketchUp yang sama dengan yang Anda gunakan sepanjang waktu. Contoh kasus: 
Setiap kali Anda mendorong/menarik persegi panjang ke dalam kotak, Anda telah 
membuat solid. 

 Periksa Entity Info untuk melihat apakah objek solid Anda. Cara termudah untuk 
mengetahui apakah sebuah grup atau komponen solid adalah dengan memilihnya dan 



194 
 

memilih Window ⇒ Entity Info. Jika solid, panel ini akan bertuliskan”Grup Padat" 
atau”Komponen Padat". Gambar 6-26 menunjukkan tempat mencarinya. 

 Solid memiliki volume. Menghitung volume bentuk sederhana seperti kotak persegi 
panjang secara manual sangatlah mudah, tetapi cobalah untuk hal yang lebih rumit 
dan Anda akan melihat mengapa pembacaan Volume di Entity Info begitu hebat. 
Gambar 6-26 menunjukkan di mana mencarinya. 

 Masalah Teknis. Padatan bisa dibuat dari berbagai bentuk. Yang ini awalnya 
membingungkan. Selama masing-masing cluster geometri dalam suatu grup atau 
komponen tertutup sepenuhnya, SketchUp menganggap grup atau komponen 
tersebut solid. Tidak masalah bahwa mereka tidak terhubung atau bersentuhan 
dengan cara apa pun; yang penting adalah suatu area dikelilingi oleh face. 

 

 

 

 
Gambar 9-25: Padatan tidak boleh berisi edge atau permukaan ekstra. 
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Gambar 9-26: Periksa panel Entity Info untuk melihat apakah pilihan Anda padat. 

Memeriksa Solid Tools 

Saat Anda memiliki objek atau objek yang solid, Anda dapat menggunakan tool Solid SketchUp 
dengan cara yang ampuh untuk membuat bentuk yang sebaliknya akan sangat rumit dan 
memakan waktu untuk membuatnya. Fo 

 Tambahkan dua padatan untuk membuat yang baru. 

 Gunakan satu benda padat untuk memotong bagian yang lain. 

Tip 

Dengan tool SketchUp Intersect Faces, Anda dapat mencapai banyak hal yang sama seperti 
yang dilakukan Solid Tools. Intersect face membutuhkan waktu lebih lama karena memerlukan 
banyak pembersihan; namun, ini masih berguna karena dua alasan yang sangat penting: Ini 
tersedia di SketchUp versi gratis dan Pro, dan berfungsi pada semua face dalam model Anda - 
tidak hanya pada padatan 

Dua hal yang perlu Anda ketahui sebelum Anda mulai menggunakan Solid Tools: 

 Buka toolbar khusus. Pilih View => Toolbars => Solid Tools untuk membuka toolbar 
yang berisi keenam tool. Anda juga dapat menemukannya di menu tool. Ingatlah 
bahwa lima di antaranya - semua kecuali tool Cangkang Luar - hanya tersedia jika Anda 
memiliki SketchUp Pro. 

 Untuk menggunakan Solid Tools, pilih sebelumnya - atau jangan. Pilih tool yang ingin 
Anda gunakan sebelum atau setelah Anda memberi tahu SketchUp objek padat mana 
yang ingin Anda pengaruhi. Seperti kebanyakan masalah”urutan operasi" (apakah 
Anda mendengarkan, fitur Follow Me?), Ini dapat membingungkan bagi sebagian 
orang. 
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Tips 

Cara termudah untuk menggunakan Solid Tools adalah dengan memilih padatan dan 
kemudian memilih tool untuk menjalankan operasi. Pengecualian yang mencolok untuk 
aturan ini adalah tool Kurangi dan Potong; keduanya sangat bergantung pada urutan 
pemilihan makanan padat Anda. Lihat Tabel 61 untuk lebih spesifik. 

Tanpa basa-basi lagi, berikut Tabel 9-1 dengan ikhtisar Solid Tools. (Lihat Gambar 9-27 untuk 
visualnya.) 

 

 

Gambar 9-27: Solid Tools memungkinkan Anda melakukan operasi pemodelan aditif dan 
subtraktif. 

Tips 

Perhatikan bahwa tool Pemisah sebenarnya melakukan tiga operasi setiap kali Anda 
menggunakannya: tool ini menghasilkan dua pengurangan dan sebuah persimpangan. Artinya, 
menggunakan Split sama seperti menggunakan Subtract dan Intersect pada padatan Anda. 
Karena alasan ini, Anda mungkin ingin menggunakan Split secara penuh. Lebih mudah untuk 
melacak apa yang akan terjadi, dan satu-satunya downside adalah Anda harus menghapus 
beberapa objek tambahan setelah selesai. 
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Menggunakan Solid Tools untuk bekerja 

Di bagian ini, Anda menemukan beberapa contoh tantangan pemodelan sehari-hari yang 
dapat dibantu oleh Solid Tools untuk mengurangi tantangan. Anda hampir pasti akan 
menghadapi situasi sulit ini saat Anda menaiki tangga menuju kesempurnaan SketchUp. 

Merakit objek kompleks dengan Union atau Outer Shell 

Jika semua gable roof, pinggul, atap, dan elemen atap lainnya padat, Anda benar-benar dapat 
menggunakan tool Serikat atau Kerangka Luar SketchUp untuk menyelesaikan masalah 
dengan cepat. 

Hal yang sama berlaku untuk apa pun yang terdiri dari beberapa elemen berbeda yang telah 
Anda susun dengan memindahkannya bersama-sama sampai tumpang tindih. Dalam pesawat 
ruang angkasa pada Gambar 6-28, lambung (atau badan) menggabungkan bagian yang 
berbeda. Perhatikan kurangnya edge tempat komponen berpotongan? Menurut kami tepian 
menambahkan detail dan definisi, terutama saat model ditampilkan menggunakan style hanya 
garis (seperti yang ada di sini). Ada juga masalah semua geometri yang tersembunyi di dalam 
lambung kapal. Menggabungkan semuanya menjadi satu padatan membantunya 
menurunkan berat badan dan terlihat lebih baik, semuanya pada saat yang bersamaan. 

 

Gambar 9-28: Menggunakan Union atau Outer Shell untuk menggabungkan beberapa padatan 
menghilangkan geometri internal dan menambahkan edge di mana permukaan berpotongan. 

Menggunakan Intersect dalam kombinasi dengan tampilan depan, atas, dan samping 

Siapa pun yang pernah mencoba membuat model mobil dengan SketchUp tahu ini pekerjaan 
yang sulit. Masalahnya adalah bahwa mobil (dan sebagian besar kendaraan lain) agak 
melengkung; lebih buruk lagi, mereka melengkung ke beberapa arah. 

Salah satu trik yang digunakan banyak pemodel untuk memblokir bentuk dasar hal-hal seperti 
mobil adalah memulai dengan ortografik - pandangan lurus ke atas, depan, dan samping - dari 
benda yang mereka coba modelkan. Berikut cara kerja metode ini: 

1. Posisikan setiap tampilan 2D di tempatnya dalam ruang 3D. 
2. Push/pull semuanya sehingga ekstrusi mereka tumpang tindih. 
3. Gunakan tool Intersect (Tools => Solid Tools => Intersect) untuk menemukan objek 

yang semua ekstrusi memiliki kesamaan. 

Metode ini tidak selalu memberikan hasil yang sempurna, tetapi jauh lebih baik daripada 
menebak-nebak. Plus, itu menyenangkan. Gambar 6-29 menunjukkan teknik dalam tindakan. 
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Gambar 9-29: Jika Anda memiliki tampilan ortografis dari hal yang Anda coba modelkan, Anda 
dapat menggunakan Intersect untuk memulai sendiri. 

Memodelkan bagian yang pas dengan Trim 

Pekerja kayu dan desainer industri, perhatikan: tool Trim SketchUp Pro benar-benar 
menghemat waktu kerja Anda. Kapan pun Anda perlu membuat model dengan bagian-bagian 
yang saling terkait atau cocok satu sama lain, Trim adalah tempat yang harus Anda lihat 
terlebih dahulu. 

Trim pada dasarnya memberi tahu satu bagian untuk”menggigit" bagian lain, yang sempurna 
untuk bengkel tukang kayu (pas, sambungan jari, dadoes, dan sebagainya), suku cadang mesin, 
sambungan bola-dan-soket, dan kondisi positif/negatif lainnya. dimana dua bagian bertemu. 

Gambar 9-30 menunjukkan bagaimana membuat sebuah kotak kayu kecil dengan sisi-sisi yang 
pas dan dasar yang diratakan. 
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Gambar 9-30: tool Trim sempurna untuk memodelkan bengkel tukang kayu dan bagian pas 
lainnya. 

 

 



200 
 

Ingat! 

Satu-satunya hal rumit tentang menggunakan tool Trim adalah mengingat mana yang harus 
dipilih terlebih dahulu. Ingatlah bahwa hal pertama yang Anda pilih (atau klik) adalah yang 
ingin Anda gunakan untuk memotong. Dalam kasus kotak pada Gambar 6-30, itu akan menjadi 
sisi dengan pas. Saat Anda memilih pas dan kemudian memilih sisi yang kosong, tool Trim akan 
memotong pas menjadi bagian kedua. Anda bisa menguasainya setelah beberapa kali 
mencoba. 

Tips 

Alat Trim memiliki trik rapi: Anda dapat tetap menggunakan cutting solid pada beberapa 
padatan lainnya. Untuk memotong dado (atau alur) ke sisi-sisi kotak pada Gambar 6-30, ikuti 
langkah-langkah berikut: 

1. Pilih Tools => Solid Tools => Trim untuk mengaktifkan tool Trim. 

Kursor Anda memiliki angka 1 di atasnya. 

2. Pilih bagian bawah kotak. 

Kursor Anda berubah untuk menunjukkan angka 2. 

3. Pilih satu sisi di kotak. 

Anda baru saja memotong dado menggunakan bagian bawah kotak yang Anda pilih 
pada Langkah 2. Kursor Anda masih bertuliskan 2. 

4. Pilih sisi kotak lainnya untuk membuat dado lain. 
5. Pilih dua sisi yang tersisa untuk dipotong dadoes di dalamnya juga. 
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BAB 10 

KOMPONEN 

Jika kita berhasil, bab ini akan dimulai dengan kata KOMPONEN dicetak setinggi 4 inci dan 
berwarna hijau neon. Komponen itu penting. 

Membuat komponen atau grup seperti merekatkan geometri dalam model Anda. edge dan 
permukaan yang dikelompokkan bertindak seperti model mini di dalam model utama Anda. 
Anda menggunakan komponen dan grup untuk lebih mudah memilih, memindahkan, 
menyembunyikan, dan sebaliknya bekerja dengan bagian model Anda yang perlu dipisahkan. 
Misalnya, jika model atap rumah merupakan komponen atau kelompok, Anda dapat dengan 
mudah menyembunyikan atau memindahkan atap agar dapat mengintip ke dalam rumah dari 
atas. 

Setelah Anda mengetahui kesamaan komponen dan grup, berikut ini perbedaannya: 

 Grup adalah konglomerasi sederhana dari edge dan face. 

 Komponen pada dasarnya adalah grup dengan keuntungan tambahan yang sangat 
penting: Perubahan yang Anda buat pada satu contoh (salinan) komponen secara 
otomatis berlaku untuk semua contoh komponen lainnya dalam model Anda. Jadi 
ubah satu komponen window, dan Anda mengubah semua contoh di mana komponen 
window itu muncul di model Anda 

Ingat! 

Belajar menggunakan grup dan komponen adalah satu-satunya hal terbesar yang dapat Anda 
lakukan untuk menjadi lebih baik di SketchUp. 

Bab ini membahas tentang membuat dan menggunakan grup dan komponen SketchUp untuk 
membuat hidup Anda jauh lebih sederhana. Kami mulai dengan berbicara tentang grup (yang 
memiliki banyak kesamaan dengan komponen). Setelah itu, kami beralih ke komponen - 
menemukannya, mengelolanya, dan membuatnya sendiri. 

Di bagian terakhir bab ini, Anda mempelajari beberapa teknik pemodelan yang memanfaatkan 
perilaku komponen. Mereka dijamin akan menghemat waktu dan tenaga Anda, dan 
menggunakannya akan membuat Anda merasa seperti bintang rock - setidaknya yang 
membuat model 3D. 

Mengelompokkan Berbagai Hal Bersama 

Geometri SketchUp (tepi dan permukaan yang membentuk model Anda) bersifat lengket. 
Dengan kata lain, hal-hal dalam model Anda ingin tetap berpegang pada hal-hal lain. Orang 
yang menemukan SketchUp sengaja membuatnya dengan cara ini, tetapi juga tahu bahwa 
terkadang Anda juga perlu memisahkan geometri. Cukuplah untuk mengatakan, membuat 
dan menggunakan grup adalah kunci untuk menjaga barang-barang dalam model Anda agar 
tidak saling menempel. Berikut beberapa alasan Anda membuat grup: 

 Geometri yang dikelompokkan tidak melekat pada apa pun. Mungkin Anda telah 
membuat model sebuah bangunan, dan Anda ingin menambahkan atap. Anda ingin 
memindahkan atap dengan Move tool, tetapi setiap kali Anda mencoba, Anda menarik 
bagian atas rumah bersamanya (seperti gambar tengah pada Gambar 5-1). Membuat 
atap menjadi kelompok terpisah memungkinkan atap berada di atas rumah Anda 
tanpa menempel ke dinding, seperti yang ditunjukkan pada gambar kanan pada 
Gambar 5-1. 
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 Menggunakan grup membuat bekerja dengan model Anda lebih mudah. Anda dapat 
memilih semua geometri dalam grup dengan mengkliknya sekali dengan tool Pilih. 
Anda dapat memindahkan grup dan membuat salinan dengan Move toolkan. 

 Anda dapat memberi nama grup. Jika Anda mengubah pilihan geometri menjadi grup, 
Anda dapat memberinya nama. Di Outliner Anda dapat melihat daftar grup (dan 
komponen) dalam model Anda, dan jika Anda telah memberi mereka nama, Anda 
dapat melihat apa yang Anda miliki. 

 Grup bisa jadi solid. Pada dasarnya, padatan adalah setiap kelompok (atau komponen) 
yang geometrinya dapat dianggap kedap air - kontinu, tanpa lubang. Makanan padat 
penting karena dua alasan: 

o Jika sebuah objek berbentuk padat, SketchUp dapat menghitung volumenya. 
Anda dapat melihat volume benda padat di 

o Panel Entity Info. Solid Tools memungkinkan Anda melakukan trik pemodelan 
yang bagus menggunakan dua atau lebih padatan. 

 

 

Gambar 10-1: Membuat atap menjadi satu kelompok berarti atap tersebut tidak akan 
menempel pada bagian bangunan Anda yang lain. 

Ikuti langkah-langkah berikut untuk membuat grup: 

1. Pilih geometri (tepi dan permukaan) yang ingin Anda ubah menjadi grup. Untuk 
bantuan dalam membuat pilihan. 

2. Pilih Edit => Buat Grup. 

Anda juga dapat mengcontext-clicks dan memilih Buat Grup dari menu konteks yang muncul. 

Untuk memisahkan geometri dalam sebuah grup, Anda perlu explodekannya. Konteks-klik 
grup dan pilih Explode dari menu konteks. edge dan permukaan yang dikelompokkan tidak 
lagi dikelompokkan menjadi satu. 

Tip 

Untuk mengedit geometri di dalam grup, klik dua kali dengan tool Pilih. Dalam mode edit, 
model Anda lainnya tampak memudar kembali, dan kotak di sekitar grup (juga dikenal sebagai 
konteks grup) berubah dari garis padat menjadi garis putus-putus. Untuk menutup konteks 
grup setelah Anda selesai mengedit, klik di luarnya, di tempat lain di window pemodelan Anda. 

Bekerja dengan Komponen 

Komponen membuat pemodelan 3D cepat, menyenangkan, dan mudah, dan bagian ini 
menjelaskan semua kemampuan khususnya. Setelah Anda menemukan keajaiban khusus 
komponen, Anda mungkin benar-benar bersemangat mempelajari seluk beluk cara kerja 
komponen: menggunakan fitur di panel Komponen, menjaga komponen tetap teratur, 
membuat komponen Anda sendiri, dan menemukan komponen dinamis yang bergerak saat 
Anda mengkliknya. 
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Apa yang membuat komponen begitu hebat? 

Jika komponennya adalah tim olahraga, kami akan memegang tiket musiman di barisan depan 
dan menghadiri setiap pertandingan dengan mengenakan kaus penggemar dan membawa 
poster buatan sendiri untuk mendukung favorit kami. (Ayo Koleksi Arsitektur!) Inilah alasan 
kami sangat menyukai penggunaan komponen kapan pun Anda bisa: 

 Semua yang benar tentang grup juga benar tentang komponen. Benar: Komponen 
melakukan semua hal yang dilakukan kelompok. Komponen tidak melekat pada model 
Anda lainnya, Anda dapat memberinya nama yang bermakna, dan Anda dapat 
memilihnya, memindahkannya, menyalinnya, dan mengeditnya dengan mudah - 
seperti yang dapat Anda lakukan dengan grup. 

 Komponen diperbarui secara otomatis. Berbeda dengan grup, saat Anda 
menggunakan beberapa salinan (disebut instance) dari komponen yang sama dalam 
model Anda, semuanya terhubung secara seram. Mengubah satu membuat semuanya 
berubah, yang menghemat banyak waktu. Misalnya, pada Gambar 10-2, ketika Aidan 
menambahkan sesuatu (dalam hal ini, window) ke satu contoh komponen windownya, 
semua contoh diperbarui. Setelah Aidan mengubah satu komponen, ketiga window 
memiliki penutup. 

 Panel Komponen memiliki fitur manajemen komponen khusus. Anda dapat 
menggunakan panel Komponen untuk menghitung, memilih, mengganti, dan 
mengelola semua contoh komponen dalam model Anda. (Grup sama sekali tidak 
muncul di panel Komponen.) Gambar 5-3 menunjukkan bangunan dasar dengan 
komponen window. Di pojok kiri bawah tab Statistik panel Komponen, Anda dapat 
melihat ada 18 window. Pada select tab panel Komponen, Anda dapat mengcontext- 
clicks untuk memilih semua window dan menggantinya dengan komponen lain hanya 
dengan beberapa klik. Kami memilih sedan putih. 

 Komponen dapat memotong bukaan secara otomatis. Mungkin Anda telah membuat 
window, dan Anda ingin window itu membuat lubang melalui permukaan apa pun yang 
Anda tempelkan. Pada tab Edit, dijelaskan nanti di bagian ini, Anda dapat mengatur 
komponen SketchUp untuk memotong bukaan mereka sendiri di face. Lebih baik lagi, 
bukaan ini bergantung pada keberadaan komponen; jika Anda menghapus komponen, 
lubangnya menghilang. 

Ingat! 

Komponen yang memotong bukaan hanya dapat dilakukan melalui satu permukaan. 
Jika dinding Anda tebal dua sisi, komponen Anda hanya memotong salah satunya. 

 Anda dapat menggunakan komponen Anda di model lain. Sangat mudah untuk 
membuat komponen apa pun yang Anda buat tersedia untuk digunakan kapan pun 
Anda bekerja di SketchUp, apa pun model yang Anda kerjakan. Jika Anda memiliki 
sekelompok suku cadang atau hal lain yang selalu Anda gunakan, membuat koleksi 
komponen Anda sendiri dapat menghemat banyak waktu dan tenaga. Untuk informasi 
selengkapnya tentang membuat koleksi komponen Anda sendiri, lihat bagian yang 
akan datang,”Select tab". 

 Komponen sangat bagus untuk membuat model simetris. Karena Anda dapat 
membalik instance komponen dan terus mengerjakannya, dan karena instance 
komponen diperbarui secara otomatis saat Anda mengubah salah satunya, 
menggunakan komponen adalah cara yang bagus untuk membuat model apa pun yang 
simetris. Jika Anda melihat sekeliling, Anda akan melihat bahwa kebanyakan hal yang 
digunakan orang simetris. Bagian”Memodelkan secara simetris: Kabar baik bagi orang 
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yang malas" di akhir bab ini membahas pemodelan hal-hal simetris seperti sofa dan 
hatchback; Gambar 5104 menunjukkan contoh. 

 Komponen menjaga ukuran file tetap rendah. Saat Anda menggunakan beberapa 
contoh dari satu komponen, SketchUp harus mengingat informasi hanya untuk salah 
satunya. Artinya, file Anda lebih kecil, yang berarti Anda akan lebih mudah mengirim 
email, mengunggah, dan membukanya di komputer. 

 Komponen ditampilkan di Outliner. Jika Anda tertarik untuk tidak membuang-buang 
waktu mencari hal-hal yang salah tempat, buatlah banyak komponen. Melakukannya 
berarti Anda dapat melihat, menyembunyikan, menampilkan, dan mengaturnya 
kembali di Outliner. 

 Komponen dapat menghemat kewarasan Anda. Anda telah menyelesaikan model 
bandara baru - dan hanya butuh waktu tiga minggu! Sayang sekali konsultan 
pencahayaan alami ingin Anda menambahkan detail kerai ke setiap salah satu dari 
1.300 window di proyek tersebut. Jika Anda menjadikan window itu sebuah komponen, 
Anda emas. Sebaliknya, jika window itu bukan sebuah komponen, Anda akan 
menghabiskan malam yang sangat lama berpegangan tangan dengan mouse komputer 
Anda. 

 Komponen bisa dinamis. Komponen Dinamis adalah komponen dengan kemampuan 
khusus. Mereka dapat diatur dengan berbagai konfigurasi, diajarkan untuk 
menskalakan secara cerdas, diprogram untuk melakukan animasi sederhana, dan 
banyak lagi. Siapa pun dapat menggunakan DC yang ada, tetapi hanya pengguna 
SketchUp Pro yang dapat membuat yang baru. Lihat”Menemukan Komponen Dinamis" 
nanti di bab ini untuk keseluruhan cerita. 

 

 

Gambar 10-2: Mengubah satu instance dari komponen mengubah semua instance lainnya 
juga. 
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Gambar 10-3: Dengan cepat menghitung semua instance window dalam model Anda (atas), 
atau bahkan menukarnya dengan komponen lain. 
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3D WAREHOUSE SKETCHUP 

 

Bayangkan sebuah tempat online tempat semua orang di dunia dapat berbagi model 
SketchUp secara gratis. Singkatnya, itulah 3D Warehouse. Dihosting oleh Trimble 
(perusahaan induk SketchUp), tersedia dalam beberapa bahasa, dan dapat ditelusuri - yang 
merupakan hal yang sangat baik karena penuh sesak dengan model. Jutaan dari mereka. 

 

Anda dapat membuka 3D Warehouse dengan beberapa cara: 
 

 Di web: Cukup ketik http://3dwarehouse.sketchup.com ke dalam browser web 
Anda. 

 Melalui SketchUp: Panel Komponen terhubung langsung ke 3D Warehouse selama 
Anda online. Anda juga dapat membuka 3D Warehouse di window terpisah dengan 
memilih File => 3D Warehouse => Dapatkan Model. 

 
Semua yang ada di 3D Warehouse tersedia untuk Anda unduh dan gunakan dalam model 
Anda sendiri. Anda juga dapat mengunggah apa pun yang Anda buat agar orang lain dapat 
menggunakannya. Cari tahu lebih lanjut tentang berbagi pekerjaan Anda di 3D Warehouse. 

 
 

Gambar 10-4: Apa kesamaan semua hal ini? Keduanya simetris. 
 

 
 

Menjelajahi Component Panel (panel Komponen) 

Panel Komponen memberi Anda tempat untuk menyimpan komponen apa pun yang Anda 
buat. Anda juga dapat mencari komponen yang telah dibuat orang lain, yang merupakan cara 
terbaik untuk menyempurnakan model Anda tanpa membuat semuanya sendiri. 

Anda dapat membawa model SketchUp apa pun di komputer Anda ke dalam file Anda saat ini 
sebagai komponen. Itu karena komponen sebenarnya hanyalah file SketchUp yang 
disematkan di file SketchUp lainnya. Saat Anda membuat komponen dalam model Anda, Anda 
secara efektif membuat file SketchUp bertingkat baru. Rapi, ya? 

http://3dwarehouse.sketchup.com/
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Panel Komponen terdiri dari empat area utama, masing-masing dibahas di bagian berikut. 

Info dan tombol 

Kami tidak benar-benar tahu harus menyebut bagian ini dari panel Komponen, jadi kami 
menyebutnya seperti: Ini untuk informasi dan tombol. Gambar 10-5 menunjukkan elemen- 
elemennya, dan inilah yang dilakukan semua hal: 

 Nama: Nama komponen yang Anda pilih muncul di sini. Jika komponen Anda ada 
dalam model Anda, itu dapat diedit. Jika komponen ada di salah satu koleksi default, 
sebenarnya tidak. Sebuah komponen dianggap ada dalam model Anda jika muncul di 
koleksi Dalam Model, yang dapat Anda baca di bagian berikutnya,”Select tab". 

 Deskripsi: Beberapa, tetapi tidak semua, komponen memiliki deskripsi yang terkait 
dengannya. Anda dapat menulis satu saat Anda membuat komponen baru, atau Anda 
dapat menambahkan satu ke komponen yang ada dalam model Anda. Seperti 
namanya, Anda dapat mengedit deskripsi untuk model hanya di koleksi Dalam Model 
Anda. 

 Tampilkan tombol Panel Pilihan Sekunder: Mengklik tombol ini membuka tampilan 
kedua dari koleksi Anda di bagian bawah panel Komponen. Gunakan tampilan ini untuk 
mengelola komponen di komputer Anda. 
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Gambar 10-5: Panel Komponen sangat bagus. 

Select Tab 

Tab ini adalah tempat tinggal komponen Anda (jika bisa dikatakan ada di mana saja). Gunakan 
select tab untuk melihat, mengatur, dan memilih komponen. Lihat Gambar 5-5 untuk melihat 
tab Select dengan segala kemegahannya. 

 

 In model button: SketchUp secara otomatis melacak komponen yang telah Anda 
gunakan dalam model Anda dan menempatkan salinannya masing-masing dalam 
koleksi Dalam Model Anda. Setiap file SketchUp yang Anda buat memiliki koleksi 
Dalam Modelnya sendiri, yang berisi komponen yang ada dalam model tersebut. 
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Mengklik tombol Model Dalam menampilkan komponen dalam koleksi Dalam Model 
Anda, jika Anda memilikinya. 

 

 
 Collection drop-down menu: Anda membuka menu ini dengan mengklik panah bawah 

di sebelah tombol Model. Komponen yang tercantum di area Favorit pada menu ini 
adalah campuran dari dua jenis koleksi: 

o Local collection adalah folder komponen yang hidup di hard drive Anda. Anda 
dapat mengaksesnya kapan saja karena merujuk ke file di komputer Anda. 

o Online collection adalah pengelompokan komponen yang ada di 3D Warehouse 
(lihat bilah sisi terdekat). Tidak seperti local collection, Anda dapat mengakses 
online collection hanya saat Anda - Anda dapat menebaknya - online. 

Sayangnya, menu tarik-turun Koleksi tidak menunjukkan koleksi mana yang lokal dan 
mana yang online. Jika Anda mengklik nama koleksi dan melihat bilah kemajuan 
sebelum Anda melihat model apa pun, koleksi itu online. 

 

 

 3D warehouse search boxBerfungsi seperti kotak telusur biasa: Ketik apa yang Anda 
cari dan tekan Enter. Model di 3D Warehouse yang cocok dengan istilah penelusuran 
Anda muncul di panel Komponen. Biasanya, Anda harus online agar fitur ini berfungsi. 

 Panel komponen: Panel ini menampilkan komponen dalam koleksi komponen yang 
saat ini dipilih, atau hasil penelusuran 3D Warehouse yang baru saja Anda lakukan. Klik 
sebuah komponen untuk digunakan dalam model Anda. 

 

Tip 

Komponen yang memiliki ikon panah hijau kecil di sebelahnya adalah khusus; mereka adalah 
Komponen Dinamis. Mereka memiliki kemampuan khusus. Anda dapat membaca tentang DC 
nanti di bab ini, di bagian”Menemukan Komponen Dinamis". 

 View options button: Cukup sederhana, sungguh. Di sinilah Anda memutuskan cara 
melihat komponen (atau subkoleksi) di panel Komponen. Anda dapat memilih ukuran 
gambar thumbnail yang berbeda atau tampilan daftar. 

 Collections Detail Menu: Di sinilah Anda mengelola koleksi komponen Anda. Berikut 
pengantar singkat untuk opsi Anda: 

o Buka Local collection: Memungkinkan Anda memilih folder di sistem komputer 
Anda untuk digunakan sebagai koleksi komponen. Semua model SketchUp di 
folder itu muncul di panel Komponen, siap digunakan sebagai komponen di 
model Anda. 

Tip 

Buat Koleksi Baru: Memungkinkan Anda membuat folder di suatu tempat di sistem komputer 
Anda yang dapat Anda gunakan sebagai koleksi komponen. Koleksi berguna jika Anda 
memiliki sejumlah komponen yang Anda gunakan sepanjang waktu; menempatkan semuanya 
di satu tempat akan membuatnya lebih mudah ditemukan. 
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PILIH DAN GANTI SEMUA MASALAH ANDA JAUH 

 

Di atas semua tombol, menu, dan window yang dapat langsung Anda lihat di select tab pada 
panel Komponen, Anda juga dapat menemukan opsi tersembunyi yang tersimpan di menu 
konteks. Menu muncul ketika Anda mengcontext-clicks komponen koleksi Dalam Model: 

 

 Select Instances: Mungkin Anda memiliki 15 instance (salinan) dari komponen yang 
sama dalam model Anda, dan Anda ingin memilih semuanya. Pastikan Anda melihat 
koleksi Dalam Model, lalu context-clicks komponen (di panel Komponen) yang 
instansinya ingin Anda pilih semua. Pilih Select Instances, dan pekerjaan Anda 
selesai. Trik ini dapat menghemat banyak waktu, terutama jika Anda memiliki 
instance komponen di semua tempat. Fitur ini bahkan memilih contoh tersembunyi 
dan yang ada di layer yang dimatikan. 

 Replace Selected: Anda mungkin ingin menukar komponen lain dengan komponen 
yang ada di model Anda. Cukup pilih contoh komponen (di window pemodelan 
Anda) yang ingin Anda ganti dan kemudian context-clicks komponen (di panel 
Komponen) yang ingin Anda gunakan. Pilih Ganti yang Dipilih dari menu konteks 
untuk melakukan pertukaran. 

 Simpan sebagai Local collection: Saat Anda memilih opsi ini, SketchUp memungkinkan 
Anda menyimpan komponen yang saat ini muncul di panel Komponen sebagai local 
collection baru. Jika komponen yang Anda lihat online, salinannya diunduh ke 
komputer Anda. Jika Anda melihat koleksi In Model Anda, konten akan disalin dan 
disertakan dalam folder baru. Jika Anda sudah melihat local collection, opsi ini tidak 
tersedia. 

 Lihat di 3D Warehouse: Jika Anda melihat online collection, opsi ini membuka koleksi 
itu di window terpisah yang menampilkan 3D Warehouse lebih detail. 

 Persyaratan Layanan 3D Warehouse: Pilih opsi ini jika Anda kesulitan tidur. Jika Anda 
bertanya-tanya siapa yang memiliki barang di 3D Warehouse, di sinilah tempatnya. 

 Add to Favourite: Memilih opsi ini menambahkan apa pun yang Anda lihat di panel 
Komponen ke bagian Favorit dari daftar Koleksi. Itu berlaku untuk local collection 
(folder di komputer Anda); online collection (dari 3D Warehouse); dan penelusuran 3D 
Warehouse. Benar - Anda dapat menyimpan penelusuran sebagai koleksi favorit. 
Model dalam koleksi Penelusuran Favorit selalu berbeda, bergantung pada apa yang 
ada di 3D Warehouse. 

Dua opsi berikutnya hanya muncul saat Anda melihat koleksi Dalam Model Anda: 

 Extend: Karena komponen dapat terdiri dari komponen bersarang lainnya, komponen 
yang Anda gunakan dalam model Anda mungkin benar-benar terdiri dari banyak 
komponen. Memilih Perluas menampilkan semua komponen dalam model Anda, baik 
komponen tersebut bersarang di dalam komponen lain atau tidak. Sering kali, Anda 
mungkin ingin membiarkan Perluas tidak dipilih. 

Tip 

Purge Unused: Pilih opsi ini untuk membuang semua komponen di koleksi Dalam Model Anda 
yang sudah tidak ada di model Anda lagi. Pastikan untuk menggunakan ini sebelum Anda 
mengirim file SketchUp Anda ke orang lain; itu secara signifikan mengurangi ukuran file Anda 
dan membuat file jauh lebih rapi. 
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Edit Tab 

Karena opsi di bagian panel Komponen ini serupa dengan yang Anda dapatkan saat membuat 
komponen baru, lihat bagian”Membuat komponen Anda sendiri", nanti di bab ini, untuk 
mengetahui keseluruhannya. 

Tip 

Anda dapat menggunakan opsi di tab Edit hanya pada komponen dalam koleksi Dalam Model 
Anda - semuanya berwarna abu-abu untuk komponen yang ada di tempat lain. 

Statistic Tab 

Ingatkah Anda siapa yang memenangkan Super Bowl 1975? Berapa banyak home run yang 
dicapai Hank Aaron dalam karirnya? Apakah Anda selalu mengecek panel informasi nutrisi 
pada kemasan makanan? Anda mungkin suka statistik, dan jika demikian, selamat datang di 
rumah. 

Meskipun tidak, tab Statistik adalah tempat yang berguna untuk melacak semua detail yang 
terkait dengan komponen apa pun yang telah Anda pilih di panel Komponen. (Lihat Gambar 
10-6.) Tab ini sangat berguna untuk melakukan hal-hal berikut: 

 Memeriksa ukuran komponen Anda: Informasi di area edge dan Face pada tab ini 
memungkinkan Anda mengetahui berapa banyak geometri dalam sebuah komponen. 
Jika Anda khawatir tentang ukuran file atau kinerja komputer Anda, coba gunakan 
komponen kecil - komponen dengan jumlah permukaan dan tepian yang rendah. 

 Melihat komponen apa yang ada di dalam komponen Anda: Baris Contoh Komponen 
mencantumkan berapa banyak contoh komponen dalam komponen yang Anda pilih. 
Jika Anda beralih dari Semua Geometri ke Komponen dalam daftar drop-down di 
bagian atas tab, Anda dapat melihat daftar semua komponen penyusun: 
subkomponen dalam komponen utama Anda. 

Siap untuk tip yang lebih baik? Gunakan Select Instances dan Replace Selected bersama- 
sama untuk membantu Anda bekerja lebih efisien. Alih-alih menempatkan 20 komponen 
pohon yang besar dan berat dalam model Anda (yang dapat memperlambat pekerjaan 
Anda), gunakan komponen yang lebih kecil dan lebih sederhana (seperti tongkat). Saat Anda 
selesai membuat model, gunakan Select Instances untuk memilih semua komponen stand- 
in sekaligus dan kemudian gunakan Replace Selected untuk menukar komponen 
sebenarnya. Gambar 5-3 (di awal bab ini) menunjukkan mekanisme pengoperasian ini, 
meskipun menggunakan window dan mobil. 
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HEMAT WAKTU - PERGI BELANJA 
 
Mengapa menghabiskan berjam-jam memodelkan pohon ek ketika Anda dapat membeli 
yang fantastis dengan harga yang wajar? Jika Anda tidak dapat menemukan yang Anda 
butuhkan di antara jutaan komponen yang dapat Anda unduh secara gratis dari 3D 
Warehouse, cobalah opsi berbayar favorit Aidan. Font Formulir (www.formfonts.com) 
adalah situs web yang menjual komponen”makan sepuasnya, berstyle prasmanan". Anda 
membayar biaya bulanan (yang ternyata sangat rendah), dan Anda memiliki akses ke ribuan 
model berkualitas tinggi apa saja. Tim pemodel internasional Form Fonts bahkan menerima 
permintaan - jika Anda membutuhkan sesuatu yang tidak mereka miliki, mereka mungkin 
dapat membuatnya jika Anda memintanya dengan baik. Meskipun Anda tidak tertarik untuk 

 
 

Gambar 10-6: Tab Statistics dari panel Komponen: Geek out of numbers. 

Tips 

Tab Statistik tidak menampilkan detail untuk komponen yang telah Anda pilih dalam model 
Anda yang sebenarnya; ini hanya menampilkan informasi tentang komponen yang dipilih di 
select tab dari panel Komponen. Untuk melihat informasi tentang komponen apa pun (atau 
jenis objek lain) yang telah Anda pilih di window pemodelan Anda, gunakan panel Entity Info 
(di Default tray). 
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Membuat komponen Anda sendiri 

Membuat komponen sederhana adalah proses yang cukup mudah, tetapi membuat 
komponen yang lebih rumit - komponen yang secara otomatis memotong bukaan, menempel 
ke permukaan, dan selalu menghadap penonton - bisa sedikit lebih rumit. Ikuti langkah- 
langkah berikut, apa pun jenis komponen yang Anda coba buat: 

1. Pilih satu atau lebih entitas yang ingin Anda ubah menjadi komponen. 

Anda dapat memilih tepi, face, gambar, panduan, bidang bagian - bahkan grup dan 
komponen lain. 

2. Pilih Edit => Buat Komponen. 

Kotak dialog Buat Komponen terbuka. (Lihat Gambar 10-7.) 

3. Beri nama dan deskripsi komponen baru Anda. 

Tip 

Dari keduanya, nama adalah yang paling penting. Pilih nama yang memungkinkan Anda 
memahami komponen apa yang ada di Outliner atau saat Anda membuka model setahun dari 
sekarang. 

4. Setel opsi perataan untuk komponen baru Anda. 

Ingin tahu apa artinya semua ini? Lihat Tabel 10-1. 

5. Pilih kotak centang Ganti Pilihan dengan Komponen jika belum dipilih. 

Langkah ini meletakkan komponen baru Anda ke dalam model tepat di tempat 
geometri yang Anda pilih, sehingga Anda tidak perlu memasukkannya dari panel 
Komponen. 

6. Klik tombol Buat untuk membuat komponen baru Anda. 

mendaftar, ada baiknya memeriksa situs web hanya untuk melihat model-model cantik 
yang dibuat oleh Font Formulir. 
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Gambar 10-7: Kotak dialog Buat Komponen. Begitu banyak pilihan. 
 

Opsi Apa yang dialkukan Tips dan Trik 

Glue To Membuat komponen secara 
otomatis menempel pada bidang 
tertentu. Misalnya, kursi hampir 
selalu berada di lantai. Ini hampir 
tidak akan pernah menempel di 
dinding, berputar ke samping. 
Ketika sebuah komponen 
direkatkan ke permukaan, 
menggunakan alat Pindah hanya 
akan memindahkannya pada 
permukaan itu - jangan pernah 
tegak lurus terhadapnya (naik dan 
turun, jika permukaannya adalah 
lantai). 

Gunakan fitur ini untuk objek yang 
Anda ingin tetap berada di 
permukaan tempat Anda 
meletakkannya, terutama objek 
yang ingin Anda atur ulang: 
Furnitur, window, dan pintu adalah 
contoh utama. Jika Anda ingin 
melepaskan komponen yang 
direkatkan dari permukaan 
tertentu, klik konteksnya dan pilih 
Pisahkan dari menu konteks. 

Set Component 
Axess 

Menyetel asal dan orientasi sumbu 
komponen. Opsi ini penting 
terutama jika Anda memiliki 
SketchUp Pro dan berencana 
menjadikan komponen ini menjadi 
Komponen Dinamis. Jika itu bukan 
rencana Anda, Anda dapat 
membiarkan opsi ini dengan aman. 

Klik tombol Set Component Axes 
untuk memilih di mana Anda ingin 
asal sumbu komponen Anda (di 
mana sumbu merah, hijau, dan biru 
bertemu). Klik sekali untuk 
memusatkan sumbu Anda, sekali 
lagi untuk menetapkan arah merah, 
dan sekali lagi untuk menetapkan 
arah hijau dan biru. Jika Anda 
membuat Komponen Dinamis, ini 
adalah sesuatu yang benar-benar 
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  harus Anda ketahui cara 
melakukannya. 

Cut Opening Untuk komponen”dalam" 
permukaan, seperti window, 
centang kotak ini untuk secara 
otomatis memotong bukaan di 
permukaan  tempat Anda 
menempelkan komponen. 

Seperti dengan komponen 
premade, pembukaan ini 
bergantung pada keberadaan 
komponen: Jika Anda menghapus 
instance komponen, bukaan ini 
menghilang.  Jika Anda 
memindahkan instance komponen, 
pembukaannya juga akan bergerak. 

Always Face 
Camera 

Membuat sebuah komponen selalu 
menghadap Anda tidak peduli 
bagaimana Anda mengorbit. Untuk 
membuat komponen 2D Face-Me 
Anda (itulah yang mereka sebut) 
bekerja dengan benar, putar calon 
komponen Anda sehingga tegak 
lurus dengan sumbu hijau model 
Anda sebelum Anda memilih Make 
Component. 

Menggunakan komponen 2D datar 
dan bukan 3D yang rumit adalah 
cara yang bagus untuk memiliki 
banyak orang dan pepohonan 
dalam model Anda tanpa 
mengganggu komputer Anda. 

Shadow Face Sun Tersedia hanya jika kotak centang 
Selalu Kamera Face dipilih. Itu 
dipilih secara default. 

Biarkan kotak centang ini dipilih 
kecuali komponen Face-Me Anda 
memenuhi tanah di dua atau lebih 
tempat terpisah, seperti yang 
ditunjukkan pada Gambar 10-8 

 
 

Tabel 10-1 Opsi Alignment Komponen 
 

Gambar 10-8: Hapus centang pada kotak Shadows Face Sun jika komponen Anda menyentuh 
tanah di lebih dari satu tempat. 
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MEMPERKENALKAN CLASSIFIER 
 

Jika Anda bertanya-tanya apa yang harus dilakukan dengan bagian Jenis dari kotak dialog 
Buat Komponen, Anda tidak sendirian. Menu tarik-turun kecil yang tampak tidak berbahaya 
ini sebenarnya adalah portal ke jiwa metadata SketchUp yang paling dalam, paling gelap, 
dan paling aneh. 

 

Berikut versi singkatnya: SketchUp Pro 2014 memperkenalkan tool baru yang disebut 
Pengklasifikasi. Jika Anda menggunakan Pro, Anda dapat memberi label pada grup dan 
komponen (yang sekarang secara kolektif disebut sebagai objek) dengan informasi tentang 
apa itu. Saat Anda membagikan model Anda dengan orang-orang yang menggunakan 
perangkat lunak BIM (Building Information Modeling) yang canggih, mereka dapat dengan 
lebih mudah mengintegrasikannya ke dalam alur kerja mereka. Anda juga dapat 
menggunakan SketchUp Pro untuk membuat laporan (daftar tabel) dari semua objek dalam 
model Anda, termasuk label yang terkait. 

 
Jenis hanyalah kata lain untuk label. Jika ada sistem klasifikasi (kata teknisnya skema) untuk 
buah, apel, jeruk, dan pisang mungkin ada tiga jenis yang tersedia di sistem itu. SketchUp 
Pro hanya dilengkapi dengan satu skema: IFC 2X3. Jika Anda ingin menggunakan yang lain 
(atau bahkan membuatnya sendiri), Anda bisa, tetapi Anda harus memuatnya terlebih 
dahulu menggunakan panel Klasifikasi dari kotak dialog Model Info. 

 
Detail tentang Pengklasifikasi berada di luar cakupan buku ini karena cara Anda 
menggunakan Pengklasifikasi sangat bergantung pada apa yang Anda gunakan untuk 
SketchUp. 

 
 
 

 

Ingat! 

Komponen hanya dapat memotong satu face dalam satu waktu. Jika dinding model Anda tebal 
dua sisi, Anda harus memotong bukaan window dan pintu secara manual. 

Mengedit, explodekan, dan mengunci instance komponen 

Mengcontext-clicks contoh komponen di window pemodelan Anda membuka menu konteks 
yang menawarkan banyak pilihan berguna. Inilah yang beberapa dari mereka memungkinkan 
Anda lakukan: 

 Edit component: Untuk mengedit semua contoh komponen sekaligus, context-clicks 
sembarang contoh dan pilih Edit component dari menu konteks. Sisa model Anda 
memudar kembali, dan Anda melihat kotak pembatas putus-putus di sekitar 
komponen Anda. Setelah selesai, klik di suatu tempat di luar kotak pembatas untuk 
menyelesaikan pengeditan; perubahan Anda telah dibuat di setiap contoh komponen 
itu dalam model Anda. 

 Make Unique: Terkadang Anda ingin membuat perubahan hanya pada satu atau 
beberapa contoh komponen dalam model Anda. Dalam kasus ini, pilih instance yang 
ingin Anda edit, context-clicks salah satunya, dan pilih Jadikan Unik dari menu konteks. 
Opsi ini mengubah instance yang Anda pilih menjadi komponen terpisah. Sekarang edit 
salah satunya; hanya contoh yang Anda buat unik yang mencerminkan perubahan 
Anda. 
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 Explode: Saat Anda mengexplode sebuah contoh komponen, Anda secara efektif 
mengubahnya kembali menjadi geometri biasa. Explode sangat mirip dengan Ungroup 
di program perangkat lunak lain (di SketchUp, Anda menggunakan Explode untuk 
membongkar komponen dan grup). 

 Lock: Mengunci grup atau contoh komponen berarti tidak ada - termasuk Anda - yang 
dapat mengacaukannya hingga kuncinya dibuka. Kunci bagian model Anda yang tidak 
ingin diubah secara tidak sengaja. Untuk membuka kunci sesuatu, context-clicks dan 
pilih Buka Kunci. 

 

MEMBUAT PINTU DAN WINDOW SENDIRI 
 

Jika Anda jenis kutu buku seperti Aidan, tidak ada yang lebih baik dari membuat komponen 
window dan pintu Anda sendiri. Inilah yang perlu Anda ketahui (lihat ilustrasi di sidebar ini 
untuk petunjuk visual): 

 
1. Gambar persegi panjang pada permukaan vertikal, seperti dinding. 
2. Hapus face yang baru saja Anda buat untuk membuat lubang di permukaan vertikal 

Anda. 
3. Pilih keempat edge lubang yang baru saja Anda buat; lalu context-clicks salah satu 

tepinya dan pilih Make Component dari menu konteks. 
4. Pastikan bahwa Glue to Any, Cut Opening, dan Replace Selection with Component 

semuanya dipilih; kemudian klik tombol Buat untuk membuat komponen baru Anda. 
5. Dengan tool Pilih, klik dua kali komponen baru Anda (di window pemodelan) untuk 

mengeditnya. Model Anda yang lain tampak sedikit memudar. 
6. Gunakan tool pemodelan seperti yang biasa Anda lakukan; terus bangun pintu atau 

window Anda sesuka Anda. 
7. Setelah selesai, klik di luar komponen Anda untuk berhenti mengeditnya. 

 

Jika bukaan yang Anda buat pernah tertutup, salah satu dari dua hal mungkin terjadi: 
 Permukaan baru telah dibuat. Coba hapus permukaan yang menyinggung untuk 

melihat apakah itu memperbaiki sesuatu; biasanya begitu. 

 Batas pemotongan sudah kacau. Batas pemotongan terdiri dari edge yang 
menentukan lubang yang dipotong komponen Anda. Jika Anda menghilangkan 
tepinya, SketchUp tidak tahu lagi harus memotong lubangnya di mana. Menariknya 
kembali biasanya membuat segalanya menjadi lurus. 
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Menemukan Komponen Dinamis 

Dahulu kala, hal paling cerdas yang dapat dilakukan sebuah komponen adalah membuat 
lubangnya sendiri di suatu permukaan.”Wow!" semua penggemar SketchUp 
berpikir,”Komponen sangat jenius!" Dan begitulah - hingga Dynamic Components hadir dalam 
versi 7. 

Sampai versi 7, komponen SketchUp pada dasarnya tidak sepintar sekarang. Jika Anda ingin 
membuat tangga lebih panjang, Anda harus membuat salinan anak tangga dan 
menempatkannya di tempat yang tepat. Jika Anda perlu mengubah warna mobil, Anda harus 
menggali Paint Bucket dan mempelajari geometri. Masalahnya adalah komponen tidak tahu 
apa yang seharusnya mereka wakili; mereka hanyalah pengelompokan face dan edge dalam 
bentuk suatu objek. 

Komponen Dinamis (DC) adalah model yang memiliki gambaran tentang apa itu; mereka tahu 
apa yang harus dilakukan saat Anda berinteraksi dengan mereka. Bagian ini menguraikan apa 
yang direpresentasikan DC untuk pemodel SketchUp dan cara menggunakannya. 

Sebelum Anda mulai bekerja dengan Komponen Dinamis, inilah yang perlu Anda ketahui: 

 DC dapat melakukan segala macam hal. Menjelaskan apa yang dilakukan DC itu rumit 
karena semuanya berbeda. Jawaban sederhana (tetapi sama sekali tidak memuaskan) 
adalah bahwa mereka melakukan apa yang telah diprogram untuk mereka lakukan. 
Gambar 10-9 menunjukkan beberapa contoh, yang dijelaskan dalam daftar berikut: 
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o Komponen pintu dinamis dapat diatur untuk berayun terbuka saat Anda 
mengkliknya dengan tool Interact, yang Anda temukan di toolbar Komponen 
Dinamis. 

o Pintu dinamis yang sama juga dapat dikonfigurasi menjadi berbagai ukuran, 
style, dan penyelesaian dengan menggunakan daftar tarik-turun sederhana di 
kotak dialog Opsi Komponen. 

o Kursi dinamis dapat diubah ukurannya menjadi sofa tetapi tanpa meregangkan 
lengan. Pemrograman dinamis juga akan menambahkan bantalan saat Anda 
membuat komponen lebih panjang. 

 

o Komponen tangga dinamis dapat secara otomatis menambah atau menghapus 
anak tangga saat Anda menggunakan tool Skala untuk membuat tangga lebih 
tinggi atau lebih pendek. 

o Orang kecil yang muncul secara default saat Anda memulai file SketchUp baru 
juga dinamis: Klik kemeja orang tersebut dengan tool Berinteraksi untuk 
melihat berbagai warna. Anda juga dapat mengganti orang default dengan 
karakter lain, dan bajunya juga berubah warna. 

 Siapapun dapat menggunakan DC. SketchUp versi gratis dan Pro dapat membaca dan 
menggunakan Komponen Dinamis. Tim SketchUp menciptakannya (setidaknya 
sebagian) untuk membuat SketchUp lebih mudah dipelajari oleh pemodel baru. 

 Anda membutuhkan Pro untuk membuat DC Anda sendiri. Jika Anda perlu membuat 
Komponen Dinamis Anda sendiri (atau memodifikasi yang telah dibuat oleh orang lain), 
Anda memerlukan salinan SketchUp Pro. 

 DC gratis. Orang-orang menambahkan DC baru ke 3D Warehouse setiap hari. Seperti 
yang dapat Anda bayangkan, perusahaan yang membuat barang-barang seperti 
furnitur dan produk bangunan (window, lemari dapur, dan lantai) sangat senang 
dengan kemungkinan yang ditawarkan DC. Banyak dari mereka sedang dalam proses 
menghasilkan DC dari semua yang ada di katalog mereka dan mempostingnya ke 3D 
Warehouse. Itu kabar baik untuk Anda; segera Anda dapat mengunduh dan 
menggunakan model yang dapat dikonfigurasi dari hampir semua hal yang Anda 
butuhkan. 

 Mereka memiliki ikon khusus. Saat Anda mengunduh SketchUp, Anda akan 
menemukan beberapa contoh DC di panel Komponen. Mereka adalah orang-orang 
dengan ikon dinamis hijau kecil di sampingnya (yang terlihat seperti panah). 
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Gambar 10-9: Komponen Dinamis dapat melakukan segala macam hal 

Menggunakan Komponen Dinamis 

Di SketchUp, Anda dapat berinteraksi dengan Komponen Dinamis dalam tiga cara dasar. 
Bergantung pada apa DC tertentu telah diatur untuk dilakukan, itu mungkin menanggapi satu, 
dua, atau ketiga interaksi berikut. 

SMART SCALING 

DC yang dirancang untuk bereaksi secara cerdas terhadap tool Skala adalah hal yang paling 
mendekati keajaiban sejati yang ditawarkan SketchUp. Alih-alih meregangkan dan menjadi 
terdistorsi saat Anda menskalakannya, bagian yang seharusnya mengubah dimensi, lakukan; 
bagian lain tidak. 

Lihat Gambar 10-10. Gambar tengah menunjukkan apa yang terjadi ketika Anda menskalakan 
komponen window nondinamik untuk membuatnya lebih lebar. Lihat bagaimana bingkai 
membentang? Yuck. Gambar di paling kanan menunjukkan versi dinamis dari window yang 
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sama. Ini menjadi lebih lebar saat Anda menskalakannya, tetapi bingkai tetap memiliki 
ketebalan yang sama. Komponen ini cukup pintar untuk mengetahui bahwa hanya beberapa 
bagian yang akan melebar saat Anda menskalakannya. 

Ada cara lain agar DC dapat menskalakan secara cerdas: dengan menambahkan atau 
mengurangi potongan saat semakin besar atau kecil. Tangga dinamis adalah contoh sempurna 
untuk ini, seperti yang ditunjukkan pada Gambar 10-11. Saat Anda menggunakan tool Scale 
untuk membuat tangga lebih tinggi, tangga menambahkan anak tangga alih-alih peregangan. 

 

Gambar 10-10: Penskalaan window nondinamik (tengah) meregangkan semuanya. Versi DC 
menskalakan dengan benar. 
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Gambar 10-11: Saat Anda membuat tangga lebih tinggi, tangga dinamis ini menambahkan 
anak tangga alih-alih meregang. 

Tip 

Anda dapat mengaktifkan toolbar Komponen Dinamis, yang merupakan cara lebih cepat 
untuk bekerja dengan DC daripada terus menggunakan Menu bar. Cukup pilih View => 
Toolbars => Dynamic Components, dan Anda sudah siap. 

COMPONENT OPTIONS 

Dalam kotak dialog Opsi Komponen, Anda dapat mengkonfigurasi DC yang telah dihubungkan 
ke kotak dialog ini dengan memilih opsi dari daftar turun bawah, mengetik dimensi, dan 
melakukan tugas sederhana lainnya. Untuk membuka kotak dialog, pilih Window => 
Component Options. Saat Anda mengubah setelan di Opsi Komponen, DC yang Anda pilih 
update untuk mencerminkan perubahan tersebut, seperti pemodelan dengan remote control. 

Ingat! 

Kotak dialog Opsi Komponen terlihat berbeda untuk setiap DC. 

Gambar 10-12 menunjukkan daftar drop-down sederhana untuk memilih warna. Namun, 
tangga lurus memungkinkan Anda untuk memilih ketinggian riser dan kedalaman tapak dari 
daftar yang telah diprogram sebelumnya. 
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Gambar 10-12: Kotak dialog Opsi Komponen terlihat berbeda untuk setiap Komponen Dinamis. 

INTERACT TOOL 
 

Aktifkan tool Berinteraksi dengan memilihnya dari menu tool atau menampilkan toolbar 
Komponen Dinamis (Tampilan ⇒ Toolbar). Penggunaan tool ini sangat sederhana: Saat DC 
disiapkan untuk bereaksi terhadap tool Interact, DC akan melakukan hal-hal saat Anda 
mengekliknya. Tindakannya bergantung pada apa yang telah Anda programkan untuk 
dilakukannya. 

Lihat truk pada Gambar 10-13; itu telah dirancang untuk bereaksi terhadap tool Berinteraksi 
dalam beberapa cara: 

 Mengklik bagian belakang siklus truk melalui opsi berikut: kotak, alas datar, atau alas 
datar dengan rel. 

 Mengklik roda depan mengubahnya dari sisi ke sisi. 

 Mengeklik pintu akan membuatnya terbuka dan tertutup. 
 

Gambar 10-13: Mengklik item dengan tool Interact membuat semuanya terjadi. 
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Tip 

Saat Anda mengarahkan kursor ke DC yang telah terhubung ke tool Berinteraksi, kursor Anda 
(awalnya disebut Jari Ajaib) bersinar sedikit kuning di bagian akhir. 

Mengaduk-aduk untuk melihat apa yang terjadi 

Anda tidak dapat mengetahui interaksi mana yang dapat Anda gunakan dengan DC tertentu 
hanya dengan melihatnya. Jika Anda tahu Anda berurusan dengan DC, cara terbaik untuk 
mengetahui fungsinya adalah dengan bereksperimen: 

 Pilih dan buka Component Options untuk melihat apakah ada sesuatu di sana. 

 Arahkan kursor ke atasnya dengan tool Berinteraksi untuk melihat apakah cahaya 
muncul di ujung kursor Anda. 

 Klik dengan tool Pilih untuk menunjukkan pegangan skalanya (kotak hijau kecil). Jika 
ada yang muncul, ambil satu dan skala untuk melihat apa yang terjadi. Jika tidak ada 
yang muncul, DC Anda tidak dapat diskalakan dengan tool Skala. 

Masalah Teknis 

Meskipun mengembangkan komponen dinamis Anda sendiri berada di luar cakupan buku ini, 
SketchUp menyediakan sumber daya online yang bagus untuk membantu Anda memulai. Lihat 
pengantar untuk mengembangkan komponen dinamis di Pusat Bantuan SketchUp 
(http://help.sketchup.com/en/article/3000123) dan koleksi Contoh Fungsi DC tim SketchUp di 
3D Warehouse (https: //3dwarehouse.sketchup .com). 

Memanfaatkan Komponen untuk Membangun Model yang Lebih Baik 

Sejumlah besar benda di galaksi terbuat dari sejenis elemen berulang. Dalam kasus objek 
simetris bilateral (seperti kebanyakan furnitur), elemen itu adalah setengah cermin. Untuk 
hal-hal seperti tangga, itu adalah anak tangga atau tapak. Keseluruhan terdiri dari dua atau 
lebih contoh dari satu bagian. Hal ini membuat pemodelan menjadi jauh lebih mudah karena 
Anda tidak sering harus membuat model secara keseluruhan - terutama jika Anda 
menggunakan komponen. 

Di bagian berikut, Anda menemukan dua metode untuk pemodelan dengan komponen. 
Metode pertama melibatkan objek simetris, dan ini mencakup sekitar 50 persen dari hal-hal 
yang mungkin ingin Anda modelkan. Teknik kedua berlaku untuk hal-hal seperti tangga dan 
pagar, yang keduanya merupakan contoh sempurna mengapa komponen pertama kali 
ditemukan. 

Pemodelan secara simetris: Kabar baik untuk orang malas dan orang pintar juga! 

Pertama, perhatikan baik-baik bentuk benda yang mungkin ingin Anda modelkan. Kemudian 
pikirkan tentang semua benda di alam semesta. Kami akan menunggu beberapa menit 
sementara Anda melakukannya. Selesai begitu cepat? Baik. Segala sesuatu di dunia dapat 
dikategorikan sebagai salah satu dari tipe formal berikut: 

 Simetris: Objek yang menunjukkan simetri bilateral terbuat dari belahan cermin. Anda 
(kurang lebih) simetris bilateral, begitu juga mobil Anda. Jenis simetri lain adalah 
simetri radial. Objek simetris radial dapat (secara konseptual) dipotong menjadi irisan 
identik yang semuanya memancar dari sumbu pusat. Bintang laut adalah contoh yang 
bagus untuk ini, begitu juga dengan payung dan pai apel. Jika Anda akan membuat 
model dari sesuatu yang menunjukkan beberapa bentuk simetri, membangun satu 
bagian dan membuat salinan adalah cara yang lebih cerdas untuk melakukannya. 

http://help.sketchup.com/en/article/3000123)
http://help.sketchup.com/en/article/3000123)
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 Asimetris: Beberapa hal - genangan air, pohon ek, dan banyak rumah - tidak simetris. 
Tidak ada trik nyata untuk membuat hal-hal ini; Anda hanya perlu minum kopi, 
menetap, dan mulai bekerja. 

Anda dapat memanfaatkan simetri bilateral dan radial dengan komponen SketchUp. Untuk 
melakukannya, kumpulkan komponen-komponen itu sebagai berikut, bergantung pada jenis 
simetri objek Anda (lihat juga Gambar 10-14): 

 Simetris bilateral: Untuk membuat model dari sesuatu yang simetris secara bilateral, 
buat setengahnya, buat menjadi sebuah komponen, dan balikkan salinannya. 

 Simetris radial: Anda dapat menggunakan komponen untuk memodelkan hal-hal yang 
simetris secara radial, seperti roda dan menara mobil, dengan membuat irisan tunggal 
dan memutar banyak salinan di sekitar titik pusat. 

 

Gambar 10-14: Simetri bilateral (atas) dan simetri radial (bawah) membuat hidup SketchUp 
Anda jauh lebih mudah. 

Bekerja lebih cerdas dengan membangun hanya setengahnya 

Bentuk-bentuk simetris bilateral ada dimana-mana. Sebagian besar hewan yang dapat Anda 
beri nama, sebagian besar furnitur di rumah Anda, dan helikopter pribadi Anda - semuanya 
dapat dimodelkan dengan membuat setengahnya, membuat komponen, dan membalik 
salinannya. 

Ikuti langkah-langkah berikut untuk mendapatkan gambaran umum tentang bagaimana 
membangun model simetris bilateral di SketchUp (lihat Gambar 10-15): 

1. Buat kotak sederhana. Anda dapat melakukan ini sesuka Anda, tetapi cara termudah 
adalah menggambar persegi panjang dan mendorong/menariknya menjadi 3D. 
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2. Gambarlah edge diagonal di sudut kotak Anda. Inti dari langkah ini adalah untuk 
menandai salah satu sisi kotak Anda sehingga ketika Anda membaliknya, Anda tidak 
bingung tentang sisi mana yang. 

3. Ubah kotak Anda menjadi sebuah komponen. Lihat”Membuat komponen Anda 
sendiri,” di awal bab ini, jika Anda bertanya-tanya bagaimana melakukan ini. 

4. Buat salinan instance komponen baru Anda. 
5. Balik salinannya. Untuk melakukan ini, context-clicks pada salinan dan pilih Balik 

Bersama dari menu konteks. Jika Anda memindahkan salinan Anda ke arah merah di 
langkah sebelumnya, pilih Flip Sepanjang => Komponen Merah. Pilih Komponen Hijau 
jika Anda bergerak ke arah hijau. 

6. Tempelkan kedua bagian kembali. Dengan menggunakan Move tool (kali ini tanpa 
fitur Salin diaktifkan), ambil salinan Anda dari sudut dan pindahkan ke atas, jatuhkan 
di sudut yang sesuai dengan aslinya. Lihatlah gambar terakhir pada Gambar 5-15. Hal 
ini penting dilakukan jika Anda ingin model Anda terlihat benar. 

 

Gambar 10-15: Mempersiapkan untuk membangun model simetris bilateral. 

Sekarang Anda siap untuk mulai membangun secara simetris. Jika mau, Anda dapat melakukan 
tes untuk memastikan semuanya berjalan lancar. (Lihat Gambar 10-16.) Ikuti langkah-langkah 
berikut: 

1. Dengan tool Pilih, klik dua kali salah satu bagian model Anda untuk mengeditnya. 
2. Gambar lingkaran di permukaan atas dan push/pull ke dalam silinder. 

Jika hal yang sama terjadi di sisi lain, Anda sebaiknya pergi. Jika hal yang sama tidak terjadi di 
sisi lain, mungkin saja: 

 Anda tidak benar-benar mengedit salah satu contoh komponen Anda. Jika tidak, Anda 
menggambar di atas komponen, bukan di dalamnya. 

 Anda tahu Anda dalam mode edit jika model Anda yang lain tampak berwarna abu- 
abu. Anda tidak pernah membuat komponen di tempat pertama. Jika bagian Anda 
tidak memiliki kotak biru di sekelilingnya saat Anda memilihnya, itu bukan contoh 
komponen. Mulai file baru dan coba lagi, dengan memberi perhatian khusus pada 
Langkah 3 di langkah sebelumnya. 
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Gambar 10-16: Uji pengaturan Anda untuk memastikan semuanya berfungsi. 
 

MEMBUAT DUA PARUH TAMPAK SEPERTI SATU SELURUH 
 

Perhatikan baik-baik perahu kecil pada gambar berikut, perhatikan bagaimana tepian di 
tengah dengan jelas menunjukkan bahwa perahu itu terbuat dari dua bagian? Jika Anda 
menghapus edge tersebut, seluruh model akan hilang karena edge tersebut menentukan 
face, dan tanpa tepi, face tidak akan ada. 

 

Alih-alih menghapus edge yang tidak diinginkan itu, Anda dapat menyembunyikannya 
dengan menggunakan Eraser sambil menekan tombol Shift. Lihat gambar kedua dan ketiga 
perahu itu? Saat Anda menahan Shift sambil menyeret edge yang ingin Anda sembunyikan 
dengan Penghapus, mereka menghilang. 

 

Ingatlah dua detail penting ini tentang edge tersembunyi: 
 

 Hidden edge tidak hilang selamanya. Sebenarnya, ini berlaku untuk hidden 
geometry apa pun dalam model Anda. Untuk melihat apa yang tersembunyi, pilih 
View => Hidden Geometry. 

 Untuk menyembunyikannya lagi, pilih saja yang sama. Untuk mengedit edge 
tersembunyi, Anda harus membuatnya terlihat. Jika Anda perlu membuat 
perubahan pada model Anda yang melibatkan edge yang telah Anda sembunyikan, 
Anda dapat melihat hidden geometry Anda (lihat titik sebelumnya) atau 
menampilkan semuanya. Cukup tunjukkan hidden geometry Anda, pilih edge yang 
ingin Anda perlihatkan, dan pilih Edit => Unhide => Dipilih. 
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Hal paling keren sejak roti diiris secara radial 

Anda dapat memodelkan objek yang menunjukkan simetri radial semudah yang memiliki 
simetri bilateral. Anda memulai dengan sedikit berbeda. Sebelum Anda mulai, satu-satunya 
hal yang harus Anda putuskan adalah berapa banyak irisan - yaitu, berapa banyak bagian 
identik - yang Anda butuhkan untuk membuat keseluruhan objek. 

Untuk memodelkan sesuatu dengan simetri radial, mulailah dengan satu irisan, buat menjadi 
sebuah komponen, lalu putar salinan di sekitar tengah. Ikuti langkah-langkah berikut untuk 
memahaminya: 

 

1. Dengan tool Poligon, gambar poligon dengan banyak sisi sebanyak jumlah segmen 
yang Anda butuhkan untuk objek yang Anda modelkan. 

Berikut cara termudah untuk menggambar poligon di SketchUp, seperti yang 
ditunjukkan pada Gambar 10-17: 

a. Pilih Tools => Polygon untuk memilih tool Polygon. Anda juga dapat memilihnya 
dari menu Bentuk pada toolbar. 

b. Klik sekali untuk menetapkan pusat (Aidan suka menempatkan pusat pada 
sumbu asal), gerakkan kursor Anda, lalu klik lagi untuk menetapkan radius. 
Jangan khawatir tentang keakuratannya sekarang. 

c. Sebelum Anda melakukan apa pun, ketikkan jumlah sisi yang Anda inginkan 
untuk dimiliki poligon Anda dan tekan Enter. 

2. Gambarkan edge dari tengah poligon Anda ke dua simpul yang berdekatan (titik 
akhir) pada perimeter, buat sebuah irisan. Untuk menemukan pusat poligon (atau 
lingkaran), arahkan kursor Anda ke garis luar selama beberapa detik dan gerakkan 
kursor ke tengah; titik inferences tengah muncul. 

3. Hapus sisa poligon Anda, hanya menyisakan irisannya. Tiga langkah pertama dalam 
daftar ini adalah tentang memastikan baji Anda pada sudut yang benar; jika tidak, 
teknik ini tidak akan berhasil. 

4. Ubah irisan Anda menjadi sebuah komponen. Lihat”Membuat komponen Anda 
sendiri", di awal bab ini, jika Anda tidak yakin tentang cara melakukannya. 

5. Buat salinan instance komponen wedge Anda dengan tool Rotate. (Lihat Gambar 10- 
18.) 

Seperti halnya Move tool, Anda dapat menggunakan Rotate tool untuk membuat 
salinan. Anda bahkan dapat membuat array (lebih dari satu salinan dalam satu waktu). 
Begini caranya: 
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a. Pilih edge irisan Anda (heh, heh) dan pilih facenya juga. 

b. Pilih tool => Putar untuk memilih Rotate tool. 
c. Tekan tombol Ctrl (Option pada Mac) untuk memberi tahu SketchUp Anda ingin 

membuat salinan. Tanda plus (+) muncul di sebelah kursor Anda. 
d. Klik ujung runcing dari irisan Anda untuk mengatur pusat rotasi Anda. 
e. Klik salah satu sudut berlawanan dari baji Anda untuk mengatur titik awal rotasi 

Anda. 
f. Klik sudut lainnya untuk membuat salinan irisan yang diputar. 
g. Ketikkan jumlah irisan tambahan yang Anda inginkan, diikuti dengan huruf x, 

lalu tekan Enter. 
6. (Opsional) Uji penyiapan Anda. 

Ikuti langkah-langkah yang terkait dengan Gambar 10-16 untuk menguji apakah 
pembaruan untuk satu komponen di objek baru Anda memperbarui semua contoh 
komponen. 

 
 

Gambar 10-17: Gambar poligon untuk memulai, gambar dua sisi untuk membuat irisan, dan 
hapus sisa poligon Anda. 

 

Gambar 10-18: Gunakan tool Rotate untuk membuat salinan dari instance komponen wedge 
Anda. 

Ingat! 
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Menyembunyikan tepian dalam contoh komponen Anda membuat model akhir Anda terlihat 
jauh lebih baik. Lihatlah bilah sisi”Membuat dua bagian terlihat seperti satu kesatuan,” di awal 
bab ini, untuk mengetahui caranya. 

Pemodelan dengan elemen berulang 

Tangga adalah contoh sempurna dari sebuah objek yang terdiri dari beberapa elemen identik. 
Jika, saat Anda mendengar frasa”beberapa elemen identik", tanda neon besar dan berkedip 
yang meneriakkan”KOMPONEN!" tidak muncul di kepala Anda, Anda tidak cukup 
menggunakan SketchUp. Di sisi lain, mungkin kita perlu lebih sering keluar 

Contoh berikut menunjukkan dua trik pemodelan SketchUp yang praktis: 

 Menggunakan komponen untuk membuat model lebih efisien 

 Membangun satu set tangga dengan cara paling cerdas 

Metode Treads Are Components melibatkan (Anda dapat menebaknya) membuat setiap 
tapak (langkah) di tangga Anda menjadi instance dari komponen yang sama. Pada dasarnya, 
Anda membangun satu tapak sederhana dengan kedalaman yang tepat, menjadikannya 
sebuah komponen, dan menyalin banyak contoh ke dalam tangga penuh. Karena setiap 
langkah terkait, apa pun yang Anda lakukan pada satu langkah otomatis terjadi pada 
semuanya. Jika Anda tidak tahu apa-apa tentang komponen, sekarang adalah saat yang tepat 
untuk memulai dari awal bab ini. 

Lakukan langkah-langkah berikut untuk membangun tangga menggunakan metode Treads Are 
Components: 

1. Buat model satu langkah, termasuk tapak dan riser. 

Anda dapat membuat langkah yang sangat sederhana pada tahap ini jika Anda mau; 
yang terpenting adalah kedalaman tapak dan ketinggian anak tangga sudah benar. 
Anda bisa mengutak-atik hal lain nanti. Lihat Gambar 10-19. 

2. Buat komponen dari langkah yang baru saja Anda buat. 

Lihat”Membuat komponen Anda sendiri", di awal bab ini, jika Anda membutuhkan 
bantuan. 

3. Pindahkan salinan langkah Anda ke posisinya, di atas yang pertama, seperti yang 
ditunjukkan pada Gambar 10-20. 

4. Ketikkan jumlah total langkah yang Anda inginkan, ketikkan x, lalu tekan Enter. 

Anda membuat larik linier, artinya Anda membuat beberapa salinan secara berkala, 
dengan arah yang sama saat Anda memindahkan salinan pertama. Mengetik 12x 
menghasilkan 12 langkah dengan jarak yang sama dengan langkah pertama dan 
salinannya. Lihat gambar terakhir pada Gambar 10-20. 

5. Dengan tool Pilih, klik dua kali salah satu langkah Anda untuk mengedit semua 
contoh komponen Anda. 

Segala sesuatu selain contoh komponen yang Anda edit sedikit memudar. 

6. Tergila-gila. 

Ini benar-benar bagian yang menyenangkan. Memiliki tangga Anda terdiri dari 
beberapa contoh komponen berarti Anda memiliki semua fleksibilitas untuk membuat 



231 
 

perubahan drastis pada semuanya tanpa harus mengulanginya sendiri. Tambahkan 
nosing (tonjolan di edge depan setiap tapak), stringer (struktur diagonal yang 
mendukung semua langkah Anda), atau bahkan pegangan dengan menjadi kreatif 
dengan cara Anda memodifikasi satu komponen contoh. Gambar 10-21 menunjukkan 
beberapa hal yang dapat Anda lakukan. 

 

 

Gambar 10-19: Buat model satu langkah, pastikan kedalaman dan tingginya akurat. 
 

 
Gambar 10-20: Buat langkah Anda menjadi instance komponen, pindahkan salinan ke posisi 
di atas aslinya, lalu buat array. 
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Gambar 10-21: Sebuah tangga dengan senar samping dan pegangan. Di sebelah kanan, contoh 
komponen tunggal. 
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BAB 11  

CUSTOM SITE PERABOTAN 

 

Komponen serba guna. Mereka bisa berdiri sendiri. Mereka dapat dibalik atau dicerminkan. 
Mereka bisa unik dan terpisah dari komponen induk. Mereka dapat digunakan untuk 
membangun komponen lain. Anda dapat membuat komponen Anda sendiri untuk mengisi 
Flatwork Base dengan perabotan situs kustom. Tutorial dalam bab ini memperkuat teknik 
penyusunan yang telah Anda gunakan untuk membuat perabotan situs kustom dengan cepat 
dan rapi. 

Setiap latihan memperkenalkan alat atau metode baru, yang dikembangkan dari komponen 
sebelumnya, dan mengharuskan Anda menerapkan keterampilan yang Anda pelajari di bab 
sebelumnya. Anda akan menggunakan komponen yang sudah selesai untuk membantu 
mengisi Flatwork Base dari bab sebelumnya. 

Proses Pemodelan 

Proses yang digunakan untuk membuat perabotan situs kustom hampir identik dengan 
langkah-langkah umum yang digunakan dalam Pemodelan Proses SketchUp. Untuk membuat 
komponen kustom, ikuti langkah-langkah berikut: 

1. Buat draf proporsi dan detail dalam denah 2D. 
2. Hapus tepi dan permukaan ekstra. 
3. Ubah sisi dan permukaan yang tersisa menjadi sebuah komponen. 
4. Putar komponen agar berdiri pada sumbu vertikal. 
5. Tambahkan volume dan detail. 
6. Tambahkan warna. 

Saat Anda memodelkan komponen perabotan situs, Anda menerapkan warna terakhir. Ini 
berbeda dari urutan yang Anda gunakan untuk membuat model Flatwork Base. Warna paling 
efektif ditambahkan ke permukaan setelah volume komponen selesai. 

Komponen dalam Komponen 

Komponen dan grup dapat dimodelkan, dibuat, atau ditempatkan di komponen atau grup lain. 
Tidak ada batasan jumlah subkomponen yang dapat dimiliki komponen utama. 
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Gambar: Komponen lampu utama (kiri) dibangun dari banyak subkomponen (kanan). 
 

Gambar: Subkomponen terdiri dari subkomponen lain. 
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Komponen Mirroring 

Alat Skala dapat membuat bayangan cermin (kebalikan) dari geometri yang dipilih. 
Kemampuan ini sangat berguna saat Anda bekerja dengan komponen. Alat serbaguna ini 
memungkinkan Anda membuat bentuk terbalik baru tanpa membuat geometri baru. 

Untuk mencerminkan objek, pilih komponen dan kemudian aktifkan alat Skala. Pilih salah satu 
gagang sudut hijau yang muncul. Dorong pegangan ke dalam pada komponen. Masukkan -1 
di Kotak Kontrol Nilai (measurement window) dan tekan Enter. Komponen akan 
mencerminkan dirinya sendiri ke arah yang berlawanan. 

Arah dan jenis pencerminan yang dicapai ditentukan oleh gagang mana yang digunakan untuk 
membuat cermin. 

Memasukkan -1 ke dalam measurement window memberi tahu SketchUp untuk menskalakan 
objek 100 persen ke arah yang berlawanan (ke dalam), menjaga objek pada skala yang sama 
(ukuran dan proporsi). Memasukkan nilai yang berbeda, baik positif atau negatif, akan 
menskalakan komponen ke proporsi yang berbeda. Misalnya, jika Anda memasukkan 0,75, 
ukuran komponen akan dikurangi sebesar 25 persen. Jika Anda memasukkan 1,25, komponen 
akan diperbesar 25 persen. Hal yang sama juga berlaku jika nilai yang dimasukkan negatif, 
perbedaannya adalah komponen tersebut akan dicerminkan atau dibalik dengan sendirinya. 

 

Gambar: Komponen cermin dan terbalik 
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Gambar: Komponen cermin dan terbalik 

Membuat Komponen Unik 

Untuk mengaktifkan opsi Make Unique, pilih satu komponen atau sekelompok komponen dan 
klik kanan. Memilih Make Unique akan mengubah salah satu komponen yang dipilih menjadi 
jenis komponen baru mereka sendiri, terpisah dari aslinya. 

 

Gambar: Keempat bangku merupakan komponen yang sama. Komponen yang dipilih”dibuat 
unik". 
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Model Organisasi 

Simpan setiap komponen khusus dalam file SketchUp terpisahnya sendiri. Ini menyelesaikan 
dua hal: 

 Ini menyediakan lingkungan pemodelan bebas halangan. Ini penting mengingat ukuran 
kecil dan detail komponen khusus. 

 Sebuah komponen yang disimpan dalam filenya sendiri dapat diimpor ke model situs 
manapun. 

Nama file harus mendeskripsikan komponen untuk memudahkan identifikasi saat mengimpor. 

Tutorial 

Selesaikan setiap tutorial komponen dalam urutan yang disajikan. Saat Anda mengerjakan 
tutorial berikut, ingat tip penting ini: 

 Lakukan semua draf dan pemodelan Anda pada Layer 0. 

 Bekerja secara terpisah mengajukan. 

 Ingatlah untuk sering menyimpan file SketchUp. 

 Sebutkan semua komponen. 

 Pastikan Anda bekerja dalam instans komponen saat mereka dipanggil atau 
dibutuhkan. 

 Gunakan Move/Copy untuk berlatih memutar geometri datar ke posisi vertikal. 
 Bersabarlah saat bekerja dengan alat Follow Me. Jika pertama kali tidak berfungsi 

dengan benar, kembali dan ulangi langkah-langkahnya. 

The Bollard 

Dalam tutorial pertama ini, Anda akan membuat draf garis besar tonggak dan kemudian 
menggunakan Follow Me untuk menghasilkan bentuk tiga dimensi. 

Unduh model: Bollard 

1. Buat draft tonggak pada permukaan persegi panjang 2D. 
2. Draft rusuk tonggak sebagai busur dengan tonjolan 1/4. Pindahkan/Salin dan susun 

busur pertama untuk membuat empat lainnya (5x). 
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3. Hapus permukaan dan tepi yang berlebih. Anda harus memiliki garis 2D tonggak itu. 
Pilih dan buat geometri muka dan garis menjadi sebuah komponen. 

4. Putar komponen sehingga berdiri secara vertikal. Gambarlah sebuah lingkaran di 
komponen instance. Lingkaran harus tegak lurus dengan komponen (horizontal). 
Jepret titik tengah lingkaran ke titik ujung kiri permukaan tonggak. Jepitkan tepi 
lingkaran ke titik akhir tepi kanan dari permukaan tonggak. Pastikan bahwa lingkaran 
digambar dalam komponen instance. 

5. Lingkaran yang ditambahkan pada langkah sebelumnya adalah tepi referensi untuk 
Ikuti Saya. Anda harus memilih kembali tepi lingkaran setiap kali melakukan Ikuti Saya 
di permukaan tonggak. Gunakan alat Follow Me pada face dalam urutan ini: 

a. Face tengah 
b. 1/4 ″ tonjolan 
c. Mendasarkan 

 
 

 

6. Tambahkan warnanya. Buat alasnya hitam dan sebagian besar tonggak merah 
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Lampu Pejalan Kaki 

Tutorial ini mengembangkan model tonggak sebelumnya. Ini mengajarkan Anda bagaimana 
memodelkan lampu pejalan kaki dan warna cat dan bahan untuk bagian tertentu dari bentuk 
segi. 
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Unduh model: Lampu Pejalan Kaki 

1. Buat konsep face. Dimensi seperti yang ditunjukkan pada diagram. 
2. Buat garis besar dan buat komponennya. Putar ke vertikal 
3. Dalam contoh komponen, gambarlah sebuah lingkaran di alasnya. 
4. Gunakan alat Follow Me di bagian muka. Lakukan sirip luar terakhir. 
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5. Tambahkan warna ke face tertentu menggunakan Hidden geometry. Nyalakan Lihat 
Hidden geometry. Di bawah Kamera, pilih Proyeksi Paralel. Dari View Toolbars Views, 
pilih salah satu dari empat tampilan depan, belakang kanan, kiri. Ini akan 
menyejajarkan sumbu tampilan untuk melihat langsung ke cahaya. Geser ke dalam 
bohlam. Menggunakan select tool, letakkan selection box di sekitar bagian tengah bola 
lampu. Biarkan face di bagian atas dan bawah bohlam tidak dipilih. Terapkan warna 
transparan (Transparent_Glass_Bold) ke face yang dipilih. 
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6. Ulangi langkah 5 untuk menambahkan warna pada bagian atas dan bawah bohlam. 
Tambahkan Color_005. Matikan Hidden geometry setelah Anda selesai dengan 
langkah ini. Di bawah Kamera, pilih Perspektif. 

7. Tambahkan warna pada lightfaces lainnya seperti yang ditunjukkan. 
 

 

Modern Bench 

Tutorial Modern Bench akan mendemonstrasikan bagaimana Push/Pull dapat digunakan 
untuk membuat volume yang dikurangi. 

Unduh model: Modern Bench 

1. Gambar volumenya. 
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2. Draf face di permukaan depan seperti yang ditunjukkan pada diagram. Warna hanya 
untuk referensi, untuk menggambarkan face. 

 

3. Push/pull bagian tengah menghadap ke dalam. Jepitkan face ke tepi di sisi berlawanan 
dari volume. Ini akan menyebabkan face tengah menghilang. 

 
 

 
4. Gunakan line tool dan gambar tepi untuk menentukan permukaan tempat duduk atas 

bangku. Pastikan untuk memutar volume. 
5. Tambahkan warna. 
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Bangku Taman 

Dalam contoh ini, Anda akan belajar meniru dan membuat komponen unik sekaligus 
memanfaatkan komponen di dalam komponen. 

Unduh model: Park Bench 

1. Draft tepi di face. 
 

2. Ubah geometri menjadi sebuah komponen. Sebut saja Frame. Tambahkan volume 
seperti yang ditunjukkan. Catatan: jika Tekan/Tarik menyebabkan sisi lain volume 
kehilangan permukaannya, pulihkan permukaan (dalam contoh komponen) dengan 
berpindah dari titik akhir ke titik akhir dengan line tool di sepanjang tepi”hampa". 
Komponen sederhana ini akan digunakan untuk membuat Bingkai Bench. 

 

3. Salin komponen Frame. Lakukan Mirror/Scale dari komponen yang disalin: pilih 
komponen dan aktifkan Scale. Pilih salah satu gagang sudut dan masukkan –1 di 
measurement window. 
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4. Pindahkan/Salin dan jepret ujung kedua komponen Bingkai seperti yang ditunjukkan 
pada diagram. Pilih kedua komponen yang terhubung. Gunakan Move/Copy dan buat 
salinan dari kedua komponen Frame. 

 
 

 

5. Pilih komponen Frame yang disalin. Aktifkan Scale dan cerminkan salinannya. Jepret 
salinan cermin ke ujung komponen sebelumnya seperti yang ditunjukkan. 

 

 

6. Pilih komponen Bingkai kanan atas. Klik kanan dan pilih Make Unique. 
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7. Masukkan instance komponen Frame yang dibuat unik. Gambarkan tepi 1'-6 ″ dari tepi 
atas komponen. Pastikan tepi digambar tegak lurus (tepi warna magenta saat 
digambar). 

 

8. Pilih garis, aktifkan Follow Me, dan pilih face yang berdekatan dengan tepi yang 
digambar. Ini akan membuat sandaran bangku masa depan. 

 

9. Pilih keempat komponen dan jadikan satu komponen yang disebut Bench Support. 
Gunakan Pindahkan/Salin dan putar komponen sehingga vertikal. 
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10. Dalam contoh komponen Bench Support, gambarlah lingkaran berjari-jari 1/2 ″ di 
persimpangan keempat komponen. Ini akan membuat face lingkaran. 

 

 
11. Push/pull permukaan lingkaran 2′-6 ″ ke luar. Keluar dari instance komponen. 

 

 
12. Salin dan tiru Bench Support. Pasang kedua komponen di ujung permukaan lingkaran 

Push/pull. Pilih kedua komponen dan buat menjadi satu komponen bernama Bench 
Frame. Gambarlah tepi dari sudut ujung depan atas ke sudut ujung depan Bingkai 
Bench. 
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13. Di depan dan sejajar dengan komponen Bingkai Kursi, gambarlah volume 6'× 4”x2″. 
Jadikan volume komponen bernama Wood Slat. Pilih titik tengah komponen Wood Slat 
di sisi terjauh dari Bingkai Bench. Pindahkan/Salin dan jepret ke titik tengah tepi yang 
digambar di depan atas langkah sebelumnya. 

 

 

14. Gunakan Move/Copy untuk menyalin komponen Wood Slat ke ujung Bench Frame. 
Selanjutnya, letakkan komponen: ketik 4/untuk membuat tiga salinan Wood Slat 
dengan jarak yang sama. 

 

 

 

15. Salin komponen Wood Slat ke atas sepanjang punggung bangku. Tempatkan 
komponen sedikit di bawah tepi atas bingkai. 
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16. Gunakan Move/Copy untuk memutar komponen Wood Slat agar sejajar sepanjang 
punggung bangku. 

 

17. Salin bagian atas Bilah Kayu ke bawah. 
 
 

 

18. Tambahkan warna. Pilih semua komponen yang menyusun bangku. Klik kanan dan pilih 
Make Component. Sebut saja Park Bench 
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Bangku Penanam Hias 

Bangku Penanam Hias dalam tutorial ini akan terdiri dari beberapa komponen individual. Anda 
akan belajar menggunakan komponen yang dibuat pertama kali sebagai referensi untuk 
membangun objek lainnya yang menyusun penanam. 

Unduh model: Bangku Penanam Hias 

1. Buat konsep tepi pada bagian muka. Buatlah sebuah komponen bernama Pot dan 
putar komponen tersebut vertikal. 

 
 

 
2. Dalam contoh komponen, tambahkan lingkaran di bagian bawah dan gunakan alat 

Ikuti Saya untuk menghasilkan volume Pot. 
3. Pilih bagian atas Pot dan Offset ke dalam 3 ″. Push/pull bagian tengah atas menghadap 

ke bawah 1″ untuk membuat sedikit bibir. 
 
 
 
 

4. Tambahkan warna hijau ke bagian bawah face di bagian atas. Tambahkan warna ke 
sisa Pot. 
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5. Keluar dari contoh komponen dan geser ke bagian bawah Pot. Buat garis di sepanjang 
sumbu tengah dari bagian bawah penanam. Dari titik tengah garis yang dirancang, 
jepret lingkaran keluar dengan radius 4’. Ini akan membuat face melingkar di sekitar 
dasar komponen Pot di luar contoh komponen. 

 

6. Offset face lingkaran ke dalam dalam urutan ini: 4 ″, 1 ″, 4 ″, 1 ″, 4 ″. Hapus permukaan 
di antara 4 sisi face yang dibuat oleh offset 1″ dan hapus sisi dalam (tengah). 

 

 
7. Push/pull masing-masing setinggi 4 ″ muka 2 ″. Jadikan setiap volume menjadi 

komponen yang disebut Slat 1 sampai 3. Pilih ketiga komponen Slat dan buat menjadi 
komponen yang disebut Kursi Bangku. 
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8. Pilih komponen Kursi Bangku dan gerakkan ke atas sepanjang sumbu vertikal 1'-6 ″. 

 

 

9. Di dekat Panci, buat permukaan persegi 2′-6 ″x2′-6 ″. Draf garis luar untuk rel bangku 
di muka seperti yang ditunjukkan. Push/pull permukaan dengan ketebalan 1″. Jadikan 
itu komponen yang disebut Rel Bench. Tambahkan warna. Putar komponen menjadi 
vertikal. 

 

 

10. Pindahkan tampilan ke bagian bawah Pot. Gambarkan garis dari titik akhir tepi di 
bagian bawah Pot yang digambar pada langkah 5. Pastikan garis tersebut memanjang 
sepanjang sumbu yang sama seperti tepi yang ada ke luar melewati Kursi Bangku. Pilih 
titik akhir bawah dari komponen Rail. Pindahkan dan pasang rel ke garis yang digambar. 
Dengan alat Rotate, putar rel agar sejajar dengan garis. Pindahkan komponen Rel di 
sepanjang garis yang digambar sehingga rel mengangkangi Kursi Bangku. 

 

 
11. Putar/Salin rel di sepanjang titik tengah sisi bawah. Pilih rel dan aktifkan alat Putar. 

Pilih bagian tengah bagian bawah Pot (titik tengah dari tepi yang ditarik melintasi 
bagian bawah) untuk titik rotasi pertama. Pilih tepi bawah luar (terjauh) dari rel. Ini 
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adalah titik rotasi kedua. Tahan tombol Ctrl (untuk membuat salinan rel) dan putar rel 
45 derajat. Masukkan nilai 45 di measurement window. 

 

 
12. Segera setelah Rotate/Copy pertama, masukkan 7x untuk membuat enam duplikat, 

masing-masing diputar 45 derajat. 
 

 

13. Impor pohon 3D. Tempatkan di tengah penanam. Ubah skala pohon ke ukuran yang 
sesuai, seperti yang ditunjukkan pada diagram. Pilih semua komponen dan buat satu 
komponen bernama Decorative Planter Bench. 
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Rel Dekorasi 

Tutorial ini akan mengajari Anda cara menyusun dan menyusun tepi dan muka kecil untuk 
membuat model detail kecil. Instruksi untuk tutorial ini dijaga seminimal mungkin. Gunakan 
beberapa proses dari tutorial sebelumnya untuk menyelesaikan langkah-langkahnya. 

Unduh model: Rel Dekoratif 

1. Buat konsep tepinya pada permukaan 12 ″×8 ″. 
 

2. Ubah setiap segmen kisi menjadi komponen yang disebut Lattice 1, Lattice 2, dan 
Lattice 
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3. Pilih dan salin ketiga komponen tersebut secara bersamaan. 
4. Gunakan alat Scale 1 dan Mirror komponen kisi yang disalin. Dengan alat 

Pindahkan/Salin, pasang ke titik akhir dokumen asli. 
5. Push/pull semua permukaan 1/2 ″. Pilih semua geometri dan ubah menjadi komponen. 

Sebut saja Edger. Putar komponen menjadi vertikal. 
6. Saat Anda menggunakan Pindahkan/Salin untuk membuat larik Edgers, tumpang tindih 

ujung setiap komponen. 
 

Pegangan 

Tutorial ini menunjukkan satu metode untuk membuat pegangan tangan yang akurat (sesuai 
dengan ADA) untuk langkah-langkah. Seperti tutorial sebelumnya, instruksi dijaga seminimal 
mungkin. 

Unduh model: Pegangan 

1. Buat konsep tepi dan permukaan dari serangkaian langkah standar. 
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2. Buat draf pekerjaan garis seperti yang ditunjukkan oleh diagram. Garis besar 
membentuk keliling pegangan. 

 

 

3. Offset face yang dihasilkan oleh garis luar pada langkah 2 ke dalam 2 ″. Hapus tepi 
bawah offset. Hapus garis diagonal di atas anak tangga. Gambar tepi ke bawah dan ke 
atas di lokasi yang ditunjukkan oleh lingkaran merah. Pastikan permukaan rel terbagi 
lagi. 
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4. Hapus permukaan dan tepi di luar dan di sekitar pegangan dan permukaan anak tangga. 
 
 

 
5. Pilih permukaan yang membentuk jeruji vertikal rel. Buat setiap komponen yang 

disebut Rel Vertikal. Pindahkan setiap komponen ke dalam 5-1/2 ″. 
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6. Push/pull rel atas 4 ″. Push/pull batang vertikal 2 ″. Pusatkan palang vertikal di rel atas. 
Pilih semua geometri rel dan ubah menjadi komponen yang disebut Handrail. Putar 
komponen menjadi vertikal. 

 

Profil Builder 

Profil Builder adalah ekstensi hebat yang dapat mengungguli FollowMe. Ini memungkinkan 
Anda membangun bentuk kompleks dan bentuk organik dengan cepat dan mudah. Ini dapat 
ditemukan di Extension Warehouse. Ada versi gratis dan Pro dari Pembuat Profil. Versi gratis 
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memungkinkan Anda untuk mengeluarkan formulir yang telah dibuat sebelumnya. Versi Pro 
memungkinkan Anda mengekstrusi formulir kustom yang Anda draf. 

 

Gambar: Profile Builder (versi gratis dan Pro) dapat ditemukan di Extension Warehouse. 
 

Gambar: Profile Builder diaktifkan dari menu Extensions. Saat terbuka, Anda dapat memilih 
bentuk yang telah dibuat sebelumnya untuk diekstrusi di sepanjang jalur yang dipilih. (Profil 
Apron yang dimuat sebelumnya dipilih pada gambar.) 
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Gambar: Busur akan memiliki profil yang dipilih di sepanjang jalur. Lingkaran merah 
menunjukkan opsi Build Along Path (Follow Me), yang merupakan alat utama yang akan Anda 
gunakan saat bekerja dengan Profile Builder. 
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Gambar: Formulir dihasilkan di sepanjang jalur. 

Versi Pro dari Pembuat Profil memungkinkan penyesuaian yang lebih besar, memungkinkan 
Anda membuat formulir yang kompleks. Misalnya, Gambar 8-21 menunjukkan permukaan 2D 
dari sebuah profil jalan. Menggunakan versi Pro, profil jalan akan diekstrusi di sepanjang dua 
busur yang terhubung. Dengan permukaan yang dipilih dan mengklik tombol Buat Profil Baru, 
profil jalan ditambahkan ke Profile Builder dan dapat diterapkan menggunakan Build Along 
Path (Follow Me). 

 

Gambar: Profil jalan permukaan 2D. Bagian atas menunjukkan konsep jalan. Bagian bawah 
akan dipilih dan digunakan untuk membuat profil. 

 

Gambar: Gunakan tombol Buat Profil Baru (dilingkari) untuk menambahkan profil jalan ke 
Pembuat Profil. 
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Gambar: Gunakan Build Along Path (Follow Me) untuk mengekstrusi profil jalan di sepanjang 
busur yang dipilih. 

Profil 2D yang dihasilkan dibangun di sepanjang jalur, membuat profil jalan 3D. Penambahan 
warna dan penyelesaian jalan dengan medan dan vegetasi membutuhkan waktu beberapa 
menit untuk menyelesaikannya. Pembuat Profil dapat dibeli dengan mengikuti tautan di 
Extension warehouse untuk situs web versi Pro. 

 

Gambar: Hasilnya berupa 3D road and walk. Anda dapat menambahkan warna ke permukaan 
untuk representasi yang lebih baik. 
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Gambar: Profil jalan yang telah selesai dengan medan dibuat menggunakan ekstensi 
Gelembung Kulit Sabun. Pohon 3D ditambahkan menggunakan PathCopy. 
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BAB 12 

MENJAGA MODEL ANDA AGAR TETAP TERATUR 

 

Menjalani hidup bisa menjadi cobaan berat, dan modeling di SketchUp tidak terkecuali. Saat 
Anda mulai mengerjakan apa pun yang Anda modelkan, Anda akan mencapai saat ketika Anda 
berhenti, mengorbit, dan bertanya-tanya bagaimana model Anda bisa menjadi kandang babi. 
Itu tidak bisa dihindari. 

Model yang besar, berat, dan tidak teratur sangat merepotkan. Mereka dapat memperlambat 
komputer Anda, atau bahkan menyebabkan SketchUp macet. Untungnya, SketchUp 
menyertakan banyak cara berbeda untuk menjaga geometri Anda - edge dan face - agar tidak 
lepas kendali. Bab ini menyajikan dua tool utama SketchUp untuk mengatur model Anda: 
Outliner dan layer. Setelah kami memperkenalkan setiap tool, kami menjelaskan cara 
menggunakannya dan cara tidak menggunakannya (apakah Anda mendengarkan, layer?). Bab 
ini diakhiri dengan contoh mendetail tentang bagaimana Anda dapat menggunakan kedua 
tool bersama-sama untuk membuat pemodelan lebih mudah. 

Anda memiliki dua metode organisasi yang Anda inginkan di SketchUp: 

 Outliner: The Outliner pada dasarnya adalah daftar mewah dari semua grup dan 
komponen dalam model SketchUp Anda. Di Outliner, Anda dapat melihat grup dan 
komponen mana yang disarangkan di dalam yang lain, menetapkan namanya, dan 
dengan mudah menyembunyikan bagian model yang tidak ingin Anda lihat. Jika Anda 
menggunakan banyak komponen (dan seharusnya), Outliner mungkin akan menjadi 
sahabat baru Anda. 

 Layer: Bagi orang yang terbiasa mengatur konten di program perangkat lunak lain, 
layer biasanya berada di tempatnya - Anda meletakkan berbagai jenis hal di layer yang 
berbeda, memberi nama layer, lalu mengaktifkan dan menonaktifkannya saat Anda 
membutuhkannya. Ini adalah konsep yang cukup sederhana. Di SketchUp, layernya 
serupa - tetapi cara kerja layer SketchUp secara berbeda penting untuk diketahui 
pemodel. 

Peringatan! 

Di SketchUp, menggunakan layer dengan cara yang salah bisa sangat mengacaukan model 
Anda. Kami tidak bercanda. Jika Anda berencana untuk menggunakan layer, baca 
bagian”Menemukan Seluk Beluk Layer," nanti di bab ini. Tidak melakukannya dapat 
mengakibatkan cedera serius atau bahkan kematian - tergantung seberapa kesalnya Anda 
saat model 50 jam Anda rusak. 

Melihat Gambaran Besarn: Outliner 

Kami berdua suka membuat daftar. Tidak hanya itu, tetapi kami senang melihat daftar - 
informasi yang tersusun rapi menjadi baris yang dapat dilipat adalah hal yang menghibur hati 
kami dan membuat mata kami berkaca-kaca. 

Sekarang, sebelum Anda memutuskan bahwa kita begitu membosankan sehingga kita 
menambahkan semangat dalam hidup kita dengan spreadsheet pengodean warna, 
pertimbangkan ini: Sebagian besar model SketchUp yang setengah rumit terdiri dari lusinan, 
jika bukan ratusan, grup dan komponen. Kelompok dan komponen ini bersarang di dalam satu 
sama lain seperti boneka Rusia, dan banyak di antaranya adalah raksasa pembunuh komputer 
seperti pohon dan semak tiga dimensi. 
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Selain itu, daftar Outliner membantu Anda melacak semua grup dan komponen Anda, 
menyembunyikan apa yang tidak ingin Anda lihat, dan (yang lebih penting) memperlihatkan 
apa yang Anda lakukan. Siap untuk terjun? Kami pikir begitu! 

Memperhatikan baik-baik Outliner 

Anda dapat membuka panel Outliner dengan memilih Window => Default Tray => Outliner 
(Windows) atau Window => Outliner (Mac). Gambar 12-1 menunjukkan tampilan Outliner jika 
sebuah model terdiri dari sebuah ruangan sederhana dengan beberapa furnitur di dalamnya. 
Setiap perabot merupakan komponen terpisah dari 3D Warehouse SketchUp. 

 

 

Gambar 12-1: Outliner mencantumkan komponen dalam model. 

Panel Outliner memiliki beberapa fitur berikut: 

 Search filter box: Jika Anda mengetik kata atau frase ke dalam kotak ini, Outliner hanya 
menampilkan item dalam model Anda yang menyertakan kata atau frase tersebut 
dalam namanya. Misalnya, ketik kopi, dan hanya komponen meja kopi yang terlihat. 

 Menu flyout Opsi Outliner: Menu kecil yang berguna ini berisi tiga opsi: 
o Expand All: Pilih opsi ini agar Outliner menampilkan semua grup dan 

komponen bertingkat dalam model Anda - semuanya terakhir (asalkan ada di 
layer yang terlihat). Ingat. Outliner hanya menampilkan grup dan komponen 
yang ada pada layer yang terlihat dalam model Anda. Dengan kata lain, apa pun 
pada layer tersembunyi tidak muncul di Outliner, jadi berhati-hatilah jika Anda 
menggunakan Outliner dan layer untuk mengatur model Anda. Anda dapat 
membaca semua tentang layer di bagian”Menemukan Seluk Beluk Layer", 
nanti di bab ini. 
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o Collapse All: Opsi ini menciutkan tampilan Outliner Anda sehingga Anda hanya 
melihat grup dan komponen tingkat atas - yang tidak bersarang di dalam grup 
dan komponen lain. 

o Sort by Name: Pilih opsi ini untuk membuat Outliner mencantumkan grup dan 
komponen dalam model Anda menurut abjad. 

 

 Outliner List window: Semua grup dan komponen dalam model Anda tercantum di sini. 
Ikon dengan empat kotak kecil menunjukkan sebuah komponen, sedangkan ikon yang 
merupakan kotak padat yang lebih besar menunjukkan sebuah grup. Panah beralih 
Perluas/Ciutkan muncul di samping grup atau komponen yang menyimpan grup atau 
komponen bertingkat. (Anda melihat contoh grup dengan komponen bertingkat pada 
Gambar 12-1.) Anda dapat membuat daftar bertingkat tetap tertutup atau 
memperluasnya sehingga grup dan komponen penyusunnya muncul dalam daftar. 

Memanfaatkan Outliner dengan baik 

Jika Anda menggunakan banyak grup dan komponen (dan seharusnya), membuka Outliner di 
layar adalah salah satu hal terbaik yang dapat Anda lakukan untuk membuat model secara 
efisien. 

Inilah alasannya: 

 Gunakan Outliner untuk mengontrol visibilitas. Alih-alih grup dan komponen 
mengcontext-clicks dalam model Anda untuk menyembunyikannya, gunakan Outliner 
sebagai gantinya. Cukup context-clicks nama elemen apa pun di Outliner dan pilih 
Sembunyikan. Saat Anda melakukannya, elemen tersebut akan disembunyikan di 
jendela pemodelan Anda dan namanya menjadi abu-abu dan dicetak miring di Outliner. 
Untuk memperlihatkannya, cukup context-clicks namanya di Outliner dan pilih Unhide. 

 Seret dan lepas elemen di Outliner untuk mengubah urutan bersarangnya. Tidak suka 
komponen yang baru saja Anda buat bersarang di dalam komponen lain? Cukup seret 
namanya di Outliner ke bagian atas daftar. Ini memindahkan komponen ke tingkat atas, 
artinya tidak disematkan pada apa pun. Anda juga dapat menggunakan Outliner untuk 
menyeret grup dan komponen ke yang lain juga. 

 Temukan dan pilih berbagai hal menggunakan Outliner. Memilih sesuatu di Outliner 
menyoroti nama sesuatu itu dan memilihnya di jendela pemodelan Anda. Dengan 
teknik ini, memilih grup dan komponen bertingkat menjadi mudah, terutama jika Anda 
bekerja dengan model yang kompleks. 

Mengkover Layer Bagian Luar dan Dalam 

Layer adalah bagian yang sangat berguna dari SketchUp, dan dapat membuat hidup Anda jauh 
lebih mudah. Layer juga dapat menjadi sumber utama sakit hati karena dapat mengacaukan 
model Anda jika Anda tidak berhati-hati. Bagian ini dapat membuat Anda berada di path yang 
benar. 

Apa itu Layer - dan apa yang bukan 

Dalam program 2D seperti Photoshop atau Illustrator, konsep layer sangat masuk akal: Anda 
dapat memiliki konten pada sejumlah layer, seperti tumpukan transparansi. Anda 
menemukan urutan yang berbeda pada layer Anda, jadi semua yang ada di layer atas secara 
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visual berada di depan semua yang ada di semua layer lainnya, seperti yang ditunjukkan pada 
Gambar 12-2. 

 

Gambar 12-2: Dalam perangkat lunak 2D, layer cukup mudah 

Tetapi SketchUp bukanlah program 2D; itu adalah program 3D. Jadi bagaimana bisa memiliki 
layer? Bagaimana benda-benda dalam ruang tiga dimensi bisa berlapis-lapis sehingga benda- 
benda pada layer yang lebih tinggi muncul di depan benda-benda di layer yang lebih rendah? 
Singkatnya, mereka tidak bisa - itu tidak mungkin. Layer di SketchUp berbeda dengan layer di 
kebanyakan program grafik lainnya, dan itu membingungkan banyak orang. 

Masalah Teknik 

SketchUp memiliki sistem layer karena beberapa pengguna SketchUp pertama adalah arsitek, 
dan banyak, banyak arsitek menggunakan perangkat lunak gambar AutoCAD. Karena 
AutoCAD menggunakan layer secara ekstensif, layer digabungkan ke SketchUp untuk 
memaksimalkan kompatibilitas antara kedua produk. Saat Anda mengimpor file AutoCAD 
berlapis ke SketchUp, layernya muncul sebagai layer SketchUp, yang cukup nyaman. Untuk 
informasi lebih lanjut tentang mengimpor file CAD ke SketchUp 

Ingat! 

Jadi untuk apa layer SketchUp? Visibilitas kontrol layer. Gunakan mereka untuk 
mengumpulkan jenis geometri tertentu sehingga Anda dapat dengan mudah 
mengaktifkannya (membuatnya terlihat) dan mematikannya (membuatnya tidak terlihat) 
saat Anda perlu. Meskipun demikian, layer tidak bekerja dengan cara yang sama seperti grup 
dan komponen; edge dan permukaan Anda tidak dipisahkan dari bagian lain dari model Anda, 
yang dapat menyebabkan kebingungan besar jika Anda tidak berhati-hati. Untuk mengetahui 
lebih lanjut, lihat bagian”Menghindari masalah", di bagian akhir bab ini. 

Menavigasi Panel Layer 

Panel Layer, diperlihatkan pada gambar 12-3, adalah bagian mesin yang cukup sederhana. 
Anda membukanya dengan memilih Window => Default Tray => Layers (Windows) atau 
Window => Layers (Mac). Berikut pengantar singkat untuk fitur panel: 

 Add Layer: Mengklik tombol ini (tanda plus) menambahkan layer baru ke file SketchUp 
Anda. 

 Delete Layer: Klik tombol ini (tanda minus) untuk menghapus layer yang saat ini dipilih. 
Jika layer yang Anda coba hapus berisi sesuatu, SketchUp menanyakan apa yang ingin 
Anda lakukan dengannya; pilih opsi dan klik Hapus. 

 Layer Options flyout menu: Menu ini menawarkan opsi berguna berikut: 
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o Purge: Saat Anda memilih Purge, SketchUp menghapus semua layer yang tidak 
mengandung geometri. Ini adalah cara praktis untuk menjaga file Anda tetap 
rapi dan rapi. 

o Color by Layer: Perhatikan bagaimana setiap layer dalam daftar memiliki 
contoh bahan kecil di sebelahnya? Memilih Warna dengan Layer mengubah 
sementara semua warna dalam model SketchUp Anda agar sesuai dengan 
warna (atau tekstur) yang ditetapkan ke setiap layer. Untuk melihat apa yang 
ada di setiap layer, langsung ke opsi ini. 

 Layer List: Ini mencantumkan semua layer dalam file SketchUp Anda. Anda perlu 
mengetahui tentang tiga kolom ini: 

o Name: Klik dua kali nama layer untuk mengeditnya. Memberi nama yang 
bermakna pada layer Anda adalah cara yang baik untuk menemukan apa yang 
Anda inginkan dengan cepat. 

o Visible: Kotak centang ini adalah inti dari panel Layer. Saat dipilih, geometri 
pada layer itu terlihat; jika kotak centang tidak dipilih, geometri layer tidak 
terlihat. 

o Color: Anda dapat memilih untuk melihat model Anda menggunakan Color by 
Layer, yang dijelaskan sebelumnya dalam daftar. Anda dapat memilih bahan 
(warna atau tekstur) mana yang akan ditetapkan ke setiap layer dengan 
mengklik contoh Warna. 

 

Gambar 10-3: Panel Layer 

Memindahkan entitas ke Layer berbeda 

Memindahkan sesuatu dari satu layer ke layer lainnya melibatkan penggunaan panel Entity 
Info. Ikuti langkah-langkah berikut untuk memindahkan entitas (tepi, face, grup, atau 
komponen) ke layer yang berbeda: 

1. Pilih entitas atau entitas yang ingin Anda pindahkan ke layer lain. 

Ingat 

Pindahkan hanya grup dan komponen ke layer lain; lihat bagian selanjutnya dalam bab 
ini untuk mencari tahu alasannya. 



269 
 

2. Buka panel Entity Info di Default Tray (Windows) atau pilih Window => Entity Info 
(Mac). 

Anda juga dapat membukanya dengan mengcontext-clicks entitas yang Anda pilih dan 
memilih Entity Info. 

3. Di panel Entity Info, pilih layer dari daftar drop-down Layer. 

Entitas yang Anda pilih sekarang berada di layer yang Anda pilih dari daftar 

Masalah Teknis 

Panel Entity Info menawarkan cara lain yang sedikit lebih rumit untuk menambahkan 
layer baru dan memindahkan entitas ke layer baru. Di panel Entity Info, ketik nama 
layer baru ke dalam bidang Layer dan tekan Enter. SketchUp membuat layer baru 
dengan nama itu dan memindahkan geometri apa pun yang saat ini dipilih ke atasnya. 
Kami menyarankan Anda menyimpan penghemat waktu khusus ini sampai Anda 
memiliki pengalaman bekerja dengan layer. Tidak ada apa pun tentang Layers yang 
sesederhana kelihatannya. 

Menghindari masalah 

Layer bisa sangat membantu, tetapi Anda perlu tahu cara menggunakannya; jika tidak, hal 
buruk bisa terjadi. Lihat apa yang boleh dan tidak boleh dilakukan berikut sebelum Anda mulai 
bekerja dengan layer: 

 Peringatan! Lakukan semua pemodelan Anda di Layer0. Selalu pastikan bahwa Layer0 
adalah layer Anda saat ini saat Anda bekerja. Menyatukan semua geometri longgar 
Anda (yang bukan merupakan bagian dari grup atau komponen) di satu tempat adalah 
satu-satunya cara untuk memastikan bahwa Anda tidak berakhir dengan edge dan 
permukaan di semua tempat. SketchUp, sayangnya, memungkinkan Anda meletakkan 
geometri pada layer apa pun yang Anda inginkan, yang berarti Anda dapat berakhir 
dengan face di satu layer, dan satu atau lebih edge yang menentukannya di layer lain. 
Ketika itu terjadi, mencari tahu di mana semua milik hampir mustahil; Anda akan 
menghabiskan waktu berjam-jam untuk mencoba memperbaiki model Anda. Properti 
sistem layer SketchUp ini merupakan titik sandungan utama bagi pengguna SketchUp 
baru; mengetahui untuk menyimpan semua yang ada di Layer0 dapat menyelamatkan 
Anda dari banyak kesedihan. 

 Jangan pindahkan apa pun kecuali grup dan komponen ke layer lain. Jika Anda akan 
menggunakan layer, ikuti aturan ini: Jangan pernah meletakkan apa pun di atas layer 
selain Layer0 kecuali itu adalah grup atau komponen. Melakukannya memastikan 
bahwa edge dan permukaan yang menyimpang tidak berakhir pada layer yang terpisah. 

 Gunakan layer untuk mengatur kelompok besar hal-hal serupa. Model SketchUp yang 
lebih rumit sering kali menyertakan hal-hal seperti pohon, furnitur, mobil, dan orang. 
Hal-hal seperti ini hampir selalu merupakan komponen, sehingga sempurna untuk 
diatur pada layer yang terpisah. Misalnya, Anda dapat membuat layer Pohon dan 
meletakkan semua komponen pohon Anda di atasnya. Karena pepohonan biasanya 
merupakan komponen yang besar dan rumit dengan banyak permukaan, 
menyembunyikan semua susunan Anda sekaligus dengan fitur layer adalah cara 
praktis untuk meningkatkan kinerja komputer Anda. 

 Jangan gunakan layer untuk mengatur geometri yang saling berhubungan; gunakan 
Outliner sebagai gantinya. Yang kami maksud dengan geometri yang saling 
berhubungan adalah hal-hal seperti tingkat lantai bangunan dan tangga. Suku cadang 
model ini tidak dimaksudkan untuk dipisahkan secara fisik dari bagian lain seperti 



270 
 

halnya kendaraan dan manusia. Ketika Anda meletakkan Level 1 di satu layer dan Level 
2 di layer lain, lebih sering daripada tidak, Anda menjadi bingung tentang apa yang 
termasuk di mana: Apakah tangga itu bagian dari Level 1 atau Level 2? Alih-alih, buat 
grup untuk Level 1, grup untuk Level 2, dan grup untuk tangga - Anda akan 
membutuhkan lebih sedikit obat sakit kepala di penghujung hari. 

 Tips. Jangan ragu untuk menggunakan layer untuk mengulang. Iterasi adalah proses 
melakukan beberapa versi dari hal yang sama. Banyak desainer bekerja dengan cara 
ini untuk mencari tahu masalah dan menyajikan opsi berbeda kepada klien mereka. 
Menggunakan layer adalah cara yang bagus untuk mengulang: Anda dapat 
memindahkan setiap versi dari hal yang sedang Anda kerjakan ke layer yang berbeda, 
lalu mengaktifkan dan menonaktifkan layer untuk menampilkannya secara bergantian. 
Ingatlah untuk mengikuti aturan tentang menggunakan grup dan komponen hanya 
pada layer terpisah (disebutkan sebelumnya), dan Anda akan baik-baik saja. 

 Tips. Lihat bilah sisi”Menggunakan Pemandangan untuk mengontrol layer" (nanti di 
bab ini) untuk cara yang bagus untuk membalik dengan cepat layer yang mewakili 
iterasi desain dalam model Anda. 

Menyatukan Semuanya Bersama 

Dalam bab ini kita berbicara tentang masing-masing metode organisasi SketchUp secara 
terpisah: membahas cara kerjanya, mengapa mereka istimewa, dan kapan menggunakannya. 
Saat Anda benar-benar bekerja di SketchUp, Anda mungkin menggunakan kombinasi dari 
semuanya, jadi menurut kami Anda akan menemukan contoh dari semua tool organisasi yang 
bekerja sangat membantu. 

Gambar 12-4 menunjukkan model rumah yang Aidan buat. Berikut cara semua tool organisasi 
bekerja sama untuk menjaga model tetap teratur: 

 Setiap lantai adalah grup. Mengatur setiap lantai ke dalam grup memungkinkan Anda 
menyembunyikan lantai mana saja yang tidak sedang Anda kerjakan, sehingga Anda 
dapat melihat apa yang Anda lakukan dan SketchUp berjalan sedikit lebih cepat. Aidan 
memasukkan satu-satunya tangga rumah di grup lantai pertama, karena itu ternyata 
hal yang paling mudah dilakukan, tetapi Anda juga bisa membuat tangga menjadi grup 
terpisah juga. 

 Atap dan dinding luar adalah group dalam Group lain. Untuk melepaskan atap dan 
dinding luar secara terpisah, masing-masing perlu menjadi satu kelompok. Namun, 
untuk menyembunyikan dan menampilkan keduanya pada saat bersamaan, Aidan 
membuat grup Shell yang menyertakan keduanya. Dengan penyiapan ini, dia dapat 
secara selektif menampilkan atau menyembunyikan hanya geometri yang ingin 
dilihatnya. Lihat Gambar 12-5. 

Tips 

Tingkat lantai, atap, dan dinding eksterior adalah kelompok, bukan komponen karena 
unik. Sebuah rumah hanya memiliki satu lantai satu, sehingga lantainya tidak perlu 
menjadi sebuah komponen. 

 Semua perabot dan perlengkapan pipa adalah komponen. Untuk melengkapi rumah, 
Aidan membuat komponen furnitur sendiri atau komponen bekas dari panel 
Komponen dan 3D Warehouse. 

Tips 
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Bila Anda hanya memiliki satu sofa, mengapa menjadikannya sebagai komponen, 
bukan grup? Dengan menjadikan setiap bagian dari furnitur dalam sebuah model 
sebagai sebuah komponen, Anda dapat melihat furnitur tersebut tercantum dalam 
koleksi Model Dalam pada panel Komponen. Anda juga dapat menyimpan furnitur 
Anda sebagai koleksi komponen terpisah di komputer Anda. Lain kali Anda pindah, 
Anda memiliki semua furnitur di satu tempat, siap untuk dijadikan model rumah baru 
Anda. 

 Semua furnitur berada di layer terpisah. Komponen furnitur bisa sedikit berat - yaitu, 
membebani sistem komputer Anda. Dengan furnitur di atas layer, Anda dapat dengan 
mudah menyembunyikan semuanya. Pengaturan ini juga memungkinkan Anda untuk 
melihat ruang Anda tanpa furnitur. Ingatlah bahwa Anda dapat mengontrol visibilitas 
sebuah layer dengan satu klik mouse. 

Tips 

Tetapi mengapa tidak membuat grup dari semua komponen furnitur dan 
menggunakan Outliner untuk menyembunyikan dan menampilkan semuanya, alih-alih 
repot-repot dengan layer? Pertanyaan bagus. Mengubah layer komponen lebih mudah 
daripada menambahkan komponen ke grup yang sudah ada. Untuk menambahkan 
sesuatu ke grup, Anda perlu menggunakan Outliner untuk menarik dan melepaskan 
sesuatu di tempat yang tepat; dengan model yang kompleks, ini bisa merepotkan. 
Mengubah layer komponen hanya dengan menggunakan panel Entity Info untuk 
memilih dari daftar. 

 

Gambar 12-4: Aidan menggunakan semua tool organisasi SketchUp untuk membangun model 
ini. 
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Gambar 12-5: Setiap lantai rumah, serta atap dan dinding eksterior, adalah satu kelompok. 
 

MENGGUNAKAN LAYAR UNTUK MENGONTROL LAYER 
 

Di SketchUp, pemandangan pada dasarnya adalah tampilan model Anda yang disimpan. 
Daripada mengutak-atik tool dan panel navigasi setiap kali Anda ingin kembali ke tampilan 
penting, Anda dapat mengklik tab Scene. 

 
Pemandangan relevan dalam bab ini karena pemandangan tidak hanya menyimpan posisi 
kamera yang berbeda; Anda juga dapat menggunakannya untuk mengontrol visibilitas 
layer. Mampu mengklik tab Scene untuk langsung mengubah layer mana yang ditampilkan 
adalah cara yang sangat ampuh untuk melakukan desain berulang: membuat dan 
menyajikan opsi berbeda dalam desain yang sama. 

 
Contoh yang sangat sederhana: Anda telah membuat model ruang tamu dan ingin mencoba 
tiga konfigurasi furnitur yang berbeda: 

 
1. Buat tiga layer - Opsi 1, Opsi 2, dan Opsi 3. 
2. Lakukan tiga pengaturan furnitur terpisah, satu per layer. Tentu saja, ini berarti Anda 

memiliki tiga salinan untuk setiap objek yang Anda pindahkan. 
3. Gunakan panel Layer untuk menampilkan Opsi 1, dan sembunyikan Opsi 2 dan Opsi 

3. 
4. Buat Scene baru dan beri nama Opsi 1 menggunakan panel Pemandangan. 
5. Ulangi Langkah 3 dan 4 untuk dua konfigurasi lainnya. 

 
Sekarang yang harus Anda lakukan adalah mengklik tab Scene untuk beralih di antara tiga 
opsi; ini jauh lebih elegan daripada harus mengutak-atik panel Layer selama presentasi. 

 

Satu lagi berita menarik yang berguna: Plugin tool Layer memungkinkan Anda (antara lain) 
membuat layer baru yang tidak terlihat di salah satu pemandangan yang telah Anda buat 
sebelumnya. Plugin ini berguna saat Anda perlu menambahkan iterasi baru setelah Anda 
membuat banyak Scene. Anda dapat menemukan plugin di Extension Warehouse. 



273 
 

BAB 13 

PEMODELAN DENAH LOKASI TERPERINCI 

Sekarang setelah Anda diperkenalkan dengan Pemodelan Proses SketchUp, sekarang saatnya 
menjelajahi beberapa metode proses tambahan. Dalam bab ini, Anda akan memperluas teknik 
yang telah Anda pelajari — menyusun Flatwork Base, menambahkan warna, dan menerapkan 
volume — dan menerapkannya saat bekerja dari gambar yang dipindai. 

Menggunakan Denah lokasi Denah lokasi digambar dan gambar berskala yang mewakili tata 
letak dua dimensi dari lingkungan binaan. Mulai dari sketsa yang digambar tangan di atas 
kertas kalkir hingga rencana pensil, spidol, Photoshop, atau AutoCAD yang rumit. 

Bab ini berfokus pada membangun dasar Flatwork dari denah yang digambar dengan tangan 
dari halaman dan bangunan sekitarnya. Untuk menyelesaikan latihan ini, unduh model 
Gambar Rencana Situs Konseptual dari 3D Warehouse. Model adalah bagian dari koleksi SPM 
Bagian 2 (SPM Bagian 2 adalah istilah penelusuran). Gunakan model tutorial yang dapat 
diunduh jika ditunjukkan. 

 

Gambar Denah lokasi yang digambar dengan tangan dipindai ke SketchUp untuk digunakan 
dengan tutorial bab 

Mengimpor Rencana Situs 

SketchUp memungkinkan Anda mengimpor beberapa format gambar standar: gambar JPEG 
(.jpg), gambar yang diberi tag (.tif), gambar bitmap (.bmp), dan gambar Grafik Jaringan 
Portabel (.png). Saat Anda menggunakan rencana situs, pastikan itu dipindai atau disimpan 
dalam format gambar yang kompatibel. 
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Untuk mengimpor gambar, buka Impor File dan pilih ekstensi file yang mendukung gambar 
rencana. Beberapa opsi akan muncul di sebelah kanan layar impor file. Pilih opsi Gunakan 
sebagai Gambar. Klik Open dan gambar akan muncul di SketchUp. Anda harus menempatkan 
dan mengukur gambar untuk SketchUp. 

Tempatkan gambar denah pada titik penyisipan 0 sumbu gambar, sama seperti yang Anda 
lakukan dengan persegi panjang awal untuk Flatwork Base. Setelah titik penyisipan dipilih, 
Anda perlu mengukur rencana. Cukup klik dan seret gambar dan klik kiri untuk memilih ukuran 
akhir. Gambar rencana tidak akan diskalakan, tetapi Anda akan mempelajari cara 
melakukannya nanti di bab ini. 

 

Gambar Memasukkan dan menskalakan rencana 

Jika Anda memilih gambar rencana, Anda akan melihat bahwa SketchUp telah mengubahnya 
menjadi sebuah grup. 

Resolusi Gambar yang Diimpor 

Tidak seperti Photoshop, SketchUp bukanlah penampil gambar. Gambar rencana yang diimpor 
akan tampak kehilangan kejernihannya, atau tampak berpiksel saat dilihat. Saat diimpor dan 
diskalakan, gambar direntangkan ke proporsi dunia nyata dan kehilangan kualitas gambar. 
Namun, gambar-gambar ini masih cukup berguna sebagai referensi penyusunan. Karena 
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resolusi gambarnya menurun, denah situs SketchUp dimaksudkan untuk dilihat dari jarak yang 
nyaman. 

Memproses file gambar dapat membebani kinerja komputer. Untuk membantu agar sistem 
Anda tidak macet, gunakan gambar JPEG jika memungkinkan. Mereka menggunakan format 
terkompresi yang tidak memakan banyak ruang komputer. 

Menempatkan Gambar Rencana pada Layer 

Tempatkan gambar denah pada layernya sendiri. Buat layer baru (tombol Window Layer Add 
Layer) yang disebut 02-IMAGE. 

Pilih grup Plan Image, buka menu Entity Info, dan tempatkan gambar plan yang diimpor pada 
layer baru. Setelah transfer selesai, jadikan Layer 0 sebagai layer aktif lagi. Ini mempersiapkan 
lingkungan pemodelan untuk penyusunan. 

Mengubah Skala Gambar 

Lingkungan binaan terdiri dari permukaan dan objek yang biasanya memiliki dimensi standar. 
Karena gambar rencana mendeskripsikan objek dan permukaan lingkungan binaan, Anda 
dapat mereferensikan banyak dimensinya dengan panjang atau lebar standar. Ikuti langkah- 
langkah ini untuk menskalakan gambar rencana 

1. Gunakan alat Pengukur Pita (Lihat Pengukur Konstruksi Bilah Alat) untuk mengukur 
area yang berkorelasi dengan dimensi dunia nyata yang Anda ketahui. Lebar dan 
panjang berikut adalah jenis yang cukup umum yang dapat Anda gunakan untuk 
membantu menentukan skala: 

o Jalan: Rata-rata 12’untuk jalur tunggal, 24' hingga 34’untuk sebagian besar 
jalan dua jalur 

o Langkah: 1˝ lebar tapak 
o Bangku: 6' atau 8 Panjang ′ 
o Mobil: 9 ′ lebar atau 18 ′ panjang 
o 

o Jalan kaki: lebar 5 ′ hingga 10 ′ 
2. Segera setelah mengukur suatu area dengan alat Pengukur Pita, masukkan (di 

measurement window) nilai dunia nyata dari area Anda diukur. Tekan Kembali. 
SketchUp akan menanyakan apakah model harus diubah ukurannya. Pilih Ya. Gambar 
rencana akan diubah ukurannya. 

3. Gunakan Tape Measurement Tool untuk memeriksa dimensi pada gambar untuk 
memastikan panjang atau lebarnya benar. Ubah ukuran gambar sesuai kebutuhan, 
ulangi langkah 1 hingga 3. 

Mempersiapkan Drafting Trace 

Anda dapat menggunakan Gambar Rencana Situs Konseptual yang telah diunduh yang 
disebutkan sebelumnya untuk sisa bab ini. Gambar latihan ini sudah diskalakan ke ukuran yang 
benar. Grup gambar berada di layernya sendiri, dan grup itu sendiri dikunci. 

Karena gambar denah akan dijiplak ke permukaan persegi panjang, permukaannya harus 
transparan. Untuk mempersiapkan face draf, ikuti langkah-langkah berikut: 

1. Buat permukaan gambar. 
a. Dengan Layer 0 sebagai layer aktif, gambar face persegi panjang di seluruh 

gambar. 
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b. Jepret titik pertama face pada 0 penyisipan; pastikan untuk menutupi dan 
menimpa seluruh permukaan gambar 

2. Jadikan face transparan. 
a. Dari alat Paint Bucket, pilih Warna 001 dari palet Warna (pilih Warna dari menu 

tarik-turun). 
b. Terapkan Warna 001 ke face. 
c. Pilih Edit di menu Material. 
d. Di bawah Edit, temukan Opacity. (Dalam beberapa sistem mungkin 

tersembunyi. Perluas menu dengan menyeret sudut untuk menemukan 
Opacity di bagian bawah.) Setel nilai Opacity menjadi 50 persen. 

Denah gambar di bawah sekarang terlihat melalui face, dan face siap untuk disusun. 
 

Gambar: Draf face persegi panjang di atas gambar denah. 



277 
 

 
 

Gambar: Warnai permukaan draf dan buat transparan. 

Tips Drafting 

Saat Anda menggambar garis, busur, dan face, Anda dapat membuat geometri bersih yang 
mudah dimanipulasi dan diedit dengan mengikuti tip berikut: 

Jangan khawatirkan akurasi. Mencoba akurat saat Anda menelusuri garis dari gambar denah 
kabur itu paling sulit. Jiplak garisnya seakurat mungkin, tetapi jangan dipikirkan. 

Gambarlah Axes/sumbu. Cobalah untuk merancang secara ortogonal dan pada sumbu. 
Memanfaatkan kesimpulan linier dan snap ke titik akhir dan titik tengah. Sebagian besar, jika 
tidak semua denah gambar, termasuk denah lokasi yang disediakan, memiliki garis yang tidak 
ortogonal. Jika memungkinkan, ubah garis non-ortogonal menjadi garis ortogonal. 

Jangan tumpang tindih garis. Garis yang tumpang tindih akan menyebabkan masalah pada 
permukaan dan kemampuan untuk menghasilkan volume dan mengedit geometri. Saat Anda 
menggambar persegi panjang, pasangkan ujung ke ujung dan pastikan tidak ada tumpang 
tindih 

Hindari garis ganda. Ini terjadi ketika dua garis bersaing untuk menjadi tepi yang sama. Saat 
Anda menggambar geometri non-ortogonal, periksa garis ganda 

Sejajarkan ujungnya. Lingkungan binaan dalam banyak kasus ditentukan oleh permukaan dan 
tepi yang sejajar, tegak lurus, dan sejajar. Sejajarkan tepi peregangan menggunakan garis yang 
berdekatan sebagai panduan. Ini mudah dilakukan dengan menggunakan alat Pengukur Pita 
(View Toolbars Construction Tape Measure) untuk membuat panduan konstruksi. Panduan 
konstruksi adalah tepi putus-putus yang berfungsi sebagai tepi referensi dan tidak 
mempengaruhi geometri. 

Gunakan Tape Measure tool (View Toolbars Construction) untuk menambahkan garis 
konstruksi. Bermain-main dengan Pita Pengukur untuk mempelajari cara kerjanya. Ini akan 
sangat berguna untuk tutorial bab. 



278 
 

 
 

Gambar: Hindari tumpang tindih dan garis ganda. 

Gunakan persegi panjang. Mencoba membagi face dengan line tool tidak selalu berhasil. 
Sebagai gantinya, gunakan alat Rectangle untuk menentukan area. Kemudian bagi lagi tepi 
dan permukaan persegi panjang agar sesuai dengan garis yang diinginkan. Ini akan 
memastikan bahwa geometri face terbagi. 

 

Gambar: Alat Pengukur Pita dapat digunakan untuk membuat panduan konstruksi. 

Identifikasi semua permukaan sebelum menyusun. Ini akan membantu Anda menentukan 
urutan penyusunan. Selain itu, permukaan memberikan titik referensi di mana tepi dan 
permukaan dapat dihubungkan. Beberapa permukaan keras yang khas termasuk beton, beton 
berwarna, pavers, aspal, batu, dinding, trotoar, dan tapak bangunan. Beberapa permukaan 
lanskap yang khas termasuk halaman rumput, crusher halus (kerikil), dan tempat tidur tanam. 
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Gambar: Identifikasi permukaan denah lokasi. 

Bug di SketchUp versi 6 dan di bawahnya terkadang mencegah face untuk dibagi lagi setelah 
garis digambar untuk menentukan face individu. Mengatasi bug itu mudah, tetapi mencari 
tahu bagaimana melakukannya akan membutuhkan beberapa pekerjaan detektif. Pastikan 
semua permukaan dibagi ke dalam area masing-masing. Jika tidak, coba yang berikut ini: 

 Pastikan semua tepi terkait ke tepi yang lain. 

 Pastikan tidak ada garis yang tumpang tindih. Ini biasanya terjadi ketika offset tool 
digunakan. Hapus dan gambar ulang garis sesuai kebutuhan untuk menghilangkan 
semua tumpang tindih. 

 Hapus tepi yang menyusun face yang harus dibagi lagi dan gambar ulang. Pergi ke 
sekitar tepi, dan hapus dan gambar ulang garis sampai face terbagi lagi. 

Urutan Drafting 

Langkah-langkah ini, yang akan dijelaskan secara lebih rinci, memberikan pedoman umum 
untuk penyusunan dan penggunaan sistem inferensi secara efektif. Pertama, buat draf garis 
besar gambar denah. Bagi permukaan secara bertahap menjadi permukaan yang lebih kecil 
dan lebih detail. Gunakan semua draf geometri untuk menjepret dan menyelaraskan tepi dan 
permukaan lainnya seiring dengan penambahan detail. Permukaan terkecil (misalnya tangga 
dan dinding) harus menjadi geometri terakhir yang Anda buat. 

Menggambar Perimeter Situs dan Tapak Bangunan 

Tepi keliling dan tapak bangunan memberikan referensi untuk menjepret dan menyelaraskan 
geometri rancangan lainnya. Pertama, gambar tapak bangunan menggunakan rectangle tool. 
Jepitkan jejak kaki ke tepi luar permukaan gambar persegi panjang. Selanjutnya, gambar tepi 
luar denah lokasi; pada contoh denah, ini adalah garis tepi jalan antara alun-alun dan area 
parkir. Perhatikan bahwa beberapa tepi perimeter dapat dipasang ke tapak bangunan 
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Gambar: Draf tapak bangunan dan keliling situs. 

Membuat Draft Permukaan yang Diidentifikasi 

Langkah 1 sampai 7 cukup rumit. Bacalah langkah-langkah sebelum mencoba tutorial ini. Buat 
draf permukaan yang telah diidentifikasi sebelumnya. Gunakan perimeter dan tepi bangunan 
sebagai referensi dan titik jepret jika memungkinkan. 

Sejajarkan tepinya. Bagian dalam alun-alun, yang ditentukan oleh tepi area perkebunan, 
terdiri dari beberapa sisi dengan sudut siku-siku. Ikuti langkah-langkah ini untuk menggambar 
garis yang sejajar, sejajar, atau tegak lurus. Gunakan gambar sebagai referensi untuk 
menemukan semua tepi. 

1. Gambar persegi panjang untuk menentukan permukaan utama alun-alun (Persegi 
Panjang 1). Tentukan lebih lanjut tepi plaza menggunakan persegi panjang yang lebih 
kecil. Gambar persegi panjang kecil (Persegi Panjang 2) di atas persegi panjang 
pertama 
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Gambar: Tentukan alun-alun dalam dengan persegi panjang 
 

 

Gambar: Menggambar alun-alun bagian dalam 

2. Gunakan alat Tape Measure untuk menggambar pemandu konstruksi dari tepi kanan 
dan kiri Persegi Panjang 2 ke tepi bawah Persegi Panjang 1. Di persimpangan pemandu 
konstruksi dan Persegi Panjang 1, gambar Persegi Panjang 3 untuk menyelesaikan 
penetapan ruang plaza interior. 
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Gambar: Sejajarkan tepi Persegi Panjang 3 dengan Persegi Panjang 2. 

3. Draft Rectangle 4. Tempatkan Rectangle 4 di atas sebagian besar area rumput pohon 
(pohon merah muda). Sejajarkan tepi kanan persegi panjang dengan titik ujung sudut 
tepi keliling 

4. Gambarkan Rectangle 5 di atas garis yang ditunjukkan pada gambar denah. Sejajarkan 
tepi atas persegi panjang dengan tepi atas Persegi Panjang 4 

5. Gambar Persegi Panjang 6; pastikan untuk menyejajarkan persegi panjang dengan tepi 
kanan dan kiri Persegi Panjang 5. Gunakan garis konstruksi untuk menjamin 
kesejajaran. Tepi bawah Persegi Panjang 6 harus berakhir di sudut kiri penanam yang 
ditunjukkan pada gambar denah. 

 

Gambar: Gambar dan sejajarkan Rectangles 4, 5, dan 6 seperti yang ditunjukkan. 

6. Untuk membuat Persegi Panjang 7, gambar tepi dari titik tengah tepi kiri alun-alun ke 
kanan. Empat kaki di atas garis ini, di tepi luar Persegi Panjang 1, gambar persegi 
panjang 10'-6 ″×8’untuk menentukan entri. 
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7. Gambarkan tepi untuk melengkapi setiap area seperti yang ditunjukkan pada diagram. 
Pastikan tepi digambar pada sumbu (hijau dan merah) jika memungkinkan, dan 
permukaannya terbagi. Jika permukaan tidak membagi lagi, perbesar ke titik akhir dari 
garis yang digambar dan pastikan itu terhubung ke tepi yang benar tempat mereka 
ditarik. 

 

 

Gambar: Saat Anda menggambar Persegi Panjang 7, sejajarkan dengan titik tengah tepi kiri 
alun-alun. 

 

Gambar: Gambarlah garis 1 sampai 6 seperti yang ditunjukkan. Idenya adalah untuk 
menghubungkan dan selanjutnya mendefinisikan dan membagi area alun-alun. 
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Gambar: Salin tepi diagonal (garis 3 dari Gambar 7-16) ke kanan. 
 

Gambar: Tambahkan dua garis dari tepi bawah persegi panjang ke keliling. 

Menambahkan Detail Tepi Kecil 

Untuk membuat draf detail kecil (tangga, trotoar, dan dinding), ikuti langkah-langkah berikut. 

1. Buat langkah-langkahnya. 
a. Pindahkan/Salin tepi di entri bawah alun-alun (Persegi Panjang 6) dan timur 

(Persegi Panjang 7) untuk membuat tangga 
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Gambar: Pindahkan/Salin anak tangga dan mendarat di entri bawah (bagian bawah Persegi 
Panjang 6). 

b. Di entri selatan, offset tepi 2’untuk membuat pendaratan. Offset tepi 
pendaratan untuk membuat tiga anak tangga selebar 1 kaki 

c. Di entri timur, dari tepi kanan, offset tiga tepi, masing-masing terpisah 1’, untuk 
membuat tiga anak tangga. 

 

 

Gambar: Pindahkan/Salin anak tangga di entri kanan (tepi kanan Persegi Panjang 7). 
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2. Buat dinding tanda masuk dan area tanam. 
a. Di kanan bawah denah, buat satu busur untuk menentukan salah satu tepi 

dinding 
 

Gambar: Draft dan Offset busur untuk membuat tanda masuk dinding dan area tanam. 

b. Offset busur untuk membuat ketebalan dinding dan untuk menentukan tepi 
penanam seperti yang ditunjukkan dalam rencana. 

c. Selanjutnya bagi dinding dan tempat tidur tanam dengan busur dan garis. 

 

Gambar: Menerapkan busur untuk lebih menentukan area penanaman. 
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Gambar: Gunakan tepi untuk menyelesaikan bentuk area tanam dan membuat face yang 
terbagi. 

3. Ciptakan fitur air yang terletak di tengah alun-alun. 
a. Gambar garis diagonal dari salah satu sudut alun-alun ke ujung yang 

berlawanan. 
b. Gunakan alat Circle (View Toolbars Drawing Circle) untuk menggambar 

permukaan bulat pada titik tengah garis diagonal, mencocokkan lingkaran 
tengah pada denah 

 

Gambar: Tempatkan lingkaran di tengah alun-alun dalam. 



288 
 

c. Hapus garis diagonal. Offset lingkaran pertama agar sesuai dengan tepi bulat 
konsentris, seperti yang ditunjukkan pada gambar 

 

 

Gambar: Offset lingkaran tengah untuk membuat tepi air mancur. 

4. Buat trotoar. Tepi antara jalan raya dan jalan setapak serta halaman rumput biasanya 
ditentukan oleh tepi jalan 6″. Menambahkan batasan ke model memberikan isyarat 
visual kepada pemirsa; itu menyampaikan realisme yang halus 

 

Gambar: Bidang rencana yang akan ditebang 

a. Pilih permukaan permukaan tempat trotoar dapat ditemukan. Offset face ke dalam 6 ″. 
Ini akan mengimbangi semua tepi yang membentuk permukaan. 



289 
 

 
 

Gambar: Offset face untuk membuat tepian yang digunakan sebagai trotoar. 

b. Gambarkan garis tegak lurus antara tepi jalan dan garis offset di lokasi di mana tepi 
jalan akan berakhir; trotoar harus terletak hanya berdekatan dengan jalan. Ulangi 
langkah ini untuk area yang dapat menampung trotoar. Pastikan permukaan 
permukaan yang Anda tentukan untuk trotoar dibagi lagi dari permukaan yang 
berdekatan. 

 

Gambar: Tentukan ujung lokasi trotoar. Hapus garis ekstra yang dibuat dari menggunakan 
offset tool. 

 

Gambar: Sebuah tepi jalan ditambahkan ke perimeter situs. 
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5. Buat dinding dan pekebun menggunakan teknik yang sama dengan yang Anda gunakan 
untuk membuat trotoar. Identifikasi area dengan dinding, gunakan offset tool untuk 
memberikan ketebalan, dan (jika perlu) tutup ujungnya dengan menambahkan tepi 
dengan line tool 

 

Gambar: Lokasi dinding penanam pada gambar denah 
 

 

Gambar: Offset permukaan area penanam untuk membuat tepian untuk dinding. 

Tinjau rencana tersebut sebelum Anda melanjutkan ke langkah berikutnya. Jika Anda 
melewatkan sesuatu atau sesuatu perlu disesuaikan, buat draf baris yang diperlukan. Pilih face 
yang menentukan lokasi untuk memastikannya telah dibagi lagi. 
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Membuat Grup dasar Flatwork 

Anda akan membutuhkan gambar rencana untuk membantu mengidentifikasi dan 
menempatkan komponen. Namun, menambahkan warna atau tekstur akan mengaburkan 
gambar denah di bawahnya. Oleh karena itu, sebelum Anda menambahkan warna atau 
tekstur pada permukaan, salin dasar Flatwork dan letakkan di sebelah dasar saat ini. 

 

Gambar : Salin dan tempel Flatwork Base di sebelah aslinya. 

1. Menggunakan selection box, pilih tepi dan geometri yang menyusun Flatwork Base. 
2. Klik kanan dan pilih Make Group. 
3. Buat layer baru bernama 01 - Flatwork. 
4. Pilih grup Flatwork Base, klik kanan dan pilih Entity Info, dan tempatkan grup ke layer 

01 - Flatwork. 
5. Gunakan Pindahkan/Salin dan letakkan salinan grup di dekat aslinya. 

Menambahkan Warna dan tekstur 

Dengan menyeimbangkan warna solid dan tekstur, Anda dapat membuat model Anda lebih 
menarik dan ekspresif secara visual. Gunakan warna dan tekstur yang paling menentukan 
material yang mewakili permukaan. Sebagai aturan umum, terapkan lebih banyak warna solid 
daripada tekstur. Ini akan membantu menggambarkan di antara permukaan. 
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Gambar: Area berwarna di denah lokasi 

Tekstur adalah gambar yang Anda gunakan untuk melukis face. Tekstur dapat diubah 
ukurannya (dibuat lebih besar atau lebih kecil). Untuk mengatur skala tekstur, pilih tekstur di 
bahan jendela dan klik tab Edit. Sesuaikan nilai dalam kotak dialog Gunakan Gambar Tekstur. 

Menghapus gambar tekstur mengubah tekstur menjadi warna solid. Di tab Edit, hapus centang 
Gunakan Gambar Tekstur. 

Untuk menjaga fokus pada denah lokasi, cat permukaan bangunan dengan warna putih. 

Menambahkan Volume 

Saat Anda menambahkan volume ke Flatwork Base, sama seperti saat Anda membuat draf, 
Anda harus melakukannya dalam urutan yang pasti. 

Turunkan permukaan jalan terlebih dahulu. Untuk sebagian besar dasar, itu adalah titik 
terendah dalam model dan menetapkan dasar kedalaman dan tinggi volume. 

Selanjutnya, tentukan permukaan yang ditinggikan tertinggi dalam model. Aturan praktis yang 
mudah adalah menemukan tangga terlebih dahulu. Karena anak tangga dalam model naik ke 
atas, permukaan tempat mereka bertransisi adalah permukaan tertinggi. Ini akan membantu 
menentukan ketinggian permukaan dan volume lainnya. 

Jalan dan Pinggir Jalan 

Push/pull jalan 6″ ke bawah. Ingatlah untuk menghapus kelebihan tepi (dan permukaan) yang 
dibuat dengan Push/Pull di sekeliling permukaan jalan. 
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Gambar: Push/pull jalan 6˝ ke bawah. 

Dalam beberapa situasi, Anda perlu menerapkan kembali warna ke bagian depan volume yang 
dibuat agar sesuai dengan tujuannya. Misalnya, permukaan vertikal trotoar dihasilkan saat 
jalan ditarik ke bawah. Ini menyebabkan warna trotoar cocok dengan jalan. Menggunakan 
Paint Bucket, cocokkan warna trotoar vertikal dengan permukaan horizontal di atasnya (warna 
trotoar dan jalan kaki) 

 

Gambar: Tambahkan warna pada permukaan vertikal di sepanjang jalan. 

Tangga dan Plaza 

Temukan kedua rangkaian langkah. Setiap langkah harus memiliki anak tangga 6 ″. Push/pull 
anak tangga untuk membuat tangga naik ke alun-alun. Pendaratan atau permukaan antara 
anak tangga terakhir dan alun-alun harus sejajar dengan anak tangga terakhir. Push/pull 
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permukaan alun-alun (termasuk permukaan fitur air) agar sesuai dengan ketinggian tempat 
pendaratan 

 
 

Gambar: Push/pull permukaan tertinggi terlebih dahulu. 

Dinding Penanam 

Naikkan dinding penanam yang berdekatan ke ketinggian yang sama dengan alun-alun. 
Push/pull akan”berhenti" dan menyesuaikan ketinggian permukaan yang berdekatan. 
Terapkan Push/pull hingga ketinggian yang diinginkan tercapai. Ketinggian tambahan akan 
ditambahkan ke dinding setelah langkah berikutnya 

 

Gambar: Push/pull dinding penanam agar sesuai dengan ketinggian permukaan alun-alun. 

Lereng 

Sebuah panci sepintas di sekitar alun-alun akan menunjukkan bahwa pintu masuk utara ke 
alun-alun diblokir oleh permukaan vertikal yang dihasilkan pada langkah sebelumnya. 
Rencana tersebut tidak menunjukkan langkah apa pun. Gambar tanjakan untuk 
mengakomodasi pintu masuk. 
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Ada banyak cara untuk menambah jalur landai. Anda akan mempelajari metode lain di Bagian 
3,”Pemodelan Medan", saat mempelajari alat Sandbox. Untuk jalan ini, gunakan line tool dan 
gambar tepi dari titik atas alun-alun (di mana tepi alun-alun dan dinding berpotongan), di 
sepanjang permukaan dinding ke titik akhir entri. Lakukan ini di kedua sisi 

 

Gambar: Untuk membuat permukaan yang berfungsi sebagai tanjakan ke dalam alun-alun, 
gambar garis diagonal dari atas entri ke bawah. 

SketchUp harus menghasilkan permukaan di antara dua tepi yang digambar. Namun, dalam 
beberapa kasus, tepinya mungkin tidak sejajar, sehingga SketchUp tidak dapat menghasilkan 
permukaan. Jika itu terjadi, buatlah garis diagonal dari tepi bawah entri ke tepi atas yang 
berlawanan. Ini akan membuat permukaan/ramp ke dalam alun-alun. Aplikasikan warna yang 
sesuai ke permukaan. 

 

Gambar: Menambahkan warna pada permukaan jalan. 

Penyesuaian Planter Wall 

Menambahkan volume ke dinding penanam membantu membuat referensi ke tepi dan 
permukaan untuk membuat jalur landai. Sekarang, sesuaikan dinding penanam di atas 
permukaan alun-alun yang ditinggikan. Push/pull dinding penanam ke atas 1 kaki lagi. Ini 
sebagian menutupi alun-alun. 
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Push/pull permukaan bedengan tanam sedikit di bawah permukaan atas dinding planter. Tiga 
permukaan yang ditinggikan (alun-alun, dinding penanam, dan tempat tidur tanam) 
membantu menciptakan skala dan daya tarik visual. 

 

Gambar: Push/pull bedengan penanam tepat di bawah bagian atas dinding penanam. 

Entry Sign Wall 

Push/pull dinding tanda masuk ke tinggi/volume 3’ 
 

Gambar: Push/pull dinding tanda masuk setinggi 3’. 

Bangunan sebagai Komponen 

Sebelum Anda menambahkan volume pada luas bangunan, buat setiap permukaan bangunan 
menjadi sebuah komponen lalu tempatkan setiap komponen tersebut ke dalam sebuah layer 
Bangunan. 
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1. Pilih satu sisi dan satu sisi yang membentuk permukaan bangunan. Klik kanan lalu pilih 
Make Component dari menu konteks. Pastikan untuk mencentang kotak Ganti Pilihan 
dengan Komponen 

 

Gambar: Ubah setiap permukaan bangunan menjadi komponen individu. 
 

Gambar: Beri nama setiap komponen Bangunan di menu Pembuatan Komponen. Tempatkan 
komponen Bangunan pada layer Bangunan. 

2. Lakukan ini untuk setiap bangunan. 
3. Dalam kotak dialog Komponen, masukkan nama untuk setiap bangunan: Gedung 1, 

Gedung 2, dan Gedung 3. Buat layer bernama Bangunan, dan gunakan Info Entitas 
untuk menempatkan bangunan pada layer tersebut. 

Langkah ini menyelesaikan dua hal: 
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 Ini memisahkan geometri bangunan dari Flatwork Base, yang memungkinkan 
bangunan ditempatkan pada layernya sendiri. 

 Dengan menempatkan bangunan pada layernya sendiri, bangunan tersebut dapat 
dimatikan sehingga tidak mengganggu saat Anda membuat model. 

 Akan lebih mudah untuk menambahkan detail seperti jendela dan pintu ke gedung. 

Volume Bangunan 

Ketinggian bangunan ditentukan oleh jumlah lantai dan ketinggian lantai ke lantai. Tinggi 
lantai ke lantai mengacu pada jarak antara satu lantai dan lantai berikutnya. Ketinggian lantai 
floorto tipikal berkisar dari 10 ′ hingga 14 ′, dengan pengecualian yang berkisar dari 18 ′ hingga 
22 ′ untuk loteng atau langit-langit berkubah 

 

Gambar: Tentukan tinggi bangunan untuk setiap bangunan. 

Untuk menambah volume bangunan, edit komponen Bangunan. Buatlah tinggi masing-masing 
11’dan 13'. Pilih gedung ketiga dan Push/pull volume ke tinggi 21’. Setelah volume 
ditambahkan, matikan layer Bangunan. Bangunan sekarang tersembunyi dari pandangan. 

Menambahkan Detail ke Volume 

Sekarang setelah volume dasar telah Dorong/Ditarik, sekarang saatnya untuk menyertakan 
detail tambahan yang membantu memberikan lebih banyak artikulasi pada model. 

Merinci Tanda 

Dinding sudut dirancang sebagai tanda di alun-alun; oleh karena itu, ini dapat menggunakan 
beberapa detail tambahan. 

1. Tambahkan penutup dinding sederhana. 
a. Dengan offset tool, pilih bagian atas dinding. Offset face ke luar 3 ″. Tepi muka 

akan berukuran 3 dan membuat muka tumpang tindih dengan tepi aslinya 
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Gambar: Offset bagian atas dinding tanda 3˝ ke arah luar. 

b. Push/pull permukaan baru setinggi 3″. Push/pull permukaan dalam 3 ″ agar 
sesuai dengan permukaan pertama. 

c. Hapus garis berlebih pada face bagian dalam dan tambahkan warna pada face. 
 

Gambar: Push/pull permukaan atas dinding tanda setinggi 3˝. 

2. Tambahkan teks 3D ke permukaan dinding tanda melengkung. Teks 3D (Lihat Text -> 
3D Constructions ->3D Text) akan menghasilkan teks yang diketik dengan tepi, face, 
dan volume. Menu ini memungkinkan Anda untuk memasukkan jenis font, perataan, 
ekstrusi (volume), dan ukuran teks. Pilih OK untuk menghasilkan teks sebagai 
komponen yang dapat ditempatkan di permukaan. 

a. Pilih Lihat Hidden geometry. Garis putus-putus vertikal akan muncul di 
permukaan lengkung dinding. Garis-garis ini menunjukkan bahwa dinding 
lengkung bukanlah kurva yang sebenarnya tetapi terdiri dari rangkaian 
permukaan datar yang menciptakan ilusi dinding lengkung. Anda bisa 
mengaplikasikan teks 3D ke setiap permukaan dinding sehingga bisa juga 
digunakan sebagai tanda. 

b. Tempatkan satu huruf di setiap face 
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Gambar: Untuk membuat tanda, tambahkan teks 3D pada permukaan dinding. 

c. Buka menu Teks 3D dan tentukan pengaturan berikut: 

 Font: Garamond 

 Size: 1 

 Extruded: 2 
d. Satu huruf dalam satu waktu, ketik Google. Tempatkan setiap huruf pada 

permukaan faset yang menentukan dinding vertikal penanam. Setelah semua 
huruf ditempatkan, matikan Hidden geometry (Lihat Hidden geometry). 
Tambahkan warna pada setiap huruf 

 

Gambar: Menambahkan warna pada teks 3D. 

Detailing Planter 

Alat Skala dapat membantu Anda memodelkan geometri yang ada untuk membuat bentuk 
tidak beraturan. Dalam contoh ini, Anda akan menggunakannya untuk membuat dinding 
miring. 

1. Pilih hanya bagian atas dari salah satu dinding penanam yang lebih kecil. 
a. Aktifkan alat Skala. Karena muka datar (2D), hanya delapan gagang skala hijau 

yang akan muncul. Ctrl + Alt dan pilih pegangan hijau sudut dan dorong ke 
dalam. Ini akan mencapai dua hal 

 Face akan diskalakan secara seragam ke dalam di semua sisi. 

 Permukaan dinding vertikal akan terlipat ke dalam dengan 
permukaan atas berskala, menciptakan dinding miring 
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Gambar: Skala bagian atas dinding ke dalam untuk membuat permukaan miring. 
 

Gambar Muka vertikal miring dari dinding penanam 

2. Bagian atas dan ulangi langkah 1. Kali ini, pilih pegangan berwarna hijau di sudut dan 
dorong ke luar. Permukaan vertikal dinding akan terlipat ke luar dengan permukaan 
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Gambar: Skala bagian atas dinding ke luar untuk membuat dinding dengan pengungkit 
 

Gambar: Muka dinding vertikal dengan tuas 

Meskipun metode ini menambahkan detail, namun metode ini menimbulkan beberapa 
masalah dengan geometri di sekitar dinding. Lokasi di mana permukaan dinding dipasang atau 
menempel pada geometri lain, seperti anak tangga, akan mengandung geometri tidak 
beraturan. Ini tidak bisa dihindari; untungnya, geometri yang tidak beraturan dapat ditutup. 
Sambil menahan tombol Shift, gunakan eraser tool dan pilih tepi yang tidak beraturan. Ini akan 
menyembunyikan garis. 
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Gambar: Menyembunyikan geometri tak beraturan yang dibuat saat Anda mengatur skala 
permukaan dinding atas. 

Saat Anda akhirnya menghasilkan gambar atau animasi model dengan geometri yang tidak 
beraturan, hindari fokus pada area tersebut. Sebaliknya, fokuskan gambar Anda di mana 
dinding miring tampak bersih dan diperhitungkan. 

Sekarang berbagai elemen dan permukaan telah ditambahkan dan didetailkan, Flatwork Base 
telah selesai. Pastikan untuk menyimpan model untuk digunakan di bab dan tutorial 
selanjutnya. Langkah selanjutnya untuk model rencana situs adalah untuk mengisi dan 
mengatur komponen yang sudah dibuat sebelumnya dan kustom. 

 

Gambar: Flatwork Base dan volume yang lengkap dan rinci 
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BAB 14 

ARSITEKTUR KUSTOM 

Memahat Bangunan Pemodelan bangunan di SketchUp seperti membuat patung dari batu: 
Pertama, Anda menentukan bentuk keseluruhan, dan kemudian Anda memahat detail 
kecilnya. Dalam istilah pemodelan, ini berarti Anda memodelkan massa bangunan dari volume 
bangunan dan kemudian membuat dan mengisi massa bangunan dengan komponen. 

Membangun Massa Saat membuat model bangunan, tugas pertama Anda adalah membentuk 
volume bangunan menjadi massa bangunan. Massa bangunan adalah rangkaian permukaan 
Push/pull yang menentukan tingkat, tepi, dan luas. Ada banyak cara untuk memanipulasi 
volume untuk menciptakan massa. Metode termudah untuk mengartikulasikan massa 
bangunan adalah dengan menggunakan geometri bangunan yang ada untuk menghasilkan 
lebih banyak detail. 

Mulailah dengan atap. Bagi lagi sisi vertikal volume bangunan dengan memilih muka 
datar”atap" dari volume bangunan dan menyalin muka vertikal ke bawah, dengan 
menggunakan tepi bangunan vertikal sebagai acuan. Face yang terbagi dapat Push/pull untuk 
membuat arkade bangunan, overhang, dan detail lainnya 

 

Gambar: Pindahkan/Salin atap ke bawah. 
 

Gambar: Volume Push/pull dari bagian muka yang terbagi 

Anda selanjutnya dapat mengartikulasikan massa bangunan dengan menggunakan line tool 
untuk membagi permukaan. Face yang terbagi dapat Push/pull untuk menciptakan tampilan 
dan nuansa khusus pada bangunan. 
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Gambar: Membagi volume bangunan menggunakan line tool 
 

Gambar: Muka Push/pull dibagi lagi dengan line tool 

Praktek Membuat Komponen Jendela dan Pintu 

Komponen jendela dan Pintu memberikan skala dan detail, dan lebih jauh menentukan 
estetika sebuah bangunan. Komponen khusus ini dibuat dari geometri massa bangunan untuk 
memotong lubang melalui permukaan tempat komponen tersebut ditempatkan. Jika 
permukaan jendela transparan, geometri di sisi lain menjadi terlihat. 

Untuk membuat komponen jendela, ikuti langkah-langkah berikut: 

1. Buat kubus 10 ′×10 ′×10 
2. Pada salah satu permukaan vertikal, gambar persegi panjang dengan lebar 8’x tinggi 6' 
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Gambar: Membuat komponen jendela pada kubus 10´×10´×10´ 

3. Hapus bagian tengah yang terbagi. 
4. Pilih tepi yang tersisa dari face yang dihapus. 
5. Sambil mengarahkan kursor ke salah satu tepi, klik kanan dan pilih Make Component 

 

Gambar: Pilih tepi face yang dihapus, klik kanan, dan pilih Make Component. 
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6. Dalam menu Komponen, kotak drop-down Glue To harus disetel ke Any dan kotak Cut 
Opening harus dicentang. Setelah dicentang, masukkan nama untuk komponen 
(Contoh jendela) dan pilih OK. Ini akan membuat dasar untuk komponen jendela 

7. Edit komponen yang baru dibuat. Dalam contoh komponen, gunakan alat Line untuk 
healing face yang hilang 

8. Offset face baru 2 ″ ke dalam. Push/pull permukaan tengah ke dalam 2” 
 

Gambar: Heal face di instance komponen jendela 
 

Gambar: Offset permukaan komponen 2˝. Push/pull face 2˝ ke dalam. 

9. Dari menu Material Translucent, pilih Translucent_Glass_Blue. Warnai warna ke face 
tengah. 

10. Keluar dari contoh komponen. 
11. Salin (Edit Salin) dan Tempel (Edit Tempel) jendela dan letakkan di sekitar kubus. 

Perhatikan bagaimana itu memotong lubang di permukaan, memungkinkan jendela 
lain yang ditempatkan terlihat 
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Gambar: Salin komponen di sekitar sisi kubus. 

12. Hapus salah satu komponen yang ditempatkan. Perhatikan bahwa permukaan kubus 
ditutup kembali setelah jendela dihapus. 

 

Gambar: Menghapus komponen jendela menyebabkan permukaan kubus ditutup kembali 

Komponen yang dibuat dapat diskalakan di tempatnya. Dalam banyak kasus, jendela perlu 
diskalakan agar lebih sesuai dengan lokasinya. Ini bisa jadi rumit. 

Yang terbaik adalah menggunakan gagang skala sudut tengah untuk menskalakan komponen 
jendela. Jika komponen jendela atau Pintu ditempatkan pada permukaan, pegangan tengah 
ini mungkin sulit ditemukan. Perbesar ke sudut atau tepi komponen untuk membantu 
menemukan lokasi gagang timbangan. Mengaktifkan View Face Style Xray dapat membantu 
dalam memilih alat Skala tengah. Setelah dipilih, matikan style Xray. Berlatihlah mencoba 
menskalakan jendela pada permukaan kubus. 
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Gambar: Zoom ke sudut komponen untuk memilih pegangan skala tengah. 
 

Gambar: Komponen jendela berskala pada permukaan kubus 
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Memecahkan Masalah Komponen Jendela 

Pada langkah 6, Glue To harus disetel ke Any (default) dan Cut Opening harus dicentang. Jika 
tidak, jendela tidak akan dibuat dengan benar; itu tidak akan memotong bukaan di muka 
tempat ia ditempatkan. Untuk memperbaiki masalah ini, periksa hal berikut: 

 Pastikan geometri jendela tidak digambar di luar contoh komponen Gedung 

 Pastikan persegi panjang yang digambar pada langkah 2 tidak terhubung atau 
menyentuh geometri bangunan lain kecuali bagian muka yang ditempelkan. SketchUp 
memiliki bug yang dapat mencegah pembuatan komponen jendela jika ada tepi yang 
menyentuh geometri bangunan lain. Ini bukan bug yang konsisten, tetapi perlu 
diperhatikan. 

Copy dan Insert 
 

Gambar: Untuk menyalin sebuah komponen, pilih dan kemudian pilih Edit Salin atau Ctrl + C 
 

Gambar:Gunakan Edit – Paste atau Ctrl + V utnuk paste dari copy component 
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Browser Komponen terletak di bawah Komponen jendela. Untuk menampilkan semua 
komponen dalam model, pilih tombol yang terlihat seperti rumah kecil (disebut In Model). 

Semua komponen yang dibuat dalam model akan terlihat di bawah tab ini. Memilih komponen 
di browser akan memasukkan salinan komponen ke dalam model. 

 

 

 
Gambar: Browser Komponen menampilkan semua komponen dalam model. 

Menyalin dan Menempel Antar Instance 

Tutorial arsitektur berikut menggunakan komponen jendela dan Pintu yang sama pada banyak 
bangunan. Untuk berulang kali menggunakan komponen, Anda dapat menyalinnya di antara 
instance komponen. Cukup pilih dan salin komponen saat berada dalam contoh bangunan. 
Saat Anda memasuki instance komponen Bangunan berikutnya, Anda dapat menempelkan 
komponen jendela atau Pintu yang disalin ke permukaan. Seperti biasa, pastikan Anda bekerja 
dalam contoh bangunan yang benar. 

Atau, saat berada dalam instance komponen Bangunan, Anda dapat menggunakan browser 
Komponen untuk memasukkan komponen jendela atau Pintu yang dibuat ke permukaan 
bangunan. 

Make Uniq 

Dalam banyak kasus, bangunan terdiri dari elemen berulang yang memiliki fungsi dan kualitas 
desain yang serupa. Elemen seperti jendela, pintu, dan kolom dapat terdiri dari bahan yang 
sama, berbagi style tertentu, atau memiliki proporsi yang terkait. Pengulangan ini dapat 
berguna saat Anda membuat model bangunan di SketchUp. Membangun satu komponen dan 
mereplikasi di sepanjang permukaan massa bangunan adalah cara cepat untuk merinci sebuah 
bangunan. 
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Jalan pintas yang berguna untuk membuat berbagai jenis jendela, pintu, atau komponen 
lainnya adalah dengan menggunakan komponen asli dan mengedit atau menyesuaikannya. 
Memilih komponen jendela atau Pintu dan membuatnya unik (klik kanan pada komponen dan 
pilih Make Unique) akan membuat versi baru dan terpisah dari komponen itu. Komponen baru 
ini kemudian dapat diedit dan disesuaikan tanpa mempengaruhi komponen aslinya. Cara ini 
bisa lebih cepat daripada membuat komponen baru dari awal. 

 

Gambar: Komponen asli dibuat unik kemudian disesuaikan. 
 

Gambar: Komponen baru dapat diatur untuk membuat style baru tanpa harus membuat 
komponen baru. 
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Gambar: Komponen asli di sebelah kiri dengan komponen yang baru disesuaikan di sebelah 
kanan 

Tutorial 

Tutorial berikut menerapkan konsep yang dibahas di seluruh bab ini. Pertama, Anda akan 
menyetel ruang kerja dengan menyimpan komponen Bangunan ke dalam file mereka sendiri. 
Kemudian Anda akan membuat model massa bangunan dan membuat komponen jendela, 
Pintu, dan Balkon khusus. 

Saat Anda mengerjakan tutorial, pastikan untuk selalu mengingat tip berikut: 

 Komponen jendela perlu dibuat pada permukaan bangunan itu sendiri. 

 Pahami pengaturan komponen saat Anda membuat komponen jendela. 

 Bekerja dalam setiap mesin virtual komponen Bangunan saat Anda menambahkan 
massa atau menempatkan komponen. 

 Jangan memindahkan lokasi gedung. 

 Saat Anda mencoba menskalakan jendela dan pintu pada permukaan bangunan, 
bersabarlah. 

Mengatur Ruang Kerja 

Ikuti langkah-langkah berikut untuk”menyetel ruang kerja" dan membuat file terpisah untuk 
komponen Bangunan. Anda dapat menerapkan langkah-langkah ini untuk memisahkan 
komponen apa pun dari model untuk pemodelan yang lebih mudah. 

1. Buka model denah lokasi. Pilih ketiga bangunan (masing-masing harus menjadi 
komponen). Dengan ketiga bangunan dipilih, klik kanan dan pilih Make Component. 
Beri nama Bangunan komponen baru. 

2. Klik kanan komponen Bangunan yang dibuat pada langkah 1. Dari menu konteks, pilih 
Simpan Sebagai. SketchUp akan meminta lokasi untuk menyimpan komponen 
Bangunan sebagai file SketchUp (.skp) terpisah. Simpan file di folder yang sama dengan 
model rencana situs. Komponen Bangunan sekarang menjadi file model SketchUp 
miliknya sendiri. Pastikan untuk menyimpan file Flatwork Base untuk menyertakan 
pembuatan komponen Bangunan. 

3. Buka file komponen Bangunan yang disimpan. Perhatikan bahwa bangunan di file yang 
disimpan tidak lagi menjadi bagian dari komponen Bangunan besar yang dibuat di 
langkah 1; setiap struktur sekali lagi merupakan komponen individual. 
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4. Setelah semua detail ditambahkan ke komponen Bangunan dalam model, file akan 
disimpan dan dimuat ulang ke dalam model denah lokasi. Jangan mengubah lokasi fisik 
bangunan. Mengubah lokasi fisik akan menyebabkan bangunan bergeser posisi setelah 
dimuat ulang dalam denah lokasi. 

Menambahkan Massa ke Gedung 1 dan 2 

Tutorial ini menambahkan massa dan detail pada Bangunan 1 dan 2. Anda akan 
menambahkan detail massa ke atap dan permukaan vertikal bangunan. Harap dicatat bahwa 
Anda harus menambahkan detail terutama pada sisi kedua bangunan yang menghadap alun- 
alun denah lokasi. 

Unduh Model: Denah Lokasi Konseptual - Massa Bangunan 
 

Gambar: Referensi bangunan 
 

 

1. Dimulai dengan atap Gedung 1, pilih permukaan atas. Dengan alat Pindah/Salin, buat 
dua salinan ke bawah dari permukaan atap di sepanjang sumbu vertikal bangunan 
dengan interval 1’. Gunakan tepi vertikal bangunan sebagai titik acuan. 
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2. Pada bangunan yang berdekatan, salin atap menghadap ke bawah. Pasangkan salinan 
ke salinan tepi atap yang dibuat pada langkah 1. Face dan tepi yang disalin akan 
membagi lagi permukaan vertikal bangunan. 

3. Push/pull permukaan bawah vertikal kedua bangunan ke dalam 4’untuk membuat 
arcade bangunan seperti yang ditunjukkan. 

 

 
4. Offset permukaan atas setiap bangunan 2’ke dalam. Push/pull permukaan tengah 

Offset 1’ke bawah. Ini menciptakan kesan halus pada atap dengan bibir. 
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5. Pada permukaan sudut Gedung 1, gambar persegi panjang berukuran 18″ dari bagian 
bawah overhang ke tepi bawah bangunan. Pilih face dan tepi dari face yang terbagi. 
Jadikan itu komponen yang disebut Kolom 1. Masuk ke instance komponen dan 
Push/Pull face outward 8 ″ untuk membuat kolom yang diekstrusi. 

6. Pindahkan/Salin komponen sepanjang muka bangunan 70’. Array-bagi (5 /) segera 
setelah Pindah/Salin awal. 

 

Kolom disusun di sepanjang permukaan bangunan 
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7. Salin kolom dari Gedung 1 ke Gedung 2. Komponen Kolom perlu disalin dari instance 
Building 1 ke instance Building 2. Putar komponen sehingga sejajar dengan permukaan 
Bangunan 2. Bagilah-larik komponen (4 /) di sepanjang permukaan Bangunan 2. 

8. Kembali ke Gedung 1 dan Push/pull sisi vertikal kedua menghadap ke bawah dari atap, 
ke dalam 6 ″ di semua sisi. Ulangi langkah ini untuk Bangunan 2. 

 

Menambahkan Massa ke Gedung 3 

Tutorial ini menambahkan massa ke Gedung 3. Bangunan 3 akan memiliki beberapa detail 
tambahan yang ditambahkan dibandingkan dengan bangunan sebelumnya. Seperti bangunan 
sebelumnya, detail harus ditambahkan pada sisi bangunan yang menghadap ke alun-alun. 
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1. Salin atap ke bawah 1 ′ dan 9′-6 ″ di sepanjang sumbu vertikal. Tepi yang disalin kedua 
menunjukkan pemisahan antara lantai pertama dan kedua. Gambarlah tepi yang 
membelah panjang atap dari titik tengah ke titik tengah. 

 

 

 
2. Push/pull dua permukaan bangunan bawah 1’ke dalam. Push/pull bagian depan 

bawah bangunan 5’ke dalam. Naikkan tepi atap yang disusun pada langkah pertama 
setinggi 8 kaki untuk membuat atap miring. 
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3. Di langkan sudut dari arcade bangunan, gambar persegi panjang 1’× 2'. Ubah menjadi 
komponen yang disebut Kolom 2. Push/pull ke bawah menuju tanah untuk menambah 
volume. 

4. Salin kolom ke titik ujung tepi berlawanan dari panjang bangunan. Array-bagi kolom (9 
/). 

 

Komponen Jendela 
 

Sekarang setelah Anda menambahkan massa pada bangunan, Anda dapat menambahkan 
komponen jendela. Anda akan belajar membuat variasi jendela dari satu komponen. 

1. Gambarlah face 7’× 9' pada Gedung 1, di antara kolom-kolom tersebut. Hapus face 
yang terbagi. Pastikan untuk bekerja di instance Building 1. 

2. Pilih keempat tepi, klik kanan pada salah satu tepi, dan pilih Make Component. 
Pastikan Glue To disetel ke Any dan kotak Cut Opening dicentang. Beri nama 
komponen jendela 1 

3. Dalam contoh komponen, pulihkan face dengan tool Line. 
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4. Di bagian depan, gambar dan offset face dengan dimensi yang ditampilkan dalam 
grafik. 

 

5. Push/pull permukaan besar ke dalam 3 ″. Tambahkan warna 
(Translucent_Glass_Corrugated) ke permukaan yang besar. Warnai tiang jendela 
(dukungan jendela) menggunakan Color_008. 
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6. Keluar dari instance jendela 1. Pindahkan jendela ke pojok kiri atas, memotong 
overhang dan tepi kolom. 

7. Skalakan komponen agar pas di antara dua kolom. 
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8. Pilih jendela dan salin dengan menggunakan titik akhir kolom sebagai referensi. 
jendela yang disalin akan memotong face tempat ia ditempatkan 

 

 

9. Array window empat kali (5x) segera setelah menyalin komponen di langkah 8. jendela 
harus disalin di antara kolom. 
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10. Salin jendela dari Gedung 1 ke dalam contoh komponen Gedung 2. Pilih komponen 
yang disalin lalu pilih Make Unique. 

11. Skala lebar komponen jendela menjadi setengah (Faktor Skala .5). Salin jendela 
berskala di sebelah aslinya. Harus ada dua komponen jendela di antara kolom. 

 

12. Dalam contoh komponen jendela, di dasar jendela, gambar persegi panjang dengan 
dimensi yang ditunjukkan. Ubah persegi panjang yang digambar menjadi sebuah 
komponen. Beri nama Awning. 

13. Dalam contoh komponen Tenda, Push/pull permukaan persegi panjang setinggi 3 ″. 
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14. Keluar dari instance komponen Awning, dan pindahkan komponen ke atas pada 
jendela seperti yang ditunjukkan. 

15.  Edit komponen Tenda. Pilih dua tepi depan. Pindahkan ujung-ujungnya ke bawah 
sepanjang sumbu vertikal. Bagian muka akan terlipat ke bawah, menciptakan tenda 
bersudut. 

 



325 
 

 
 

16. Edit warna komponen Bangunan dan jendela. 
a. Warnai permukaan yang lebih besar: Translucent_Glass_Gold. 
b. Warnai empat jendela teratas: Translucent_Glass_Green_Dark. Jendela telah 

ditambahkan ke Gedung 1 dan Gedung 2. 
 

Komponen Pintu 

Tutorial ini menambahkan komponen Pintu. Seperti variasi jendela, komponen Pintu akan 
dibuat menggunakan komponen jendela yang sudah dibuat 

1. Pilih komponen jendela tengah dari Bangunan 1. Buat komponen unik. 
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2. Dalam contoh komponen unik, buat draf garis seperti yang ditunjukkan dalam diagram. 
a. Offset dua sisi jendela besar 3” 
b. Buat garis di tengah setiap face di sepanjang titik tengah. 
c. Buat garis di seluruh face. Offset garis horizontal 2” 

3. Warnai bagian muka dari bagian muka yang terbagi 
4. Ulangi langkah sebelumnya dan tambahkan geometri pintu ke jendela yang 

ditunjukkan pada Gedung 2. 
 

Komponen Balkon 
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Tutorial ini menambahkan komponen Balkon, yang akan ditambahkan ke Gedung 3. 

1. Pada permukaan lantai dua Gedung 3, di antara kolom pertama, buat draf komponen 
untuk balkon. 

a. Buat draf permukaan 14’× 8', 6 ″ dari tepi bawah tingkat kedua. 
b. Hapus face, pilih tepi, dan buat tepi dalam komponen yang disebut Balkon 
c. Di dalam komponen tersebut, sembuhkan face. d. Offset face 2 ″. 

2. Push/pull permukaan tengah 4’ke dalam. 
 

 
3. Pada permukaan Push/pull dari langkah 2, buat draf garis tambahan untuk 

menentukan pintu dan jendela balkon. Offset face 2 ″. Gambarlah tiang jendela (lebar 
2″), seperti yang ditunjukkan pada diagram. Push/pull permukaan yang lebih besar ke 
dalam 3 ″. 
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4. Tambahkan warna Translucent_Glass_Blue ke permukaan jendela. Warnai mullion 
menggunakan Color_001. 

 

5. Offset tepi bawah balkon 6 ke dalam. Offset lagi 3 ″. Pastikan face terbagi lagi. 
 

6. Push/pull permukaan lebar 3’lebar 3' untuk membuat rel balkon. 
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7. Copy/Array komponen Balkon antara kolom bangunan 
 

8. Menyalin dan Membuat Unik komponen jendela dan Pintu dari Bangunan 2. 
Tempatkan di sepanjang permukaan lantai pertama Gedung 3. Sesuaikan warna kaca 
komponen jendela dan Pintu yang disalin agar sesuai dengan warna balkon 
(Translucent_Glass_Blue). 

9. Simpan file. 
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BAB 15 

MENYUSUN DAN MEMPRESENTASIKAN MODEL 

Sekarang Flatwork Base, perabotan situs kustom, dan arsitektur bangunan telah selesai, Anda 
memiliki satu langkah terakhir untuk menyelesaikan model Anda. Anda masih perlu 
menyatukan semua geometri dan komponen untuk membuat gambar yang rapi. Saat Anda 
membaca tentang konsep yang disajikan dalam bab ini, Anda akan memperbarui model denah 
lokasi Flatwork Base. Dalam bab ini, Anda akan diperkenalkan dengan konsep berikut: 

 Menata vegetasi dan komponen penyempurnaan lokasi 

 Menempatkan komponen dalam urutan logis 

 Membuat dan mengekspor scene 

Metode Penyusunan 

Saat Anda bekerja lebih banyak dengan SketchUp, Anda akan menemukan bahwa Anda sering 
perlu memindahkan objek dari satu lokasi ke lokasi lain. Misalnya, Anda mungkin perlu 
memindahkan komponen dari satu file SketchUp ke file lainnya atau dari gambar denah 2D ke 
3D Flatwork Base. Memahami bagaimana dan mengapa komponen seperti vegetasi dan 
perabotan lokasi dipindahkan sangat berharga saat Anda bekerja dengan SketchUp. Bab ini 
membahas dua metode pengaturan yang berbeda: metode Akurasi dan metode Kecepatan. 

Denah lokasi Flatwork Base yang Anda buat memberikan kesempatan untuk 
mempertimbangkan metode berbeda untuk mengatur komponen situs. Dalam tutorial ini, 
Anda akan menempatkan komponen vegetasi menggunakan metode Akurasi, dan Anda akan 
menambahkan perabotan situs menggunakan metode Kecepatan. 

Metode Akurasi 

Gambar denah 2D memberikan lokasi yang akurat untuk semua vegetasi dan perabotan situs. 
Setelah komponen diimpor dan ditempatkan pada gambar denah 2D, mereka dapat 
dipindahkan ke lokasi yang sama di Flatwork Base. 

Dengan menggunakan titik akhir gambar denah dan titik akhir Flatwork Base, Anda dapat 
merelokasi komponen yang dipilih dengan alat Pindahkan/Salin. 

 

Gambar: Gambar denah dan Flatwork Base 

Jika Flatwork Base menyertakan volume yang ditinggikan (seperti alun-alun, anak tangga, dan 
trotoar), setiap komponen yang direlokasi akan muncul di bawah permukaan dan permukaan 
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base. Anda perlu memindahkan setiap komponen ke atas pada sumbu vertikal untuk duduk di 
atas permukaan Flatwork Base. 

Metode Kecepatan 

Anda dapat memperkirakan lokasi objek di Flatwork Base menggunakan gambar denah 
sebagai referensi visual. Cara penataan ini lebih cepat (tidak perlu menaikkan komponen), 
tetapi kurang akurat. 

Urutan dan penyesuaian logis 

Menempatkan komponen dalam urutan tertentu dapat membantu merampingkan tata letak 
komponen, memelihara organisasi layer, dan mengoptimalkan kinerja komputer. Dengan 
menempatkan objek komponen ini dalam urutan berikut, Anda akan dengan mudah dapat 
menambahkan lebih banyak detail. 

1. Bangunan 
2. Vegetasi 3D 
3. Komponen lokasi 

Bangunan 

Muat ulang komponen Bangunan yang disimpan dari model asli. Langkah sederhana ini 
menghidupkan denah lokasi dan memberikan konteks saat Anda mengimpor vegetasi dan 
perabotan lokasi. Dalam model Flatwork Base, pilih komponen Bangunan yang tidak 
diartikulasikan. Klik kanan dan pilih Muat Ulang. Jelajahi lokasi folder komponen Bangunan 
Pilih file yang benar dan klik Buka. Bangunan akan diperbarui untuk mencerminkan perubahan 
dan komponen yang diselesaikan dari tutorial. 

 

Gambar: Muat ulang komponen Bangunan di denah lokasi. 

Bangunan yang telah disesuaikan telah meninggalkan celah di Flatwork Base. Celah tersebut 
terjadi saat arkade bangunan ditambahkan ke massings 

Matikan layer Bangunan. Dengan alat Rectangle, masukkan instance Flatwork Base dan 
tambahkan permukaan untuk mengisi lokasi bangunan. Warnai permukaan agar sesuai 
dengan beton yang berdekatan dari Flatwork Base. 

Vegetasi 3D 

Pohon tiga dimensi merupakan komponen yang sangat diinginkan; mereka menambahkan 
realisme, skala, dan estetika. Mereka terdiri dari banyak tepi dan permukaan — dan dapat 
mengganggu kinerja komputer. Tips berikut dapat membantu Anda mengelola komponen ini 
dengan mempertahankan organisasi dan kinerja, sambil menambahkan detail yang kaya. 
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Gambar: Perbaiki geometri permukaan di lokasi bangunan 

Tambahkan dan sesuaikan tiga varietas pohon 3D menggunakan metode Akurasi. 

1. Berbagai jenis vegetasi harus ditempatkan pada layer yang terpisah. Misalnya, model 
denah lokasi menunjukkan tiga jenis pohon yang berbeda. Sertakan tiga layer untuk 
mengakomodasi setiap varietas pohon. Nama layer yang disarankan adalah Trees 01, 
Trees 02, dan Trees 03. 

2. Jika Anda memiliki banyak komponen vegetasi tertentu, bagi komponen tersebut 
menjadi beberapa layer. Pisahkan vegetasi berdasarkan lokasi atau pengelompokan 
jika diperlukan. Sebagai latihan tambahan, alih-alih membuat tiga layer Pohon, buat 
enam. Pisahkan setiap pengelompokan pohon menjadi dua kelompok. 

3. Vegetasi 3D yang diimpor dengan tipe seragam tampak artifisial dan berulang; ia tidak 
memiliki kualitas alami dan organik. Penampilan yang tidak wajar ini dapat dengan 
mudah diperbaiki dengan ekstensi khusus yang disebut Skala CLF dan Putar Banyak. 
Skala CLF dan Rotate Multiple mengacak sumbu rotasi dan tinggi komponen yang 
dipilih untuk menciptakan kebiasaan yang lebih alami dan organik. Itu dapat 
ditemukan dan dipasang dari Extension warehouse secara gratis. Pergi ke Extension 
Chris Fulmer Tools Scale dan Rotate Multiple Scale dan Rotate Randomly. Ini akan 
memunculkan menu yang memungkinkan Anda menyesuaikan faktor skala. 
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Gambar: Impor dan susun pepohonan 3D ke gambar denah. 
 

 

Gambar: Terapkan Skala CLF dan Putar Banyak ke pohon 3D. 
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Gambar: Sesuaikan skala beberapa pohon. 
 

Gambar: Impor dan sesuaikan tipe vegetasi kedua. 



335 
 

 
 

Gambar: Terapkan Skala CLF dan Putar Banyak. 
 

 

Gambar: Tambahkan tipe vegetasi 3D ketiga. Ingatlah untuk menggunakan layer. 
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Gambar: Terapkan Skala CLF dan Putar Beberapa dan kemudian sesuaikan. 
 

 

Gambar: Menggunakan titik ujung kanan bawah pada alas sebagai referensi, pindahkan pohon 
dari gambar denah ke Flatwork Base. 

 

Gambar: Gambar rencana dan lokasi elemen situs 

4. Pilih semua vegetasi setelah ditempatkan dan disesuaikan. Pindahkan menggunakan 
metode Akurasi. Pilih komponen Tree yang terletak pada gambar denah 2D dan 
pindahkan ke Flatwork Base. Referensi titik akhir sudut yang sama dari gambar 2D dan 
Flatwork Base untuk memindahkan komponen. 

5. Untuk membantu kinerja komputer, matikan layer Vegetasi saat sudah selesai. Ini akan 
memungkinkan Anda untuk terus bekerja dalam model tanpa perlambatan SketchUp 
karena jumlah permukaan vegetasi 3D yang tinggi. Misalnya, setelah varietas pohon 
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disertakan dalam model, buatlah itu tidak terlihat sebelum Anda menambahkan lebih 
banyak jenis pohon. Nyalakan layer Vegetasi hanya jika: 

 Model sedang dievaluasi untuk desain dan estetika. 

 Anda mengekspor tampilan model ke gambar atau animasi. 

Menyerahkan Komponen 

Perabotan situs tidak perlu diatur dalam urutan tertentu. Ini benar apakah Anda sedang 
menyusun komponen yang dibuat sebelumnya yang serupa. Namun, sebagai aturan umum, 
Anda harus memastikan setiap jenis komponen berada di layernya sendiri. Sebelum Anda 
mengimpor komponen, buat layer untuk setiap jenis perabotan dan aktifkan. 

 
 
 
 

 

Gambar: Impor dan sisipkan komponen situs yang dibuat khusus. Masukkan tonggak, lampu 
pejalan kaki, bangku taman, bangku penanam, dan pegangan tangan. 

Meskipun komponen khusus tersedia, termasuk komponen yang dibuat sebelumnya dapat 
menambah detail model. Untuk latihan ini, impor pertama, susun, dan skala komponen 
kustom yang dibuat menggunakan metode Kecepatan. Selanjutnya, tambahkan komponen 
yang sudah jadi. 
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Gambar: Sertakan komponen yang telah dibuat sebelumnya untuk melengkapi perabotan 
situs kustom. Sertakan komponen tambahan seperti meja dan kursi, tempat sampah, mobil, 
orang, dan jet air. 

 
 
 

Gambar: Jet air siap pakai termasuk dalam air mancur tenga. 

FormFonts menawarkan pustaka paling serbaguna dari komponen situs yang dibuat dengan 
baik dan dibuat sebelumnya (elemen arsitektur juga). Komponen ini dapat diunduh dengan 
cepat untuk membuat component library yang substansial dan dapat digunakan kembali. 
Untuk berlangganan, kunjungi www.formfonts.com. 

http://www.formfonts.com/
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Membuat dan mengekspor Scene 

Setelah Flatwork Base diisi dengan bangunan, vegetasi, dan perabotan lokasi, gunakan alat 
berikut untuk menyetel posisi kamera, menyesuaikan bidang pandang, dan mengaktifkan 
Langit dan Bayangan. Saat Anda membaca bagian ini, coba buat ulang scene yang 
diperlihatkan dalam langkah 1 hingga 7. 

Memilih Scene Anda 

Geser model untuk menemukan tampilan yang Anda inginkan. Saat Anda menemukannya, 
simpan scene dengan membuka jendela Default Baki Pemandangan dan pilih tombol Tambah 
Pemandangan (tanda tambah) untuk menambahkan pemandangan. Temukan dan buat 
semua scene Anda sebelum mengekspor gambar apa pun. 

 

 

Gambar: Membuat scene dengan menu Pemandangan 

Menu Pemandangan 

Ketika tombol Add Scene dipilih, SketchUp akan menyimpan posisi relatif kamera. Tab Scene 
akan dibuat di bawah garis menu. Menggeser menjauh dari scene dan kemudian memilih tab 
Pemandangan yang dihasilkan akan mengembalikan kamera ke scene yang disimpan. 
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Menu Scene memungkinkan Anda untuk menyempurnakan scene yang disimpan. Banyak opsi 
berbeda dapat disesuaikan saat menyimpan pemandangan. Secara default, semua opsi dipilih, 
yang berarti bahwa nilai atau posisi apa pun yang ada saat scene ditambahkan akan dimuat 
ulang saat scene diaktifkan kembali. Tinjau opsi di bawah menu Scene dan lakukan eksperimen 
dengan cara menyesuaikannya. 

Tool Camera position 

Saat Tool Camera position (View Toolbars Walk Through Position) aktif, Anda dapat memilih 
lokasi dalam model dengan menjentikkan ke tepi atau face. Setelah dipilih, tampilan akan 
bergeser untuk menempatkan kamera di lokasi tepat yang dipilih sebagai sudut pandang 
orang pertama, 5’di atas tanah — tampilan akan seperti Anda berdiri di lokasi itu. 

Alat Melihat Sekitar 

Anda dapat menyesuaikan tampilan lebih banyak lagi menggunakan alat Melihat Sekeliling 
(Lihat Bilah Alat Berjalan Melalui Melihat Sekeliling). Setelah alat tersebut aktif, Anda dapat 
menggeser kamera ke segala arah sambil mempertahankan lokasinya saat ini. 

Alat Zoom 

Memilih alat Zoom (Zoom Kamera View Toolbars) memungkinkan pengguna untuk 
menyesuaikan lebar dan lebar (bidang pandang atau kedalaman bidang) dari tampilan kamera 
hanya dengan mengetikkan nilai ke dalam measurement window dan menekan Enter. Fitur ini 
bekerja mirip dengan lensa kamera asli; memilih Zoom dan memasukkan 35mm ke dalam 
measurement window akan menyesuaikan tampilan kamera yang mirip dengan lensa kamera 
35 milimeter. 

Tampilan Rencana dan Ketinggian 

SketchUp memungkinkan Anda melihat ketinggian (tampilan samping) dan rencana (tampilan 
atas-bawah) model. Buka menu Kamera dan pilih Proyeksi Paralel. Ini akan menyesuaikan 
kamera ke tampilan nonperspektif. Selanjutnya, pilih View Toolbars Views. Menu Tampilan 
menyediakan tampilan isometrik, denah, dan sisi model. Dengan Proyeksi Paralel aktif, 
bersama-sama dengan Tampilan, SketchUp akan menghasilkan tampilan rencana (Atas) dan 
ketinggian (Depan, Kanan, Belakang, Kiri). 

Orang dan Mobil 

Orang dan mobil adalah objek terakhir yang Anda tambahkan ke model. Dengan 
menggunakan orang dan komponen mobil siap pakai, Anda dapat menghidupkan model dan 
menunjukkan konteks bangunan, skala, dan bagaimana ruang digunakan 

Cara yang efisien untuk menempatkan mobil dan orang adalah berdasarkan scene demi scene 
— terutama untuk tampilan tingkat mata. Tentukan pemandangan apa yang diinginkan dan 
tambahkan orang dan mobil sesuai kebutuhan. 

Pohon dan Pemandangan 

Saat Anda mencoba menentukan pemandangan dengan menavigasi di sekitar model, coba 
aktifkan layer Pohon. Jika ini menyebabkan masalah kinerja yang serius, Anda selalu dapat 
menonaktifkan layer Pohon. Temukan lokasi tampilan yang Anda suka, dan nyalakan 
pepohonan sehingga Anda dapat menilai pemandangan tersebut. Jika Anda menemukan 
pemandangan yang Anda suka, pertama-tama aktifkan layer Pohon, lalu tambahkan 
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pemandangan tersebut. Ini akan memastikan bahwa layer Pohon dihidupkan ketika tab Scene 
tertentu dipilih. 

Hanya aktifkan layer Pohon yang akan terlihat di tempat kejadian. Pepohonan yang tidak ada 
dalam layar tampilan untuk pemandangan tertentu harus tetap tidak terlihat, jika 
memungkinkan. Ini akan membantu menghasilkan ekspor lebih cepat. Lakukan ini dengan 
menempatkan tipe pohon pada banyak layer, seperti yang ditunjukkan sebelumnya. 

Menambahkan Langit 

SketchUp dapat mensimulasikan warna langit. Menambahkan latar belakang langit 
memberikan kedalaman dan realisme pada pemandangan setinggi mata. Untuk 
menghidupkan langit, pergi ke Window Default Tray Styles Edit Tab Background Settings 
centang kotak Sky. 

Untuk menyesuaikan warna langit, klik dua kali contoh warna di sebelah kotak Langit. 

 
Mengekspor Scene dan Bayangan 

Bayangan harus diaktifkan hanya saat Anda mengekspor gambar. Pohon 3D yang mendetail 
yang digabungkan dengan Shadows akan membuat navigasi menjadi tidak mungkin bahkan 
pada sistem komputer terbaik. 

Saat scene Anda siap untuk diekspor, pilih tab Scene yang diinginkan, tunggu SketchUp 
menavigasi ke scene, lalu aktifkan Shadows. Ekspor tempat kejadian 

Mengekspor scene dengan Bayangan dihidupkan dapat memakan waktu dari 5 hingga 15 
menit, tergantung pada komputer. Menggunakan pohon 3D dengan Bayangan dihidupkan 
dapat meningkatkan waktu render dengan faktor 10. Ketika pemandangan seperti itu diekspor, 
sumber daya komputer digunakan secara maksimal. Anda dapat menggunakan aplikasi lain, 
tetapi akan sulit untuk masuk kembali ke SketchUp. Tunggu hingga render selesai. SketchUp 
akan tampak terhenti (tidak merespons); Namun, biasanya tidak demikian. Kemampuan 
SketchUp untuk menyediakan scene yang dirender secara real-time adalah unik dan 
membutuhkan waktu. Scene yang diekspor layak untuk ditunggu. Setelah ekspor selesai, 
matikan Shadows sebelum Anda memilih tab Scene berikutnya. 

Memecahkan Masalah Bayangan 

Jika sebuah objek memancarkan bayangan pada titik yang menguntungkan dari tampilan 
tingkat mata, bayangan pemandangan akan terdistorsi. Ada dua solusi untuk masalah ini: 

 Anda dapat menyesuaikan pengaturan lokasi atau bayangan pemandangan. 
 Anda dapat menentukan objek mana yang memancarkan bayangan pada titik pandang 

kamera. Pilih objek itu (biasanya, ini akan menjadi komponen Bangunan atau Pohon di 
belakang atau berbatasan langsung dengan posisi scene) dan klik kanan untuk 
membuka Info Entitas. Di bawah Entity Info, hapus centang pada kotak Cast Shadow. 
Objek tidak akan menghasilkan bayangan saat dinyalakan, sehingga tidak akan 
merusak kamera. 
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Gambar: Menu Entity Info dengan opsi Cast ShadowsDalam tutorial ini, Anda akan belajar 
menduplikasi pemandangan dan memecahkan masalah dengan bayangan. 

Unduh file: Rencana Situs Konseptual – Selesai 

1. Nyalakan layer Tree setelah tampilan diatur. Atur Field Of View menjadi 55mm. 
Tambahkan scene. Nyalakan Shadows. Setelah Bayangan aktif, jangan menggeser atau 
bergerak dalam model. 

 

Gambar: Navigasikan ke dan coba buat ulang scene ini. 

2. Di bawah File Export, simpan scene sebagai JPEG. (Tingkat detail dalam model akan 
menyebabkan ekspor gambar dari SketchUp membutuhkan waktu antara 2 dan 10 
menit. Ini adalah biaya untuk menambahkan detail tersebut. Namun, gambar akan 
menjadi ekspresif dan kaya.) Praktikkan mengekspor lebih banyak gambar. 

3. Setelah gambar diekspor, matikan Shadows. 
4. Sesuaikan tampilan model menjadi melihat ke bawah dan memfokuskan pada alun- 

alun. 
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Gambar: Pemandangan alun-alun dari mata burung 

5. Tambahkan scene dari menu Scene. 
6. Aktifkan Shadows dan ekspor gambar, seperti pada langkah 2. 
7. Matikan Shadows setelah ekspor selesai. 
8. Di bawah Kamera, aktifkan Proyeksi Paralel. 
9. Pilih Top dari menu View. Ini akan membuat tampilan denah model yang sebenarnya. 

 

 

Gambar: Gambar tampilan rencana dengan bayangan 

10. Matikan pohon di halaman pohon yang lebih besar. 
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11. Nyalakan Shadows. 

12. Ekspor gambar. 
13. Matikan Shadows setelah ekspor selesai. Di bawah Kamera, pilih Perspektif. 
14. Di bawah menu Camera, pilih Position Camera. 
15. Paskan ke lokasi di depan alun-alun sehingga tangga dapat terlihat di latar depan. 
16. Tambahkan scene. 
17. Nyalakan Shadows dan ekspor pemandangan. Matikan Shadows setelah selesai. 
18. Scene berikutnya ini lebih sulit untuk disiapkan. 

 

Gambar: Pemandangan alun-alun dari tangga depan dekat jalan raya 
 

Gambar: Pemandangan alun-alun dari dalam lantai dua gedung. Pepohonan dimatikan untuk 
melihat alun-alun dengan jelas. 

19. Arahkan ke Gedung # 3. 
20. Dengan menggunakan Position Camera, cobalah memposisikan pandangan untuk 

melihat alun-alun dari balik jendela kaca salah satu balkon. Pilih lokasi balkon di 
gedung yang menunjukkan pemandangan ke tengah alun-alun. Matikan semua layer 
Pohon yang mungkin menghalangi tampilan. Triknya adalah menavigasi dari posisi 
yang dipilih, mundur di belakang kaca. 

21. Tambahkan scene. 
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22. Nyalakan Shadows. Jika bayangan mendistorsi tampilan, matikan bayangan, menjauh 
dari posisinya, dan pilih Bangunan # 3 (Anda harus memasukkan contoh komponen 
bangunan untuk melakukannya). Dengan bangunan yang dipilih, klik kanan dan buka 
Entity Info. Hapus centang pada kotak Cast Shadow. Pilih tombol Scene Tab. Sekarang 
nyalakan Shadows dan ekspor pemandangannya. 

23. Matikan Shadows setelah scene diekspor. Cobalah untuk membuat ulang dan 
mengekspor pemandangan untuk dua gambar terakhir. 

Gunakan langkah-langkah yang diuraikan untuk ekspor sebelumnya untuk menambahkan 
pemandangan, mengaktifkan bayangan, dan mengekspor gambar. 

 

Gambar: Pemandangan dari bangku pekebun dari bawah gedung arcade 
 

 

Gambar: Pemandangan jalan setapak antara alun-alun dan bangunan yang berdekatan 
dengan jalan alun-alun 
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BAB 16 

TUTORIAL ARSITEKTUR 

Bab ini menguji keterampilan penyusunan dan pemodelan Anda. Untuk menyelesaikan model 
tutorial dengan sukses, Anda perlu menerapkan pelajaran dan prosedur yang Anda pelajari di 
bab sebelumnya. Latihan tersebut berfokus pada pembangunan sebuah bangunan kompleks 
dari awal. Anda akan merancang pelat lantai yang rumit, menghasilkan massa bangunan yang 
terlibat, dan menerapkan satu set komponen jendela dan Pintu khusus untuk menyelesaikan 
struktur. Selain itu, Anda akan belajar cara bekerja dengan busur dan tepi lingkaran dan cara 
mencangkok komponen ke permukaan melengkung 

Tutorial menggunakan gedung Jefferson County Courthouse, yang terletak di Lakewood, 
Colorado, sebagai inspirasinya. Anda akan membuat model bangunan yang konseptual dan 
masuk akal. Sifat desain bangunan yang menantang menjadikannya latihan yang bagus. 

Tutorial ini menggunakan Pemodelan Proses SketchUp. Sekali lagi, prosesnya adalah sebagai 
berikut: 

1. Membuat draf denah/garis besar tapak bangunan 2D. 
2. Push/pull volume. 
3. Tambahkan warna. 
4. Buat komponen jendela dan Pintu khusus. 
5. Susunlah komponen-komponen pada bangunan tersebut. 

Bekerja dengan busur dan Lingkaran 

Geometri busur dan lingkaran tidak dibangun dari kurva atau lingkaran yang sebenarnya. 
Sebaliknya, busur dan lingkaran terdiri dari serangkaian tepi linier, atau segi, untuk 
menggambarkan kelengkungan dan kebulatan. 

SketchUp memungkinkan Anda menyesuaikan jumlah tepi yang membentuk busur dan 
lingkaran. Saat pertama kali mengaktifkan alat Arc atau Circle (cukup klik), measurement 
window akan menampilkan Sisi. Jumlah default sisi untuk sebuah busur adalah 12, dan default 
untuk lingkaran adalah 24. Ini berarti bahwa setiap busur atau lingkaran yang digambar — 
tidak peduli panjang, orientasi, atau ukurannya — akan terdiri dari 12 atau 24 faset kecuali 
Anda mengubah default. 
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Gambar: Tepi menyusun busur dan lingkaran 

Nilai default dapat disesuaikan untuk menambah atau mengurangi jumlah sisi. Lebih banyak 
sisi membuat kurva lebih halus dan bulat. Namun, lebih banyak faset dapat mempersulit 
penyertaan komponen. Ini dijelaskan secara rinci di bagian ”Komponen dan Permukaan bagian 
depan". 

Untuk tutorial Gedung Pengadilan, pastikan saja bahwa busur dan lingkaran disetel ke nilai 
default 12 dan 24 sisinya. Model tutorial tidak dapat dibangun dengan benar jika Anda 
menggunakan nilai lain. 

Hidden geometry 

Face 3D yang diekstrusi yang berasal dari busur atau tepi lingkaran dibuat dari permukaan segi. 
Jumlah face segi sama dengan jumlah sisi yang membentuk busur atau lingkaran. 

Untuk menyetel tepi putus-putus yang membentuk kelengkungan agar terlihat, aktifkan 
Hidden geometry (Lihat Hidden geometry). Ini akan memungkinkan setiap face dipilih dan 
disesuaikan. 
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Gambar: Hidden geometry menyusun silinder 
 

Gambar: Dengan membuat hidden geometry terlihat, Anda dapat Push/pull face individu pada 
silinder. 

Komponen dan Permukaan Segi 

Komponen, seperti jendela dan pintu, dapat ditempelkan ke masing-masing permukaan 
kelengkungan. Ketika hidden geometry terlihat, menempatkan komponen pada permukaan 
tidak berbeda dengan menempatkan komponen pada permukaan lainnya. 

Face segi dapat mengganggu komponen. Misalnya, komponen jendela disusun di antara dua 
sisi, dengan tepi tersembunyi di tengah. Ini akan menyebabkan komponen disembunyikan 
atau terganggu oleh permukaan yang berdekatan. Komponen hanya dapat ditempatkan pada 
satu permukaan datar, dan tidak boleh tumpang tindih dengan facet face yang berdekatan. 
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Gambar: Komponen jendela ditempelkan pada satu muka silinder 
 
 

Gambar: Komponen Jendela ditempelkan di antara dua sisi, menyebabkannya dikaburkan. 

Komponen yang dibuat untuk direkatkan ke permukaan dapat disalin dan diterapkan ke 
permukaan sisi lainnya. Komponen yang dipilih, baik disalin dengan referensi atau hanya 
dipindahkan, akan menempel dan sejajar dengan bagian depan (face) tujuan. Saat Anda 
menerapkan komponen ke sisi bagian depan (face), biarkan SketchUp menyelaraskan 
komponen ke bagian depan (face) sebelum Anda menempatkannya. 
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Gambar: Komponen jendela sedang disalin dari satu permukaan silinder ke yang lain 
menggunakan titik ujung tepi untuk referensi (1). Komponen yang disalin ditempelkan dengan 
benar ke bagian depan (face) tujuan (2). Setelah ditempatkan, jendela akan membuat lubang 
pada permukaan silinder (3). 

Objek facet dapat berisi begitu banyak permukaan sehingga sulit untuk menempatkan 
komponen. Gambar diatas menunjukkan dua massa bangunan yang serupa dengan dinding 
melengkung. Massing dengan 12 faset tidak memungkinkan penempatan komponen Pintu; 
mereka tidak muat di face yang sempit. Sebaliknya, struktur dengan lima segi dengan mudah 
memasukkan komponen Pintu. Saat Anda membuat model, pastikan Anda hanya 
menggunakan jumlah sisi yang diperlukan. 

 
 

Gambar: Jumlah tepi yang digunakan untuk membuat busur dan lingkaran dapat 
memengaruhi penempatan komponen. 

Untuk menambahkan lebih banyak detail volume, Anda juga dapat Push/pull permukaan 
mana pun yang memiliki komponen yang ditempelkan padanya. Jika sebuah permukaan di 
Dorong/Ditarik, komponen yang direkatkan akan bergerak dengan volume yang disesuaikan. 

 
 

Gambar: Komponen akan bergerak dan menyesuaikan saat face di Dorong/Ditarik. 

Tutorial Gedung Pengadilan 

Tutorial Gedung Pengadilan akan membutuhkan lebih banyak waktu untuk diselesaikan 
daripada latihan sebelumnya. Untuk menyelesaikannya, Anda harus memperhatikan detail 
kecil: menyusun dan meletakkan denah dasar, memastikan volume massa benar, dan 
menempatkan komponen khusus dengan benar. 
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Unduh Model: Gedung Pengadilan Jefferson County Saat Anda mengerjakan latihan ini, ingat 
dan terapkan tip-tip ini: 

 Bekerja dengan Hidden geometry yang diubah menjadi terlihat (Lihat Hidden 
geometry). 

 Periksa kembali dimensi dan lokasi sebelum Anda melanjutkan ke langkah berikutnya. 
 Saat membuat draf denah dasar, pastikan tepi dan garis yang menghubungkan busur 

paralel (offset) ditarik tegak lurus. 

 Saat Anda sedang menyusun tepi dan busur, perhatikan baik-baik titik awal, titik akhir, 
dan lokasi tonjolan. 

 Pastikan bahwa garis lengkung dan lingkaran memiliki jumlah faset yang benar. Untuk 
tutorial ini, busur harus memiliki 12 sisi dan lingkaran harus memiliki 24. 

 Perhatikan baik-baik instruksi yang menunjukkan apakah Anda harus mengimbangi 
sebuah face atau sebuah tepi. 

 Draf pada Layer 0. 
 Pastikan tinggi massa bangunan dibuat seperti yang ditunjukkan. Massing harus akurat 

agar komponen dapat ditempatkan dengan baik. 
Hanya empat komponen khusus yang akan dibuat dan digunakan untuk mengisi massa. Untuk 
latihan ini, hanya bagian depan bangunan saja yang perlu diisi komponen jendela dan Pintu. 

 Atur komponen sesuai petunjuk. Dimensi mengacu pada tepi tersembunyi dan tepi 
biasa. Dalam beberapa kasus, Anda perlu menggambar, membuat, atau mengimbangi 
tepi untuk menempatkan komponen. 

 Anda perlu belajar menyalin dan menyusun komponen pada permukaan bersebelahan. 
Ini bisa jadi rumit, dan butuh waktu untuk menguasainya. 

 Ingatlah untuk tidak menimpa komponen dengan tepi putus-putus (tersembunyi). 

Menyusun Plat Lantai 

Mulailah membuat model Gedung Pengadilan Jefferson County dengan membuat draf pelat 
lantai terlebih dahulu, seperti yang dijelaskan dalam langkah-langkah ini: 

1. Pelajari diagram dasar pelat lantai dan biasakan diri Anda dengannya. Buat draf face 
persegi panjang. Gambarlah tepi dari sudut kiri atas ke sudut kanan bawah permukaan 
persegi panjang. Tambahkan lingkaran (radius 50’) ke titik tengah tepi diagonal. 

2. Buat busur di sisi kiri pelat lantai. Hapus tepi diagonal di luar lingkaran. 

 

3. Mengimbangi busur awal ke luar 100’. 
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4. Gambar tepi di sepanjang sumbu hijau. Hubungkan kedua titik ujung ke busur offset 
dari langkah 3. Draf busur kedua (sisi kanan pelat) dan offset 100’. 

 

 
5. Gambarlah tepi tegak lurus dari titik ujung busur offset ke busur pertama. Draft tepi 

mulai 27’di dalam busur offset, di sepanjang sumbu hijau. 
 

 

6. Draft tepi sepanjang sumbu merah, mulai dari titik akhir tepi diagonal lingkaran ke arah 
busur yang berdekatan. Gunakan geometri konstruksi jika diperlukan. Pastikan tepi 
membagi face antara lingkaran dan busur. 
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7. Draft tepi dari lokasi yang ditunjukkan. Tepi akan dihubungkan dari titik ujung facetge 
ke titik ujung tepi facet. Draf total enam sisi: empat di kiri dan dua di kanan pelat lantai. 

 

 
8. Offset busur dalam 26’dan 27' di kedua sisi untuk membuat garis ganda 1’terpisah. 
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9. Hapus permukaan di luar permukaan yang telah digariskan. Pelat lantai harus 
menyerupai gambar. 

 

 
Menambahkan Volume 

Sekarang setelah Anda menyusun pelat lantai, lanjutkan membuat model Gedung Pengadilan 
dengan menambahkan volume. Untuk melakukan itu, Push/pull permukaan di sisi kiri pelat 
lantai, seperti yang ditunjukkan pada langkah 10 hingga 14. 

10. Push/pull alas ke ketinggian 27'-6 ″. Tambahkan tembok pembatas. Parapet adalah 
penghalang seperti dinding di tepi atap atau bangunan. Ketinggian tembok pembatas 
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adalah 7'-6 ″. Permukaan tembok pembatas ditentukan oleh busur offset pada langkah 
8. 

 

11. Push/pull sekumpulan permukaan yang berdekatan ke total 42'-6 ″. Push/pull tembok 
pembatas dengan tambahan 7′-6 ″. 

 

12. Push/pull set face berikutnya ke total 67′-6 ″. Push/pull tembok pembatas dengan 
tambahan 7′-6 ″. 
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13. Push/pull set face berikutnya ke total 77′-6 ″. Push/pull tembok pembatas dengan 
tambahan 7′-6 ″. 

 

 

14. Push/pull set face terakhir di sisi kiri dasar hingga total 75’. Push/pull tembok 
pembatas dengan tambahan 7′-6 ″. 

 

Sekarang saatnya Push/pull permukaan di sisi kanan pelat lantai, seperti yang 
ditunjukkan pada langkah 15 hingga 17. 
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15. Push/pull set face pertama ke ketinggian dasar 27'-6 ″. Push/pull tembok pembatas 
dengan tambahan 7′-6 ″. 

 

 
16. Push/pull sekumpulan permukaan yang berdekatan ke total 42'-6 ″. Push/pull tembok 

pembatas dengan tambahan 7′-6 ″. 
 

 

17. Push/pull set face terakhir ke total 77′-6 ″. Push/pull tembok pembatas  dengan 
tambahan 7′-6 ″ 

 

 

18. Push/pull setengah lingkaran yang terletak di bagian luar pelat lantai sebelah kiri 
setinggi 15 kaki. 
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19. Push/pull setengah lingkaran yang terletak di bagian luar pelat lantai sebelah kanan 
setinggi 15 kaki. 

 

20. Push/pull lingkaran tengah ke ketinggian 82'-6 ″. Push/pull permukaan yang 
berdekatan di kedua sisi lingkaran tengah ke ketinggian 75’. 
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21. Offset permukaan atas lingkaran tengah seperti yang ditunjukkan. 
 

 
22. Push/pull empat sisi dalam yang Anda offset pada langkah sebelumnya ke ketinggian 

7'-6 ″. Dua permukaan dalam terakhir harus 7'-6 ″ lebih tinggi dari permukaan yang 
berdekatan. Jangan Push/pull dua sisi luar. 

 

23. Masukkan komponen Courthouse Glass Dome. Komponen ini dapat ditemukan di 3D 
Warehouse di bawah istilah penelusuran SPM 2. Tempatkan komponen di atas 
lingkaran tengah. Skala dan sesuaikan komponen Kubah Kaca agar pas dengan bagian 
atas permukaan lingkaran dalam, seperti yang ditunjukkan. 
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24. Hidden geometry harus terlihat agar langkah ini berfungsi. Salin enam sisi yang 
menyusun area depan massa bangunan pusat ke bawah sepanjang sumbu biru, 68'-6 ″. 
Pastikan tepi yang disalin membagi bagian face di bawah. Push/pull dua permukaan 
yang kedua terakhir dari luar, 4’ke luar. 

 
 
 

25. Push/pull sisi dalam sisi dari face yang diekstrusi pada langkah sebelumnya menuju 
pusat massa, 5’. 
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26. Gambarlah dua sisi untuk menghubungkan dua permukaan yang diekstrusi. 
Gambarkan tepi dari titik ujung luar atas dan bawah. Jika dilakukan dengan benar, ini 
akan healing face di bagian atas dan depan. 

 
 

 

27. Tambahkan warna pada massa. Warnai seluruh krem (Material Marker Beige). Jangan 
mengubah atau menerapkan warna pada komponen Courthouse Glass Dome. 

 

Menambahkan Komponen Kustom 

Sekarang saatnya menambahkan jendela dan pintu. 

Pada permukaan massa bangunan, buat draf garis besar komponen jendela 1 seperti yang 
ditunjukkan. 

28. Push/pull permukaan jendela ke dalam 2 ″. Tambahkan warna transparan. 



362 
 

 
 

29. Pada permukaan massa bangunan, draft jendela 2. Buat draft garis besar dasar dan 
offset permukaan ke dalam 1’. Pastikan untuk menyusun tiang 2 ″ untuk jendela. 

30. Pada permukaan Dorong/Ditarik, tarik bingkai jendela seperti yang ditunjukkan. 
Push/pull permukaan jendela ke dalam 2 ″. Tambahkan warna. 

 

 

31. Push/pull permukaan jendela 2 ″ ke dalam. Tambahkan warna. 
32. Untuk membuat jendela 3, copy dan paste jendela 2. Buat salinannya unik (klik kanan 

dan pilih Make Unique). Dalam contoh komponen, gambar dua sisi seperti yang 
ditunjukkan dalam grafik. Pastikan mereka membagi bagian depan (face). 
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33. Pilih dua tepi atas bingkai jendela 3. Pindahkan langsung vertikal 2 'untuk membuat 
panel jendela miring. 

34. Untuk membuat pintu, cari dan buat komponen Pintu pada permukaan bangunan 
seperti yang ditunjukkan. Draf di bagian muka (face) yang dibuat pada langkah 26 
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35. Buat konsep komponen Pintu Masuk Utama dalam tiga tahap. Gunakan dimensi yang 
disediakan dalam grafik untuk garis besar komponen umum dan rinci. Pertama, buat 
draf garis besar pintu. 

 

 
36. Tambahkan tiang dan pembagian lebih lanjut ke komponen Pintu Masuk Utama 

dimulai pada langkah sebelumnya. 
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37. Tambahkan tepi pada dua sisi tengah dari komponen Pintu Masuk Utama. Ini akan 
menentukan gagang pintu pada komponen. 

 
 

38. Untuk lebih mendefinisikan komponen Pintu Masuk Utama, menambah dan mengatur 
volume: Push/pull jendela menghadap ke dalam 3 ″. Terapkan Material Markers Yellow 
ke kusen pintu. Push/pull permukaan pintu atas 2’ke arah luar. Terapkan warna 
transparan ke permukaan jendela. 
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39. Pilih dan pindahkan tepi bawah bingkai atas ke dalam 1’untuk membuat panel kusen 
pintu bersudut, seperti yang ditunjukkan pada diagram. 

 

 

40. Salin dan susun tiga komponen Pintu Masuk Utama pada permukaan ekstrusi massa 
bangunan yang dibuat pada langkah 24, 25, dan 26. Skalakan komponen agar pas. 
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Menyusun Komponen pada Gedung 

Sekarang setelah Anda membuat komponen, Anda perlu mengaturnya di gedung seperti 
yang ditunjukkan pada langkah-langkah berikut. 

41. Masukkan jendela 1 di lokasi yang ditunjukkan pada massa. 
 

42. Pastikan Anda menempatkan jendela di muka di lokasi yang benar seperti yang 
diarahkan oleh dimensinya. 
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43. Salin dan tempel jendela kedua 2'-6 ″ dari sisi yang berdekatan/tepi hidden geometry 
putus-putus. 

 

44. Segera setelah menempatkan jendela kedua, tambahkan jendela ketiga dengan jarak 
yang sama antara dua lainnya dengan memasukkan 2/di measurement window. 

 

45. Salin dan tempel ketiga jendela ke bawah 12'-6 ″ sepanjang sumbu biru, menggunakan 
tepi atas jendela sebagai referensi. 
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46. Array/salin tiga jendela dari langkah 45: masukkan 4x ke dalam measurement window. 
Bagian depan sisi bangunan sekarang terdiri dari 15 komponen jendela 1. Langkah 
selanjutnya akan memanfaatkan jendela yang sudah ditempatkan untuk lebih mengisi 
bagian muka bangunan yang berdekatan. 

47. Pilih semua jendela yang Anda tempatkan pada langkah 45 hingga 47. Menggunakan 
tepi kiri atas sebagai referensi, salin dan tempelkan seluruh jendela yang disetel ke 
bagian depan yang berdekatan. Referensikan tepi kiri face untuk penempatan. 
Pastikan jendela yang disalin diatur dengan benar ke permukaan; mereka harus sejajar 
dan memotong lubang di bagian depan. 

 

 
49. Pilih dua kolom kiri jendela yang ditempel di langkah 48. Salin dan tempelkan ke sisi 

berikutnya (ke kanan) dengan cara yang sama seperti yang diuraikan pada langkah 48. 
50. Salin/tambahkan dua jendela di atas jendela yang ditempel dari langkah 49. Saat Anda 

menempatkannya, pastikan untuk menggunakan dimensi yang benar seperti yang 
ditunjukkan. 
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51. Seperti yang ditunjukkan, salin enam jendela dari muka yang sama yang diisi pada 
langkah 45–47. Tempel jendela ke permukaan yang berdekatan di sebelah kiri. 
Gunakan tepi untuk referensi seperti yang ditunjukkan oleh panah kuning pada 
diagram. 

52. Dari permukaan yang sama (langkah 45–47), salin dan tempel enam jendela pada 
permukaan di kiri permukaan sebelumnya. 

 
 
 

53. Pindahkan / salin jendela dari langkah sebelumnya ke permukaan yang berdekatan di 
sebelah kiri. Ini melengkapi penataan jendela untuk sisi bangunan ini. 
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54. Dengan menggunakan metode yang sama seperti pada langkah 42 sampai 53, susun 
dan isi face di sisi lain (kanan) bangunan. Kedua sisi bangunan itu simetris dan 
komposisi jendelanya harus identik. 
Setelah ini selesai, isi bagian tengah, massa bulat bangunan di sebelahnya. 

 
 

55. Sisipkan jendela 3 ke salah satu permukaan massa tengah. Bagian atas jendela harus 
berjarak 5’dari tepi atas lingkaran luar. Pastikan hidden geometry masih terlihat untuk 
menyelesaikan langkah-langkah ini. 
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56. Salin dan tempel lima jendela tambahan ke setiap permukaan, semua 5’di bawah tepi 
atas face segi. 

 
 

 
57. Sisipkan Jendela 2, 2'-6 ″ di bawah Jendela 3. 
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58. Copy/Array jendela 2 ke bawah pada setiap sisi. Jarak tepi atas dari jendela ke jendela 
harus 10′-6 ″. Lakukan ini untuk masing-masing dari enam tampilan depan (face) 

Setelah semua jendela dan pintu ditambahkan, massa pusat bangunan akan muncul seperti 
yang ditunjukkan pada gambar ini. 

 

Menambahkan Detail ke Gedung 

Sekarang bangunan tersebut memiliki pintu dan jendela, Anda dapat menambahkan detail 
yang lebih halus. Set tangga ini akan merinci tembok pembatas yang ada di bagian atas 
atap. 

59. Cari tembok pembatas pertama seperti yang ditunjukkan pada grafik. Detail tembok 
pembatas seperti yang digariskan pada langkah 60 hingga 62. Ulangi langkah ini pada 
tembok pembatas di sepanjang bagian depan bangunan. 
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60. Dimulai dengan tepi kiri permukaan tembok pembatas, gambar persegi seperti yang 
ditunjukkan. Persegi harus berukuran 2′-6 ″ kali 2′-6 ″. Ini harus terletak 2′-6 ″ dari tepi 
kiri tembok pembatas dan 2′-6 ″ dari tepi atas. 

61. Gunakan Pindahkan/Salin dan salin draf persegi ke ujung face. Tempatkan itu 2′-6 ″ 
dari ujung yang terputus-putus. Array/Divide (4 /) untuk membuat tiga salinan dengan 
jarak yang sama. 

62. Menggunakan Push/pull, Dorong setiap sisi ke dalam, paskan ke bagian belakang 
tembok pembatas. Face harus dihapus, meninggalkan kekosongan. 
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63. Pindah ke tembok pembatas berikutnya di sepanjang bagian atas bangunan. Ulangi 
langkah-langkah yang diuraikan sebelumnya untuk membuat rongga pembatas 2′-6 ″ 
kali 2′-6 ″. Sesuaikan jumlah rongga di setiap face sesuai kebutuhan. 

 

64. Ulangi proses pembuatan tembok pembatas di sisi lain bangunan. Dengan cara ini 
detail tembok pembatas cocok di kedua sisi bangunan. 

65. Fokus pada dua face di kedua sisi massa pusat bangunan bundar. Offset setiap face 
10’ke dalam. Push/pull permukaan tengah 2’ke dalam dan Tambahkan Warna: Bahan 
Markers Chipboard. 

66. Tempatkan sebuah persegi panjang di sekitar sembilan jendela terbawah ditempatkan 
pada permukaan pada langkah 47 (set pertama jendela 1). Pastikan persegi panjang 
terpasang dengan tepat ke tepi bawah face. Jangan tumpang tindih atau terhubung ke 
tepi kiri dan kanan face. 

67. Push/pull permukaan yang terbagi ke dalam 2’. Komponen yang ditempelkan akan 
bergerak mengikuti muka. Warnai papan chip face untuk menambahkan warna. Ulangi 
langkah ini untuk lokasi face lainnya di ujung depan bangunan. 
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Model bangunan selesai. Anda dapat menambahkan lebih banyak detail, seperti bayangan, 
untuk membuatnya terlihat lebih realistis. 
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DAFTAR PUSTAKA 
 

Alex Schreyer’s book: The title of Architectural Design with SketchUp: Component-Based 
Modeling, Plugins, Rendering, and Scripting (Wiley) certainly implies that it’s a book for 
architects. That’s not strictly true; it’s actually a great resource for anyone looking to 
find out more about all the topics in the subtitle. Alex deserves special credit for his 
skillful introduction to Ruby scripting for nonprogrammers. 

Bonnie Roskes’s books: Bonnie’s The SketchUp Book (published by 3DVinci) was the first book 
available, and now she has several titles, including SketchUp books for kids. If you think 
you want to get another, bigger book about SketchUp (written with architects and 
other design pros in mind), check out Bonnie’s books at www.3dvinci.net. 

Daniel Tal’s books: Daniel Tal focuses on specific techniques that can help build advanced 
3Dmodeling skills. SketchUp for Site Design: A Guide to Modeling Site Plans, Terrain 
and Architecture, 2nd Edition (Wiley) is, simply put, a great book. Dan’s latest book 
(also published by Wiley) is Rendering in SketchUp: From Modeling to Presentation for 
Architecture, Landscape Architecture and Interior Design. It demystifies the dark art of 
photo realistic rendering in a way that might finally get you to try it. When you’re ready 
to take the next step in your SketchUp relationship, get Dan’s books. 

Dennis Fukai’s books: Three words: jaw-dropping detail. Dennis’s books are hard to describe. 
He’s written seven of them, each is fully illustrated in SketchUp, and each teaches a 
different subject. If you want to discover more about using SketchUp in building 
construction or more about construction itself, or you just want to be completely 
inspired by what you can do with SketchUp, have a look at these books. Search for his 
name on Amazon (www.amazon.com) or go to website, www.insitebuilders.com 

Extension Warehouse: Extensions typically add little bits of functionality for specialized tasks, 
such as 3D printing. Indeed, it's no coincidence that most of the discussion about 
extensions occurs in Chapter 9, which is all about 3D printing. Whether you use 
SketchUp for architecture, woodworking, interior design, movie sets, or something 
else, you can find whole categories of extensions designed to make specific tasks a 
little bit easier. Start exploring at http://extensions.sketchup.com/ or within SketchUp, 
choose Window ⇒ Extension Warehouse. To actually install an extension in SketchUp, 
you need to login with a Trimble ID or Google account. When you log in through 
SketchUp (that is, by choosing Window ⇒ Extension Warehouse), installing an 
extension is usually pretty easy: Just click the red Install button in the upper left of the 
extension's details page. 

Matt Donley’s book: The man behind MasterSketchUp.com has written an e-book called 
SketchUp to LayOut: The Essential Guide to Creating Construction Documents with 
SketchUp Pro and LayOut. Unlike Mike Brightman’s book (which we mention earlier), 
Matt’s book approaches the subject from more of a beginner’s perspective. It also 
shows woodworking and kitchen and bath examples, which should appeal to people 
who aren’t architects. 

MasterSketchUp.com: Matt Donley has put together a nice site dedicated to helpful tips and 
tricks, videos, and other tutorials. He also self-published a book about LayOut; you can 
read about it in the next section. (www.mastersketchup.com) 

Michael Brightman’s book: A recent addition to the SketchUp bookshelf, Michael’s The 
SketchUp Workflow for Architecture: Modeling Buildings, Visualizing Design, and 
Creating Construction Documents with SketchUp Pro and LayOut (Wiley) is a watershed 
in the history of SketchUp publishing. He came up with a viable workflow for using 
SketchUp Pro (including LayOut) to produce complete construction document sets that 
look just like the ones you’d normally use AutoCAD or Revit to make. The stuff in this 
book is insanely clever — you have to read it to believe it. 

http://www.3dvinci.net/
http://www.insitebuilders.com/
http://extensions.sketchup.com/
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my.SketchUp: This free version of SketchUp runs in a web browser. my.SketchUp debuted in 
2016 with a limited toolset, but the main cast of drawing tools is all there. You can 
expect to see more features as the product evolves. All the tools that are available work 
almost exactly as they do in SketchUp, although you will find some minor differences 
to accommodate working in a browser instead of in an application installed on your 
computer. Visit http://www.sketchup.com/products/my-sketchup. 

Online Help Center: The SketchUp Help Center includes hundreds of articles created 
specifically to help new users along. (Rebecca helped to write many of them.) The 
easiest way to get to the SketchUp Help Center is to choose Help ⇒ Knowledge Center 
from the SketchUp menu bar. 

Self-paced tutorials: These are SketchUp files that use scenes to teach different aspects of the 
program in a “follow along with me” style. If this is how you like to figure things out, 
have a look. 

SketchUcation: You find discussions, tutorials, plugins, news, and piles of other good stuff at 
SketchUcation. You'll also find a large and active forum of users from around the world. 
(www.sketchucation.com) 

SketchUp Community Forum: SketchUp's online forum is a thriving online community and a 
great place to learn from other SketchUp users. When a 3D modeling issue has you 
stumped, the folks here can lend you a hand. 

SketchUp School videos: This is a terrific YouTube channel. The free videos are first rate, and 
you can buy a subscription to watch over a hundred more on SketchUp School’s 
website. (www.youtube.com/4sketchupgo2school) The School designers have also 
produced some of the world’s finest SketchUp educational/training videos; you can 
pay for a subscription to watch the School website (www.sketchupschool.com). The 
production quality on these things is outstanding, and Mike Tadros and Alex Oliver 
(two of the School guys) do an amazing job of teaching SketchUp for both the Windows 
and Mac operating systems. 

SketchUp training resources: SketchUp publishes first-rate materials right on its website 
(www.sketchup.com/learn): 

The SketchUpdate blog: Visit the SketchUp blog regularly for news, case studies, tips and 
tricks, modeler profiles, plugins, and other updates. (http://blog.sketchup.com/) 

Video tutorials: When SketchUp first launched in 2000, it became known for its excellent video 
tutorials. Figure 16-1 shows the series for beginners. We can’t recommend them highly 
enough; there’s nothing like seeing SketchUp in action. 

http://www.sketchup.com/products/my-sketchup
http://www.youtube.com/4sketchupgo2school
http://www.sketchup.com/learn)
http://blog.sketchup.com/



